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Info sulla guida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro e corretto
del dispositivo, si prega di leggere con attenzione la guida per l'utente prima di
utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in dotazione sono
progettati esclusivamente per questo dispositivo e potrebbero non essere
compatibili con altri dispositivi.

Le descrizioni si basano sulle impostazioni predefinite del dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad aggiornamenti e il
supporto per tali applicazioni puo essere sospeso senza preawiso. Per eventuali
domande relative alle app preinstallate sul dispositivo, contattare un Centro di
assistenza LG. Per le app installate dall'utente, contattare il provider del servizio
di riferimento.

La modifica del sistema operativo del dispositivo o linstallazione di software
provenienti da fonti non ufficiali potrebbe danneggiare il dispositivo e causare
il danneggiamento o la perdita di dati. Tali azioni costituiscono una violazione
dellaccordo di licenza LG e annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo acquistato
a seconda dellarea, del provider del servizio, della versione del software o del
sistema operativo e sono soggetti a modifiche senza preawiso.

| software, laudio, gli sfondi, le immagini e gli altri elementi multimediali forniti
con questo dispositivo sono concessi in licenza per uso limitato. Lestrazione e
[utilizzo di questi materiali per scopi commerciali o altri scopi potrebbe costituire
una violazione delle leggi sul copyright. La piena responsabilita per ['utilizzo
illegale degli elementi multimediali spetta agli utenti.

| servizi relativi ai dati, come ad esempio messaggistica, caricamento e
download, sincronizzazione automatica o servizi di posizionamento, potrebbero
comportare costi aggiuntivi. Per evitare costi aggiuntivi, selezionare un piano
dati adeguato alle proprie esigenze. Per ulteriori informazioni, rivolgersi al
proprio gestore di telefonia mobile.

La presente guida per l'utente e redatta nelle principali lingue per ogni paese. A
seconda della lingua di redazione, i contenuti potrebbero in parte variare.



Notifiche informative

& ATTENZIONE: situazioni che potrebbero provocare lesioni all'utente e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o danni al
dispositivo.

E NOTA: awisi o informazioni aggiuntive.
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di sequito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come l'intensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)
Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.

+ Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

Anche se si possono riscontrare differenze tra i livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 \W/kg in media per dieci grammi
di tessuto.

Il valore SAR pili elevato registrato per questo modello per ['uso vicino allorecchio & pari a
0,357 W/kg (10 g) e paria 1,304 W/kg (10 g) a contatto conil corpo.



+ Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed &
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati o messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.

Informazioni fornite dalla FCC in merito
all'esposizione alle frequenze radio

Nellagosto del 1996, la Federal Communications Commission (Commissione federale per

le comunicazioni, FCC) degli Stati Uniti, attraverso azione in Report and Order FCC 96-326,
ha adottato uno standard di sicurezza aggiornato relativo allesposizione umana allenergia
elettromagnetica delle frequenze radio emessa dai trasmettitori con normativa FCC. Tali linee
guida sono coerenti con gli standard di sicurezza in precedenza determinati da standard sia
internazionali sia statunitensi. La progettazione del presente dispositivo & conforme alle linee
guida FCC e a tali standard internazionali.

Parte 15.19

Questo apparecchio e conforme alla parte 15 delle norme FCC. Il funzionamento e soggetto
alle due condizioni riportate di seguito:

(1) Il dispositivo non deve generare interferenze dannose.

(2) Il dispositivo deve accettare eventuali interferenze ricevute, incluse quelle che potrebbero
comportare errori di funzionamento.

Parte 15.21

Modifiche non espressamente approvate dal produttore potrebbero annullare lautorita
dellutente all'utilizzo dellattrezzatura.
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Funzionamento del dispositivo indosso all'utente

Il presente dispositivo ¢ stato testato per le tipiche funzioni in cui lo siindossa, mantenendo

la parte posteriore del dispositivo a 1 cm (0,39 pollici) di distanza da corpo dell'utente. Per
rispettare i requisiti FCC relativi allesposizione alle frequenze radio, & necessario mantenere
una distanza di separazione minima tra il corpo dell'utente e la parte posteriore del dispositivo
di 1 cm (0,39 pollici). Potrebbe non essere possibile utilizzare fermagli da cintura, custodie

e accessori simili contenenti componenti in metallo. Gli accessori da indossare che non
mantengono una distanza di separazione di 1 cm (0,39 pollici) tra il corpo dellutente e la parte
posteriore del dispositivo e che non sono stati testati per le tipiche funzioni in cui si indossa il
dispositivo potrebbero non rispettare i limiti FCC relativi allesposizione alle frequenze radio e
devono dunque essere evitati.

Parte 15.105

Questa apparecchiatura é stata testata e rispetta i limiti di un dispositivo digitale di Classe B,

ai sensi della parte 15 delle norme FCC. Questi limiti sono stabiliti per fornire una protezione
adatta dalle interferenze dannose in un'installazione residenziale. Questo apparecchio genera,
utilizza e puo irradiare energia in radiofrequenza; inoltre, se non viene installato e utilizzato
secondo le istruzioni, pud causare interferenze dannose alle comunicazioni radio. Tuttavia, non
esiste alcuna garanzia che queste interferenze non si verifichino in una particolare installazione.
Se la presente apparecchiatura causa interferenze dannose o ricezione di canali televisivi,
determinabili accendendo e spegnendo il dispositivo, si consiglia vivamente di tentare di
correggere linterferenza attuando una o piti delle sequenti misure:

Orientare o posizionare di nuovo lantenna di ricezione.
+ Aumentare lo spazio che intercorre tra lapparecchio e il ricevitore.

+ Collegare lapparecchio a una presa su un circuito differente rispetto a quello a cui &
collegato il ricevitore.

Per assistenza, consultare il rivenditore o un tecnico radio/TV esperto.
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Manutenzione e cura del prodotto

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare [apparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere apparecchio.

Non sottoporre lapparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo all'interno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre & in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Non ricaricare il telefono vicino a materiali infiammabili che potrebbero provocare incendi a
causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).

Non caricare il dispositivo quando si trova su superfici morbide.

Il dispositivo dovrebbe essere caricato in unarea ben ventilata.

Non esporre [apparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.

Usare gli accessori con attenzione e delicatezza. Non toccare [antenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. I danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.
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Il dispositivo e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, & necessario
maneggiare con cura il dispositivo durante o subito dopo ['utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed uninsufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dellutente.

Evitare che la polvere di sostanze estranee entri nel caricatore / porta del cavo USB. Pud
generare calore o fuoco.

Evitare di esporre il dispositivo a basse pressioni dellaria ad alta quota.

Non esporre il dispositivo a pressioni dellaria estremamente basse. Altrimenti cio pud
causare lesplosione della batteria o perdite di liquido o gas infiammabile.

Evitare che il prodotto venga a contatto con liquidi. Non utilizzare o caricare il prodotto se
& bagnato. Se il prodotto si bagna, indicatore dei danni causati dai liquidi cambia colore.
Tenere presente che cio limitera la possibilita di ricevere eventuali servizi di riparazione
gratuiti previsti dalla garanzia.

Funzionamento efficiente del dispositivo

Dispositivi elettronici

Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

| produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 35 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse pud causare danni,
malfunzionamenti o perfino esplosioni.

Indicazioni per un uso sicuro ed efficiente 10



Sicurezza in automobile
Verificare le leggi e le normative che riguardano ['utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la quida.

Prestare la massima attenzione alla guida.

Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o
rispondere a una chiamata.

L'energia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo e dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.

Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto volume per
lunghi periodi.

L'udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati nel tempo. Si
consiglia pertanto di non accendere o spegnere il telefono indossando gli auricolari e di tenere il
volume di ascolto delle conversazioni e della musica a un livello ragionevole.
Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a sentire le persone
nelle vicinanze o se il volume & tale da essere udito dalla persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato pud causare la perdita
delludito.

Indicazioni per un uso sicuro ed efficiente 11



Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
+ Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili allinterno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
L'uso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.

« Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti cellulari. Pertanto,
si consiglia di non affidarsi solo al dispositivo per eventuali chiamate di emergenza. Contattare
il fornitore di servizi locale per conoscere la disponibilita dei servizi di emergenza nel proprio
paese.
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Manutenzione e informazioni sulle batterie

Non & necessario scaricare completamente la batteria prima di ricaricarla. A differenza
dialtri sistemi a batteria, questo cellulare non presenta un effetto memoria in grado di
compromettere le prestazioni della batteria.

Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per consentire una
maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
Tenere puliti i contatti metallici della batteria.

Sostituire la batteria quando le prestazioni non sono pit accettabili. La batteria puo essere
ricaricata centinaia di volte prima che sia necessario sostituirla.

Se la batteria e rimasta inutilizzata per un lungo periodo, ricaricarla per ottimizzarne le
prestazioni.

Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in ambienti
particolarmente umidi, ad esempio nel bagno.

Evitare di lasciare il dispositivo in luoghi con temperature eccessivamente basse o elevate
per non comprometterne le prestazioni.

L'uso di un tipo di batteria errato pud comportare il rischio di esplosioni. Attenersi alle
istruzioni per lo smaltimento delle batterie usate.

Quando il dispositivo e completamente carico, scollegare sempre il caricabatterie dalla presa
di corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete, impostazioni del
prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come ad esempio,
forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Consumo energetico (modalita standby di rete): 0,4 W
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Protezione delle informazioni personali

+ Assicurarsi di proteggere le informazioni personali per evitare la perdita e [uso improprio
delle informazioni sensibili.

Esequire sempre il backup dei dati importanti durante ['utilizzo del dispositivo. LG non &
responsabile di eventuali perdite di dati.

Assicurarsi di esequire il backup di tutti i dati e di ripristinare il dispositivo durante lo
smaltimento del dispositivo per impedire 'uso improprio delle informazioni sensibili.

Leggere attentamente la schermata delle autorizzazioni durante il download delle
applicazioni.

Utilizzare con cautela le applicazioni che hanno accesso a piti funzioni o a informazioni
personali.

Controllare regolarmente gli account personali. In caso di uso improprio, chiedere al provider
del servizio di eliminare o modificare le informazioni del proprio account.

In caso di perdita o furto del dispositivo, modificare la password dellaccount per proteggere
le informazioni personali.

Non utilizzare applicazioni provenienti da fonti sconosciute.

A Awviso sulla sostituzione della batteria

+ Una batteria agli ioni di litio & un componente pericoloso che puo causare lesioni
gravi.

« Lasostituzione della batteria da parte di personale non qualificato puo causare
danni al dispositivo.

« Non sostituire la batteria autonomamente. La batteria potrebbe essere
danneggiata, surriscaldarsi e provocare lesioni. La batteria deve essere sostituita
da personale qualificato. La batteria deve essere riciclata o smaltita separatamente
rispetto ai rifiuti domestici.

Nel caso in cui il prodotto contenga una batteria incorporata nel prodotto che
non puo essere facilmente rimossa dall'utente finale, LG raccomanda che la
batteria venga rimossa solo da professionisti qualificati, sia per la sostituzione sia
per il riciclaggio al termine della vita del prodotto. Per evitare danni al prodotto,

e per la propria sicurezza, gli utenti non devono tentare di rimuovere la batteria,
ma contattare il Servizio clienti di LG o altri fornitori di servizi indipendenti per
ottenere consiglio.

« Larimozione della batteria comporta lo smantellamento della custodia del
prodotto, la disconnessione di cavi/contatti elettrici, e [attenta estrazione della
cella batteria utilizzando strumenti specifici. In caso di bisogno di istruzioni per
professionisti qualificati su come rimuovere la batteria in modo sicuro, si prega di
visitare http7//www.lge.com/global/sustainability/environment/take-back-recycling.
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Funzioni con lo schermo aperto

Modalita schermo aperto

E possibile ruotare il display principale come illustrato in figura per usare due

schermi.

Rotazione verso l'alto

Usare il pollice destro per spostare leggermente in senso orario la parte inferiore

dello schermo principale.

Schermo principale

7

0,

Schermo secondario

5 « Non applicare forza eccessiva, in quanto lo schermo principale si apre in modo

semiautomatico.

« Fare attenzione a non pizzicarsi il pollice quando si tira verso il basso lo schermo

principale.

Funzioni personalizzate




Home schermo aperto

Home schermo aperto ¢ la prima schermata che appare dopo aver ruotato lo
schermo principale. In questa modalita e possibile usare le home page dello
schermo principale e dello schermo secondario separatamente oppure insieme in
vari modi.

[ =

Home schermo
aperto dello
schermo principale

Home schermo
aperto dello schermo
secondario

Schermo principale
La schermata home dello schermo principale appare come illustrato sotto.

Icone delle app

Scegliere e aprire unapp trascinando l'icona dell'app a sinistra e a destra. Alcune app
dello schermo principale possono essere utilizzate sia sullo schermo principale che
quello secondario.
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Configurazione della schermata home

Toccare e tenere premuto uno spazio vuoto dello schermo principale, quindi
configurare la schermata home come desiderato.

Eliminazione delle 1
icone delle app

Configurazione di Cestino app
sfondo e temi 1

Configurazione di
Home schermo
aperto

Uso delle icone delle app

Toccare e tenere premuta 'icona di unapp. E possibile eliminare lapp dalla
schermata home o usare immediatamente varie funzioni dellapp.

I3
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Schermo secondario

La schermata home dello schermo secondario appare come illustrato sotto. Lo
schermo secondario puo essere utilizzato in vari modi.

Icone di accesso rapido —
Barra di navigazione

Impostazione rapida dello schermo secondario.

E possibile trascinare verso il basso la parte superiore dello schermo secondario per

aprire la finestra di impostazione rapida.

- E possibile toccare P per aggiungere o eliminare un‘icona nella finestra di
impostazione rapida o per cambiarne la posizione.

+ Toccare e tenere premuta un'icona nella finestra di impostazione rapida per
aprire la schermata di configurazione.
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LG Touch Pad

Uso di LG Touch Pad —

- Toccare ) per aprire LG Touch Pad.

|

——
=

Uso con un mouse

Uso di LG Touch Pad

+ Una volta attivato LG Touch Pad nello schermo secondario, sullo schermo
principale appare un cursore del mouse come quelli dei PC, da spostare per
scegliere liberamente le icone..
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Uso della Presa Stabile
- E possibile toccare @I per attivare la Presa Stabile.

— Disattiva Presa stabile

-+ Quando é selezionato Presa Stabile, lo schermo secondario e bloccato.

+ Per sbloccarlo, toccare sulla scritta semi-trasparente "Disattiva Presa Stabile”
come mostrato nella figura soprastante

Funzioni personalizzate
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Multitasking in Modalita Schermo aperto

L'uso del multitasking ruotando lo schermo principale consente di usare unapp su
entrambi gli schermi o di usare contemporaneamente due app, una per schermo.

E + Questa funzione potrebbe non essere supportata da alcune app.

Ingrandimento dei video

1 Toccare @3 sullo schermo principale.

2 Scegliere un video da riprodurre e toccare Riproduci video.
3 Toccare {{ sullo schermo secondario.

« Sullo schermo secondario appare la schermata di controllo del video.

= =

=

— Apre il controllo del
video.

Controlla il video —!
sullo schermo
secondario
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Espansione dell'app YouTube
1 Toccare @3 sullo schermo principale.
2 Scegliere il contenuto di YouTube da riprodurre e riprodurlo.

3 Toccare ({ sullo schermo secondario.

+ Sullo schermo secondario appare la schermata di controllo dei contenuti
multimediali.

(=N

e—— Disattiva il controllo dei
contenuti multimediali sullo

schermo secondario
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Uso di Multi App

Una volta selezionate le app con il widget Multi App sullo schermo secondario, &
possibile usare contemporaneamente le due app selezionate ogni volta che si tocca
il widget. Impostare le app usate di frequente come Multi App.

1 Toccare e tenere premuto uno spazio vuoto nello schermo secondario.

— Imposta Multi App

AN —

2 Toccare Impostazioni Multi App (g,
3 Scorrere verso il basso lelenco delle app e selezionare due app da usare come

Multi App.
Yy Bt
& -
Visualizza lanteprima D o Seleziona due a
Multi App ’ ' P
a2 ©
@ 1
S 2/
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A Toccare Applica.

5 Nella schermata principale dello schermo secondario viene creata licona Multi
App.

Usa l'icona Multi App —

E + Per eliminare l'icona Multi App, toccare e tenere premuta l'icona sullo schermo
secondario, toccare Rimuovi da Casa, quindi toccare Rimuovi.
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Funzioni della fotocamera

Uso della fotocamera con lo Modalita schermo

aperto

Quando lo schermo dello smartphone e aperto, & possibile usare delle funzioni
specifiche per la registrazione video sfruttando la Fotocamera Gimbal.

Modalita Gimbal

E possibile utilizzare la fotocamera come se fosse inserita in un gimbal. Registrare |
video in modalita Gimbal per usufruire delle opzioni di stabilizzazione avanzate.

1 Ruotare lo schermo principale.
+ Se l'app fotocamera e gia aperta, quando si apre lo schermo la modalita
Gimbal si attiva automaticamente.

2 Toccare (@) sullo schermo principale.
3 Selezionare Modalita Gimbal scorrendo le modalita della fotocamera.

/A Toccare @ per awiare [a registrazione in modalita Gimbal.

Impostazioni 1 T Risoluzione
——
Modalits Pan Follow 1 e— Impostazioni del flash
Modalita First Person View 1 Ripristina impostazioni
Modalita Follow Modalita Blocco

Effetti sonori L Joystick

Elenco modalita foto —

Barra di navigazione —

S 2/

- Per scattare una foto mentre si registra un video, toccare @).

- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare @.

5 Toccare @) per terminare la registrazione.
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Modalita FPV (First
Person View)

Consente spostamenti laterali, verticali e variazioni di
inclinazione dell'inquadratura. Questa modalita simula i
movimenti che puoi fare con la tua testa ed é consigliata per le
riprese in cui vuoi sequire ['azione in maniera dinamica.

Modalita Pan Follow

Consente solo gli spostamenti laterali dellinquadratura. Questa
modalita ti aiuta a tenere fissa la linea dell'orizzonte facilitando
le riprese panoramiche.

Modalita Follow

Consente spostamenti laterali e verticali dellinquadratura, ma
inibisce le variazioni diinclinazione. Questa modalita tiene fissa
la linea dell'orizzonte e simula i movimenti che puoi fare con i
tuoi occhi.

Consigliata per riprendere grandi spazi, come edifici o eventi
sportivi.

Joystick

E possibile spostare il joystick in qualsiasi direzione si desideri, in
modo da orientare linquadratura senza spostare lo smartphone
e allo stesso tempo riducendo al minimo la sfocatura.

Modalita Blocco

Toccare e tenere premuto per bloccare l'inquadratura.

Effetti sonori

- Base: E possibile registrare laudio in stereofonia per le riprese
standard.

+ Registrazione ASMR: Incrementa la sensibilita dei microfoni
per registrare anche i suoni piti flebili.

« Bokeh vocale: Attenua i rumori ambientali per focalizzarsi sulla
voce del soggetto.
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Ripresa di video in Slow Motion

E possibile realizzare video divertenti rallentando la velocita di registrazione.
1 Ruotare lo schermo principale.

2 Toccare (=) sullo schermo principale.

3 Selezionare Slow Motion scorrendo le modalita della fotocamera.

4 Toccare @ o €O per scegliere la durata delleffetto slow motion.

N\
Imposta le opzioni della ——— o Imposta le opzioni del
fotocamera I flash
Sceglie la durata

-

- Parte al rallentatore: Consente di applicare leffetto slow motion a una sezione

specifica del video.

- Toccare © nel momento in cui si desidera che venga applicato leffetto slow
motion. Con una breve pressione, leffetto slow motion viene applicato per 0,5
secondi. Con una pressione prolungata, leffetto slow motion viene applicato
fino a quando non si rilascia il dito.

+ Tutto in Slow Motion: Consente di applicare leffetto slow motion allintero
video.
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Registrazione TimelLapse
E possibile registrare video Timelapse ottimizzati per la situazione.

I video possono essere registrati con velocita ottimale e movimento costante
analizzando vari ambienti di ripresa. La velocita di Timelapse puo essere regolata
automaticamente in base al soggetto e allambiente di ripresa.

E possibile anche selezionare manualmente la velocita di Timelapse.
1 Ruotare lo schermo principale.
2 Toccare (&) sullo schermo principale.

3 Selezionare TimeLapse scorrendo le modalita della fotocamera.

+ Scegliere ingrandimento dello schermo per la scena da registrare sullo
schermo secondario.

Sceglie lingrandimento
dello schermo

Sceglie la velocita di
Timelapse

-

« Scegliere la velocita di Timelapse sullo schermo secondario.

E + Selezionando Auto, viene impostata automaticamente la velocita adatta per lo
schermo da registrare.
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/' Toccare @ per registrare un video.

Durante la registrazione, & possibile cambiare lo zoom e la velocita di
Timelapse.

Toccando la velocita desiderata, la velocita di Timelapse viene regolata
durante la registrazione.

Per mettere in pausa la registrazione del video, toccare @). Per riprendere la
registrazione del video, toccare @.

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare |'area desiderata per regolare la
luminosita.

5 Toccare @ per arrestare la registrazione.
« llvideo registrato viene salvato nella Galleria.

« Durante la registrazione Timelapse, laudio non viene registrato.

- E possibile toccare @ per registrare video Timelapse notturni.
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Ripresa di una registrazione video doppia

E possibile utilizzare contemporaneamente le fotocamere anteriore e posteriore
per registrare un video. E possibile salvare i video di ciascuna fotocamera come un
unico file oppure come due file distinti.

1 Ruotare lo schermo principale.
7 Toccare (%) sullo schermo principale.

3 Selezionare Dual recording scorrendo le modalita della fotocamera.
+ Lafotocamera pop up frontale si solleva automaticamente.

/I Toccare @) per registrare un video con doppia registrazione.

—

Schermata di registrazione frontale J { I— Schermata di registrazione posteriore

Dividi vista —oi =l PP

- E possibile toccare e tenere premuto lo schermo principale e trascinare per
cambiare la posizione delle schermate della fotocamera frontale e di quella
posteriore.

+ Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare .

5 Toccare @) per terminare la registrazione.

E « Se i sceglie di salvare separatamente, i video della fotocamera frontale e di quella
posteriore vengono salvati come file distinti.

Se si sceglie di salvare come illustrato, i video della fotocamera frontale e di quella
posteriore vengono salvati in uno schermo.

A + Quando si awia la modalita Doppia registrazione, la fotocamera pop up frontale
si solleva. Non premere o tirare la stessa con forza eccessiva, perché si potrebbe
rompere.
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Ripresa di PIP (Picture in Picture)
+ Toccando (g nella schermata di controllo dello schermo secondario, la
schermata di registrazione passa alla ripresa di una PIP (Picture in Picture).
- Toccando (2), & possibile scambiare le posizioni delle schermate della
fotocamera frontale e di quella posteriore.

- E possibile toccare e tenere premuta la schermata PIP e trascinarla a uno dei
quattro angoli desiderato.

— Riprende una PIP
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Funzioni di registrazione audio

Registrazione video con opzioni di registrazione

audio particolari

E possibile registrare un video con tre diverse opzioni di registrazione vocale, a
seconda della situazione.

1 Toccare (&) e selezionare Video scorrendo le modalita della fotocamera.

7 Toccare @ e selezionare Base, Modalita ASMR o Bokeh vocale scorrendo le
opzioni audio.

Base
E possibile registrare un video con un stabile stiono stereo.

Modalita ASMR

E possibile registrare un video ASMR con i due sensibili microfoni integrati nel
dispositivo.
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Bokeh vocale
E possibile enfatizzare la voce del soggetto riducendo il rumore ambientale.
+ Perridurre il rumore ambientale, trascinare il dispositivo di scorrimento verso 02).

Registrazione di suoni ASMR

Questa funzione consente di registrare 'audio in modo chiaro e preciso
amplificando il suono rilevato dai microfoni.

1 Toccare LG > Registratore Audio HD e toccare = > ASMR.

7 Toccare . per registrare audio.

- Per mettere in pausa la registrazione, toccare @). Per continuare la
registrazione, toccare @).

3 Toccare @) per terminare la registrazione dellaudio.

LG 3D Sound Engine

La funzione LG 3D Sound Engine consente di sentire un suono stereoscopico e
ottimizzato. Durante la riproduzione di musica o video, & possibile ascoltare un
suono stereoscopico e awolgente come se fosse dal vivo.

1 Trascinare verso il basso il pannello notifiche.

7 Toccare @ per attivare o disattivare la funzione LG 3D Sound Engine.
Oppure toccare Impostazioni > Suono > Qualita del suono ed effetti > LG
3D Sound Engine e toccare per attivare la funzione.

5 « Sesi connette al prodotto un dispositivo audio esterno come cuffie o un
altoparlante, appare un pop-up che richiede di attivare la funzione LG 3D Sound
Engine.
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Assistente Google

Panoramica Assistente Google

Il tuo dispositivo dispone di Assistente Google incorporato. Trova le risposte e fai
cose mentre sei in giro.

E « Per utilizzare questa funzione, stabilire prima la connessione alla rete.

Awvio di Assistente Google
1 Scorrere diagonalmente da un angolo inferiore dello schermo.
2 Toccare GET STARTED.

3 Seguire le istruzioni visualizzate sullo schermo.
« Il dispositivo salva i dati della voce dell'utente per il riconoscimento.

4 Impostare se utilizzare o meno la funzione di riconoscimento vocale.

+ Quando questa funzionalita e attivata, & possibile esequire Assistente
Google pronunciando “OK Google” nella schermata Home.

5 Toccare Fine.

Accesso vocale

1 Quando la schermata Home & spenta o bloccata, pronuncia “OK Google” o
“Hey Google.".

7 Quando appare la schermata di Assistente Google, pronuncia un comando o
poni una domanda.
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Accesso dalla schermata Home
1 Scorrere diagonalmente da un angolo inferiore dello schermo.

2 Pronuncia un comando o una domanda quando sulla parte inferiore dello
schermo appare *+ -«

E - Inun ambiente in cui la connessione Wi-Fi o dei dati mobili & scarsa, la funzione
Assistente Google potrebbe essere limitata e la precisione del riconoscimento
vocale potrebbe essere ridotta.

Se la pronuncia & ambigua, il microfono e coperto, un lettore multimediale &

in riproduzione o l'ambiente circostante & rumoroso, il grado di precisione del
riconoscimento vocale potrebbe essere ridotto. Quando si utilizza il prodotto
mediante i comandi vocali, pronunciare le parole con precisione in un ambiente
silenzioso per una migliore precisione del riconoscimento vocale.
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Componenti e accessori del prodotto

I sequenti articoli sono forniti in dotazione con il dispositivo.

+ Dispositivo + Caricabatteria
.+ Cavo USB + Guida introduttiva
+ Spillo di espulsione + Custodia per telefono

Gli elementi descritti sopra possono essere facoltativi.

A

Gli elementi forniti in dotazione con il dispositivo ed eventuali accessori disponibili
possono variare a seconda dell'area e del provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di accessori di altri
produttori puo influire sulle prestazioni di chiamata del dispositivo o causare
malfunzionamenti. Il servizio di riparazione LG potrebbe non coprire simili
situazioni.

Alcune delle componenti del dispositivo sono fatte di vetro temperato. Se si lascia
cadere il dispositivo su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del dispositivo e contattare un Centro di assistenza clienti LG.

E + In mancanza di uno di questi elementi di base, contattare il rivenditore presso cui &
stato acquistato il dispositivo.

Per acquistare altri elementi aggiuntivi, contattare un Centro di assistenza clienti LG.

« Alcuni elementi contenuti nella confezione del prodotto sono soggetti a modifica
Senza preawviso.

- L'aspetto e le specifiche del dispositivo sono soggetti a modifica senza preawviso ai

fini del miglioramento del prodotto.

Le specifiche del dispositivo possono variare a seconda dell'area o del provider del
servizio.

+ Rimuovere la pellicola protettiva dal sensore di impronte digitali prima di utilizzare
la funzione di riconoscimento delle impronte digitali.
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Panoramica delle parti
Fotocamera pop up 4-

Sensore di prossimita/ —— —T T— —— Altoparlante auricolare

luminosita ambientale

]» Tasti volume (+/-)

l— Tasto accensione/blocco

—————————— Touchscreen

—— Sensore per impronte digitali

®

Porta per caricabatteria/

cavo US|
Microfono ———
Obiettivi fotocamera —— ‘
posteriore ‘ @
Q)
Flash —! +— Alloggiamento scheda
[ ) Nano-SIM/Scheda di
H : memoria
: 1 NFC
[N )
—— Area dellantenna per la
ricarica wireless
=
Altoparlante —1 L Microfono
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A Non tentare di rimuovere da sé il coperchio posteriore.

« Fare cio potrebbe danneggiare gravemente la batteria e il dispositivo, e cio
potrebbe causare surriscaldamento, incendi o infortuni. Il coperchio posteriore e
la batteria del dispositivo non devono essere rimossi o sostituiti da personale non
qualificato.

« Il telefono e un dispositivo elettronico che genera calore durante il suo normale
funzionamento. Il contatto diretto ed estremamente prolungato con la pelle
in assenza di unadeguata ventilazione puo provocare disagi e piccole ustioni.
Pertanto, maneggiare con cura il telefono durante o subito dopo ['utilizzo.

« Tastivolume

- Consentono di regolare il volume delle suonerie, delle chiamate o delle
notifiche.

- Durante [utilizzo della Fotocamera, premere delicatamente un tasto volume
per scattare una foto. Per scattare foto in maniera continua, tenere premuto
il tasto volume.

- Quando lo schermo & spento o bloccato, premere il tasto volume gili due
volte per awiare lapp Fotocamera. Premere due volte il tasto volume su per
awiare Capture+.

+ Tasto accensione/blocco
- Premere brevemente il tasto se si desidera accendere o spegnere lo schermo.
- Tenere premuto il tasto se si desidera selezionare unopzione di alimentazione.
+ Sensore per impronte digitali

- E possibile utilizzare il sensore di impronte digitali in basso al centro
dello schermo per utilizzare la funzione di riconoscimento delle impronte
digitali. Per i dettagli, vedere, consultare la sezione Informazioni generali sul
riconoscimento delle impronte digitali.
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Alcune funzioni potrebbero essere limitate a seconda della regione e delle
specifiche del prodotto dei diversi fornitori di servizi di telecomunicazione.

i

+ Nella parte posteriore del prodotto sono integrati il chip NFC e le antenne di
ricarica wireless integrate. Fare attenzione a non danneggiare o coprire il chip NFC
o le antenne di ricarica wireless.

- Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso contrario, il
touchscreen potrebbe danneggiarsi.

La pellicola o accessori di protezione dello schermo potrebbero interferire con il
sensore di prossimita.

Se si utilizzano accessori quali pellicole di protezione, cover e custodie non originali
di LG Electronics, fare attenzione poiché i pulsanti, i sensori e gli obiettivi del
prodotto potrebbero non funzionare correttamente. In tal caso non e possibile
ricorrere al servizio in garanzia fornito da LG Electronics, ed LG Electronics non
garantisce danni quali malfunzionamenti del prodotto.

Se il dispositivo & bagnato o viene utilizzato in un luogo umido, il touchscreen o i
pulsanti a sfioramento potrebbero non funzionare correttamente.

Nel prodotto sono integrati due microfoni. Fare attenzione a non coprire i microfoni.
Mentre si parla al telefono, non coprire il microfono con le mani o le dita.

Non utilizzare custodie per telefono non originali, né coprire il microfono con
accessori, nastro adesivo ecc.

Quando si utilizza il prodotto, tenerlo correttamente, come mostrato nell'immagine.

Microfono Non coprite il microfono.

— —— I'E

G
Na

N ~

Microfono Non coprite il microfono.
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Accensione o spegnimento

Accensione
Quando il prodotto e spento, tenere premuto il tasto di accensione/blocco.
E + Quando si accende il dispositivo per la prima volta, viene avviata la configurazione

iniziale. La durata del primo awio dello smartphone potrebbe essere piti lunga di
quella abituale.

Spegnimento
Tenere premuto il tasto di accensione/blocco, quindi selezionare Spegni.

Riavvio del dispositivo

Se il dispositivo non funziona oppure non risponde ai comandi, riawviarlo seguendo
le istruzioni sottostanti.

1 Tenere premuti contemporaneamente il tasto di accensione/blocco e il tasto
volume giti fino a quando il dispositivo non si spegne.

7 Quando viene riawiato il dispositivo, rilasciare il tasto.

Opzioni di alimentazione

Tenere premuto il tasto di accensione/blocco, quindi selezionare unopzione.
+ Spegni: Spegnere il dispositivo.
+ Spegni e riavvia: consente di riawviare il dispositivo.
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Installazione della scheda SIM

Inserire la scheda SIM (Subscriber Identity Module, modulo d'identita dell'abbonato)
fornita dal provider del servizio per iniziare a utilizzare il dispositivo.

A « Utilizzare lo spillo di espulsione con cautela, poiché e dotato di unestremita
appuntita.

1 Inserire la graffetta nel foro dellalloggiamento della scheda e premere la
graffetta, quindi estrarre lalloggiamento della scheda dal prodotto.

2 Allineare le schede Nano-SIM sullalloggiamento delle schede e premere la
scheda nella direzione della freccia come illustrato nella figura.

Scheda Nano-SIM 2

l_ Scheda Nano-SIM 1

E « llvassoio della scheda SIM 2 serve anche come vassoio della scheda di memoria.
Tuttavia, non & possibile posizionare contemporaneamente sia la scheda SIM sia la
scheda di memoria (opzionale).
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3 Inserire lalloggiamento della scheda nel telefono come illustrato nella figura.
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E + Questo dispositivo supporta solamente le schede Nano SIM.

Nano Micro

« Affinché non si verifichino problemi di prestazioni, si consiglia di utilizzare il
dispositivo con il tipo corretto di scheda SIM. Utilizzare sempre una scheda SIM
realizzata in fabbrica, fornita dall'operatore.

« Non perdere la scheda SIM. LG non é responsabile di eventuali danni e altri
problemi causati dalla perdita o dal trasferimento di una scheda SIM.

Fare attenzione a non danneggiare la scheda SIM durante le operazioni di
inserimento e rimozione.

+ Quando siinserisce la carta SIM o la scheda di memoria, & necessario collocarla
correttamente nel foro di alloggiamento della scheda.

+ Quando inserisci di nuovo il foro di alloggiamento della scheda nel dispositivo, &
necessario inserirlo orizzontalmente seguendo la direzione della freccia, come
mostrato in figura. Assicurati che la scheda collocata sul foro di alloggiamento
della scheda non si sposti dalla posizione corretta.

Inserire la scheda SIM sull'alloggiamento con i contatti color oro rivolti verso il
basso.

Assicurati di inserire la carta SIM nel dispositivo seguendo le istruzioni nel manuale
utenti.

Se inserisci o rimuovi ['alloggiamento dal dispositivo, assicurati che non vi entrino
acqua o altri liquidi. Se un alloggiamento o una scheda bagnati vengono inseriti nel
dispositivo, questo potrebbe danneggiarsi.

« Lascheda di memoria e un elemento opzionale.

Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.

Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.
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Inserimento della scheda di memoria

Inserire la scheda di memoria nel dispositivo.

A seconda del produttore e del tipo di scheda di memoria, alcune schede di
memoria potrebbero non essere compatibili con il dispositivo.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.

2 Estrarre lalloggiamento della scheda.

3 Posizionare la scheda di memoria sullalloggiamento con i contatti color oro

rivolti verso il basso.
( )
Scheda di memoria
(Opzionale, venduta separatamente)
S Scheda SIM
©© <

BE S

- J

\
J

A Inserire nuovamente lalloggiamento nello slot.

A « Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.

E Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.
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Rimozione della scheda di memoria

Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
7 Nella schermata Home, toccare Impostazioni > Archiviazione > /\.

2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

w

Rimuovere la scheda di memoria.

4 Inserire nuovamente lalloggiamento nello slot.

A + Non rimuovere a scheda di memoria mentre il dispositivo sta trasferendo o
accedendo a informazioni. In caso contrario, potrebbe verificarsi la perdita o la
corruzione dei dati, oppure il danneggiamento della scheda di memoria o del
dispositivo. LG non & responsabile di eventuali perdite causate dallabuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.
Caricare il dispositivo con il cavo USB tipo C.

Terminale del cavo di ricarica
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Non utilizzare o caricare il prodotto in presenza di umidita sulla porta di ricarica,
su terminali esposti, sul cavo di ricarica, sulladattatore di ricarica ecc. Il prodotto
potrebbe non funzionare correttamente o rompersi o danneggiarsi, e sussiste

il rischio di lesioni causate da scosse elettriche, incendio, surriscaldamento,
esplosione ecc. Se si nota la presenza di umidita in tali aree, interrompere
immediatamente ['utilizzo o la ricarica del prodotto e rimuovere completamente
l'umidita.

>

Non staccare il coperchio della batteria.

Questo prodotto utilizza una batteria non rimovibile. Non rimuovere o sostituire
il coperchio della batteria o la batteria. Se si rimuove o sostituisce il coperchio
della batteria o la batteria, il prodotto potrebbe venire danneggiato, e potrebbe
surriscaldarsi o esplodere.

Usare solo il cavo USB e ladattatore di ricarica forniti con il prodotto come
componenti di base.

Il dispositivo e dotato di una batteria ricaricabile interna. Per motivi di sicurezza,
non rimuovere |a batteria incorporata.

Lutilizzo del dispositivo durante il caricamento potrebbe causare scosse elettriche.
Per utilizzare il dispositivo, interrompere il caricamento.

Rimuovere il caricabatteria dalla presa di alimentazione una volta completato il
caricamento del dispositivo. In questo modo si evita un inutile consumo di corrente.

i

Un adattatore di ricarica che supporta la ricarica rapida e incluso nel prodotto. La
funzione di ricarica rapida potrebbe non funzionare se si utilizza un adattatore di
ricarica rapida diverso da quello originale fornito in dotazione con il prodotto.

Per caricare |a batteria, & anche possibile collegare un cavo USB tra il dispositivo
e un computer desktop o portatile. Questo metodo puo richiedere piti tempo
rispetto al collegamento delladattatore a una presa a parete.

Non caricare la batteria con un hub USB non in grado di mantenere la tensione
nominale. Il caricamento potrebbe non riuscire o arrestarsi inavvertitamente.

Quando ci si reca presso un centro di assistenza per un problema della batteria,
portare con sé il prodotto e il caricabatterie. Poiché la batteria & un materiale di
consumo, la durata della batteria potrebbe ridursi con il passare del tempo.
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Precauzioni per l'utilizzo del dispositivo

Assicurarsi di utilizzare il cavo USB fornito in dotazione, non utilizzare cavi USB
o caricabatterie di terze parti con il dispositivo. La garanzia limitata LG non copre
['uso di accessori di terze parti.

Il mancato rispetto delle istruzioni contenute in questa quida e [utilizzo non
corretto potrebbero portare al danneggiamento del dispositivo.

Ricarica wireless

Questo dispositivo supporta una funzione di ricarica wireless. Carica il dispositivo
con un caricabatteria wireless certificato Qi (opzionale, venduto separatamente).

Caricare la batteria con un caricabatteria wireless

1 Colloca il tuo dispositivo al centro del caricabatteria wireless, allineandolo con
I'antenna per la ricarica wireless sul retro del dispositivo.

+ Per controllare ['area dell'antenna per la ricarica wireless, vedere Panoramica
delle parti.

7 Quando la batteria & stata ricaricata, rimuovere il dispositivo dal caricabatteria.

A + Quando si ricarica la batteria con il caricabatteria wireless, evitare di porre materiali
magnetici, metallici o conduttori tra il dispositivo e il caricabatteria. Infatti, questi
materiali possono disturbare [a ricarica e far surriscaldare il caricabatteria. In
questo caso, il dispositivo, il caricabatteria o la carta SIM/scheda di memoria
possono essere danneggiati
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Se la temperatura della batteria supera un certo livello quando il dispositivo & in
carica, sara necessario interrompere (a ricarica.

Se materiali magnetici, metallici o conduttori dovessero trovarsi vicino al retro del
dispositivo, oppure fosse inserita una custodia protettiva, il dispositivo potrebbe
non essere caricato adeguatamente.

Se si ricarica la batteria con il caricabatteria wireless in aree in cui il segnale di
rete e debole, le prestazioni di rete del tuo dispositivo potrebbero essere ridotte
ulteriormente.

Carica il dispositivo con un caricabatteria wireless certificato Qi (opzionale, venduto
separatamente). Dato che la garanzia limitata LG non copre luso di accessori di
terze parti, contattare il produttore delle stesse.

Questo prodotto supporta la ricarica wireless. Per ricaricare il prodotto utilizzare
un caricabatterie wireless certificato Qi (venduto separatamente). Alcuni
caricabatterie wireless con cavo a spirale potrebbero non supportare |a ricarica
wireless. | caricabatterie che supportano il profilo EPP (Extended Power Profile)
consento la ricarica wireless ad alta velocita.

LG Electronics declina ogni responsabilita per problemi riguardanti accessori di
altre marche. Per tali problemi, contattare il produttore dellaccessorio.

Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in esecuzione diverse
app e funzioni contemporaneamente e in maniera continuativa.

Annullare le operazioni in background per aumentare la durata della batteria.

Per ridurre al minimo il consumo della batteria, sequire questi Consigli:

Disattivare la funzione Bluetooth® o rete Wi-Fi quando non le si utilizza.

Impostare lo spegnimento dello schermo su un lasso di tempo il piti breve
possibile.

Ridurre al minimo la luminosita dello schermo.
Impostare un blocco schermo quando il dispositivo non € in uso.

Controllare il livello della batteria quando si utilizza una qualsiasi delle app
scaricate.
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Touchscreen

E possibile imparare a conoscere le modalita di controllo del dispositivo mediante
[utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire unapp o
unopzione.

Tenere premuto

Toccare e tenere premuto per diversi secondi per visualizzare un menu con le
opzioni disponibili.
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Toccare due volte

Toccare rapidamente due volte per eseguire lo zoom avanti o indietro su una pagina
\Web o su una mappa.

Trascinamento

Toccare e tenere premuto un elemento, ad esempio un‘app o un widget, quindi
spostare il dito in un'altra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.

Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E possibile
utilizzare questo gesto per scorrere un elenco, una pagina Web, delle foto, delle
schermate e altro ancora.
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Awvicinare e allontanare le dita

Awicinare due dita per eseguire lo zoom indietro, ad esempio su una foto o una
mappa. Per eseguire lo zoom avanti, allontanare le dita.

B

/,'

Non esporre il touchscreen a eccessivi urti fisici. Il sensore touch potrebbe
danneggiarsi.

Se il dispositivo viene utilizzato vicino a materiale magnetico, metallico o
conduttore, potrebbe verificarsi un guasto del touchscreen.

Se si utilizza il dispositivo sotto luci intense come la luce solare diretta, lo schermo
potrebbe non essere visibile a seconda della posizione. Utilizzare il dispositivo

in una posizione ombreggiata o con una luce ambiente non troppo intensa, ma
sufficientemente luminosa da consentire la lettura.

Non premere lo schermo applicando una forza eccessiva.

Toccare delicatamente ['opzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si tocca lo schermo
indossando un guanto o con la punta dellunghia.

Il controllo touch potrebbe non funzionare correttamente se lo schermo e umido
o0 bagnato.

Il touchscreen potrebbe non funzionare correttamente se sul dispositivo &
applicata una pellicola o un accessorio di protezione dello schermo acquistati da un
negozio di terze parti.

La visualizzazione di un'immagine statica per lunghi periodi di tempo potrebbe
causare il fenomeno delle immagini residue o di ritenzione delle immagini.
Spegnere lo schermo o evitare di visualizzare la stessaimmagine per un lungo
periodo quando il dispositivo non € in uso.
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Sfondo

Informazioni generali sulla schermata Home

La schermata Home ¢ il punto di partenza per accedere a diverse funzioni e app
sul dispositivo. Scorrere verso lalto dal bordo inferiore di qualsiasi schermata per
andare direttamente alla schermata Home.

Sulla schermata Home e possibile gestire tutte le app e i widget. Scorrere sulla
schermata verso sinistra o destra per visualizzare in un colpo docchio tutte le app

installate.

Layout della schermata Home
E possibile visualizzare tutte le app e organizzare i widget e le cartelle sulla

schermat:

5

a Home.

Barra di stato —]

etz _.-

-— Widget di ricerca di Google

4 .
Cartella —' P ﬂ o3

Icona della pagina
i (s » N & K— Area diaccesso rapido
Barra di navigazione — e T

« Laschermata Home puo variare a seconda della politica del produttore, delle

impostazioni dell'utente, della versione del software o del provider del servizio.
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Barra di stato: consente di visualizzare le icone di stato, lorario e il livello della
batteria.

Widget meteo: consente di visualizzare le informazioni meteorologiche e
l'orario di una zona specifica.

Widget di ricerca di Google: digita o parla per aprire Google Search.

Cartella: £ possibile creare cartelle per classificare le app in base ai criteri
desiderati.

Icona della pagina: consente di visualizzare il numero totale di aree della
schermata Home. E possibile toccare licona della pagina desiderata per
accedere alla pagina selezionata. L'icona corrispondente allarea corrente verra
evidenziata.

Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

Barra di navigazione: consente di andare alla schermata precedente o alla
schermata Home durante ['uso dellapp, e controllare lelenco delle app usate di
recente.

Uso della barra di navigazione
Questa ¢ la guida alle gesture per il controllo della barra di navigazione.
- Per andare alla schermata Home, scorrere verso 'alto dal bordo inferiore dello
schermo.
+ Per tornare alla schermata precedente, scorrere verso linterno dal bordo sinistro
o destro dello schermo.
+ Per andare alla schermata Panoramica, scorrere verso lalto e tenere premuto
dal bordo inferiore dello schermo.
+ Per passare rapidamente tra le app, scorrere verso destra sul bordo inferiore
dello schermo per andare alle app utilizzate in precedenza.

« Gesti e limpostazione predefinita per la barra di navigazione. Per cambiarla a Solo
pulsanti d]/ O / D nella schermata Home toccare Impostazioni > Display >
Barra di navigazione, quindi selezionare Solo pulsanti
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Icone di stato

Quando & presente una notifica relativa a un messaggio non letto, un evento del
calendario o una sveglia, nella barra di stato viene visualizzata licona di notifica
corrispondente. Verificare lo stato del dispositivo visualizzando le icone di notifica
presenti nella barra di stato.

Nessun segnale

H N

Trasmissione di dati tramite la rete in corso

N
r

Sveglia impostata

A

Modalita vibrazione attiva

Bluetooth attivo

Collegato a un computer tramite USB

Livello batteria

Modalita Aereo attiva

Chiamate senza risposta

Wi-Fi attivo

Modalita silenziosa attiva

QA ) N W=D

GPS attivo

“}

Hotspot attivo

Nessuna scheda SIM

La modalita NFC ¢ attiva

Alcune di queste icone potrebbero apparire in modo diverso o non apparire
affatto a seconda dello stato del dispositivo. Fare riferimento alle icone in base
all'ambiente e alla zona effettivi in cui si utilizza il dispositivo nonché al provider
del servizio.

Le icone visualizzate possono variare a seconda dell'area o dei provider dei servizi.
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Pannello notifiche
E possibile aprire il pannello notifiche trascinando la barra di stato verso il basso
sulla schermata principale.
- E possibile trascinare verso il basso la finestra di awiso o toccare licona della
freccia per aprire l'elenco delle icone di impostazione rapida.
- E possibile toccare 0 peraggiungere, eliminare o disporre le icone nella finestra
diawiso.

+ Tenendo premuta licona, viene visualizzata la schermata delle impostazioni
relative alla funzione in questione.

E - E possibile utilizzare il pannello notifiche anche durante il blocco schermo. Trascina
il pannello notifiche quando lo schermo & bloccato per accedere rapidamente alle
funzioni desiderate.
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello schermo in base
allorientamento fisico del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di accesso rapido.

E possibile anche toccare Impostazioni > Display e attivare Rotazione automatica
nella schermata Home.

Modifica della schermata Home
Nella schermata Home, toccare e tenere premuto uno spazio vuoto, quindi avviare
l'azione desiderata da sotto.
+ Perridisporre le aree della schermata Home, toccare e tenere premuta un'area e
trascinarla in un'altra posizione.
+ Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.
+ Per modificare sfondi, temi, icone e AOD, toccare e tenere premuta un‘area
vuota della schermata Home, quindi selezionare Sfondo & Tema.
E inoltre possibile toccare Impostazioni > Sfondo & Tema nella schermata
Home, quindi selezionare sfondi, temi icone e AOD da applicare al dispositivo.

+ Per modificare la griglia, toccare e tenere premuta un'area vuota della
schermata Home, quindi selezionare Griglia. Toccare la griglia desiderata, quindi
toccare Applica.
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+ Per configurare le impostazioni della schermata Home, toccare e tenere
premuta un‘area vuota della schermata Home, quindi selezionare Imposta
schermata home. Per i dettagli, vedere, consultare la sezione Imposta
schermata home.

Per visualizzare o reinstallare le app disinstallate, toccare e tenere premuta
un'area vuota della schermata Home, quindi selezionare Cestino app. Per i
dettagli, vedere, consultare la sezione Cestino app.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare O, quindi
toccare nuovamente la schermata.

Ll Schermata predefinita
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Visualizzazione del tema di sfondo

Nella schermata Home e possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.

Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awicinare le dita sulla schermata Home o trascinare verso lalto — dal bordo
inferiore dello schermo.

Spostamento di app sulla schermata Home
Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla in
un'altra posizione.

+ Perinserire le app utilizzate piti spesso nella parte inferiore della schermata
Home, toccare e tenere premuta un'app, quindi trascinarla nellarea di accesso
rapido nella parte inferiore.

+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella schermata
Home.

Funzioni di base 60



Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla su
un'altra app.
+ Viene creata una nuova cartella e le app vengono aggiunte al suo interno.

Modifica di cartelle

Nella schermata Home, toccare una cartella ed eseguire una delle seguenti azioni.
- Per modificare il nome della cartella, toccare il nome della cartella.
- Per modificare il colore, toccare il cerchio in alto a destra.

« Per aggiungere app, toccare e tenere premuta una app, quindi trascinarla sopra
la cartella e rilasciarla.

+ Per rimuovere un'app dalla cartella, toccare e tenere premuta l'app, quindi
trascinarla all'esterno della cartella. Se l'app rimossa e ['unica esistente nella
cartella, viene rimossa automaticamente anche la cartella.

- E possibile anche aggiungere o rimuovere le app dopo aver toccato ().

E + Quando si utilizza un tema scaricato, non e possibile modificare il colore della
cartella.
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Imposta schermata home
E possibile personalizzare le impostazioni della schermata Home.

1
2

Nel

lla schermata Home, toccare Impostazioni > Display > Sfondo.

Personalizzare le sequenti impostazioni:

Seleziona Launcher: consente di selezionare una modalita per la schermata
Home.

Effetto scorrimento schermo: consente di selezionare un effetto da
applicare quando si passa a un'altra area della schermata Home.

Aspetto delle icone: consente di scegliere se si desidera che le icone
abbiano gli angoli squadrati o arrotondati.

Feed Google: consente di visualizzare alla sinistra della schermata Home
principale.

Ordina le app per:Impostare la modalita di ordinamento delle app sulla
schermata Home.

Nascondi applicazioni: consente di selezionare le app da nascondere nella
schermata Home.

Scorrimento continuo: attivare per consentire lo scorrimento continuo della
schermata Home (ritorno alla prima schermata dopo ['ultima schermata).
Scorri verso il basso su Sfondo: consente di cercare app o contenuti, o
visualizzare le notifiche scorrendo verso il basso sulla schermata Home.
Scorri verso l'alto su Sfondo: consente di cercare app o contenuti
scorrendo verso lalto sulla schermata Home.

Sfondo Lock: consente diimpedire che le app o i widget siano spostati o
rimossi.
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Personalizzazione di Home schermo aperto

Home schermo aperto ¢ la prima schermata che appare dopo aver ruotato lo
schermo principale verso lalto. E possibile utilizzare le schermate Home dello
schermo principale e dello schermo secondario in vari modi.

Orologio e —
meteo

Scorciatoie —r-s
applicazioni

Schermo
principale

%~ Barradi
navigazione

Schermo secondario —

— lcone di accesso rapido
Barra di navigazione —x

Scorciatoie applicazioni: Consente di avviare rapidamente le app nellelenco.

Barra di navigazione: E possibile usare i gesti per andare alla schermata
Home, alla schermata precedente, alla schermata Panoramica o per passare
rapidamente tra le app.

Icone di accesso rapido: Consente di usare le app che si desidera awviare
direttamente.

Funzioni di base
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Configurazione della schermata Home schermo

aperto
E possibile cambiare le impostazioni relative alla schermata Home quando lo
schermo principale e aperto.
1 Nella schermata Home, toccare Impostazioni > Display > Home schermo
aperto.
7 Scegliere la funzione desiderata per impostare una configurazione.
« Scorri verso il basso su Sfondo: consente di selezionare cosa si desidera

visualizzare scorrendo verso il basso la schermata Home principale in
modalita Swivel.

+ Scorciatoia multi-app: consente di scegliere di eseguire due app
contemporaneamente sullo schermo principale e sullo schermo secondario.

+ Scorri verso il basso su Sfondo: consente di selezionare cosa si desidera
visualizzare scorrendo verso il basso lo schermo secondario in modalita
Swivel.

- Effetto scorrimento schermo: consente di scegliere leffetto visivo
desiderato quando si fa ruotare il telefono.

+ lcone del cassetto delle app: consente di visualizzare icona del cassetto
delle app @ sullo schermo secondario.

« Sfondo Lock: consente di impedire che le app o i widget siano spostati o
rimossi.

+ Guida: consente di visualizzare la guida per Swivel Home.
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Blocco schermo

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di accensione/
blocco. Il blocco awiene anche quando il dispositivo viene lasciato inattivo per un
determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un blocco schermo,
viene immediatamente visualizzata la schermata Home.

Per maggiore sicurezza e per impedire |'accesso indesiderato al dispositivo,
impostare un blocco schermo.

E « Il blocco schermo impedisce inutili input tocco sullo schermo del dispositivo
e riduce il consumo della batteria. E altamente consigliabile attivare il blocco
schermo mentre non si usa il dispositivo.

Impostazione di un blocco schermo

Per la configurazione delle impostazioni del blocco schermo sono disponibili varie

opzioni.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Seleziona il blocco dello schermo e quindi selezionare il metodo preferito.

7 Personalizzare le sequenti impostazioni:
Nessuno: consente di disattivare la funzione di blocco schermo.

Trascina: consente di scorrere con un dito sullo schermo per sbloccarlo.

Sequenza: consente di disegnare una sequenza per sbloccare lo schermo.

PIN: consente di immettere una password numerica per sbloccare lo
schermo.

Password: consente diimmettere una password alfanumerica per sbloccare
lo schermo.

Impronte digitali: consente di sbloccare lo schermo utilizzando le impronte
digitali.
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Personalizza Blocco schermo
Puoi personalizzare il blocco schermo.

7 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Personalizza Blocco schermo.

2 Seleziona una funzione che vuoi impostare.

« Orologio: consente diimpostare il punto in cui posizionare ['orologio sul
blocco schermo.

« Collegamenti: Consente di scegliere le app da esequire sul blocco schermo.
Questa impostazione appare solo quando uno schermo di blocco viene
impostato.

- Animazione meteo: Consente di visualizzare le animazioni meteo relative
alla posizione attuale sulla schermata di blocco.

+ Informazioni di contatto per telefono perso: Consente di impostare il
testo da visualizzare sulla schermata di blocco per identificare il proprietario
del telefono.

Impostazioni di Blocco con sicurezza
Puoi impostare blocchi schermo sicuri.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Impostazioni di Blocco con sicurezza.

7 Seleziona una funzione che vuoi impostare.

- Rendi visibile la sequenza (visualizzato solo quando come blocco schermo
& impostata una sequenza): attivare questa opzione per rendere visibile la
sequenza.

+ Blocco timer: Consente di impostare lintervallo di tempo prima che
lo schermo si blocchi automaticamente dopo lo spegnimento della
retroilluminazione (time out a causa di inattivita).

« Blocco istantaneo con tasto accensione: Attivare questa opzione
per bloccare istantaneamente lo schermo quando si preme il tasto di
accensione/blocco. Questa impostazione supera le impostaszioni del timer
del blocco di sicurezza.

+ Mostra blocco (visualizzato solo quando & impostato un blocco schermo):
Attivare questa opzione per visualizzare l'icona di blocco tenendo premuto
il pulsante di accensione/blocco. Toccare l'icona di blocco per disattivare il
smart lock, lo sblocco biometrico e le notifiche sulla schermata di blocco.
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+ Smart Lock: Consente di impostare dispositivi, luoghi, voce e/o rilevamento
su corpo affidabili che permettono al tuo telefono di restare sbloccato.

E « Le opzioni di menu disponibili possono variare a seconda del metodo di blocco
schermo selezionato.

Toc Toc

E possibile accendere o spegnere o schermo toccandolo due volte.

E « Questa opzione é disponibile solo sulla schermata Home fornita da LG. Potrebbe
non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall'utente.

+ Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.

Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Se sitocca la parte superiore o inferiore dello schermo, a velocita di
riconoscimento potrebbe essere pili bassa.

Spegni lo schermo

Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di
blocco.

In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.

Disattivazione di Toc Toc
Se non si desidera utilizzare la funzione Toc Toc, impostare come segue:

Nella schermata Home, toccare Impostazioni > Estensioni > Toc Toc e trascinare
per disattivare la funzione.
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Riconoscimento delle impronte
digitali

Informazioni generali sul riconoscimento delle
impronte digitali

Prima di utilizzare la funzione di riconoscimento delle impronte digitali, & necessario
registrare la propria impronta sul dispositivo.
La funzione di riconoscimento delle impronte digitali puo essere impiegata nei casi
seguenti:

+ Per sbloccare lo schermo.

+ Pervisualizzare i contenuti bloccati in Galleria o QuickMemo+

+ Per confermare un acquisto effettuando laccesso a unapp o identificandosi

tramite limpronta digitale.

E « Limpronta puo essere utilizzata dal dispositivo per il riconoscimento dellutente.
Impronte digitali molto simili appartenenti a utenti diversi potrebbero essere
riconosciute dal sensore diimpronte come la stessa impronta. Per una maggiore
sicurezza, impostare il blocco schermo con una Sequenza, un PIN o una Password.

Se il dispositivo non riesce a individuare le impronte digitali o se si dimentica il
valore specificato per |a registrazione, recarsi presso il pit vicino Centro di servizio
clienti LG con il dispositivo e la scheda di identificazione.

Precauzioni per il riconoscimento delle impronte digitali
L'accuratezza del riconoscimento delle impronte digitali potrebbe diminuire a causa
di diverse regioni. Per massimizzarla, eseguire le sequenti verifiche prima dell'utilizzo
del dispositivo.
+ In basso al centro dello schermo del prodotto, & presente un sensore integrato
che riconosce le impronte digitali. Fare attenzione a non graffiare o danneggiare
il sensore diimpronte digitali con oggetti metallici come monete o chiavi.

Se si desidera acquistare e utilizzare una pellicola di protezione, verificare presso
il luogo di acquisto che il prodotto possa usare il lettore di impronte digitali. Con
alcuni prodotti, il riconoscimento delle impronte digitali potrebbe non essere
possibile o il prodotto potrebbe non funzionare correttamente. In tal caso

non e possibile ricorrere al servizio in garanzia fornito da LG Electronics, ed LG
Electronics non garantisce danni quali malfunzionamenti del prodotto.
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Se si sostituisce la pellicola di protezione sul prodotto con una pellicola
polarizzata che diffonde la luce o con una pellicola troppo spessa, questa puo
ridurre la capacita di riconoscimento delle impronte digitali.

Se sul prodotto si applica vetro temprato o unaltra pellicola di protezione
spessa, la funzione di riconoscimento delle impronte digitali potrebbe non
operare correttamente. In tal caso, assicurarsi di rimuovere la pellicola di
protezione dal prodotto prima di usare la registrazione delle impronte digitali e
la funzione di riconoscimento delle stesse.

In presenza di sostanze estranee (sudore, creme, acqua, sporco, grasso ecc.) sul
sensore di impronte digitali o sul dito da applicare sul sensore, il riconoscimento
delle impronte digitali potrebbe non funzionare correttamente. Pulire il sensore
e il dito e rimuovere tutta ['umidita prima di posizionare il dito sul sensore.

Se la superficie del dito & ruvida a causa di una cicatrice o di un'immersione
prolungata in acqua, il sensore potrebbe non essere in grado di riconoscere
limpronta digitale. In tal caso, registrare unaltra impronta digitale.

Se si piega il dito o si usa solamente la punta del dito, il riconoscimento
dellimpronta potrebbe non avere esito positivo. Assicurati che il tuo dito copra
lintera superficie del sensore per impronte digitali.

Esequire la scansione di un solo dito per ciascuna registrazione. La scansione
di pits di un dito potrebbe compromettere |a registrazione e il riconoscimento
dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria circostante e secca. Se
[aria circostante & secca, evitare a scansione delle impronte digitali o toccare un
oggetto metallico, quale ad esempio una moneta o una chiave, prima di eseguire
la scansione delle impronte al fine di eliminare lelettricita statica.

Funzioni di base 69



Registrazione delle impronte digitali

E possibile registrare e salvare la propria impronta digitale sul dispositivo per
utilizzare l'identificazione tramite impronta digitale.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

E + Questa funzione ¢ disponibile solo se & impostato il blocco schermo.
- Bloccare il dispositivo con una sequenza, un PIN o una password.

« Senon e stato impostato il blocco schermo, attivarlo seguendo le istruzioni
visualizzate sullo schermo. Per i dettagli, vedere, consultare la sezione
Impostazione di un blocco schermo.

2 Controllare la posizione del sensore di impronte digitali in basso al centro dello
schermo e posare leggermente il dito sul sensore.

E « Assicurarsi che il dito copra completamente il sensore di impronte digitali.

3 Seguire le istruzioni visualizzate sullo schermo.

+ Posare il dito sul sensore e tenerlo in posizione fino a quando non si avverte
una vibrazione.

+ Muovere lo stesso dito sul sensore, di poco alla voltg, fino al completamento
della registrazione dellimpronta digitale.

/. Una volta completata la registrazione dell'impronta, toccare OK.

+ Toccare Aggiungi altro per registrare unaltra impronta digitale. Se si registra
solo un'impronta digitale e il dito corrispondente non € in condizioni ottimali,
il riconoscimento dellimpronta potrebbe non funzionare correttamente.
Come misura preventiva, registrare piti impronte digitali.

Funzioni di base 70



Gestione delle impronte digitali
E possibile modificare o eliminare le impronte digitali registrate.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare unimpronta digitale per rinominarla.
Per eliminarla, toccare _||j

Visualizzazione dell'icona dell'impronta digitale

quando lo schermo é spento

E possibile impostare la visualizzazione della posizione del sensore di impronte
digitali sullo schermo quando lo schermo & spento.

71 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Toccare Tocca per mostrare l'icona quando lo schermo & spento per abilitare
lopzione.

Effetto icona

E possibile scegliere [effetto che appare quando si tocca licona dellimpronta
digitale.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Toccare Effetto icona e selezionare leffetto desiderato.
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Sblocco dello schermo con un'impronta digitale

E possibile sbloccare lo schermo o visualizzare i contenuti bloccati utilizzando la

propria impronta digitale.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

7 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare la funzione
desiderata:
+ Blocco schermo: consente di sbloccare lo schermo con un'impronta digitale.

+ Blocco del contenuto: consente di accedere con limpronta digitale ai
contenuti che sono stati bloccati In Galleria e QuickMemo+.

Toc Toc
E possibile accendere o spegnere o schermo toccandolo due volte.

Nella schermata Home, toccare Impostazioni > Estensioni > Toc Toc per abilitare
lopzione.

E + Questa opzione ¢ disponibile solo sulla schermata Home fornita da LG. Potrebbe
non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall'utente.

Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.

Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Sessitocca la parte superiore o inferiore dello schermo, la velocita di
riconoscimento potrebbe essere pit bassa.

Spegni lo schermo

Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di
blocco.

In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.
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Funzione Multitasking

Schermata Utilizzi recenti

Scorrere verso lalto la barra di navigazione = e tenerla premuta per visualizzare la
cronologia di utilizzo recente.

Finestra pop-up
E possibile aprire piti app sullo schermo e passare facilmente da una allaltra in
qualsiasi momento.

T Scorrere verso l'alto e tenere premuto — dal lato inferiore dello schermo.

2 Toccare licona dellapp nella parte superiore sinistra della schermata dellapp e
selezionare Finestra pop-up.

+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.

3 Lapp appare sullo schermo nella forma di una finestra pop-up.

(I

np

E + Questa funzione potrebbe non essere disponibile per alcune app o schermate.
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Utilizzo della finestre popup

+ — Riduce a icona |a finestra pop-up. La finestra pop-up viene ridotta a icona
mobile dell'app e puo essere spostata dove desiderato sullo schermo.

- _ 1 :Espande lapp a schermo intero.
- X :Chiude lapp.

- Per spostare la finestra pop-up: Trascinare |a parte superiore della finestra
pop-up.

- Per regolare le dimensioni della finestra pop-up: Trascinare il bordo sinistro,
destro o inferiore della finestra pop-up.

E « E possibile aprire fino a 5 app usando le finestre popup.

« Per selezionare un'app tra quelle aperte, toccare la relativa finestra pop-up. La
finestra pop-up selezionata viene portata in primo piano.

« Le finestre popup non possono essere spostate nellarea della barra di stato o della
barra di navigazione.
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Uso della cartella delle app per le finestre popup
Toccando — sulla finestra pop-up, la finestra popup viene ridotta a icona dellapp.
E possibile trascinare licona dell’app in qualsiasi punto trascinandola.

Se due o pit finestre popup sono ridotte a icona, viene creata la cartella delle app
per contenere le icone delle app.

E + Licona dellapp utilizzata piu di recente viene usata come icona della cartella delle
app. Toccando l'icona, tutte le icone delle finestre popup ridotte a icona appaiono
nella cartella delle app.
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5 + Sesitoccaalungo la cartella delle app delle finestre popup e si trascina la cartella
della app in Rimuovi, la cartella delle app viene rimossa.
« Per rimuovere una delle app dalla cartella delle app, aprire [a cartella delle app e
trascinare licona dell'app fuori dalla cartella delle app.
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Multi Window

Quando si usa la navigazione a gesti (per impostazione
predefinita)

1 Scorrere verso lalto e tenere premuto — dal lato inferiore dello schermo.
+ Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.
2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare Multi Window.
« Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

« Le applicazioni selezionate vengono visualizzate nella parte inferiore dello
schermo.

Quando si usa la navigazione sono con i pulsanti

1 Toccare E] nella barra di navigazione.
+ Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.

2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare =

+ Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

E + Perregolare le dimensioni dello schermo diviso, trascinare la barra al centro dello
schermo

« Per disattivare la funzione di finestra multipla, trascinare la barra al centro verso
lalto o verso il basso fino allestremita dello schermo.

« La funzione Multi Window non é supportata da alcune app LG o da alcune app
scaricate dal Play Store.
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Crittografia della scheda di memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di memoria.
l'accesso ai dati crittografati sulla scheda di memoria non sara possibile da un altro
dispositivo.

7 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Crittografia e credenziali > Cripta la Scheda SD.

7 Leggere le informazioni generali sulla crittografia della scheda di memoria
visualizzate sullo schermo, quindi toccare Continua per continuare.
3 Selezionare un'opzione e toccare Crittografia.

- Crittografia del nuovo file: consente di crittografare solo i dati salvati sulla
scheda di memoria dopo la crittografia.

Crittografia completa: consente di crittografare tutti i dati attualmente
salvati sulla scheda di memoria.

+ Escludi file multimediali: consente di crittografare tutti i file ad eccezione di
quelli multimediali come musica, foto e video.

E + Una volta awiata la crittografia di una scheda di memoria, alcune funzioni non
sono disponibili.

Se il dispositivo si spegne mentre la crittografia e in corso, il processo di crittografia
non riuscira e alcuni dati potrebbero danneggiarsi. Occorre percio assicurarsi che il
livello della batteria sia sufficiente prima di awiare la crittografia.

L'accesso ai file crittografati & possibile solo dal dispositivo in cui i file sono stati
crittografati.

« Lascheda di memoria crittografata non puo essere utilizzata su un altro
dispositivo LG. Per utilizzare la scheda di memoria crittografata su un altro
dispositivo mobile, formattare la scheda

« E possibile attivare la crittografia della scheda di memoria anche se nel dispositivo
non é installata alcuna scheda di memoria. Qualsiasi scheda di memoria installata
dopo la crittografia verra automaticamente crittografata.
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Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta visualizzando.

Tramite un collegamento rapido

Tenere premuti contemporaneamente il tasto di accensione/blocco e il Tasto
volume git per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots nella
Galleria.

Tramite screenshot

Nella schermata di cui si desidera acquisire uno screenshot, trascinare verso il basso
la barra di stato, quindi toccare ().

E « Peridettagli, vedere, consultare la sezione Scrittura di note su uno screenshot.

Registrazione schermata

E possibile registrare la schermata.

1 Trascinare verso il basso la barra di stato per aprire lelenco delle icone di
accesso rapido.

2 (Se necessario, scorrere a sinistra sull'area delle icone di accesso rapido.)
Sfiorare (®).

3 Leggere la dichiarazione di non responsabilita e toccare Inizio. La registrazione
inizia in 3 secondi.

Seleziona la fotocamera pop up frontale Arresta la registrazione

00:00:05 (&

Tempo di registrazione della schermata Seleziona |a registrazione vocale

+ Quando si tocca 9 la fotocamera pop up si solleva ed & inclusa anche la
visualizzazione dalla fotocamera frontale.
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A Per arrestare la registrazione, toccare (®). Il video registrato viene salvato nella
Galleria.

E « Laviolazione dei diritti di altre persone, quali il diritto di ritratto o di proprieta
intellettuale, o la diffamazione della reputazione di altre persone utilizzando le
funzioni fornite per il servizio di registrazione dello schermo, possono comportare
responsabilita civili, penali o amministrative in conformita con le leggi vigenti. LG
Electronics declina ogni responsabilita legale per le azioni degli utenti.

Immissione di testo

Utilizzo della barra degli strumenti Smart

E possibile usare vari metodi di immissione da tastiera da un'unica posizione. E
possibile selezionare il metodo di immissione desiderato dalla parte superiore della
tastiera.

1 Selezionare il metodo diimmissione da tastiera desiderato dalla barra degli
strumenti Smart.

7 Toccare « « « e selezionare il metodo di immissione da visualizzare nella barra
degli strumenti Smart, oppure riorganizzarli

P R
Barra degli —e = w @ 808 %

strumenti Smart

o] o -] [ -]

« I metodi di immissione supportati possono variare a seconda del dispositivo.

« E possibile attivare o disattivare la barra degli strumenti Smart dalle impostazioni
della tastiera.
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- © :Aggiungere emoji.
+ @ :Toccare per aggiungere emoticon animate o creare le proprie emoji
usando una foto o la fotocamera.

- @ :Consente di usare la tastiera GIF di Tenor. Toccare Accetta per usare
questa funzione.

+ 22 :Aprire Draw Chat.

+ § :Immettere testo tramite voce

- §63 : Accedere alle impostazioni della tastiera.

. - Aprire Appunti.

-/ :Inserire il testo mediante scrittura manuale. E necessario scaricare i dati

della lingua di immissione per la scrittura manuale. Toccare Download per
scaricare i dati della lingua di immissione per la scrittura manuale.

. Attivare a tastiera fluttuante quando si usa la funzione Multi Window. £
possibile anche spostare la testiera nella posizione desiderata.

. :Toccare per usare la modalita di utilizzo con una mano
+ T2 Toccare per regolare le dimensioni della tastiera.
. :Toccare per regolare la trasparenza della tastiera.
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Utilizzo della tastiera Smart
E possibile utilizzare la tastiera Smart per immettere e modificare testo.

Con la tastiera Smart il testo viene visualizzato mentre lo si digita, senza dover
passare dalla schermata a una tastiera tradizionale e viceversa. In questo modo e
possibile trovare e correggere con facilita gli eventuali errori durante la digitazione.

Spostamento del cursore

Con la tastiera Smart & possibile spostare il cursore esattamente nella posizione
desiderata. Quando si digita un testo, toccare e tenere premuta la barra spaziatrice,
quindi trascinarla verso sinistra o destra.

< Smart keyboard >

E + Questa opzione ¢é disponibile solo sulla tastiera QWERTY.
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Suggerimento di parole

La tastiera Smart analizza automaticamente abitudini di utilizzo dell'utente per
suggerire le parole utilizzate pili spesso durante la digitazione. Quanto piu si utilizza
il dispositivo, tanto pit precisi saranno i Consigli.
Immettere un testo, quindi toccare una parola suggerita o trascinare delicatamente
verso lalto il lato sinistro o destro della tastiera.
+ La parola selezionata viene inserita automaticamente. Non e necessario digitare
manualmente ogni lettera della parola.

Smartphone et P P—— sra| Smartphones

I-I-Ill'fl

Copia e incolla

E possibile tagliare o copiare del testo da unapp, quindi incollarlo nella stessa app. £
anche possibile eseguire altre app e incollare il testo al loro interno.

1 Toccare e tenere premuta |'area attorno al testo che si desidera copiare o
tagliare.

7 Trascinare @ / B per specificare l'area da copiare o tagliare.
3 Selezionare Taglia o Copia.
+ Il testo tagliato o copiato viene aggiunto automaticamente agli Appunti.

/. Toccare e tenere premuta la finestra di inserimento del testo, quindi selezionare
Incolla.

E « Inassenza di un elemento copiato o tagliato, 'opzione Incolla non verra
visualizzata.
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Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo
E possibile riprodurre foto, video o canzoni salvate sul proprio dispositivo da una TV,
1 Connettere laTV e il dispositivo alla stessa rete Wi-Fi.

7 Mentre sivisualizzano gli elementi dell'app Galleria o Musica, toccare (g o + >
Riproduci su un altro dispositivo.
Oppure, nella schermata Home toccare Impostazioni > Dispositivi connessi >
Condivisione schermo e quindi toccare () ) per attivare la funzione.

3 Selezionare la TV a cui si desidera connettersi.

E + Perlutilizzo con Chromecast, e consigliabile che i servizi di Google Play siano
aggiornati

Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad esempio un
computer; un dispositivo NAS o un dispositivo mobile, utilizzando le app Galleria o
Musica.

Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado di supportare
la funzione DLNA alla stessa rete wireless.

E « Assicurarsi che la Condivisione file (DLNA) sia attiva sia nel dispositivo mittente
che nel dispositivo connesso.

Ricerca di dispositivi vicini
E possibile visualizzare un elenco di dispositivi DLNA connessi alla stessa rete
selezionando il menu + > Dispositivi nelle vicinanze in ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se li si stesse utilizzando
sul proprio dispositivo.
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Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro dispositivo LG oppure
un tablet.

Invio di file

Dalla Galleria o altre app, toccare : > Condividi 0 <&, quindi selezionare un
dispositivo dallelenco di condivisione file.

Ricezione di file
Trascinare verso il basso la barra di stato e toccare Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione file, nella
schermata Home toccare Impostazioni > Dispositivi connessi > Condivisione File
> SmartShare Beam () ).

5 « E possibile condividere file con determinati dispositivi che supportano DLNA.

Non disturbare

E possibile limitare o disattivare laudio delle notifiche per evitare di essere disturbati
per un determinato periodo di tempo.

Nella schermata Home, toccare Impostazioni > Suono > Non disturbare.
+ Toccare Modo e selezionare la modalita desiderata:

- Solo priorita: consente di ricevere le notifiche sonore o con vibrazione per le
app selezionate. Anche se é attiva la modalita Solo priorita, le sveglie suonano
comunque.

- Silenzio totale: consente di disabilitare sia [audio che la vibrazione.
+ Seleziona le priorita: rricevi allarmi e le notifiche per le app selezionate.
- Chiamate da:imposta una serie di notifiche quando ricevi una chiamata.

E « Chiamate ripetute: la seconda chiamata dalla stessa persona entro 15 minuti non
viene resa silenziosa.
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- Messaggi da:imposta una serie di notifiche quando ricevi un messaggio.

Utilizza modalita Non disturbare: Attiva la funzionalita Non disturbare.

Sonno:imposta il programma in base al quale attivare la funzionalita Non
disturbare.

Guida: Visualizzare la guida per Non disturbare.

AOD (always-on display)

E possibile visualizzare la data, lora o la firma, anche se lo schermo principale e

spento.

Scorrere il lato inferiore della schermata di AOD (always-on display) per attivare

diverse funzioni, tra cui Camera, Capture+, Wi-Fi, impostazioni audio, Bluetooth,

Flash, Musica e molto altro.

7 Nella schermata Home, toccare Impostazioni > Display > AOD (always-on
display).

7 Seleziona 'immagine che vuoi visualizzare e tocca Salva.

Tocca limmagine desiderata tra Orologio digitale, Orologio analogico,
Doppio orologio e Firma o Immagine.

Toccare Mostra display e selezionare Tocca per mostrare per 10 secondi
0 Mostra sempre.

Toccare Strumenti rapidi e lettore musicale per scorrere sulle icone di
stato di Strumenti rapidi e lettore musicale.

+ Per aumentare la luminosita della funzione AOD (always-on display), toccare
Display pit luminoso.
+ Per visualizzare la quida di Always-on display toccare Guida.

E « La batteria potrebbe scaricarsi piti velocemente quando si utilizza AOD (always-on
display). Spegnere questa funzione per risparmiare la batteria.

« Per disattivare la funzione Always-on display, nella schermata Home toccare
Impostazioni > Display > AOD (always-on display), e quindi toccare @ ).
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Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito dal proprio
gestore del servizio.

E « Alcuni store di app potrebbero richiedere la creazione di un account e la
registrazione.

« Alcune app potrebbero essere a pagamento.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ SmartWorld potrebbe non essere supportato a seconda dell'area o del provider
del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

Disinstallazione con il gesto di tocco e pressione lunga

Tenere premuta unarea vuota della schermata, e quindi premere € dellapp da
eliminare.

Disinstallazione tramite il menu delle impostazioni

Nella schermata Home, toccare Impostazioni > Applicazioni > Informazioni
applicazione, selezionare unapp e quindi toccare Disinstalla.

5 « Alcune app non possono essere disinstallate dagli utenti

Disinstallazione di app dallo store di app

Per disinstallare un'app, accedere allo store di app da cui e stata scaricata e
disinstallarla.
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Installazione e disinstallazione di app durante il

setup

Quando si accende il dispositivo per la prima volta, e possibile scaricare le app
consigliate.

E possibile saltare alla fase successiva senza linstallazione.

Cestino app
E possibile visualizzare le app disinstallate. E inoltre possibile reinstallare le app che
sono state disinstallate nelle ultime 24 ore.
1 Nella schermata Home, toccare LG > Cestino app.
Si puo inoltre toccare e tenere premuta unarea vuota della schermata Home,
quindi toccare Cestino app.

7 Attivare la funzione desiderata:
« Ripristina: consente di reinstallare lapp selezionata.
- {i1] : consente di rimuovere definitivamente dal dispositivo le app disinstallate.

E « Le app disinstallate vengono rimosse automaticamente dal dispositivo 24 ore
dopo la disinstallazione. Se si desidera reinstallare le app disinstallate, & necessario
scaricarle nuovamente dallo store di app.

+ Questa funzione e attiva solamente sulla schermata Home. Se si disinstallano delle
app mentre si utilizza la schermata EasyHome o un altro launcher, queste vengono
immediatamente e definitivamente rimosse dal dispositivo.
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Scorciatoie applicazioni

Nella schermata Home, toccare e tenere premuta l'icona di una app come Chiama,
Invia messaggio, Camera, Galleria e Impostazioni per mostrare un menu di accesso
rapido. Utilizza le app in maniera piti semplice grazie alle scorciatoie per app.

« Toccare & per impostare i widget per 'app.
+ Toccare (§) per visualizzare le informazioni sullapp.

5 + Questa funzione ¢ disponibile solo in alcune app.
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Telefono

Chiamata vocale

Per eseguire una chiamata vocale, utilizzare uno dei metodi disponibili, ad esempio
immettere manualmente un numero di telefono e selezionarlo dall'elenco dei
contatti o dall'elenco delle chiamate recenti.

Esecuzione di una chiamata dal tastierino numerico
71 Nella schermata Home, toccare (% > Componi.
2 Eseguire la chiamata utilizzando un metodo a scelta:

- Immettere un numero di telefono e toccare @@.

« Toccare e tenere premuto un numero di composizione veloce.

« Cercare un contatto toccando la lettera iniziale del relativo nome nell'elenco
dei contatti, quindi toccare 9.

E « Perimmettere "+" quando si esegue una chiamata internazionale, toccare e tenere
premuto il numero 0.

« Peridettagli vedereAggiunta di contatti per ottenere ulteriori informazioni su
come aggiungere numeri di telefono all'elenco di selezione rapida.

Esecuzione di chiamate dalla Rubrica
1 Nella schermata Home, toccare (@ > Rubrica.

2 Dopo aver selezionato il numero da chiamare dallelenco dei contatti nella
rubrica, toccare &...
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Risposta a una chiamata

Per rispondere a una chiamata, trascinare ° sulla schermata della chiamata in

arrivo.

+ Se e collegato un auricolare stereo, e possibile eseguire le chiamate utilizzando il
pulsante di chiamata/fine sull'auricolare.

- Per terminare una chiamata senza spegnere lo schermo, nella schermata Home
toccare Impostazioni > Rete & internet > Impostazioni chiamate > Rispondi
e termina chiamate e quindi attivare Termina le chiamate con il tasto di
accensione.

E + Nella schermata Home, toccare Impostazioni > Rete & internet > Impostazioni
chiamate > Rispondi e termina chiamate > Termina le chiamate con il tasto
di accensione, € possibile terminare le chiamate premendo il tasto di accensione/
blocco mentre é attiva la schermata della chiamata in corso.

Rifiuto di una chiamata
Per rifiutare una chiamata in arrivo, trascinare ° attraverso la schermata della
chiamata in arrivo.
+ Per inviare un messaggio di rifiuto, trascinare ['opzione del messaggio di rifiuto
per la schermata.

« Per aggiungere o modificare un messaggio di rifiuto, nella schermata Home
toccare Impostazioni > Rete & internet > Impostazioni chiamate > Blocco
chiamate & Rifiuta con messaggio.

+ Quando e in arrivo una chiamata, premere il tasto volume su, volume giti o il
tasto di accensione/blocco per disattivare laudio della suoneria o la vibrazione,
oppure per mettere in attesa la chiamata.

Verifica di una chiamata in arrivo durante ['utilizzo
di un'app
Quando si riceve una chiamata mentre si sta utilizzando un‘app, & possibile

visualizzare una notifica pop-up nella parte superiore della schermata. Si pud
accettare la chiamatg, rifiutarla o inviare un messaggio dalla schermata pop-up.

E + Nella schermata Home, toccare Impostazioni > Rete & internet > Impostazioni
chiamate > Altre impostazioni > Pop-up di chiamata in arrivo e quindi
selezionare il modo in cui si desidera visualizzare la chiamata in arrivo quando si
usa un'app.
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Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte superiore dello
schermo viene visualizzato 4,

Per visualizzare i dettagli della chiamata persa, trascinare la barra di stato verso il
basso. E inoltre possibile toccare (& > Chiamate nella schermata Home.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata e possibile accedere a varie funzioni toccando i pulsanti
visualizzati sullo schermo:

Rubrica: consente di visualizzare l'elenco di contatti durante una chiamata.

Attesa: mette in attesa la chiamata corrente.

Tastiera: consente di mostrare o nascondere la testiera del telefono.

Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa essere udita
dall'interlocutore.

Bluetooth: consente di passare la chiamata a un dispositivo Bluetooth associato
€ Connesso.

- @ : consente di terminare una chiamata.
-+ :consente di accedere a opzioni di chiamata aggiuntive.

E + Levoci delle impostazioni disponibili possono variare a seconda dell'area e del
provider del servizio.
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Esecuzione di una chiamata a tre vie
E possibile esequire una chiamata a un altro contatto nel corso di una chiamata.

1 Durante una chiamata, toccare + > Aggiungi.

2 Immettere un numero di telefono e toccare .
+ Le due chiamate vengono visualizzate contemporaneamente sullo schermo
e la prima chiamata viene messa in attesa.

3 Per awiare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio provider del
servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate

Per visualizzare i record delle chiamate recenti, nella schermata Home toccare (8 >
Chiamate. E quindi possibile utilizzare le sequenti funzioni:
+ Per visualizzare i record dettagliati delle chiamate, selezionare un contatto. Per
eseguire una chiamata a un contatto selezionato, toccare ...

- Per eliminare i record delle chiamate, toccare : > Elimina.

E « Ladurata visualizzata delle chiamate potrebbe essere diversa da quella addebitata.
Rivolgersi al proprio provider del servizio per ulteriori informazioni.

La cronologia delle telefonate non puo essere recuperata una volta cancellata.

Stringi due dita o allargale per regolare la dimensione del carattere per i registri
delle chiamate o i contatti.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.
7 Nella schermata Home, toccare (% > Componi o Chiamate.

7 Toccare : >Impostazioni chiamate e quindi configurare le opzioni in base alle
proprie preferenze.
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Messaggi

Invio di un messaggio
E possibile creare e inviare messaqgi ai propri contatti utilizzando lapp di
messaggistica.

E - Linvio di messaggi all'estero potrebbe essere soggetto a ulteriori costi. Rivolgersi al
proprio provider del servizio per ulteriori informazioni.

T Nella schermata Home, toccare ).

2 Sfiorare GD.

3 Specificare un destinatario e creare un messaggio.
- Per usare le opzioni multimediali, tocca ().
« Per accedere alle voci di menu opzionali, toccare .

/. Toccare B> per inviare il messaggio.

Lettura di un messaggio

E possibile visualizzare i messaqgi scambiati organizzati per singolo contatto.

1 Nella schermata Home, toccare ).

7 Selezionare un contatto dall'elenco dei messaggi.

E + Nell'elenco dei messaggi o nella finestra di chat, & possibile regolare le dimensioni

dei caratteri posizionando due dita sullo schermo e allontanando o awicinando
le dita.
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Configurazione delle impostazioni dei messaggi
E possibile modificare le impostazioni dei messaggi in base alle proprie preferenze.

1 Nella schermata Home, toccare B
2 Toccare ¢ > Impostazioni dall'elenco dei messaggi.

E - E possibile specificare le impostazioni per la finestra di awiso, il blocco delle
chiamate, l'awiso di emergenza, i messaggi multimediali ecc.

Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare tutti i momenti
memorabili.

Nella schermata Home, toccare (&).

E « Prima di scattare una foto o registrare un video, pulire ['obiettivo della fotocamera
con un panno morbido.

Prestare attenzione a non macchiare [obiettivo della fotocamera con le dita o altre

sostanze.

Le immagini incluse nella presente guida potrebbero essere diverse da quelle
effettive del dispositivo.

+ Lefoto e i video possono essere visualizzati o modificati dalla Galleria. Per i
dettagli, vedere, consultare la sezione Informazioni generali sulla Galleria.

«Non utilizzare il prodotto per scopi che potrebbero violare la privacy o i diritti di
altre persone.
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Scatto di una foto
E possibile scattare foto con la fotocamera del prodotto.
T Toccare (&) e mettere a fuoco il soggetto.
- E possibile toccare il soggetto da mettere a fuoco.
- E possibile allontanare o awicinare due dita per ingrandire o ridurre.
7 Sfiorare @) per scattare una foto.

- Einoltre possibile premere il tasto volume su o volume gili per scattare una
foto.

- E possibile scattare una foto durante la registrazione di un video premendo
® sullo schermo.

+ Le informazioni visualizzate nella schermata di ripresa possono variare a
seconda della fotocamera selezionata (anteriore o posteriore) e alla modalita
fotocamera.

« Lafotocamera si disattiva automaticamente se non la si usa per un po’ di
tempo dopo aver aperto lapp Fotocamera.

Applica gli effetti filtro
Imposta le proporzioni dello Cambia le im ;
[ postazioni della
schermo | 1 fotocamera
Imposta le opzioni della — o +—— Cambia le impostazioni del
fotocamera timer
— Seleziona tra zoom 1.0x con
angolo standard/zoom 2.0x
con angolo standard/zoom
0.5x grandangolare
Consente alla funzione Al di — o——— Apre Google Lens
applicare automaticamente
[effetto migliore per la scena
o——— Consente di passare dalla
? . fotocamera anteriore a quella

Apre la Galleria —————— posteriore e viceversa
Consente di scattare foto
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E « E possibile aprire lapp della fotocamera premendo brevemente due volte il tasto
di accensione. Nella schermata Home, toccare Impostazioni > Estensioni >
Collegamenti e quindi toccare Apri Fotocamera per attivarla.

+ Quando lo schermo & spento o bloccato, awviare la fotocamera premendo due volte
il tasto volume giti. Nella schermata Home, toccare Impostazioni > Estensioni >
Collegamenti e quindi toccare Apri Fotocamera () per attivarla

Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare §63 sulla schermata.

E « Le opzioni disponibili potrebbero variare a seconda della fotocamera selezionata
(anteriore o posteriore) e alla modalita fotocamera selezionata.

Ottimizzatore
automatico della
scena

Riconoscendo la scena che viene registrata, applica automaticamente
limpostazione della risoluzione ottimale.

Riconoscendo la figura umana quando si scatta una foto a una

Composizione ) . .

persona, consiglia la composizione ottimale.

Informa ['utente quando gli occhi del soggetto erano chiusi o
Consigli limmagine e sfocata, per consentire di ottenere una fotografia

ottimale.

Dimensioni foto

Consente di scegliere le dimensioni e le proporzioni della foto.

HDR

Consente di ottenere foto dai colori vividi ed effetti compensati
anche quando le foto sono scattate contro luce. Queste funzioni sono
disponibili grazie alla tecnologia High Dynamic Range (HDR) integrata
nella fotocamera.

Correzione della
distorsione dello
scatto ultra

Corregge la distorsione dello schermo quando si scattano foto ultra
grandangolari.

grandangolare
Risparmia spazio di archiviazione comprimendo il file immagine in
Salva in HEIF formato HEIF. Altri dispositivi potrebbero non supportare i file video
in formato HEIR.
Foto dal vivo Registra 'azione prima e dopo aver scattato una foto.
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Tracking focus

Consente alla fotocamera di mantenere la messa a fuoco sul
soggetto che si tocca sullo schermo, anche se il soggetto & in
movimento. (Disponibile quando & in funzione la fotocamera

Standard.)

Griglia

Consente di visualizzare le griglie di guida in modo da poter scattare
foto o registrare video in base alle linee di riferimento orizzontali e
verticali.

Scatto al Cheese

Consente di scattare una foto pronunciando ‘Cheese; ‘Smile;
‘Whiskey; Kimchi' o LG

Aggiungi Filigrana

Consente di visualizzare una filigrana sulle foto.

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione GPS.

Consente di selezionare se si desidera archiviare le immagini e i video

Archiviazione nellArchivio interno o nella Scheda SD. (Disponibile quando la scheda
di memoria & inserita.)
Guida Fornisce una guida per ciascun menu della fotocamera.

Opzioni aggiuntive della fotocamera anteriore

Correzione della
distorsione del
selfie

Corregge le parti distorte del viso

Salva come
capovolta

Salva le immagini come capovolte dopo aver scattato dei selfie.

Scatto di selfie

Scatta un selfie selezionando le sue opzioni tra Scatto tramite gesto
della mano e Scatto automatico.

5

anteriore.

« E possibile applicare leffetto make-up quando si scatta un selfie con la fotocamera

+ Scatto tramite gesto della mano viene effettuato mediante il riconoscimento
della forma di una mano e Scatto automatico viene effettuato mediante il
riconoscimento di un viso.
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Selezione della modalita

5 possibile selezionare comodamente tra le modalita visualizzate sullo schermo, che
sono selezionate per adattarsi all'ambiente di ripresa.

Toccare (&) e scorrere le modalita della fotocamera verso sinistra o destra, oppure
scorrere lo schermo a sinistra o a destra per selezionare una modalita della
fotocamera.

e Modalita della
fotocamera

Uso delle modalita della fotocamera

Registrazione di video TimeLapse
E possibile registrare video Timelapse ottimizzati per la situazione.

I video possono essere registrati con velocita ottimale e movimento costante
analizzando vari ambienti di ripresa. La velocita di Timelapse pud essere regolata
automaticamente in base al soggetto e all'ambiente di ripresa.

E possibile anche selezionare manualmente la velocita di Timelapse.

1 Toccare (&) e selezionare TimeLapse scorrendo le modalita della fotocamera.
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Imposta le opzioni della —=

fotocamera [
Imposta la risoluzione dello

schermo

2 iles — Imposta/annulla limpostazione
[ del flash
Timelapse notturno

Attiva/disattiva Steady Cam

Timelapse Modalita foto corrente

pR-r— Passaalla fotocamera
anteriore/posteriore

l— Consente di registrare video

Anteprima — ot

2 Toccare @ per registrare un video.

« Durante la registrazione, e possibile cambiare lo zoom e la velocita di
Timelapse.

« Toccando la velocita desiderata, la velocita di Timelapse viene regolata
durante la registrazione.

- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare .

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare l'area desiderata per regolare la
luminosita.

3 Toccare @ per arrestare la registrazione.
+ Il video registrato viene salvato nella Galleria.

5 « Durante la registrazione Timelapse, laudio non viene registrato.
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Registrazione di un video
1 Toccare G e selezionare Video scorrendo le modalita della fotocamera.

2 Toccare @) per registrare un video.

Imposta la fotocamera —— o Impostail flash

Imposta la risoluzione dello Applica leffetto filtro

schermo

Attiva/disattiva Steady Cam

Toccare per cambiare le ——2 S e O€lezionare lo zoom
opzioni audio tra Base, b laf
Modalita ASMR e Bokeh 17 assa alla fotocamera
vocale. anteriore/posteriore

Anteprima 41 (I Consentedi registrare video

- Per scattare una foto mentre si registra un video, toccare @).

- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare .

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare |'area desiderata per regolare la
luminosita.

3 Toccare @) per terminare la registrazione del video.
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Scatto di ritratti
E possibile scattare foto o video in cui il soggetto risalta ed & piti distinto sfocando
lo sfondo.
T Toccare (&) e selezionare Ritratto scorrendo le modalita della fotocamera.
+ Selezionare un effetto desiderato scorrendo le opzioni di effetto disponibili
per Ritratto.
2 Toccare @) per scattare una foto, oppure toccare e tenere premuto @) per
registrare un video.

- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare .

Imposta la fotocamera —g¢} o — Imposta il timer

Imposta le proporzioni dello ——=
schermo

Imposta il valore di apertura

Seleziona un effetto

3 Toccare @) per terminare la registrazione del video.

« Quando appare il messaggio “Ritratto & disponibile’, iniziare a scattare una foto.

La funzione Ritratto potrebbe non essere disponibile se la fotocamera non € in
grado di riconoscere il soggetto-

Durante lo scatto di foto, mantenere una distanza di 1,3 ~ 5 piedi dal soggetto.
« Questa funzionalita non e disponibile se 'ambiente e buio.
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Uso di un adesivo

E possibile aggiungere vari adesivi nelle foto o nei video. E disponibile anche leffetto
dinamico spostando gli Adesivi AR 3D.

T Toccare (&) e selezionare Sticker scorrendo le modalita della fotocamera.

7 Toccare 5 per scattare una foto, oppure toccare e tenere premuto &3 per
registrare un video.
- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare @.

3 Toccare @) per terminare la registrazione.

Adesivi AR 3D

La fotocamera di profondita sul lato posteriore del dispositivo consente di creare
realistici Effetto AR 3D riconoscendo i contorni del viso in modo pili dettagliato.

T Toccare (&) e selezionare Sticker scorrendo le modalita della fotocamera.
2 Toccare @

3 Scorrere lelenco di adesivi verso sinistra o verso destra per selezionare ladesivo
AR da usare.

« Il viso riconosciuto dalla fotocamera viene scansionato in 3D.
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/| Toccare @@ per scattare una foto, oppure toccare e tenere premuto (@) per
registrare un video.

+ Lafoto viene ripresa con Adesivi AR 3D applicato.

E + Lafunzione di scansione 3D della Z-camera & disponibile solo per la ripresa di primi
piani rawvicinati.

Uso di altre modalita della fotocamera
Toccare () e selezionare Altro scorrendo le modalita della fotocamera.

Vista notturna

E possibile scattare foto notturne vivide e nitide. Vista notturna si attiva
automaticamente quando si scattano foto in condizioni di luminosita ridotta.

E possibile anche riprendere scene notturne nitide utilizzando la funzione Vista
notturna manualmente.

1 Toccare @ e selezionare Altro scorrendo le modalita della fotocamera.
2 Sfiorare (.

3 Sfiorare @) per scattare una foto.
- Per regolare la luminosita della foto, spostare € a sinistra o a destra.
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E - Rimanere fermi, in modo che la fotocamera non scuota mentre si scatta una foto.

Panoramica

E possibile creare una foto panoramica spostando la fotocamera nella direzione da
fotografare e unire gli scatti continui di una vista ampia.

1 Toccare @ e selezionare Altro scorrendo le modalita della fotocamera.
7 Sfiorare ;]
3 Toccare @), quindi spostare lentamente la fotocamera in una sola direzione.

/4 Toccare @) per interrompere 'acquisizione della panoramica.

Imposta la fotocamera ——)

E + Quando si sposta la fotocamera in una direzione, assicurarsi che linquadratura
ripresa non sia fuori dalla linea guida.
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Fotocamera manuale
E possibile creare foto dal tocco professionale grazie a varie funzioni avanzate.

1 Toccare @ e selezionare Altro scorrendo le modalita della fotocamera.

7 Toccare &.

3 Personalizzare le sequenti impostazioni della fotocamera.
« Se si seleziona Auto, le opzioni vengono regolate automaticamente in base
al soggetto e allambiente di ripresa.
+ Se e selezionata lopzione Focus peaking, larea di messa a fuoco viene
evidenziata con un colore. Questa funzione e disponibile solo nella modalita
Messa a fuoco manuale (MF).

Imposta la fotocamera ——2 g —— Impostail timer

Imposta le proporzioni dello
schermo

Imposta il flash

Applica leffetto filtro

Visualizza le varie

! opzioni di Graphy

Resetta le
impostazioni

Regolail Regolare il la
bilanciamento del velocita
bianco dellotturatore
Regola la messa

Regola la velocita

afuoco
ISO

Regola la
luminosita

4 Toccare @) per scattare la foto.
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E + Sesitocca @ e si seleziona un effetto Graphy, appare un elenco delle foto
consigliate con varie impostazioni.

La selezione degli effetti Graphy consente di scattare utilizzando il bilanciamento
del bianco, la velocita dell'otturatore e i valori di impostazione ISO applicati alla foto
consigliata.

« La funzione Graphy e disponibile solo nella modalita Fotocamera manuale.

E possibile vedere una varieta di foto consigliate scaricando l'app Graphy da
Google Play Store.

A seconda del proprio piano tariffario, potrebbe essere addebitato il costo dei dati
utilizzati per il download.

+ Toccare @ e quindi Foto con Graphy @ ) per disattivare questa funzione.

Video manuale

E possibile registrare un video personalizzando manualmente diverse opzioni. Si
possono regolare i valori del bilanciamento del bianco, della messa a fuoco, della
luminosita, dell'ISO, della velocita dell'otturatore e altri ancora.

1 Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.

7 Toccare [}

Imposta la fotocamera ——s g Impostail flash

Imposta la risoluzione dello 41 l‘*— Applica leffetto filtro

schermo

Resetta le Regolail
impostazioni bilanciamento
dell'audio

Regola il — =8
bilanciamento del

o — Regolareil la
velocita

bianco dellotturatore
Regola la messa a N
fuoco Regola la velocita
Regola la 1SO
luminosita
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3 Regolare manualmente le impostazioni della fotocamera come necessario.

/I Toccare @ per registrare un video.

Slow Motion

E possibile creare un video divertente cambiando la velocita di movimento dei

soggetti del video.

1 Toccare @ e selezionare Altro scorrendo le modalita della fotocamera.
Sfiorare @.

2
3 Personalizzare le sequenti impostazioni della fotocamera.
4

Toccare @ o « per selezionare la durata delleffetto slow motion.

+ Parte al rallentatore: Consente di applicare leffetto slow motion a una
sezione specifica del video.

- Toccare © nel momento in cui si desidera che venga applicato leffetto
slow motion. Con una breve pressione, leffetto slow motion viene
applicato per 0,5 secondi. Con una pressione prolungata, leffetto slow
motion viene applicato fino a quando non si rilascia il dito.

« Tutte le Slow Motion: Consente di applicare leffetto slow motion all'intero
video.

5 Toccare @ per awiare la registrazione.

- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare .

6 Per terminare la ripresa, toccare @.
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YouTube Live
E possibile registrare un video e caricarlo direttamente su YouTube.

Per utilizzare questa funzione, & necessario soddisfare i requisiti di idoneita. Per i
requisiti, contattare YouTube.

T Nella schermata Home, toccare (&).
2 Selezionare Altro scorrendo le modalita della fotocamera, quindi toccare (o).
E « YouTube Live e disponibile solo quando il proprio dispositivo & connesso a Internet.

Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

Utili funzioni della fotocamera

Scatto di foto con la funzione Al

Quando si scatta una foto, la funzione Al riconosce il soggetto e applica l'effetto
ottimale alla foto.

E « Toccare . per disattivare la funzione Al.

App utili 110



Blocco Esposizione automatica/Messa a fuoco automatica
E possibile fissare il livello attuale di esposizione e mettere a fuoco la posizione
toccando e tenendo premuto lo schermo. Per disattivare la funzione, toccare
unarea vuota sulla schermata.

Blocco Esposizione
automatica/
Messa a fuoco
automatica

E « Questa funzione é disponibile solo in alcune modalita specifiche.

Zoom avanti o indietro

E possibile allontanare o awicinare due dita per ingrandire o ridurre quando si
scattano foto o si registrano video.

E - La funzione di zoom avanti/indietro non & disponibile in modalita selfie

(fotocamera anteriore).
+ Questa funzione non e supportata in diverse modalita.
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Utilizzo di Burst Shot

E possibile scattare foto consecutive e visualizzarle come immagini in movimento
nella Galleria.

1 Toccare @ e selezionare Foto.

2 Toccare e scorrere @) a sinistra o a destra.

+ Vengono scattate piti foto consecutive (fino a 100 foto) mentre si tiene
premuto..

Scatto tramite gesto della mano
E possibile scattare selfie tramite gesti.
Mostrare il palmo della mano alla fotocamera anteriore e quindi stringere il pugno.
E inoltre possibile stringere il pugno e poi aprirlo verso la fotocamera anteriore.
+ Dopo tre secondi la foto viene scattata.

»

i

Per utilizzare questa funzione, passare alla modalita fotocamera anteriore, quindi
toccare §63 > Scatto di selfie> Scatto tramite gesto della mano.

Wil

Assicurarsi che il palmo e il pugno siano all'interno della linea di riferimento in
modo che la fotocamera possa rilevarli

Questa funzione potrebbe non essere disponibile mentre sono in uso alcune altre
funzioni della fotocamera.
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Scatto automatico

E possibile utilizzare la funzione di rilevamento del volto per scattare selfie in
maniera semplice e comoda. Si pud impostare il dispositivo in maniera tale che,
quando ['utente quarda verso lo schermo, la fotocamera anteriore rilevi il volto e
scatti automaticamente un selfie.
+ Quando la fotocamera anteriore rileva il volto, viene visualizzata la cornice guida
di colore bianco. Se il soggetto allinterno della cornice guida smette di muoversi,
la cornice guida diventa blu, quindi la fotocamera scatta una foto.

E - Toccare §83 > Scatto di selfie > Scatto automatico per attivare la funzione
Scatto automatico.

Scatto intervallato
E possibile scattare selfie a intervalli regolari.

Mentre & in uso la fotocamera anteriore, mostrare il palmo della mano alla
fotocamera, quindi stringere rapidamente il pugno per due volte.

+ Vengono scattate quattro foto a intervalli regolari dopo un timer di ritardo di tre
secondi.

Salva come capovolta

Prima di scattare una foto con la fotocamera anteriore, toccare §33 > Salva come
capovolta. 'immagine viene capovolta in senso orizzontale.

E « Durante [utilizzo della fotocamera anteriore, & possibile modificare le modalita di
scatto dei selfie nelle opzioni della fotocamera. Per i dettagli, vedere, consultare la
sezione Personalizzazione delle opzioni della fotocamera.
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Galleria

Informazioni generali sulla Galleria
E possibile visualizzare e gestire le foto e i video salvati sul dispositivo.

Visualizzazione delle foto
E possibile visualizzare le foto salvate nel prodotto.
T Toccare (Y e selezionare la cartella desiderata.

7 Toccare la foto desiderata.
+ La cartella Galleria contiene Foto, Album, Ricordi, e Play.

l— Apre Google Lens.
Consente di tornare alla —e +—— Consente di accedere a opzioni
schermata precedente. aggiuntive.

—— Galleria anteprime

—

Consente di aggiungereao — +— Consente di eliminare le
rimuovere dai preferiti. —l—[—' immagini
Consente di modificare le Consente di condividere le
immagini immagini

E « Toccando leggermente lo schermo, appare il menu Dettagli. Toccando nuovamente
lo schermo, il menu scompare.
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Riproduzione di un video
E possibile riprodurre i video salvati nel prodotto.

e "
Consente di tornare alla —s « : e—— Consente di accedere a
opzioni aggiuntive.

schermata precedente.

Consente di riprodurre o
sospendere la riproduzione
del video.

e— Galleria anteprime

*— Consente di eliminare le

]

Consente di modificare le Consente di condividere le
immagini immagini

Consente di aggiungere ao —
rimuovere dai preferiti.

E « Perregolare il volume dell'audio, trascinare in alto o in basso il lato destro della
schermata del video.

Per regolare la luminosita dello schermo, trascinare verso lalto o verso il basso il
lato sinistro della schermata.

Trascinando lo schermo a sinistra nella schermata di riproduzione video & possibile
riawolgere (REW) e trascinando a destra ¢ possibile avanzare rapidamente (FF).
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Rubrica

Informazioni generali sui contatti
E possibile salvare e gestire i contatti.
Nella schermata Home, toccare LG > Rubrica.

Aggiunta di contatti

Aggiunta di nuovi contatti

T Nella schermata dell'elenco dei contatti, toccare .

« Appare un pop-up che consente di selezionare la posizione di salvataggio del
contatto. Selezionare la posizione desiderata.

7 Immetterei dettagli del contatto e toccare Salva.

Importazione di contatti
E possibile importare contatti da un altro dispositivo di archiviazione.

1 Nella schermata dell'elenco dei contatti, toccare > Gestisci contatti >
Importa.

2 Selezionare le posizioni di origine e di destinazione del contatto che si desidera
importare, quindi toccare OK.

3 Selezionare i contatti e toccare Importa.

Aggiunta di contatti all'elenco di composizione veloce

1 Nella schermata dell'elenco dei contatti, toccare > Selezione rapida.
7 Toccare Aggiungi contatto da un numero di composizione veloce.

3 Selezionare un contatto.

E + Mentre siaggiunge un nuovo contatto, toccare [3{3 per aggiungere un numero di
chiamata rapida.
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Ricerca di contatti
E possibile ricercare contatti utilizzando una delle sequenti opzioni:

+ Toccare la barra di ricerca nella parte superiore della schermata Rubrica e
inserire il contatto o il numero di telefono che si desidera cercare.

« Scorrere |'elenco dei contatti verso lalto o verso il basso.

« Dall'indice della schermata dell'elenco dei contatti, toccare la lettera iniziale di
un contatto.

E + Premendo la barra di ricerca nella parte superiore della schermata Rubrica e
inserendo un contatto o un numero di telefono, vengono visualizzati i risultati della
ricerca integrati dalla cronologia delle chiamate e dall'elenco dei contatti salvati
nel prodotto.

Elenco dei contatti

Modifica di contatti
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.
7 Nella schermata dell'elenco dei contatti, toccare f e modificare i dettagli.

3 Toccare Salva per salvare le modifiche.

Eliminazione di contatti
E possibile eliminare contatti utilizzando una delle sequenti opzioni:

+ Nella schermata dellelenco dei contatti, toccare e tenere premuto un contatto
che si desidera eliminare, quindi toccare 11}

- Toccare + > Elimina nella schermata dellelenco dei contatti.

E + | contatti cancellati non possono essere recuperati.
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Aggiunta ai preferiti
E possibile registrare i contatti utilizzati pili spesso come preferiti.
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.

2 Nella schermata dei dettagli dei contatti, toccare sﬁ;

Creazione di gruppi

T Nellelenco dei gruppi di contatti, toccare Gruppi, quindi toccare —-

2 Immettere il nome del nuovo gruppo.

3 Toccare Aggiungi iscritti, selezionare i contatti, quindi toccare Aggiungi.

/. Toccare Salva per salvare il nuovo gruppo.

QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni su questa
funzione avanzata del blocco note, come ad esempio la gestione immagini e gli
screenshot, che non sono supportati dal blocco note tradizionale.

Creazione di una nota
1 Nella schermata Home, toccare LG > QuickMemo+.
2 Toccare @ per creare una nota.
- @ : consente di salvare una nota.
+ € :Annullare le modifiche precedenti.
+ (7 :Applicare di nuovo le modifiche annullate di recente.
T :consente di immettere una nota utilizzando la tastiera.
- 9 :consente di salvare i tipi di penna preferiti.
-/ :consente di scrivere delle note a mano.
- A& :consente di cancellare le note scritte a mano.
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- g :consente di passare al font calligrafico qguando si scrive a mano.
-+ :Consente di accedere a opzioni aggiuntive.

3 Toccare @ per salvare la nota.

Scrittura di note su uno screenshot
1 Mentre sivisualizza la schermata che si desidera acquisire, trascinare la barra di
stato verso il basso, quindi toccare @
« La schermata viene acquisita e visualizzata come miniatura nella parte
inferiore destra dello schermo.
7 Per scrivere note sullo schermo, toccare :d:

3 Scrivere note usando gli strumenti.
- T3 : consente diingrandire o ridurre, oppure regolare larea da acquisire.
+ / :consente di scrivere delle note a mano.
- & :consente di cancellare le note scritte a mano.
+ €5:Annullare le modifiche precedenti.
« 7 :Applicare di nuovo le modifiche annullate di recente.
+ (35 : consente diritagliare lo schermo come desiderato.
/Al Toccare N/ e salvare le note.
+ Le note salvate possono essere visualizzate in Galleria.
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Funzioni aggiuntive dopo aver acquisito uno screenshot

DO MORE AT ONCE

Toccare per acquisire l'intero
schermo utilizzando la funzione
di scatto di scorrimento.

Toccare per registrare lo schermo.

Toccare per scrivere note sulla — e i) We e ——— Toccare per eliminare lo
schermata acquisita % m screenshot acquisito
N

Toccare per condividere lo Q

screenshot acquisito.

E + Puoi scattare una foto dellintero schermo, utilizzando la funzione di scatto di
scorrimento
- Durante [uso di unapp come Messaging e Chrome, trascinare verso il basso il
pannello notifiche e quindi toccare ( ) Toccare quindi :~L: per acquisire lintera
schermata visualizzata come unico file
Questa funzione e disponibile solo in alcune app che supportano la funzione scatto
di scorrimento

« Stringi due dita o allargale per regolare il layout del promemoria.
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Orologio

Sveglia

E possibile impostare una sveglia in modo che si attivi a un orario specificato.
1 Nella schermata Home, toccare LG > Orologio > Sveglia.

7 Toccare -} per aggiungere una nuova sveglia.

3 Configurare le impostazioni della sveglia e toccare Salva.

« Sesi seleziona una sveglia impostata in precedenza, € possibile modificarla.

« Per eliminare una sveglia, toccare E > Elimina nella parte superiore dello schermo.
In alternativa, toccare e tenere premuta la sveglia.

Fusi orari
E possibile visualizzare l'ora attuale delle citta di tutto il mondo.
7 Nella schermata Home, toccare LG > Orologio > Fusi orari.

2 Toccare -} e aggiungere una citta.

Timer

E possibile impostare il timer in modo da attivare un segnale acustico dopo un
periodo di tempo specificato.

T Nella schermata Home, toccare LG > Orologio > Timer.

2 Impostare il tempo e toccare Inizio.

« Per sospendere il timer, toccare Pausa. Per riprendere il timer; toccare
Riprendi.

3 Toccare Stop per arrestare la sveglia del timer.
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Cronometro
E possibile utilizzare il cronometro per registrare un tempo.

1 Nella schermata Home, toccare LG > Orologio > Cronometro.

7 Toccare Inizio per awiare il cronometro.
+ Perregistrare un tempo, toccare Giro.

3 Toccare Pausa per sospendere il cronometro.
+ Per riprendere il cronometro, toccare Riprendi.

+ Per cancellare tutte le registrazioni e awviare di nuovo il cronometro, toccare
Reset.

Musica

E possibile riprodurre e gestire canzoni o album musicali
1 Nella schermata Home, toccare LG > Musica.

7 Selezionare una categoria.

3 Selezionare un file musicale.
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Accendi/spegni Flash Light.

Consente di impostare effetti
sonori.

Consente di tornare alla —s -
schermata precedente.

®

i

:e—— Consente di accedere a opzioni
aggiuntive.

— Consente di riprodurre o
sospendere la riproduzione.

Toccare per riprodurre il file
corrente dall'inizio/Toccare due
volte per riprodurre il file
precedente/Toccare e tenere
premuto per riawolgere.

casuale.

3
Consente di riprodurre in ordine ——I
-
s

Consente di regolare il volume —Leay

b4
()

Toccare per riprodurre il file
successivo/Toccare e tenere
premuto per avanzare
velocemente.

3]
L— Consente di selezionare una
modalita di ripetizione.

=e— Andare allelenco In

dellaudio.
Consente di aggiungere a o PR

rimuovere dai preferiti.

riproduzione ora.

E Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

I file di dimensioni superiori al limite massimo potrebbero generare un errore.

I file musicali potrebbero essere protetti dai titolari di copyright internazionali o da

leggi sul copyright. Prima di copiare un file musicale, potrebbe essere necessario
ottenerne l'autorizzazione legale. Per scaricare o copiare un file musicale, verificare
prima le leggi sul copyright del relativo paese.

licona Hi-Fi.

App utili
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Calcolatrice

E possibile utilizzare due tipi di calcolatrici: la calcolatrice semplice e la calcolatrice

scientifica.
1 Nella schermata Home, toccare Google > Calcolatrice.

2 Utilizzare il tastierino numerico per eseguire un calcolo.
+ Per calcolare dallinizio, toccare e tenere premuto {X]

ThinQ

E possibile collegare facilmente il prodotto a dispositivi IoT per monitorarli e
utilizzarli comodamente.

Nella schermata Home, toccare LG > ThinQ_

5

Lavatrice, asciugatrice, styler; lavastoviglie, forno e robot aspirapolvere possono
essere registrati solo quando il prodotto & in modalita standby.

Cercare il marchio ThinQ sul prodotto per vedere se puo essere collegato all'app
ThinQ.

Toccare = per vedere le varie funzioni dellapp ThinQ.
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LG Health

E possibile gestire il proprio stato di salute e mantenere buone abitudini di fitness
monitorando lesercizio fisico svolto.

Informazioni preliminari su LG Health
E possibile configurare LG Health al primo awio dellapp o dopo averla ripristinata.
1 Nella schermata Home, toccare LG > LG Health.

2 Seguire le istruzioni visualizzate sullo schermo per completare la
configurazione.

Utilizzo di LG Health

E possibile visualizzare le informazioni principali su LG Health e gestire la quantita di
esercizio fisico e le informazioni relative alla salute.

1 Nella schermata Home, toccare LG > LG Health.

2 Sono disponibili le sequenti opzioni.

-+ = :consente di visualizzare il registro del proprio esercizio fisico nel giorno
che si desidera monitorare.

- Q :consente diiniziare a monitorare una sessione di esercizio fisico. Il
percorso e la quantita di esercizio fisico svolto vengono registrati per
ciascuna tipologia di esercizio.

-+ :consente di impostare gli obiettivi giornalieri di esercizio fisico, compresi i
passi e le calorie, oppure di configurare diverse impostazioni di LG Health.

E + Le informazioni relative alla salute fornite da LG Health sono studiate per la
comodita dell'utente e non possono essere utilizzate a scopo di prevenzione,
trattamento e diagnosi di malattie né per altri scopi medici.

+ LG Health potrebbe variare o potrebbe non essere disponibile a seconda del paese
e del provider del servizio. Le funzioni di LG Health disponibili e le app che possono
essere abbinate a LG Health possono variare a seconda del paese. Le variazioni
sono dovute alle diverse leggi e normative vigenti.
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Registratore Audio HD

Il Registratore Audio HD ti consentira di configurare manualmente le impostazioni
audio in modo tale da poter registrare audio in base all'ambiente in cui ti trovi.

Modalita di registrazione

E possibile registrare un file audio ad alta definizione selezionando e configurando
la modalita audio desiderata, adatta allambiente di registrazione.

Nella schermata Home, toccare LG > Registratore Audio HD >=—.

Normale
E possibile registrare audio senza impostazioni aggiuntive.

ASMR

E possibile registrare suono ASMR.

Concerto
E possibile registrare audio durante un concerto o altri eventi musicall.

Personalizzato

E possibile configurare manualmente le impostazioni desiderate per registrare
laudio.

Modalita Studio

La modalita Studio consente di riprodurre un file audio o musicale e registrare
contemporaneamente la propria voce, creare un accordo registrando piti volte
la propria voce, nonché registrare i propri commenti sul file audio originale del
presentatore o del parlante.

1 Nella schermata Home, toccare LG > Registratore Audio HD > =>
Personalizzato.

Sfiorare J -
Selezionare un file audio da utilizzare come musica di sottofondo.

Toccare @) per registrare la voce.

u b wN

Toccare @) per salvare il file registrato.
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La musica di sottofondo puo essere riprodotta solo attraverso gli auricolari.
Assicurarsi di collegare gli auricolari prima di utilizzare questa funzione.

Per modificare altre impostazioni, toccare E > Impostazioni, quindi personalizzare
il tipo di file, la profondita in bit, la frequenza di campionamento e altre
impostazioni.

Quando si seleziona la modalita Concerto o Personalizzato con gli auricolari
connessi, appare \[IJ*. Toccare \U* quindi selezionare il microfono da utilizzare

E possibile monitorare la qualita del suono mediante (altoparlante auricolare
collegato durante una registrazione audio. Durante una registrazione audio in
modalita Studio, il monitoraggio del suono non & supportato. E possibile sentire
solamente la musica di sottofondo.

Launcher Del Gioco

E possibile impostare se utilizzare il launcher del gioco, dove & possibile visualizzare
l'elenco dei giochi installati nel prodotto e selezionare le impostazioni di gioco quali
la disattivazione dellaudio multimediale, la limitazione degli awvisi ecc.

1 Nella schermata Home, toccare Launcher Del Gioco.

2 Selezionare lopzione desiderata.

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata Home, toccare LG > Smart Doctor.
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LG Mobile Switch

E possibile trasferire dati con facilita da un dispositivo usato a un dispositivo nuovo
mediante LG Mobile Switch.

1 Nella schermata Home, toccare LG > LG Mobile Switch.
E possibile anche toccare Impostazioni > Sistema > Backup > LG Mobile
Switch.
+ Se l'app non ¢ installata nel prodotto, scaricare e installare I'app LG Mobile
Switch dal Google Play Store.

2 Sequire le istruzioni visualizzate sullo schermo per selezionare il metodo
desiderato per il trasferimento.

E + | datiin un account Google non saranno sottoposti a Backup. Quando si
sincronizza |'account Google, le app di Google, i contatti di Google, il calendario di
Google, i dati delle app di promemoria di Google e le app scaricate dal Play Store
vengono archiviati automaticamente sull'app Drive.

Caricare completamente la batteria prima del trasferimento di dati per evitare lo
spegnimento involontario durante il processo.

Cestino app

E possibile vedere lelenco delle app disinstallate sulla schermata Home. Le app
eliminate nelle ultime 24 ore possono essere recuperate.

Nella schermata Home, toccare LG > Cestino app.
Per maggiori informazioni, vedere Cestino app.
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SmartWorld

E possibile scaricare vari giochi, contenuti audio, app e tipi di carattere forniti da LG
Electronics. Si puo inoltre personalizzare il dispositivo in base alle proprie preferenze
utilizzando temi per la schermata Home e tipi di carattere.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ Questa funzione potrebbe non essere supportata a seconda dell'area o del
provider del servizio.

71 Nella schermata Home, toccare SmartWorld.
7 Toccare > Account LG, quindi effettuare l'accesso.

3 Selezionare e scaricare i contenuti desiderati.

RemoteCall Service

Il dispositivo puo essere sottoposto a diagnostica in modalita remota per risolverne
i problemi. Innanzitutto, eseguire una chiamata telefonica a un Centro di assistenza
clienti LG come segue:

« Per servirsi di questa funzione, & prima necessario accettarne ['utilizzo.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

T Nella schermata Home, toccare LG > RemoteCall Service.
2 Collegare una chiamata al centro di assistenza clienti LG.

3 Al collegamento della chiamata, sequire le istruzioni dell'addetto al servizio per
immettere un numero di accesso a sei cifre.

+ Il dispositivo viene connesso in modalita remota e viene awviato il servizio di
assistenza remota.
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Messaggio CB

E possibile visualizzare trasmissioni di testo in tempo reale su situazioni di
emergenza, come tifoni, inondazioni e terremoti.

Nella schermata Home, toccare Messaggio CB.

App di Google

E possibile utilizzare app di Google impostando un account Google. Quando si
utilizza un'app di Google per la prima volta, viene visualizzata automaticamente

la finestra di registrazione dell'account Google. Se non si dispone di un account
Google, crearne uno dal dispositivo. Per i dettagli su come utilizzare un‘app, vedere
la Guida contenuta nell'app.

E « Alcune app potrebbero non funzionare a seconda dell'area o del provider del
servizio.

Calendario

L'app Calendario consente di tenere traccia del proprio programma di eventi (che &
stato creato), organizzato per Giorno, 3 giorni, Settimana o Mese.

Chrome
Un browser web veloce, semplice e sicuro, costruito per la rete moderna.

Documenti

Docs & uno strumento collaborativo di elaborazione di testi che aumenta la
produttivita. Usa Docs per creare, modificare e lavorare insieme in tempo reale.

Drive

Drive & un'app di condivisione e immagazzinaggio di file che facilita lindividuazione,
la condivisone e la collaborazione su progetti di lavoro ovunque e in ogni istante.
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Duo

Crea video chiamate semplici e di alta qualita verso i tuoi amici e famigliari su
telefoni Android e iPhones.

Gmail

Gmail & un'app facile da usare che tiene al sicuro i tuoi messaggj, rende pit smart la
tua casella di posta e ti aiuta a restare organizzato.

Google

L'app Google ti tiene aggiornato sulle cose che ti interessano. Trova risposte rapide,
esplora i tuoi interessi e ricevi un feed di storie e aggiornamenti su argomenti
importanti per te.

Maps

Stai andando da qualche parte? Vai con Maps, app con GPS in tempo reale sulla
quale puoi fare affidamento per navigazione, traffico, transito e dettagli su milioni di
luoghi, come recensioni ed eventi popolari.

Foto

La casa di tutte le tue foto e video, organizzata automaticamente per condividere e
salvare le cose piti importanti.

Play Film

Consente di utilizzare il proprio account Google per noleqgiare o acquistare film. £

possibile acquistare contenuti e riprodurli ovunque.

YT Music

Un nuovo servizio di streaming musicale da YouTube.
Fogli

Sheets e un foglio di lavoro collaborativo che aumenta la produttivita. Usa Sheets
per importare, organizzare e analizzare informazioni in tempo reale.
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Presentazioni

Google Slides & uno strumento per presentazioni in tempo reale che aumenta la
produttivita. Usa Slides per organizzare informazioni, presentare risultati e prendere
decisioni insieme in tempo reale.

YouTube

Guarda i tuoi canali preferiti, ascolta la musica che ami e carica video da condividere
con le persone intorno a te.

Assistente
Il tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte e fai
cose mentre sei in giro.

E + Assistente Google non e disponibile in tutte le lingue o paesi.

Files
E possibile visualizzare e gestire file salvati sul dispositivo.
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Impostazioni

E possibile personalizzare le impostazioni del dispositivo in base alle proprie
preferenze.

Nella schermata Home, toccare Impostazioni.

E + Inserendo una parola chiave nella finestra di ricerca nella parte superiore dello
schermo, e possibile trovare comodamente gli elementi da impostare

Rete & internet

Dual SIM
E possibile configurare le impostazioni dual SIM.
1 Nella schermata delle impostazioni, toccare Rete & internet > Dual SIM.
2 Personalizzare le seguenti funzioni:
+ Scheda SIM 1: modificare il nome e l'icona della scheda SIM 1.
+ Scheda SIM 2: modificare il nome e l'icona della scheda SIM 2.

« Colore del tema della scheda SIM: modificare i temi del colore per le
schede SIM.

+ Modalita Risparmio: attivare o disattivare la modalita risparmio: In modalita
Risparmio, se si effettua una chiamata a un contatto al quale e assegnata
una specifica SIM, tale SIM viene utilizzata per la chiamata anche se laltra

SIM e attiva, ad esempio in caso di utilizzo dei dati mobili.

- Dati mobili: selezionare una scheda SIM da utilizzare per il servizio dati
cellulare. E possibile anche disattivare questa funzione.

- Roaming dati: selezionare questa opzione per attivare il dispositivo affinché
utilizzi i dati mobili durante il roaming al di fuori dell'area della propria rete

domestica.

- Dati mobili durante le chiamate: Accedere ai dati mobili usando la scheda
SIM dati non predefinita temporaneamente durante una chiamata HD con la

stessa scheda.
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Wi-Fi

E possibile connettersi a dispositivi vicini tramite una rete Wi-Fi.

Connessione a una rete Wi-Fi
1 Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.
7 Toccare per attivarlo.
+ Vengono visualizzate automaticamente le reti Wi-Fi disponibili.
3 Selezionare unarete.
« Potrebbe essere necessario immettere la password Wi-Fi della rete.

+ Questo processo viene ignorato in caso di reti a cui e gia stato effettuato
l'accesso in precedenza. Se non si desidera esequire automaticamente la
connessione a una determinata rete \Wi-Fi, toccare la rete, quindi toccare
Elimina.

Impostazioni della rete Wi-Fi
Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.

- Passa a rete dati: se la funzione connessione dati mobile & attiva e il dispositivo
non e in grado di connettersi a Internet tramite la connessione Wi-Fi, il
dispositivo si connette a Internet tramite la connessione dati mobile.

E « Questa funzione dipende dal provider del servizio.

-+ :consente di personalizzare le impostazioni della rete Wi-Fi.
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Wi-Fi Direct

E possibile connettere il dispositivo ad altri dispositivi che supportano la funzione

\Wi-Fi Direct per condividere direttamente i dati con essi. Non & necessario disporre

diun punto di accesso. Utilizzando la funzione Wi-Fi Direct, e possibile connettere

pit di due dispositivi.

1 Nella schermata delle impostazioni, toccare Rete & Internet > Wi-Fi > >
Avanzate Wi-Fi> Wi-Fi Direct.

« Vengono automaticamente visualizzati i dispositivi vicini che supportano la
funzione Wi-Fi Direct.

2 Selezionare un dispositivo.

« La connessione awiene quando il dispositivo accetta la richiesta di
connessione.

5 « La batteria potrebbe scaricarsi piti rapidamente quando si utilizza il Wi-Fi Direct.

Dati mobili

E possibile attivare o disattivare i dati mobili. E inoltre possibile gestirne l'utilizzo.

Attivazione dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.

7 Toccare per attivarlo.

Personalizzazione delle impostazioni dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.
7 Personalizzare le sequenti impostazioni:

+ Dati mobili: consente di utilizzare le connessioni dati su reti mobili.

- Limita l'utilizzo dei dati mobili: consente di impostare un limite di utilizzo
dei dati mobili in modo da bloccarli al raggiungimento della soglia.

+ - consente di personalizzare le impostazioni dei dati mobili.

« llvolume di utilizzo dei dati misurato in base al prodotto e il volume calcolato
dal proprio gestore di telefonia mobile potrebbero essere diversi.
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Impostazioni chiamate

E possibile personalizzare le impostazioni di chiamata, ad esempio le opzioni per le
chiamate vocali e per quelle internazionali.

E « Alcune funzioni potrebbero non essere supportate a seconda dell'area o del
provider del servizio.

T Nella schermata delle impostazioni, toccare Rete & internet > Impostazioni
chiamate.

7 Personalizzare le impostazioni.

Tethering
Tethering USB

E possibile connettere il dispositivo a un altro dispositivo tramite USB e condividere
i dati mobili.
1 Connettere il dispositivo e gli altri dispositivi tramite il cavo USB.

2 Nella schermata delle impostazioni, toccare Rete & Internet > Tethering >
Tethering USB e quindi toccare () ) per attivarlo.

5

Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Quando si esegue la connessione a un computer; scaricare il driver USB da
wwwlg.com e installarlo sul computer:

Non é possibile inviare o ricevere file tra il dispositivo e un computer quando il
tethering USB ¢ attivo. Disattivare il tethering USB per inviare o ricevere file.

| sistemi operativi che supportano il tethering sono Windows XP o versione
superiore, o Linux.
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Hotspot Wi-Fi

E possibile impostare il dispositivo in modo da farlo funzionare come un router
wireless affinché altri dispositivi possano connettersi a Internet utilizzando i suoi
dati mobili.

T Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Hotspot Wi-Fi e toccare () ) per attivare la funzione.

7 Toccare Imposta hotspot Wi-Fi e immettere il Nome Wi-Fi (SSID) e la
password.

3 Attivare il Wi-Fi sull'altro dispositivo e selezionare il nome della rete del
dispositivo nell'elenco delle connessioni Wi-Fi.

4 Immettere la password di rete.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether#wifi

Timer per lo spegnimento automatico dell'hotspot Wi-Fi

Se 'hotspot Wi-Fi non viene utilizzato per un determinato periodo di tempo,
viene disconnesso in automatico. Puoi impostare il periodo di tempo per la
disconnessione automatica.

Tethering Bluetooth

Un altro dispositivo connesso tramite Bluetooth puo connettersi a Internet
utilizzando i dati mobili del proprio dispositivo.

1 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering Bluetooth e quindi toccare () ) per attivarlo.

7 Attivare il Bluetooth su entrambi i dispositivi e associarli.
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5 « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether=Bluetooth_tethering

Guida

E possibile visualizzare la guida sull'utilizzo del tethering e degli hotspot.
Nella schermata delle impostazioni, toccare Rete & internet > Tethering > Guida.

Modalita aereo

E possibile disattivare le funzioni di chiamata e dei dati mobili. Quando questa
modalita e attiva, restano disponibili le funzioni che non implicano il trasferimento di
dati, ad esempio i giochi e la riproduzione di brani musicali.

7 Nella schermata delle impostazioni, toccare Rete & internet > Modalita aereo.

2 Toccare () ) nella schermata di conferma.

Reti mobili
E possibile personalizzare le impostazioni delle reti mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Reti mobili.
7 Personalizzare le sequenti impostazioni:
+ Modalita rete: consente di selezionare un tipo di rete.

+ Nomi punti di accesso: consente di visualizzare o cambiare il punto di
accesso per |'utilizzo dei servizi di dati mobili. Per cambiare il punto di
accesso, selezionarne uno fra quelli disponibili nel relativo elenco.

« Operatori di rete: consente di cercare gli operatori di rete e di connettersi
automaticamente a una rete.
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VPN

E possibile connettersi a una rete virtuale sicura, ad esempio a una Intranet. £
inoltre possibile gestire la rete privata virtuale connessa.

Aggiunta di una rete VPN

1 Nella schermata delle impostazioni, toccare Rete & internet > VPN.

2 Sfiorare+

3 Immettere i dettagli della rete VPN e toccare Salva.

Configurazione delle impostazioni della rete VPN
1 Toccare unarete VPN nell'elenco VPNS.

7 Immettere i dettagli relativi allaccount utente della rete VPN e toccare
Connetti.

+ Per salvare i dettagli dell'account, selezionare la casella di controllo Salva le
informazioni sull'account.

DNS privato
E possibile configurare le opzioni del DNS (Domain Name System) privato.
1 Nella schermata delle impostazioni, toccare Rete & internet > DNS privato.

7 Selezionare lopzione desiderata e toccare Salva.
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Dispositivi connessi

Bluetooth

E possibile connettere il dispositivo a dispositivi vicini che supportano la funzione
Bluetooth per scambiare direttamente i dati con essi. Connettere il dispositivo a un
auricolare Bluetooth e a una tastiera. In questo modo sara pit semplice controllare
il dispositivo.

Associazione a un altro dispositivo

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Bluetooth.

2 Toccare () ) per attivarlo.
+ Vengono automaticamente visualizzati i dispositivi disponibili.
- Per aggiornare l'elenco dei dispositivi, toccare ().

E + Nellelenco sono visualizzati solamente i dispositivi impostati come visibili.

3 Selezionare un dispositivo dall'elenco.
A Seguire le istruzioni visualizzate sullo schermo per effettuare l'autenticazione.

E « Questo passaggio viene saltato per i dispositivi cui & stato effettuato laccesso in
precedenza.

Invio di dati tramite Bluetooth

1 Selezionare un file.
- E possibile inviare file multimediali o contatti.

2 Toccare <& > Bluetooth.

3 Selezionare un dispositivo di destinazione per il file.
« Il file viene inviato non appena viene accettato dal dispositivo di destinazione.

E « | processi di condivisione di file potrebbero differire, a seconda del file.
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Condivisione schermo
E possibile riprodurre la schermata e laudio del dispositivo su un altro dispositivo,
come ad esempio una TV, in grado di supportare la funzione Miracast.

T Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione schermo.

2 Toccare ()) per attivarlo.

3 Selezionare un dispositivo dall'elenco dei dispositivi vicini.

+ Seil dispositivo desiderato non é visualizzato, toccare Ricerca per aggiornare
l'elenco.

+ Una volta effettuata la connessione al dispositivo, sul relativo schermo viene
visualizzata la schermata del dispositivo.

E + La Condivisione schermo si spegne automaticamente se non vi & alcun dispositivo
compatibile per la condivisione nelle vicinanze.

NFC

E possibile utilizzare il dispositivo come tessera dei trasporti o carta di credito. E
inoltre possibile condividere dati con laltro dispositivo.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > NFC.

2 Toccare () ) per attivarlo.

+ Mettere a contatto il proprio dispositivo con laltro dispositivo che supporta
NFC per consentire la condivisione di dati.

E - L'antenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.
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Pannello di condivisione

E possibile condividere i contenuti delle app Galleria, Musica e File Manager con i
dispositivi nelle vicinanze. Inoltre, & possibile condividere contenuti con delle persone
specifiche nelle app che utilizzano Google Condivisione diretta.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Pannello di
condivisione.

7 Toccare @ ) per disattivare ciascuna opzione.

- Dispositivi nelle vicinanze: E possibile visualizzare i dispos
e possibile condividere i contenuti delle app Galleria, Musica e File Manager.

« Condivisione diretta: da unapp che supporta Google Condivisione diretta,
& possibile visualizzare un'icona che consente di condividere contenuti con
persone specifiche.

Condivisione File

E possibile inviare e ricevere file scambiandoli tra il dispositivo e altri dispositivi o
tablet LG.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione File.
7 Personalizzare le sequenti impostazioni:
+ WING: consente di modificare il nome del dispositivo.
+ Salva in: consente diimpostare la cartella di destinazione in cui salvare i file
inviati da altri dispositivi.
- Condivisione File: consente la ricezione di file inviati da altri dispositivi.

+ SmartShare Beam: consente di condividere file con altri dispositivi tramite
SmartShare Beam.

+ Guida: consente di visualizzare la guida alla condivisione dei file.
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Server multimediale

E possibile condividere contenuti multimediali presenti sul dispositivo con dispositivi
vicini che supportano la funzione DLNA.

T Nella schermata delle impostazioni, toccare Dispositivi connessi > Server
multimediale.
7 Personalizzare le sequenti impostazioni:
« Condivisione di contenuti: consente di condividere contenuti presenti sul
dispositivo con dispositivi vicini.
+ WING: consente di impostare il nome del dispositivo.

5 « Aseconda del prodotto dell'utente, i nomi dei menu potrebbero apparire in modo
diverso

- Contenuti da condividere: consente di selezionare il tipo di contenuti
multimediali da condividere con altri dispositivi.

Dispositivi consentiti: consente di visualizzare un elenco dei dispositivi a cui
& consentito accedere ai contenuti presenti sul dispositivo.

- Dispositivi non autorizzati: consente di visualizzare un elenco dei dispositivi
a cui non e consentito accedere ai contenuti presenti sul dispositivo.

Stampa

E possibile connettere il dispositivo a una stampante Bluetooth e stampare foto o
documenti salvati sul dispositivo.

Nella schermata delle impostazioni, toccare Dispositivi connessi > Stampa.

« Toccare Servizio di stampa predefinito per cercare le stampanti a cui e
possibile connettersi. Oppure, toccare + > Aggiungi stampante per aggiungere
manualmente una stampante.

- Toccare (+) Nuovo servizio per scaricare lapp della stampante desiderata.

E « Questa funzione é disponibile sono quando e attiva la funzione di rete mobile o
Bluetooth.

Per scaricare [app della stampante in (+) Nuovo servizio, & necessario prima
accedere al proprio account Google.
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Suono

E possibile personalizzare le impostazioni relative a suono, vibrazione e notifiche.

Nella schermata delle impostazioni, toccare Suono e personalizzare le seguenti
impostazioni:

Profilo audio: consente di passare alla modalita audio Suono, Vibrazione o
Silenzioso.

Volume: consente di regolare il volume dellaudio di diversi elementi.

Suonerie: consente di selezionare una suoneria per le chiamate in arrivo. E
possibile aggiungere o eliminare suonerie.

Suono di notifica: consente di selezionare una suoneria per le notifiche. E
possibile impostare un brano musicale salvato sul dispositivo come suoneria di
notifica.

Suoni di sistema: consente di selezionare lattivazione o disattivazione di
ciascun suono di sistema.

Suoneria con vibrazione: consente di impostare sul dispositivo la vibrazione e la
riproduzione di una suoneria in contemporanea.

Suoneria contatto: consente di creare una suoneria per una chiamata in arrivo
da un determinato contatto.

Allerta flash per le chiamate in arrivo:imposta il lampeggiamento secondo la
suoneria LG.

Non disturbare: consente di impostare il tempo, l'intervallo e il tipo di app per
cui ricevere messaggi di notifica. E possibile ricevere messaggi di notifica solo in
particolari giorni della settimana.

Qualita del suono ed effetti: usare la funzione per impostare la qualita e gli
effetti audio quando si riproduce una canzone o video.

- Volume: consente di regolare il volume dellaudio di diversi elementi.

Normalizza volume: Usare la funzione per normalizzare i volumi di sorgenti
audio differenti.

- Equalizzatore: Usare |a funzione per regolare le impostazioni
dell'equalizzatore.

LG 3D Sound Engine: Usare la funzione per riprodurre musica o video in un
audio tridimensionale, immersivo e vivido quando cuffie, altoparlanti, o altri
dispositivi audio esterni sono connessi. Per i dettagli, vedere, consultare la
sezione LG 3D Sound Engine.
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Sottotitoli dal vivo: consente diimpostare il dispositivo in modo che rilevi la
voce nel contenuto multimediale e generi automaticamente i sottotitoli.
Potenza vibrazione: consente di regolare l'intensita della vibrazione.

Tipo vibrazione: consente di selezionare il tipo di vibrazione per le chiamate in
arrivo.

Vibrazione al tocco: consente di impostare la vibrazione del dispositivo quando
si toccano determinati elementi sullo schermo.

Notifiche

E possibile controllare lelenco delle app installate e configurare le impostazioni per
le notifiche.

1
2

Nella schermata delle impostazioni, toccare Notifiche.

Personalizzare le impostazioni come desiderato.

Display

E possibile personalizzare impostazioni dettagliate per ogni tipo di schermata.

Nella schermata delle impostazioni, toccare Display e personalizzare le seguenti
impostazioni:

Sfondo: consente di personalizzare le impostazioni per la schermata Home. Per
i dettagli, vedere, consultare la sezione Imposta schermata home.

Home Schermo aperto: consente di personalizzare le impostazioni della
modalita Swivel Home.

Barra di navigazione: consente di configurare la barra di navigazione. Per
maggiori dettagli, vedere Uso della barra di navigazione.

AOD (always-on display): consente di visualizzare sempre informazioni come
data, ora e notifiche, anche quando lo schermo & spento. Per maggiori dettagli,
vedere AOD (always-on display).

Schermo secondario: consente di impostare la luminosita o il colore dello
schermo secondario.

Vista comfort: consente di ridurre la quantita di luce blu sullo schermo del
dispositivo per limitare ['affaticamento degli occhi.
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- Modalita notte: di notte e possibile applicare un tema dello schermo oscurato
per evitare ['abbagliamento.

- Colore dello schermo: Regola colore e temperatura del colore per lo schermo
desiderato.

E « Toccare O per ripristinare le impostazioni.

Amplificatore Video: Durante la riproduzione di un video in modalita schermo
intero, e possibile modificare le impostazioni per una visualizzazione a Colore
dello piti luminosa e dinamica.

Carattere: modificare dimensione, grassetto, o facciata.

Colori menu e app LG: consente di cambiare il colore di accento per
impostazioni, menu, finestre di notifica ecc.

Dimensioni display: consente di impostare gli elementi presenti sullo schermo
su dimensioni facilmente visibili per [utente. Alcuni elementi potrebbero
cambiare posizione.

Schermo intero App: consente di selezionare le app da aprire a schermo intero.

Luminosita: utilizzare a barra di scorrimento per madificare la luminosita dello
schermo.

Automatico: consente di impostare |a regolazione automatica della luminosita
dello schermo in base allintensita luminosa dellambiente.

Extra luminosita: consente di regolare la luminosita a un livello superiore a
quello massimo.

Timeout schermo: consente di disattivare automaticamente lo schermo
quando il dispositivo viene lasciato inattivo per un determinato periodo di
tempo.

Rotazione automatica: consente di ruotare automaticamente lo schermo a
seconda dellorientamento del dispositivo.

Screen saver: consente di visualizzare uno screen saver quando il dispositivo &
collegato al supporto o al caricabatteria. Selezionare un tipo di screen saver da
visualizzare.

Schermo a una mano: ridurre le dimensioni dello schermo in modo da poter
utilizzare il dispositivo con una sola mano.
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Sfondo & Tema

E possibile selezionare lo sfondo, il tema dello schermo, lo stile delle icone o AOD
(always-on display) per il dispositivo.

1 Nella schermata delle impostazioni, toccare Sfondo & Tema.

2 Toccare Sfondo, Tema, Icona 0 AOD per personalizzare le impostazioni.

Blocco schermo & sicurezza

E possibile personalizzare le impostazioni della schermata di blocco e della
sicurezza.

T Nella schermata delle impostazioni, toccare Blocco schermo & sicurezza.

2 Personalizzare le impostazioni.

- Google Play Protect: scansiona giornalmente il dispositivo per scoprire app
potenzialmente nocivi.

+ Trova il mio dispositivo: tracciare a distanza la posizione del dispositivo.
Puoi anche proteggere i tuoi dati in modo sicuro se hai smarrito il tuo
dispositivo.

- Aggiornamento sicurezza: controlla gli aggiornamenti software e configura
le impostazioni di installazione automatiche.

+ Seleziona il blocco dello schermo: seleziona il metodo di blocco schermo
desiderato. Per i dettagli, vedere, consultare la sezione Impostazione di un
blocco schermo.

+ Personalizza Blocco schermo: modifica le informazioni visualizzate sullo
schermo bloccato.

+ Impostazioni di Blocco con sicurezza: modifica le impostsazioni di blocco
sicuro.

- Impronte digitali: consente di usare limpronta digitale per sbloccare
lo schermo o il contenuto. Per i dettagli, vedere, consultare la sezione
Informazioni generali sul riconoscimento delle impronte digitali.

+ Blocco del contenuto: consente di impostare un tipo di blocco (password o
sequenza) per i propri file della Galleria.

- Crittografia e credenziali: configura le impostazioni per |a cifratura e le
credenziali della scheda SD.
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- Cripta la Scheda SD: consente di crittografare la scheda di memoria per
impedire ['utilizzo su un altro dispositivo. Per i dettagli, vedere, consultare
la sezione Crittografia della scheda di memoria.

- Protezione delle credenziali: consente di visualizzare il tipo di memoria
su cui sara salvato il certificato di sicurezza.

- Credenziali di fiducia: visualizza i certificati CA root e i certificati CA

installati dall'utente del tuo sistema.

Credenziali dell'utente: visualizza e modifica le informazioni dei

certificati sicuri conservati sul tuo dispositivo.

- Installa dalla memoria:installare un certificato sicuro da un archivio.

- Cancella archivio: cancella i certificati sicuri installati da utente e le
credenziali relative.

Amministratori dispositivo: consente privilegi per limitare il controllo o
[utilizzo del dispositivo a determinate app.

Trust agents: consente di visualizzare e utilizzare agenti attendibili installati
sul dispositivo.

Puntina schermo: consente di fissare la schermata dellapp in modo che sia
possibile utilizzare soltanto lapp attiva al momento.

Accesso all'utilizzo: consente di visualizzare i dettagli sull'utilizzo delle app
sul dispositivo.

Privacy

E possibile trovare e regolare tutte le impostazioni sulla privacy.
1 Nella schermata delle impostazioni, toccare Privacy.

7 Personalizzare le impostazioni.
+ Gestione autorizzazioni: Consente di controllare e cambiare le
autorizzazioni concesse alle app.
« Blocco schermo: Consente diimpostare le notifiche da visualizzare sul
blocco schermo.

Rendi visibili le password: attivare questa opzione per visualizzare
rapidamente ciascun carattere della password mentre si digita per vedere
cosa si sta immettendo.

« Servizi di personalizzazione del dispositivo: consentono di ottenere
suggerimenti in base agli utenti, alle app e ai contenuti interattivi.
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+ Compilazione automatica Google: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, o numero
di carta di credito con un singolo tocco. £ possibile anche disattivare questa
opzione, usare la funzione Google Autocomplete, oppure aggiungere un
nuovo account di servizio.

« Cronologia delle posizioni Google: Consente di abilitare o disabilitare
la Cronologia delle posizioni. Quando e abilitata, Google periodicamente
memorizza e utilizza i dati sulla posizione piti recenti del telefono in
connessione con account Google.
Nella schermata Cronologia delle posizioni, toccare + per visualizzare e/o
gestire i dati sulla posizione.

Gestione attivita: Seleziona attivita e informazioni che si desidera vengano
salvate da Google.

Annunci: Consente di controllare D pubblicita e impostare le pubblicita
personalizzate.

Utilizzo e diagnostica: Abilitare questa opzione per migliorare 'esperienza
Android inviando automaticamente a Google dati diagnostici e sull'utilizzo
del dispositivo e delle app.

Posizione

E possibile controllare come vengono condivise le informazioni sulla propria
posizione e configurare ['autorizzazione per accedere alle informazioni sulla propria
posizione.

Nella schermata delle impostazioni, toccare Posizione e impostare la funzione
desiderata.
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Estensioni

Smart Doctor

E possibile utilizzare Smart Doctor per eseguire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata delle impostazioni, toccare Estensioni > Smart Doctor.

Context Awareness

E possibile modificare automaticamente le impostazioni del dispositivo in base alla

sequenza di utilizzo e alla posizione.

T Nella schermata delle impostazioni, toccare Estensioni > Context Awareness.

7 Attivare gli elementi per i quali si desidera modificare automaticamente le
impostazioni.

- AUTOMATIZZATO: E possibile impostare il dispositivo in modo che modifichi
automaticamente il profilo audio, le opzioni Bluetooth e Wi-Fi in diversi
ambienti, ad esempio A casa, Fuori casa, Al lavoro e Non al lavoro. E possibile
anche impostare che unapp si apra quando vengono collegati gli auricolari o
quando viene connesso un dispositivo Bluetooth.

E « Per poter usare questa funzione, le posizioni di casa e lavoro devono essere
presenti in I miei luoghi. Nella schermata delle impostazioni, toccare Posizione > |
miei luoghi per impostare le posizioni.

Servizio personalizzato
E possibile ottenere risultati intelligenti utilizzando la ricerca integrata.

1 Nella schermata delle impostazioni, toccare Estensioni > Servizio
personalizzato.

2 Toccare () ) per attivarlo.
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Visualizzazione estesa con schermo aperto

In Modalita Swivel, le app possono essere estese a entrambi gli schermi.

1 Nella schermata delle impostazioni, toccare Estensioni > Visualizzazione
estesa con schermo aperto.

2 Toccare () ) per attivarlo.

- ESTESO PER IMPOSTAZIONE PREDEFINITA: consente di vedere unapp in
vista estesa quando si apre lapp nello schermo principale.

Gaming
E possibile configurare le impostazioni di gioco per gli strumenti, la grafica el
risparmio energetico.
1 Nella schermata delle impostazioni, toccare Estensioni > Gaming.
7 Personalizzare le sequenti impostazioni:
- Launcher Del Gioco: Toccare () ) per usare la funzione Launcher Del Gioco.

- Strumenti di gioco: E possibile esequire la funzione durante il gioco
toccando l'icona degli strumenti di gioco tra i pulsanti a sfioramento anteriori.

« Grafica di gioco: Regola |a grafica di gioco.
E « Se si modifica la risoluzione video di alcuni giochi, le funzioni di visualizzazione dello
schermo potrebbero non funzionare correttamente.

+ Questa funzione potrebbe non essere disponibile per alcune app di gioco.

- Tempo di pausa: Riduce la luminosita dello schermo e le prestazioni, ogni
volta che si abbandona il gioco per piti di 5 minuti.
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Registrazione schermata

E possibile configurare le impostazioni della registrazione dello schermo.

1 Nella schermata delle impostazioni, toccare Estensioni > Registrazione
schermata.

7 Personalizzare le seguenti impostazioni:
« Includi te stesso nel video da: Selezionare una delle seguenti opzioni.

- Immagine:Include limmagine del profilo nel video durante la
registrazione. Una volta effettuata questa selezione, toccare @ e
selezionare unimmagine del profilo. Regolare quindi le dimensioni
dellimmagine usando la barra di scorrimento.

- Fotocamera anteriore: Include sé stessi registrati con la fotocamera
anteriore durante |a registrazione dello schermo.

- Mai: Non viene incluso niente.
+ Sorgente Audio: Scegliere [sorgente audio tra Mic e Contenuto.

+ Risoluzione video: Selezionare la risoluzione per la registrazione dello
schermo.

Dual App

E possibile installare app di messaqgistica duplicate nel prodotto e utilizzare due

account contemporaneamente.
T Nella schermata delle impostazioni, toccare Estensioni > Dual App.

2 Dopo aver letto la dichiarazione di non responsabilita, toccare Conferma.

3 Nellelenco delle app disponibili, toccare Installa per installare una copia dellapp

desiderata e seqguire le istruzioni visualizzate sullo schermo.

+ Sullo schermo viene visualizzato lelenco delle app duplicate disponibili.
Durante linstallazione, sulla schermata Home vengono generate le icone
delle app.
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Suggerimento applicazione

Consente di accedere rapidamente alle app di cui si ha bisogno al momento nella
schermata Panoramica

Nella schermata delle impostazioni, toccare Estensioni > Suggerimento
applicazione.

Penna

E possibile configurare le opzioni per ['uso di una penna attiva (opzionale, in
vendita separatamente). Questo dispositivo supporta Active Pen AES2.0 (Active
Electrostatic).

7 Nella schermata delle impostazioni, toccare Estensioni > Penna.

7 Personalizzare le seguenti impostazioni:

- Tasto Penna Collegamenti: consente di configurare le scorciatoie per tutti i
pulsanti della penna attiva.

+ Scorciatoie applicazioni: Selezionare quale app (fino a cinque) visualizzare
come collegamento quando la penna e rimossa dal dispositivo.

+ Anteprima promemoria: Attivare per visualizzare i promemoria recenti in
Pen Pop.

« Suono scrittura: Attivare per applicare effetti sonori alla modalita disegno.

- Mostra puntatore: Attivare per visualizzare un puntatore della penna nei
puntiin cui si passa con la penna.

+ Gesti ignora barra di navigazioneta: Blocca limmissione di gesti per la
barra di navigazione, e risulta utile quando si disegna o si scrive sul bordo
dello schermo con una Active Pen.

Impostazioni 154



Collegamenti

E possibile utilizzare pulsanti quali accensione/blocco, volume e Assistente Google
per esequire direttamente determinate app o funzioni.

T Nella schermata delle impostazioni, toccare Estensioni > Collegamenti.

7 Personalizzare le seguenti impostazioni.

- Apri Fotocamera: premere il tasto di accensione due volte per awiare la
Fotocamera.

+ Apri Promemoria a schermo spento: quando lo schermo é bloccato o
spento, premere due volte il tasto volume su (+) per aprire promemoria off
screen.

« Apri Fotocamera: quando lo schermo é bloccato o spento, premere due
volte il tasto volume gili (-) per awviare Fotocamera.

E « Assistente Google non supporta alcune lingue.

Toc Toc
Esequire un doppio tocco sullo schermo per spegnerlo o accenderlo.
Per i dettagli, vedere, consultare la sezione Toc Toc.

Aumenta la sensibilita al tocco

E possibile aumentare la sensibilita al tocco del touchscreen. Si consiglia di attivare
questa funzione quando si usa una protezione per lo schermo.

Nella schermata delle impostazioni, toccare Estensioni > Aumenta la sensibilita
al tocco
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Applicazioni

E possibile controllare lelenco delle app installate e configurare le impostazioni per
notifiche, autorizzazioni delle app e altro ancora.

1 Nella schermata delle impostazioni, toccare Applicazioni.

2 Personalizzare le impostazioni.

Batteria

E possibile visualizzare le informazioni sulla batteria corrente o attivare la modalita
risparmio energetico.

T Nella schermata delle impostazioni, toccare Batteria.

7 Personalizzare le seguenti impostazioni:

Utilizzo della batteria: consente di visualizzare i dettagli sull'utilizzo della
batteria.

Ricarica ottimizzata: regola automaticamente la velocita di carica in base a
come si carica, per ridurre il calore e prolungare la durata della batteria.

Batteria adattiva: consente di risparmiare la batteria impedendo
lesecuzione in background delle app.

Limitazione sfondo: abilitare questa opzione per limitare le app in
background e risparmiare la batteria durante ['uso del dispositivo. Le app
con limitazioni per il risparmio energetico potrebbero non funzionare
correttamente o potrebbero non inviare notifiche.

Risparmio energetico: consente di ridurre il consumo della batteria
riducendo alcune impostazioni del dispositivo, come la luminosita del display,
la velocita e lintensita della vibrazione.

Eccezioni del risparmio energetico: seleziona le app che vengono

utilizzare senza alcuna restrizione in modalita di risparmio energetico o di
ottimizzazione della batteria.
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Archiviazione

E possibile visualizzare e gestire la memoria interna sul dispositivo o lo spazio di
archiviazione della scheda di memoria.

1 Nella schermata delle impostazioni, toccare Archiviazione.

2 Personalizzare le seguenti impostazioni:

+ Archivio interno: consente di visualizzare lo spazio di archiviazione totale
e lo spazio libero nella memoria interna del dispositivo. Visualizza un elenco
delle app in uso e la capacita di archiviazione di ciascuna app.

« Scheda SD: consente di visualizzare lo spazio di archiviazione totale e lo
spazio libero nella scheda di memoria. Questa opzione compare soltanto
quando viene inserita una scheda di memoria. Per disattivare la scheda di
memoria, toccare

Account

E possibile aggiungere utenti con i quali condividere e registrare un account cloud.
1 Nella schermata delle impostazioni, toccare Account.

7 Personalizzare le impostazioni.

Benessere digitale e Controllo
genitori

E possibile visualizzare il tempo di utilizzo del prodotto e impostare il timer per
ciascuna app. E possibile inoltre gestire il tempo di utilizzo del telefono cellulare
utilizzando le modalita Bedtime e Focus.

Nella schermata delle impostazioni, selezionare Benessere digitale e Controllo
genitori e impostare la funzione desiderata.
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Google

E possibile utilizzare le impostazioni di Google per gestire le proprie app e le
impostazioni dell'account di Google.

Nella schermata delle impostazioni, toccare Google.

Sistema

Centro aggiornamenti

Puoi controllare e installare la versione pili recente dell'app o del software fornito
alG

1 Nella schermata delle impostazioni, toccare Sistema > Centro aggiornamenti.

7 Personalizzare le sequenti impostazioni:

- Aggiornamento applicazione: controlla se e disponibile un aggiornamento.
Se disponibile, puoi installare 'aggiornamento.

- Aggiornamento software: controlla se e disponibile un aggiornamento
software. Se disponibile, puoi installare ['aggiornamento.

Lingua e tastiera
E possibile personalizzare le impostazioni di lingua e tastiera del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Lingua e tastiera.
7 Personalizzare le seguenti impostazioni:
« Lingua: consente di selezionare una lingua da applicare al dispositivo.

- Gestisci tastiere: e possibile modificare le impostazioni di base della tastiera
del prodotto, impostare gli ambienti di utilizzo per la tastiera LG o altre
tastiere installate e impostare la funzione di riconoscimento vocale per i
comandi con Google Voice. E possibile inoltre impostare se visualizzare il
pulsante della tastiera nell'area dei pulsanti a sfioramento della schermata
Home, in modo da poter passare rapidamente a un‘altra tastiera.
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- Tastiera fisica: selezionare per usare |a tastiera fisica, o controllare i tasti dei
collegamenti da tastiera.

« Servizio Compilazione automatica: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, 0 numero
di carta di credito con un singolo tocco. Puoi anche disattivare questa
opzione, usare Google Autocomplete, 0 aggiungere un nuovo account di
servizio.

« Lettura text-to-speech: consente di configurare le impostazioni delloutput
sintesi vocale.

Velocita del puntatore: consente di regolare la velocita del puntatore di un
mouse o trackpad.

Inverti i pulsanti del mouse: consente di invertire il pulsante destro del
mouse in modo che esegua le principali azioni di manipolazione diretta.

Data e ora
E possibile personalizzare le impostazioni di data e ora del dispositivo.
1 Nella schermata delle impostazioni, toccare Sistema > Data e ora.

7 Personalizzare le impostazioni.

Memoria

Consente di visualizzare la quantita media di utilizzo della memoria in un
determinato periodo di tempo e la memoria occupata da unapp.

71 Nella schermata delle impostazioni, toccare Sistema > Memoria.

2 Toccare w per impostare una fascia oraria per il recupero dei dati.
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Backup
E possibile esequire il backup dei dati salvati sul dispositivo su un altro dispositivo o
account.

T Nella schermata delle impostazioni, toccare Sistema > Backup.

7 Personalizzare le seguenti impostazioni:
LG Mobile Switch: consente di trasferire i dati da un vecchio dispositivo LG a
quello nuovo. Per i dettagli, vedere, consultare la sezione LG Mobile Switch.

+ Backup e ripristino: consente di eseguire il backup dei dati del dispositivo o
ripristinare i dati di un backup nel dispositivo.

A - Ilripristino del dispositivo potrebbe eliminare i file di backup salvati nellarchivio.
Assicurarsi di copiare e salvare i file di backup importanti nel proprio PC.

. Google Backup: madifica le impostazioni di backup di Google. E possibile
anche controllare 'account di backup attualmente usato, o aggiungere un
nuovo account di backup.

Riavvio & Ripristino
E possibile ripristinare il dispositivo, includendo le impostazioni di rete e app.
1 Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino.

7 Personalizzare le sequenti impostazioni:

+ Riavvio automatico: riawia e ottimizza automaticamente il telefono all'ora
impostata. Toccare () ) per attivare la funzione. Il dispositivo si riawia
automaticamente all'ora impostata e si ottimizza. Seleziona la data e l'ora
del riawio.
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E - Puoiimpostare il dispositivo affinché si riawii una volta la settimana. Il dispositivo
si riavvia automaticamente entro un'ora dall'ora impostata.

+ Unavolta che il dispositivo si riawia, le notifiche e i badge sono cancellati. Salvare i
dati importanti prima dell'ora preimpostata.

+ Lafunzionalita di riavvio automatico non ¢ attivata nelle seguenti situazioni.
Quando lo schermo e acceso, quando il dispositivo & in uso, quando il livello della
batteria & il 30% o meno, o quando la scheda USIM ¢ bloccata.

- Aseconda del fornitore del servizio di telecomunicazione, la funzione di riawio
automatico potrebbe non essere disponibile.

Ripristino delle impostazioni della rete: consente di ripristinare Wi-Fi,
Bluetooth e altre impostazioni di rete.

Ripristina preferenze applicazione: ripristina le impostazioni dio un'app. |
dati salvati nell'app non saranno cancellati.

Reset impostazioni: consente di ripristinare tutte le impostazioni
predefinite di sistema.

Ripristino dati di fabbrica: consente di ripristinare tutte le impostazioni del
dispositivo ed eliminare i dati.

E « llripristino e il riawio del dispositivo elimina tutti i dati presenti sullo stesso. Inserire
nuovamente il nome del dispositivo, laccount Google e altre informazioni iniziali.

« Dopo linizializzazione dei dati, i dati non possono pili essere recuperati.

Info sul telefono

= possibile visualizzare informazioni sul dispositivo, come nome, stato, dettagli
software e informazioni legali.

Nella schermata delle impostazioni, toccare Sistema > Info sul telefono e
visualizzare le informazioni.

Normative & Sicurezza

E possibile visualizzare i certificati normativi e le relative informazioni sul proprio
dispositivo.
Nella schermata delle impostazioni, toccare Sistema > Normative & Sicurezza.
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Accesso facilitato

E possibile gestire i plugin di accessibilita installati sul dispositivo.

1
2

Nella schermata delle impostazioni, toccare Accesso facilitato.

Personalizzare le sequenti impostazioni:

Visione > TalkBack: consente di impostare il dispositivo in modo da
notificare lo stato dello schermo o le azioni tramite voce.

Visione > Notifiche vocali:impostare sul dispositivo la lettura delle
informazioni del chiamante tramite voce.

Visione > Carattere: modificare dimensione, grassetto, o facciata.

Visione > Dimensioni display: consente di impostare gli elementi presenti
sullo schermo su dimensioni facilmente visibili per 'utente. Alcuni elementi
potrebbero cambiare posizione.

Visione > Zoom touch: consente di eseguire lo zoom avanti o indietro
toccando lo schermo tre volte.

Visione > Zoom della finestra: consente di eseguire lo zoom avanti o
indietro allinterno di una finestra e invertire il colore.

Visione > Puntatore del mouse grande: consente di ingrandire il puntatore
del mouse.

Visione > Schermo ad alto contrasto: consente di modificare il colore di
sfondo in nero per uno schermo ad alto contrasto.

Visione > Inversione del colore dello schermo: consente di aumentare il
contrasto del colore del display per le persone ipovedenti.

Visione > Regolazione del colore dello schermo: consente di regolare il
colore del display.

Visione > Monocromatico: consente di far passare lo schermo alla modalita
scala di grigi.

Visione >Termina le chiamate con il tasto di accensione: consente di
terminare una chiamata premendo il tasto di accensione/blocco.

Udito > Sottotitoli dal vivo: consente di impostare il dispositivo in modo
che rilevi la voce nel contenuto multimediale e generi automaticamente i
sottotitoli.

Udito > Preferenze di didascalia: consente di attivare il servizio dei
sottotitoli durante la riproduzione di video per non udenti.
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« Udito > Flash allarme: consente di impostare il dispositivo in modo da
notificare all'utente le chiamate in arrivo, i messaggi e le sveglie con una luce
lampeggiante.

+ Udito > Disattiva tutti i suoni: consente di disattivare tutti i suoni e
abbassare il volume sul ricevitore.

- Udito > Canale audio: consente di selezionare il tipo di audio.

- Udito > Bilanciamento del suono: consente di regolare il bilanciamento
dell'uscita audio. Consente di utilizzare la barra di scorrimento per modificare
il bilanciamento.

+ Movimento & cognizione > Touch assistant: consente di attivare il pannello
touch per facilitare lutilizzo di pulsanti e gesti.

+ Movimento & cognizione > Input tattile: consente di immettere il testo
toccando e tenendo premuto lo schermo, o di modificarlo semplicemente
toccando lo schermo.

+ Movimento & cognizione > Tastiera fisica: consente di personalizzare le
impostazioni della tastiera.

+ Movimento & cognizione > Click automatico del mouse: consente di
cliccare il puntatore del mouse automaticamente in caso di assenza di
movimento.

+ Movimento & cognizione > Tocca e tieni premuto per le chiamate:
consente di rispondere o rifiutare le chiamate toccando e tenendo premuto il
pulsante di chiamata, invece di trascinarlo.

- Movimento & cognizione > Timeout schermo: consente di disattivare
automaticamente lo schermo quando il dispositivo viene lasciato inattivo per
un determinato periodo di tempo.

+ Movimento & cognizione > Aree di controllo tattile: consente di limitare
l'area touch in modo che soltanto una determinata porzione dello schermo
possa essere controllata dall'inserimento touch.

« Collegamento alle funzioni di accessibilita: consente di accedere
rapidamente a una funzione utilizzata di frequente toccando O tre volte.

- Rotazione automatica: consente di cambiare automaticamente
lorientamento dello schermo a seconda della posizione fisica del dispositivo.

Seleziona per ascoltare: consente di toccare gli elementi e ricevere una
risposta vocale.

+ Switch Access: consente di creare combinazioni di tasti per controllare il
dispositivo.
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Impostazioni della lingua

E possibile selezionare una lingua da utilizare sul dispositivo.
+ Nella schermata Home, toccare Impostazioni > Sistema > Lingua e tastiera >
Lingua > Aggiungi lingua, quindi selezionare una lingua.
- Toccare e tenere premuta = quindi trascinarla in cima allelenco delle lingue
per impostarla come lingua predefinita.

LG Bridge

Informazioni generali su LG Bridge

E possibile esequire il backup dei contatti, delle foto e di altri elementi sul computer
o0 aggiornare il software del dispositivo.

« Peridettagli, vedere la guida di LG Bridge.
« Le funzioni supportate possono variare a seconda del dispositivo.

« Il driver USB LG e un programma necessario per connettere o smartphone LG con
il computer e viene installato quando si installa LG Bridge.

Funzioni di LG Bridge

- Consente di esequire il backup dei dati dal dispositivo a un computer o
ripristinare i dati da un computer al dispositivo tramite un collegamento con
cavo USB.

+ Consente di aggiornare il software del dispositivo da un computer tramite un
collegamento con cavo USB.
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Installazione di LG Bridge su un computer
1 Andare sul sito wwwlg.com dal proprio computer.

7 Selezionare la regione.

3 Fare clic su Supporto > Software e firmware.

4

Immettere il nome del dispositivo.
OPPURE
Selezionare Categoria prodotto.

5 Andare a Sync PC > LG Bridge per scaricare il file di installazione.

+ Andare su Dettagli per visualizzare i requisiti minimi per l'installazione di LG
Bridge.

Aggiornamento software del telefono

Aggiornamento software del telefono LG Mobile da

Internet

Per ulteriori informazioni sull'utilizzo di questa funzione, visitare
http//wwwi.lg.com/common/index,sp, selezionare il paese e la lingua.

Questa funzione consente di aggiornare facilmente il firmware del telefono a
una versione pitl recente da Internet senza la necessita di visitare un centro

di assistenza. Questa funzione sara disponibile solo se e quando LG mette a
disposizione una nuova versione del firmware per il dispositivo.

Poiché laggiornamento del firmware del telefono cellulare richiede la massima
attenzione da parte dell'utente per tutta la durata del processo di aggiornamento,
assicurarsi di controllare tutte le istruzioni e le note visualizzate a ogni passaggio
prima di procedere. Si prega di notare che la rimozione del cavo USB durante
laggiornamento puo danneggiare gravemente il telefono cellulare.

E « LGsiriserva il diritto di rendere disponibili aggiornamenti del firmware
esclusivamente per modelli selezionati a propria discrezione e non garantisce la
disponibilita della versione piti recente del firmware per tutti i modelli di cellulari.
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Aggiornamento software del telefono LG Mobile
tramite Over-the-Air (OTA)

Questa funzione consente di aggiornare facilmente il software del telefono a una

nuova versione tramite OTA, senza collegamento di un cavo USB. Questa funzione
sara disponibile solo se e quando LG mette a disposizione una nuova versione del

firmware per il dispositivo.

Per eseguire [aggiornamento del software del telefono,

Impostazioni > Sistema > Centro aggiornamenti > Aggiornamento software >
Controlla aggiornamenti.

E « | dati personali dell'utente presenti sulla memoria interna del telefono, ivi comprese
le informazioni relative allaccount Google e qualsiasi altro account, i dati e le
impostazioni di sistema/applicazioni, le app scaricate e la licenza DRM potrebbero
andare perduti nel processo di aggiornamento del software del telefono. Pertanto,
LG consiglia di eseguire il backup dei dati personali prima di aggiornare il software
del telefono. LG non si assume alcuna responsabilita per eventuali perdite di dati
personali.

+ Questa funzione dipende dallarea e dal provider del servizio.
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Guida antifurto

Configurare il dispositivo per impedire ad altre persone di utilizzarlo se é stato
ripristinato alle impostazioni di fabbrica senza permesso. Ad esempio, in caso
di smarrimento, furto o cancellazione dei dati del dispositivo, solo qualcuno in
possesso delle informazioni sullaccount Google o delle informazioni sul blocco
schermo puo utilizzare il dispositivo.

Per assicurarsi che il dispositivo sia protetto e sufficiente:

+ Impostare un blocco schermo: Se il dispositivo viene smarrito o rubato, ma
si dispone di un blocco schermo, il dispositivo non puo essere cancellato

utilizzando il menu Impostazioni a meno che lo schermo non venga sbloccato.

Aggiungere il proprio account Google sul dispositivo: Se il dispositivo viene
cancellato, ma e presente un account Google su di esso, il dispositivo non
puo terminare il processo di configurazione fino a quando le informazioni
dellaccount Google non vengono nuovamente inserite.

Dopo aver protetto il dispositivo, & necessario sbloccare lo schermo o immettere la
password dellaccount Google, se & necessario effettuare un ripristino di fabbrica.

Questo fa si che il ripristino venga effettuato da una persona di fiducia.

E + Non dimenticare account Google e la password aggiunti al dispositivo prima
di eseguire un ripristino di fabbrica. Se non & possibile fornire le informazioni

sullaccount durante il processo di configurazione, non sara possibile utilizzare il

dispositivo dopo aver esequito il ripristino di fabbrica
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Informazioni avviso software Open
Source

Per ottenere il codice sorgente contenuto in questo prodotto secondo quanto
consentito dalle licenze GPL, LGPL, MPL e altre licenze Open Source, visitare
http://opensource.lge.com.

In aggiunta al codice sorgente, sono disponibili per il download tutti i termini di
licenza, le esclusioni di responsabilita e e relative note di copyright.

LG Electronics fornira anche il codice open source su CD-ROM su richiesta tramite
e-malil all'indirizzo opensource@I|ge.com addebitando il costo delle spese di
distribuzione (ad esempio il costo di supporti, spedizione e gestione).

Lofferta e valida per un periodo di tre anni a partire dalla nostra ultima spedizione
di questo prodotto. Lofferta e valida per gli utenti che avranno ricevuto queste
informazioni.

Informazioni sulle normative
(Numero ID normativa, etichetta
digitale ecc.)

Per informazioni sulle normative, andare in Impostazioni > Sistema > Normative
& Sicurezza.
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Marchi di fabbrica

+ Copyright ©2020 LG Electronics Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android, Chrome,
Google Photos, Google Play Protect, Google Calendar, Google Docs, Google Drive,
Google Sheets e altri marchi e logo correlati sono marchi di Google LLC.

- Bluetooth® & un marchio registrato di Bluetooth SIG, Inc. nel mondo.
- Wi-Fi® e il logo Wi-Fi sono marchi registrati di Wi-Fi Alliance.
« Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

HE HEVCAdvance™

‘: Covered by Patents at patentlisthevcadvance.com
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Dichiarazione sulla sicurezza del laser

Attenzione!

Questo prodotto utilizza un sistema laser. Per garantirne un utilizzo corretto,
leggere attentamente il presente manuale dell'utente e conservarlo come
riferimento per il futuro. Se 'unita richiede manutenzione, contattare un centro di
assistenza autorizzato.

Lutilizzo di controlli e regolazioni o lesecuzione di procedure diverse da quelle
specificate puo provocare lesposizione a radiazioni pericolose.

Per evitare lesposizione diretta al fascio laser, non tentare di aprire l'involucro o
entrare in contatto diretto con il laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-F100EMW é conforme ai requisiti essenziali e alle altre disposizioni della
Direttiva 2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo
http7//wwwi.lg.com/global/declaration
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Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

Labanda 5150 - 5350 MHz e limitata esclusivamente all'utilizzo domestico.

AT | BE | BG|CH |CY |CZ|DE|DK|EE]|EL
Q ES | FI | FR|{HR [ HU|E | IS | Im| 0L |LT
LU [LV | MT [ NL|NO|PL|PT|RO|SE]SI
SK | AL | ME | RS | MK | TR | BA | XK [UK(NI)
@
Il servizio 5G dipende dalla copertura del servizio e dalla compatibilita con 'operatore.
Verifica la compatibilita con il tuo operatore sul sito www.lg.com/it
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http://www.lg.com/it

Ulteriori informazioni

Parti in vetro temperato

Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.

+ Se silascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.

In questi casi, interrompere immediatamente 'uso del dispositivo e contattare
un Centro di assistenza clienti LG.

+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.

Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Proporzioni
Alcune app scaricate potrebbero non supportare alcune proporzioni.

In tal caso, selezionare le proporzioni dello schermo pili adatte allapp o consultare il
provider dellapp per ulteriori informazioni.

CUSTOMER CARE

c 199600044

Per conoscere gli orari di apertura e i relativi costi ti invitiamo a visitare il sito di LG
Italia wwwilg.com/it
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Guida al trasferimento dati

+ Per i dati trasferibili tra dispositivi LG e tra un dispositivo LG e un dispositivo di
parti terze, vedere lo schema seguente.

Dispositivo Ii':z:s:;“;? Dispositivo
LG . i0S
parti terze
Tipo Dettagli dell'elemento - N —
Dlspféltwo Dispositivo Dlsplt-)éltlvo
LG
Contatti, messaggi, registri
chiamate, calendario, 0 0 0
Dati registrazioni audio
i
personat Promemoria X 0
Sveglie X X
Datll - Foto, wdeq, canzoni, 0 0 0
multimediali | documenti
Impostazioni della schermata
) 0 X X
home (cartelle e widget)
dischermo Impostazioni della schermata
di blocco (impostazioni di 0 X X
blocco schermo escluse)
App scaricate 0 0
Applicazioni | i personali contenuti nelle 0 X -
app scaricate
Certificato pubblico 0 0 X
A hamate o
' f 0 X X

e notifiche, accessibilita,
batteria)

E « Alcune dati potrebbero non essere trasmessi a seconda della versione del
software, della versione delle app, del sistema operativo, e delle politiche del

produttore del dispositivo o del gestore del servizio.
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Bande di frequenza supportate Potenza in uscita trasmettitore

GSM 900 33.7dBm
GSM 1800 30.7dBm
WB1 242 dBm
W B8 25.2dBm
LTEB1 252dBm
LTEB3 237dBm
LTEB7 23.7dBm
LTEB8 25.2dBm
LTEB20 252dBm
LTEB28 252dBm
LTEB38 25.2dBm
LTE B40 252dBm
5G Sub6n1 252dBm
5G Sub6n3 25.2dBm
5G Sub6n7 252dBm
5G Sub6n28 252dBm
5G Sub6n78 22.7dBm
BT 2.4GHz 12dBm
WLAN 2.4GHz 19dBm
WLAN 5GHz 20 dBm
NFC - 23 dBuA/m

Le informazioni sulladattatore da viaggio si possono trovare su
http/wwwi.lg.com/global/support/cedoc/cedoc
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani
misti mediante impianti di raccolta specifici installati da enti pubblici o dalle

I autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita presso
il punto vendita all‘atto dellacquisto di una nuova apparecchiatura equivalente.
Gli utenti finali domestici possono inoltre consegnare gratuitamente
apparecchiature elettriche ed elettroniche di piccolissime dimensioni (non
eccedentii 25 cm) a fine vita direttamente presso un punto vendita a cio
abilitato, senza obbligo di acquistare una apparecchiatura nuova di tipo
equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a fine
vita.

2.1l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sullambiente. Una gestione
responsabile del fine vita delle apparecchiature elettriche ed elettroniche
da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al recupero
sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni piti dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(www.lg.com/global/recycling)

Smaltimento delle batterie/accumulatori

1. Questo simbolo potrebbe essere associato ai simboli chimici del mercurio (Hg),
cadmio (Cd) o piombo (Pb) se la batteria contiene piti di 0,0005% di mercurio,
0,002% di cadmio 0 0,004% di piombo.

2. Tutte le batterie e gli accumulatori devono essere smaltiti separatamente
rispetto alla raccolta differenziata municipale, mediante impianti di raccolta
specifici designati dal governo o dalle autorita locali.

3.l corretto smaltimento di batterie e accumulatori obsoleti contribuisce a
prevenire possibili conseguenze negative sullambiente, sulla salute degli
individui e su tutte le altre specie viventi.

4. Per informazioni pili dettagliate sullo smaltimento di batterie e accumulatori
obsoleti, contattare ['ufficio del comune di residenza, il servizio di smaltimento
rifiuti o il negozio in cui & stato acquistato il prodotto.
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FAQ

In questo capitolo sono descritti alcuni problemi che potrebbero verificarsi durante
l'uso del dispositivo. Alcuni problemi richiedono una chiamata al provider del
servizio, ma la maggior parte e facilmente risolvibile in autonomia.

Errore scheda SIM

Assicurarsi che la scheda SIM sia inserita correttamente.

Nessuna connessione alla rete o connessione di rete interrotta
Il segnale & debole. Spostarsi verso una finestra o in uno spazio aperto.
Sei al di fuori dellarea coperta dal fornitore di rete. Spostati e controlla la rete.

Le chiamate non sono disponibili
Nuova rete non autorizzata.

Assicurati di non avere impostato il blocco chiamate dal numero che effettua la
chiamata.

Assicurati di non avere impostato il blocco chiamate dal numero che stai
chiamando.

Non é possibile accendere il dispositivo
Quando la batteria & completamente scarica, il tuo dispositivo non si accende.
Ricaricare completamente la batteria prima di accendere il dispositivo.

Errore di caricamento

Assicurarsi che il dispositivo sia in carica a una temperatura normale.
Controllare il caricabatteria e il suo collegamento al dispositivo.
Utilizzare solo gli accessori forniti autorizzati da LG.

La batteria si scarica piu rapidamente rispetto a quando é
stata acquistata

Esponendo il dispositivo o la batteria a temperatura molto alte o molto basse, la
durata della batteria potrebbe ridursi.

Il consumo della batteria aumenta quando si usano certe app o funzionalita, come
GPS, giochi o internet.

La batteria e usurabile e la sua durata si riduce nel corso del tempo.
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Messaggi d'errore vengono visualizzati quando si avvia la
fotocamera.

Ricaricare la batteria.

Liberare memoria trasferendo i file a un computer o cancellando i file dal proprio
dispositivo.

consente di riawviare il dispositivo.

Se i problemi con app della fotocamera persistono dopo avere tentato con questi
suggerimenti, contattare il centro di assistenza LG Electronics.

La qualita delle foto & bassa.

La qualita delle foto potrebbe variare, a seconda dellambiente e delle tecniche
fotografiche usate.

Quando si realizzano foto e video, la qualita angolare standard & migliora rispetto al
grandangolo.

Realizzando foto in posti bui, di notte o interni, potrebbero essere presenti disturbi
o le immagini potrebbero essere sfocate.

In caso di problemi, azzerare le opzioni.

Lo schermo tattile risponde lentamente o in modo non
corretto

Collegando una protezione per lo schermo o accessori opzionali allo schermo tattile,
potrebbe non funzionare correttamente.

Indossando guanti, se le mani non sono pulite quando si tocca lo schermo tattile o
si sfiora lo schermo usando oggetti affilati o le punte delle dita, lo schermo tattile
potrebbe non funzionare.

Lo schermo tattile potrebbe non funzionare correttamente in condizioni di umidita
0 quando & esposto allacqua.

Riawviare lapparecchio per annullare eventuali bug del software.

Se lo schermo tattile e graffiato o danneggiato, visitare un centro di assistenza LG
Electronics.

Appendice 178



Chiude la chiamata o si blocca

Riavviare il dispositivo.
« Se il dispositivo si chiude la chiamata o si blocca, potrebbe essere necessario
chiudere le applicazioni o spegnere del tutto il dispositivo e riaccenderlo.

Eseguire un riavvio
- E possibile utilizzare un ripristino superficiale del dispositivo se lo schermo
si blocca oppure se i pulsanti, lo schermo a sfioramento o il dispositivo non
rispondono pill in modo corretto.
+ Per esequire un ripristino superficiale del dispositivo, tenere premuti i tasti
Volume giti e Power fino a quando il dispositivo non si riavvia.

Azzerare il dispositivo
+ Seimetodiillustrati sopra non risolvono il problema, esequire un ripristino dati
di fabbrica.
+ Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino >
Ripristino dati di fabbrica.
- Questo metodo consente di ripristinare tutte le impostazioni del dispositivo
ed eliminare i dati. Prima di esequire il ripristino dei dati di fabbrica, effettuare
copie di backup di tutti i dati importanti salvati nel dispositivo.

- Seil dispositivo & associato a un account Google, effettuare laccesso allo
stesso account Google dopo il ripristino.
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L'apparecchio Bluetooth non € localizzato
Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo.

Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo a cui
vuoi connetterti.

Assicurarsi che il dispositivo e altri dispositivi Bluetooth siano nellarea massima del
Bluetooth (10 m)

Se i suggerimenti indicati non ti hanno aiutato a risolvere il problema, contatta un
centro di assistenza LG Electronics.

Quando colleghi il tuo apparecchio a un computer, non viene
stabilita una connessione.
Assicurarsi che il cavo USB che stai usando sia compatibile con il tuo apparecchio.

Assicurarsi che sul proprio computer siano installati e aggiornati i driver nella
versione corretta.

Un'applicazione scaricata sta causando molti errori.
L'applicazione presenta dei problemi.
Rimuovere e reinstallare applicazione.
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EAAHNIKA
MAnpo@opieg OXETIKA UE AUTO TO

gyxepidio xpnong

Yag euxaploToUpE Tou eMAEEaTE AUTO To TTPOIOV LG. Nal Tnv ao@ali Kat owoTn
XPrion TG CUOKEUNG, TAPAKAAEIOTE va SIaBACETE MPOTEKTIKA AUTO TO EYXELPISI0
TIPWV XPNOIHOTOIOETE TN CUCKEUH yla TIPWTN QOPA.

- Na xpnotpomoleite mavtote yvriola agecoudp LG. Ta mapexopeva e§apTripata
TipoopiCoval AmOKAEIOTIKA YIal XPrioN HE AUTHY TNV GUOKEUN Kal EVOEXETaL va
unv eivat oupBatd pe AMNEG CUOKEUEC,

« Otmeplypagéc Bacifovtal oTig MpoemAeYUEVEG PUBIOELS TNG OUOKEUNG.

OL TIPOEYKATECTNHEVES EPAPLIOYEG 0T GUOKEUK UTIOKEIVTAL OE EVNUEPWOELG,
Kal 1 TTapoxT| UMOOTAPIENG VIO AUTEC TIC EQAPHOYES EVOEKETAL VA SLOKOTTE
Xwpi¢ mpoeidomoinon. Ev éxeTe EpWTHOELC OXETIKA LIE L0l EQAPLOYI TIOU
TIAPEXETAL LIE Tr) OUOKEUN), EMKOWVWVAOTE PE éva KEvTpo emokeuwv TG LG.
TXETIKA HE EQAPHOYE TIOU EXOUV EYKATAOTABEL A6 TOV XPHOTN, UMOPEITE Val
ETMIKOWWVIOETE PIE TOV APHOSIO TIAPOXO UTINPECIWV.

+ H tpomomoinon Tou A&lToupykoU GUGTAKATOC TNG CUOKEUNG 1 N EYKATAOTACN
MOyIopIKOU amo avemionpeg myég umopei va mpokahéoel BAABN oTn ouokeur
Kat va 0dnynoel o€ Kataotpo®n 1 anwAela Sedopévwvy. Tétolou gidoug
evépyelec anmoteholy mapaBiaon g adelag xpriong e LG Kat €xouv w¢
QmOTENEGHA TNV AKUPWON TG EYYUNONG 00G.

Kdmolo meplexOpeVo Kal EIKOVEC UMopE( va Sla@épouv oe axéon He TN
GUCKEUN 00C, avAAoya LE TNV TIEPLOKT, TOV TIAPOXO UTINPESIWY, TV €KSoon
TOU AOYIGUIKOU 1 TNV €KS00N TOU AEITOUPYIKOU CUOTAKATOC, KAl UMOpEi va
aMdG€ouv xwpic mpoeidomoinon.

+ To MoyIOUIKO, OL XOl, Ol TATETOAPIEC, Ol EIKOVES Kat BAAA Uéoa TTou TIapExovTal
padi pe Tn GUOKELN 0ag ouVOSEVOVTAL OO AGEL VIO TIEPIOPICUEVN XPriON.
Tuxdv e€aywyn Kat Xprion autwv Twv VMKWV Yia UTopIKoUG r AAOUG OKOTIOUG
evOEXETAL VO OLVIOTA TTAPABIcN TWV VOUWY TERT TIVEUMATIKWV SIKAUWUATWV.
Q¢ TENKOG XPAOTNG, EXETE TNV TP €UBUVN yia TUXOVV TAPAvVOuN XProN Twv
HEOWV QUTWV.

EvSéyetat va umdpyouv mpAoBeTeS XpeWTELS yia TN peaieg SeSopévwy, OTwG
Yia TIC U peoieg avTaAayng INVURATWY, T @opTwon i T Mjwn Sedopévwy,
TOV QUTOHATO CUYXPOVIOUO Kal TIG UTinpeaieg TomoBeaiag. MNa va unv
€MBOPUVEDTE Ue MPOOBETEC XPEWTELC, EMAECTE éva TpOypappa dedopévwv
TI0U VOl KAAUTITEL TIG AVAYKEG GG, ETTIKOIVWVIOTE L TOV IAPOXO UTTNPECIWV 0O
Y10 TTEPIOOOTEPEC NETTTOUEPELEG,



- To mapdv eyxelpidio xpriong éxet ouvtayBei oTig BaoikéC Y\wWooeC yia KdBe
Xwpa. Avaloya pE T YAWooa TTou XPnOLHOTIOLEITAL, TO TIEPLEXOUEVO EVEEKETAL
va Slagoporoleital.

ZUUBOVAEUTIKEG AVAKOIVWOELC

MPOEIAONMOIHZH: KataoTagoelg mou Umopei va MPOoKAaAéCOULV TPAUHATIOHO
TOU XPAOTN KAl TPITWV.

A MPOZOXH: Kataotdoelg mou pmopei va mpoKaAéaouv ENapPU TPAUHATIOHO
1 {nWa 0T GUOKEUH.

5 THMEIQZH: Avakovwoelg 1y TpdoBeTeq TANPOQOpIEC.

MAnpo@opieg OXETIKA PE AUTO TO EYXELPISIO XPrIONG
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0d6nyisg yia ac@aln Kat amoteAEGUATIKA
Xpnon

AlaBaoTe TIg mapakdtw amég odnyieg. H un tpnon autwv Twv odnyiwv pmopei va
amnofei emkivéuvn 1 mapdvopn.

Y& MePIMTWon oQAAUATOE, N GUCKELN 0ag SlaBETel éva epyaleio Aoyiopikol Tou Ba
SnuioupyroeL éva apyxeio kataypagrg o@aiuatog. To epyaleio cuMéyel Sedopéva
€151KA Y10 TO CUYKEKPIUEVO OPAAua OTIwG Ta £€AG: LoxUG onpatog, cell ID position

0€ TIEPIMTWON AmPACHEVNG AMOPPIYNG KARONG KAl EQAPHOYEG TTOU UTIAPXOULV 0T
GUOKeUN. To apXEio KATaYPAPrG XPNOIUOTIOLETAL AMTOKAEIOTIKA YI0l TOV TPOGSIOPIoHO
NG AITiag Tou OQAAUATOG. AUTA Ta OPXEQ KATAYPAPG Eival KpUTTToypag@nuéva Kat n
TIPOORacn o€ auTd gival EPIKTH POvVo amd e€0uCIoS0TNHEVA KEVTPA EMIOKEVAG TNG LG,
O€ TIEPITTTWON TIOU XPELOOTEL Va EMOTPEWETE TN OUOKEUR OAG VIO ETIIOKEVN.

'EkBeon o¢ evépyela padlocuyvotritwy

MAnPoPopieC OXETIKA HE TNV €KBETN O€ PASIOKUHATA Kall TO GUVTENEDTH EIOIKIG
amoppd@nong (XEA).

AuTH N GUOKEUN €XEl OXESIAOTEL WOTE VOl GUMUOPPWVETAL LE TIG LOXUOUOEG AMAITHOELS
aopaleiag yia tnv ékBeon og padiokupata. Ot amartioelg autég BaciCovtal og
EMOTNUOVIKEG 0dnyieg Tou ephapBavouv mepBwpLa aopaleiag yia Ty TPooTasia
OAWV TWV aTOPWY, ave€apTnTa amod TNV NAKia fj TNV KATtdoTaon TG Uyeiag Toug.

+ XTI 08nYieg OXETIKA pE TNV éKBEDN OE PASIOKUHATA XPNOIMOTIOLETA Miat HovASa
UETpNOoNG N omoia gival yvwoTh w¢ CUVTENEDTAG EISIKNG amoppoenang i XEA. Ot
é\eyyol yla 1o XEA Sie§dyovtal pe Tumomoinpéveg HeBdS0UC, e Tn GUOKEUN va
EKTTENTTEL OTO PEYIOTO TIIOTOMOINMEVO ETMESO 10XVOG O ONEG TIC {WVES CUXVOTATWY
TIOU XPNOIUOTIOLE.

« Av Kal umopei va umapyouv Sla@opég petady Twv emmédwv Tou LEA yia
S1apopa povTéNa BUOKEUWV TNG LG, OAa Ta HovTéAa €xouv oXedIOTEl WOTE Va
QVTATIOKPIVOVTaL OTIG OXETIKEG 0dNYiEG yia TV ékBeon o€ padlokupata.

« To 6pto Tou ZEA mou ouviotatat amd t Alebvr) Emtporm Mpootaciag améd  Mn
loviCouoa AktivoBoAia (ICNIRP), givat 2 W/kg pe Bdon Tov UMoAoYIoHS TG HENG
TG ya 10 ypappdpla owpatikol 10Tou.

+ HuynAotepn T tou ZEA yia autd To povTého, Omwe éxel eheyxDei yia xprion oto
auri, eivat 0,357 W/kg (10 g) kat yia xprion oto owpa givai 1,304 W/kg (10 ).



« AutA n cuokeur MAnPEOI TIG MPOUTTOBETELS Yia TN ékBEaN OE PadlooUXVOTNTEG
€iTe TAV XpNolHomolETal TNV Kavovikr Béon xpriong Sima ato auri gite dtav
Bpioketal og amdoTacn TouAdxioTov 5 mm amnd to owpa. Otav xpnotpomnoleital
BrKn petagopdg, KA {wvng fi Brkn yia xprion oto owua, Sev mpémel va
mepthapBavel pETAMIKA oTolxEla Kal TTPETEL VO GUYKPATEL TO TIPOIOV G€ amdoTaon
TOUAdXI0TOV 5 mm amd To owpa oac. Na tn petadoon apyeiwv Sedopévwy iy
UNVUPATWY, N GUOKELR amaitei Tnv Umapén moloTikA¢ oUvEeonc oTo Siktuo. Xe
OPIOHEVEG TIEPITTTWOELG, N METAS00N apyeiwv SeSopEVWY 1} UNVUPATWY UMOpPEi
va kaBuoTteproel éwg 6Tou givat Slabéoiun pia Tétota ouvdeon. Beaiwbeite ott
TNPOUVTAL Ol IAPATTAVW 08NYIEG OXETIKA HIE TNV AMAOTACK AT TO CWHA UEXPL VA
olokAnpwbei n petadoon.

MAnpo@opieg oxeTIKA pe TNV €KOEDN GE PASIOCUXVOTNTES
ané tnv Opoomnovdiakn Emrpornn Emkowvwviwy twv HIMA

Tov AlyouoTo Tou 1996, n Opoomovdiakr Emtporr Emkowwviwv (FCC) Twv Hvwpévwv
MoNTewwv, pe tn Spdon tng Report and Order FCC 96-326, ui0B£tnoe éva evnuepwpévo
TPATUTIO AOPANELQG YIa TNV €KBEON TOU AVBPWTTOU OTNV NAEKTPOUAYVNTIKY EVEPYEL
padioouyvotitwy (RF) mou ekméumeTal amd MOUMOUE ot 0TToiot TEAOUV UTIO ToV
puBpIOTIKG éNeyxo TnG FCC. Ot odnyieg auTEC €ival CUVETEIG HIE TOUG KAVOVIOHOUG
acpaleiag mou eixav 1ebei 0To MapeN@OV amd Ta Siebvny Kal apepikavika mpotuma. H
oxediaon auTrg TG CUOKEURG CUMHOPPWVETAL UE TIG 0dnyieg Tng FCC kat pe autd ta
S1ebvry mpdruma.

AnAwon Part 15.19

AUTH 1 CUOKEUH} CUHHOPPWVETAL HE TO ApBpo 15 Twv Kavoviopwv T FCC. H xprion
UMOKEITal 0TI akoAouBe¢ 500 mpoUmoBEéaelc:

(1) AutA n cuokeun Sev pmopei va mpokaléoel emPBAaPeic mapepBoAEC kat

(2) auTr n ouokeun Mpémel va amodéxeTal omoladnmoTe MAPEUPOAN,
oupnepAapBavopévwy mapeUBOAWV TIOU HITOPET va IPOKAAEGOUY avemBUpnTn
Aertoupyia.

AnAwon Part 15.21

Tuxov ahayég iy TPomoTToloEI TToU GV EYKPIVOVTAL PNTA amd TOV KATAOKELAOTH
MIOPOUV VA AKUPWOOUV TO SIKaiwua xpriong Tou e§omAiopoU.
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Xpron oto cwpa

AUTH 1 OUOKEUT €XEL ENeYXDE( Y10 TUTIIKN XPriON OTO OWHA, HE TO TTOW MEPOC TNG

og anéotaon 0,39 vtowv (1 cm) amoé To oW Tou XPHOTN. [a CUPHOPPWON PE TIG
anaitrioelg g FCC yia tnv ékBeon o€ padioouyvdtnteg, mpémel va Statnpeitat eNdyiotn
anéotaon 0,39 vtowv (1 cm) avapesa To WA TOU XPROTN KAl TO THow PéEPOG TNG
OUOKEUNG.

Evééxetat va pnv pmopolv va xpnaotpomotnBouv KA otipténg oe {wvn, Brikeg kat
napepepn afeaoudp mou Slabétouv peTarika e§aptripata. Ta afecoudp yia xprion
0TO OWHa 1o Sev umopouv va Slatnpricouv amdotaocn 0,39 vtowv (1 cm) petady

TOU OWHATOG TOU XPHOTN KAl TOU TToW MEPOUG TNG CUOKEUNG Kall Ta ortoia Gev €xouv
GOKIHOOTEL yia TUTTIKEG XPROEIG 0TO OWHA, EVOEXETAL va Uy TANpolv Ta 6pia T FCC yia
Vv €kBeon o€ PadlooUXVOTNTEC Kall TIPETEL VOl AMTOPEVYOVTAL.

AfAwon Part 15.105

AUTOG 0 £EOMANIGHOG ExEL ENEYXBEL KOl CUUOPPWVETAL LIE TA OPLA VIO TIG PNPLAKES
OUOKEVEG Katnyopiag B, cuppwva pe To Part 15 twv kavoviouwv FCC. Autd ta 6pta
eival oxedlaopéva yia va Tapéxou EMAPKI TPOOTAsia évavTt eMPAABWY mMapepBoAwY
o€ OIKIaKr eykatdotaon. O €0mNOHOC QUTOG TTAPAYEL XPNOILOTOLE KAl MMTOPE( val
EKTTEUDEL EVEPYELD PASIOOUXVOTHTWY Kal, av Sev eyKaTaoTabe( Kat xpnotpomoindei
oUpPWvVa pe TIG 0dnyieg, umopei va mipokahéoel empPAapeic mapepBolég oTig
padioemkowwvieg. QaTo00, Sev uTApxEL £yyunon 6Tt Sev Ba undp&ouv mapepPoAEG
O€ M0 GUYKEKPIPEVN EYKATAOTAON. AV auTOG 0 EE0MAIOHOG TIPOKaNEDEL emPAapEic
TIAPEUPONEG OTNV TNAEOTTIKA AN, YEYOVOG TTOU UMOpPEi vat SlamoTwOei pe Thv
amevepyomoinon kai evepyomoinan Tou eE0mAIGHOU, 0 XpoTng evBappuvetal va
Sokipaoel va SlopBuwoel Tic mapepBolég Ue éva 1y eploodtepa amd Ta e§RG PETPa:

AMGETE TV TPOsaVATONOHO 1y TN Béon TG Kepaiag ARYnG.

Auénote v amdotacn petal eEomiopou Kat SkTn.

« ZuvdéaTe Tov e§0MAIOUO o€ TIPIla TTOU AVIAKEL 08 AANO KUKAWHA QO QUTO WE TO
ormoio eival ouvSeSepEvog 0 SEKTNC.

+ YUMPOUNEUTEITE TO METAMWANTH 1} évav EUTTEIPO TEXVIKO pado@uvwv/TnAedpaonc
yia Boribela.

Opovtiba kal GUVTHPNON TOU TIPOIOGVTOC
+ Naypnotporoleite povo ta e€aptripata mou mepthapBavovtal 0T CUOKEUAGia Kal ivat
eoualodotnpéva amd v LG. H LG Sev mapéxel eyyunoelg yia tuxov BAaBeg fy amotuyieg
Aettoupyiag mou ogeilovtal og e€apTripaTa GMWV KATAOKEUAOTWV.

+ Oplopéva TepLEOpEVA Kall EIKOVEC EVEEXETAL va SlagEéPouv amd Tn CUOKEUN 0aG XWPIG
npogidomnoinan.
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« Mnv anmocuvappoloyeite T povada. Otav anarrouvtal Epyacieg EMOKEUNG, MapadwoTe
NV o€ €EEIBIKEVPEVO TEXVIKO.

+ Katatn Siakprrikr euyépeta tng LG, ot eMOKeVE TOU KAAUTITOVTAL OO TNV €yyOnon
evdéxetat va mephapBdvouv Ty TomoBETon avTaMaKTIKWVY HEPWY 1 TIVAKWY (gite
KavoUPIwV €{Te EMOKEVAOHEVWVY), e TNV TPoUTOBEON OTI N AEITOUPYIKOTNTA TOUG €ival
10080Vapn E TN AETOUPYIKATNTA TWV HEPWV TTOU QVTIKATAOTABNKAV.

+ Kpatdte T GUOKEUN HaKPLA amO NAEKTPIKEG OUOKEUES OMTWG TNAEOPATELS, padIdpwva Kal
UTIOAOYIOTEG,

« H ouokeur| mpémel va QUAAOCETAL MaKPLA amd Tyég BepuoTnTaC, OTwg KAAoPIpéP
NAEKTPIKEC KouCive.

+ TMpocé€te va pnv méoeL.

+H ouokeur| dev mpémel val UOKELTAL O€ PNXAVIKEG GOVATELS f} KpadaopoU.

+ AmevepyomolEiTe Tn OUOKEULN OTIG TIEPIOKEG OTTOU amayopeUETal N XPrion TG COHPWVA E
€181koU¢ KavovIopoUG. Mo TapAdelya, pnv XENOIHOTIOIETE TN GUGKEUT) OE VOOOKOEID,
KaBWG N XPron TG UMopEi va EMNPEACEL EVAITONTO LATPIKG EEOTNIOHO.

+ Mnv mavete T cuokeun Ue Ppeypéva xépla, otav popTilel. Mmopei va mdbete
nAektpomAngia kat va mpokAnBei coBapr) BAABN otn cuokeun.

+ Mnv @oprilete 1o TNAé@wvo KovTd 08 E0PAeKTA UNKG, KaB)G evoéxeTal va BeppavBei kat
va SnpioupynBei Kivouvog mupkaylag.

« Xpnotpomolrote éva oteyvd mavi yia va kabapioeTe o mepiBAnpa TG CUOKEUNG (v
xpnotporoleite SlahUTeG 6muwg Bevdivn, SIOAUTIKOG ) OIVOTIVEUHA).

+ Mn @oprilete T cuokeur dtav PpiokeTal Mavw o€ MOAAKA uAoHaTa.

+H ouokeunr mpémel va poprtiletal o€ KaAd agpI{OpEVO XWpo.

+ Mnv a@riveTe Tn GUOKEUN O€ XWPOUG LE UTIEPBONIKO KOO 1y OKGvI.

+ Mnv TomoBeTeite T GUOKEUR Sim\a O€ MOTWTIKES KAPTEG 1} EIOITHPIA HECWV LETAPOPAG.
Mropei va emmpedoet Tig TANPOQOPIEG TTOU TIEPIEXOVTAL OTIG HAYVNTIKEC TAIVIEC.

« Mnv ytumdre v 086vn pe agunea avtikeipeva, kabwg evéxetal va mpokaléoete BAABN
0TI OUOKEUN.

+ Mnv ekBéteTe TN GUOKELN O€ LYPA 1} Lypaaia.

« Xpnotpomoleite pe mpoaoxr Ta aeaoudp, dnwg m.y. Ta akouoTikd. Mnv ayyilete dokoma
TNV Kepaia.

+ Mnv xpnotpomoleite, pnv ayyilete Kat pnv mpoomabeite va apapECETE 1 va
embI0pOWOETE OMIACHEVO, KOUMEVO ) payiopévo yuahi. H eyyunon Sev kahomtel BAdBeg
TIoU 0EINOVTaL O€ KAKH XPron TG Yudhivng 08dvng.

«H ouokeun ivat n\ektpovikr Kat mapdyet BepuOTNTA KATA Tr SIAPKELD TNG KAVOVIKNAG
Aertoupyiag, H mapatetapévn, Apeon emagr Ke 1o G€ppa 0ag UM OUVONKES AVEMAPKOUG
€€0EPIOLOL EVOEXETAI VAl EMPEPEL SUOPOPI 1} LIKPA EYKAUUATO. ZUVETILIG, XEIPIOTEITE UE
TIPOOOKT T GUOKELN) 0aG KATA TN A&IToupyia iy apéowg peTa.
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« Av Bpayei n GUoKeLN, AMOCUVOEDTE TNV AUEOWG KAt OTEYVWOTE TNV Kahd. Mnv
EMIYEIPNOETE VOl EMOTIEVOETE TO OTEYVWH UE Hiat EEWTEPIKR TNy BeppotnTag, omwg eivat
0L (pOUPVOL, OL POUPVOL LIKPOKULATWY 1 Ol OTEYVWTHPEG LAV,

+ To uypd 0N Bpeyuévn ouokeur aMALEL TO XPWHA TNG ETIKETAG TOU TTPOIOVTOG OTO
E0WTEPIKO TNG OUOKEUNG. H eyyinon Sev kaAimTel BAABEC TG GUOKEURG ToU opeihovTal
otnv ékBear Tng o€ uypa.

+ Mia @opnTtr cuokeur amaitei owoTr Kukhogopia aépa yia T Sidxuon tng BepudtnTac.

H apeon emagr pe 1o G€ppa Kal n avemapKrig KUKAOQopia Tou aépa 0T GUOKEUR UMopE(
va odnynoet oe umepBéppavon) . H ouokeur) Ba mpémet va Bpioketal o€ amdotaon
TouAdioTov 1,0 cm oo To OWHA TOU XPAOTN.

« Eumodiote Ty €icodo okovng i dAMwv Eévwv ouotwv ot BUpa Tou YOPTIOTH/Tou
kahwdiov USB. EvdéxeTat va mpokAnBei umepBéppavan 1y mupkayld.

ATOQUYETE TNV éKOECN TNG CUOKEUNG O€ XaUNAR aTUOCQAIPIK THEON 0€ UYNAG

UEYANO UPOPETPO.

+ Mnv exBétete T ouoKeur o€ TOAU XaunA} ATHOCQAIPIKN TTEON. AAPOPETIKA,
umopei va mpokAnBei ékpnén g pmatapiag i Slappor) eVPAEKTOU LYPOU 1 agpiou.

+ OpovTioTe va pnv €pBel To TPOIOV O€ EMAYPN LE yPd. Mnv XpnolpomoleiTe

EMAVaPOPTICETE TO MPOIGV av éxel umooTei {nuid. Av To mpoidv Bpaxei, n Auxvia

BAAPNG amd uypd Ba aMdel xpwia. AdBete umdPn oag OTL GE QUTAY TNV TEPIMTWON

Sev Ba SikaloUoTe TIG SwPeAV UTNPEGTES EMOKEUVNG TTOU KAAUTTTOVTAL Ao TV

gyyunon.

Anote\eopATIKNA XPON TNG CUGKEVAG

HAEKTPOVIKEG OUOKEVEC
'O\eG Ot GUOKEVEG MMopEi va G€xovTal TapeUPBOAEG Tou emmpealouv Ty anddoar Toug.
+ Mnv XPNOIUOTIOLEITE TN GUOKEUI KOVTA OE LATPIKO EE0MAICUO XwpiG va €xeTe Addfel
OXETIKN Gdel. ZUUBOUNEUTEITE TO yIaTPO GG yia va SIAMOTWOETE av N Aerroupyia
TNG OUOKEUNG UMOPEi va TIPOKaAéTEL TTAPEPBONEG 0TN AelToupyia TG IATPIKAG 0ag
OUOKEUNG.
+ Ol KATAOKEVAOTEG BNUATOSOTWY OUVIOTOUV ENAXIOTN amdaTaon 15 cm petagd
AMWV CUOKEUWV Kall TOU Bpatodotn, yia Thy amoguyn moavwv mapepBoAwy.
+ AUTI) ) GUOKEUN MITOPE( VOl TIAPAYEL EVTOVO PWG 1) WG TOU AvaBooPrvel.
« Oplopéva BonBrpata akong evaéxeTal va IoTAVTAL TTOPEUPONEC ATTO GUOKEVEG.
+ MiKpég MapepBONEG EVOEXETAI VOl ETNPEACOUV OUOKEVEG, OTIWG TNAEOPATELG,
padI6GWVa, UTONOYIOTEG KT
« Av givai Suvato, XpnouomoloTe T cuoKeun o€ Beppokpaocieg petagd 0 °C kat
35°C. H ékBeon g ouokeunig o€ MOAU XapnAEG 1 upnAég Beppokpaaieg evoéxetal
va TIPoKaAéael {npid, Suohertoupyia iy akdpa Kat €Kpnén.
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0481Kn ao@alela

ENéyE€Te TOUG VOMOUG KOl TOUG KAVOVIGHOUG YIaL Tr XPr0N OUCKEUWY OTAV OONYEITE.

+ Mnv XPNOIUOTIOLEITE TTIOTE GUOKEUN XEIPOG OTAV OSNVYE(TE.

Eotiaote OAn oag Ty mpoaooyr oty odriynon.

YTAPOTAOTE OTNV AKPEN TOU SPAOU Kal 0TABUEVOTE TO OXNKA 0ag TPV
TIPOYHOTOTOINOETE 1 AMAVTHOETE O€ M KAON, €GV TO amaitouv ol ouvBriKeg
odriynong.

+ H evépyela padloouyvoTATWY EVOEXETAL VO EMNPEAGEL OPIOUEVA NAEKTPOVIKA

GUOTAUATA 0TO OXNHA 00E, OTIWE TO PASIOPWVO TOU QUTOKIVITOU Kall TOV E§0TTANICHO
acgaleiag.

« Eav 10 0xnpa oag ivat §omAiopévo e évav 1y TIEPICOATEPOUG AEPOCAKOUCG,

unv eykabioTdte Kat Pnv tomobeteite actppato eomiiopd o onpeia omou Ba
eumodietal n Aerroupyia Tou agpooakou. Evaéxetal va mpokAnbei Suohettoupyia
TOU 0EPOOAKOU 1 00PBaPAC TPAUUATIONAE AOYw aKATAANANG anddoond.

« 'Otav akoUTe HOVOIKN eV BpiokeoTe £§w, PePaiwbeite OTi éxete pubuioel Tnv

£€vtaon og éva Aoyiko eminedo, yla va €XeTe emiyvwon Tou Tt cupBaivel yopw oag.
AUTO gival IBLAITEPA CNUAVTIKO OTAV KIVEIOTE KOVTA 08 SPOUOUC.

MpokAnon BAAPNC otnv akon cag
Ta va mpogulayteite amd mBavr) PAGPN TG akorig oag, amo@UyeTe TV
aKpdaon o€ UPNAG emimeda oL yia Peyala Xpovikd SlaoTtruarta.

Evééxetat va mpokAnBei BAGPN otnv akor) oag eav ekTiBeoTe og Suvatd fixo yia
TIAPATETAPEVO XPOVIKO SIA0TNUA. EMOPéVG, 0aG GUVIGTOUE Va NV EVEPYOTIOIEITE
1] AMEVEPYOTIOLEITE TO TNAEPWVO KOVTA 0Ta aUTId 0aG. Emiong, oag cuvioToUpe va
pUBpieTe TNV évTaon TNG HOUGIKG Kall TOU fi¥ou KAong o éva hoyikd emimedo.

« '0tav XPNOIHOTOLEITE OKOUOTIKE, VA MEIWVETE TNV €VTacon TOU XoU av Sev akoUTe

600U HINOUV YUpw 00 1} av To dTopo Tou KABeTal Sim\a o0 UMOPE va aKoUoEL
QUTO TTOU OKOUTE.

E + H umepPoNkn nNTIKr TEn amd Ta AKOUOTIKA UITOPE( va TTPOKOAEDEL

QMWAELD TNG AKONG.
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luvdhiva e§aptrpata

Oplopéva P€pn TNG CUOKEUNG 00C Eival KATAOKEUAOHEVA amd YUANL To yuai pumopei

VOl OTIAOEL AV I CUOKEUT 00 TTECEL TIAVW OE OKANPEN EM@AVELD 1) SEXTEL IOXUPOUG
Kpadaopoug. EGv omdoel kdmoto YuaAvo e€ApTNHa, KNV TO ayYIEETE Kat pnv
ETTIKEIPHOETE VA TO APAIPECETE. TAHATHOTE VO XPNOIHOTIOLEITE Tr) CUCKEUH 0ag PéXPL VA
avTikataoTaBei To Yuahi amo e0uatoSoTnuévo TTAPOYO UTTNPECIWV.

Media avativaéewv

Mnv xpnotpomolgite Tn CUOKEUN O TTEPLOXES 0oL YivovTal avaTtivaelc. Na akohouBeite
TOUG TTEPLOPIOUOUG KAl OTTOLOUG KAVOVIGHOUG 1) KAVOVEG LOXUOUV.

MepiBdaMovta 6mou umdpyel Kivduvog ekpnéewv
+ Mnv XpNOILOTOIEITE TN OUOKEUN OE ONEI QVEPOSIAGHOU KAUGTUWV.
+ Mnv XpnOIHOTOLEITE TO TNAEPWVO KOVTA OE KAUGIHA 1} XNHIKA.

« Mnv pETaQEPETE Kal Pnv amoBnKeVETE EVPAEKTA AEPLD, UyPd 1} EKPNKTIKA OTOV iS10
XWPO TOU AUTOKIVATOU 0agG OTIOU TOTOBETEITE TN GUCKEUN 1} TA a§E0OUdp TNG.

Xpnon o€ agpooKAPog
O1 00UPUATEG CUOKEVEG UMOPOUV VA TIPOKAAEGOUV TIAPEUBOAEG OTA CUOTAHATA
AEPOOKAPWV.

« MNpw empPiBaoTeite o€ AEPOOKAPOG, OTTEVEPYOTIOIOTE TN GUCKEUN).

+ ‘000 TO aEPOOKAPOG BPICKETAL OTO £50POG, UNV XPNOILOTOIEITE TO TNAEPWVO XWPIG
adeia amd o mMipwya.

MNadia

Oulagte Tn ouoKeur Og AoPANEG HéPOG, pakpla amod maudid. MepapPavel e§aptrhpata
MIKPOU pEeYEBOUG TTOU EVOEXETAI VAl TIPOKANETOUV KiVEUVO TIVIYHOU EQV AMTOOTIAOTOUV
amé 1o TNAéQwvo.

Eneiyouoec KA\oEIC

O1 emeiyouoeg KANOELG evEéxeTal va pnv ivat Slabéotpeg og OAa Ta Siktua KIvnTrg
Aepwviag, Ma to Adyo auto, Sev mpémel va Bacileate amokAEIOTIKA OE auTr TN
GUOKEUN YIa EMEIYOUTEG KANTELC. ETIKOIVWVIAOTE HIE TOV TOTTIKO TIAPOXO UTINPETIAV Yial
Va EVIUEPWOEITE OXETIKA UE AUTO TO Bépa.
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H}\npocpoplac Kal @PovTida pumataplwv
Aev ival amapaitnTo va anogopTioTel Mpw N ratapia yia va Ty
EMAVAPOPTIOETE. Z& avTiBeon pe GAa ouoTApaTa prataplwy, Sev epgavifetal 1o
QAIVOLEVO UVIALING TTOU UMTOPE VOl EMNPEACEL TNV amdS00n TNG Unatapia.

« Xpnoworoleite uovo pmatapieg kat opTioTég LG. Ot popTioTéq LG éxouv oxediaoTei
UE TPAOTO TETOI0, WOTE Va peyloTomololy Tn Sidpkela {whg TG Prmatapiod.

+ Mnv amoouvappoNoYEiTe Kat unv BPOUKUKAWVETE TV Pmatapia.

« Alotnpeite KaBapEG TIG METAANKES EMOPES TNG PmaTapiag.

« AvtikaBiotdre v pmatapia otav pelwdei onuavtika n anddoon e, H umatapia
UMOPEL VOl POPTIOTEL EKATOVTASES POPES LEXPL VA XPEIAOTE AVTIKATAOTAON.

« Edav n umatapia Sev éxel xpnotpomoindei yia moAl kaipd, popTioTe T yia va
UEYIOTOMOINOETE TN SIAPKEL XPAONG TNG.

+ Mnv a@rivete ekTeBeIpévo To PopTIoTH TG umatapiag ameubeiag otnv nAakn
QKTIVOBONIC Kall NV TOV XPNOIMOTIOLEITE OE XWPOUG HE TTOAR LYPAGia, OTTWE TO
umavio.

+ Mnv a@rivete v pratapia og Beppolc i KPUOUG XWPOUE, KaBWG evaéxeTal va
pewwbei n amdédoor e,

« Eav avtikataotiioete T pratapia pe AavBaopiévo TOmo pmatapiag, umdpyel
Kivouvog ékpnéng. H amdppudn Twv XpnotuomotnuéVWY Hmatapliv PEMEL va yiveTat
oUPPWVa PE TIG 08nyieC.

« o va amo@UyeTe TNV AOKOTIN KATAVAAWGN EVEPYELAG AMTO TO YOPTIOTH, VA TOV
QmoCUVSEETE TAVTOTE Mo TNV TPICa META TNV T PN YOPTION TNG CUCKEUNC.

H mpaypatikn Sapketa {wng Tng umatapiog e§aptdatat amoé t Slapdpewon Tou
SIKTUOU, TIG PUBHITELG TV TTPOTOVTWY, TIC CUVIBELEG XPrONG, TV MmaTapia Kat Tig
TEPIBANNOVTIKEG OUVORKEG,

« BePawwBeite mwg n prmatapia Sev EpeTal o€ EMAQN HE AIUNPA QVTIKEIPEVT, OTIWE
Sovtia {wwv 1 kap@ld. Ydpyxel Kivduvog avaphegne.

+ Katavalwon evépyelag (\ertoupyia avapovrig Siktuou): 0,4 W

Ac@ANEIQ TIPOCWTTIKWV GTOIXEIWV
+ Na TIpooTATEVETE IAVTA TA IPOCWTTIKA GO OTOIKEID, WOTE VA EUMOSIOETE TUXOV
S1appoég Sedopévwy 1 KATAXPNON EVAIcONTWY TANPOPOPILV.
+ Na énpioupyeite mavta avtiypaga ac@aleiag Twv onpavtikwv oag Sedopévwy dtav
XPnolpomoleite Tn ouokeun. H LG Sev ivat umevBuvn yia Tuxov anwAeleq SeSopévwv.

« Mpv meTd&eTe TN OUOKEUR, Va SNUIOVPYATETE avTiypaga ac@aleiog OAwv Twv
Sedopévwv Kal va KAVETE EMavapopd TG SUOKEUNG WOTE Va EPMOSIOETE TUXOV
Katdypnon euaiocbnTwv MANPOPOPIWV.
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« 'Otav katePalete pappoyég, va SlaPalete MPOOEKTIKA TNV 006V TwV SIKAIWHUATWV.

+ Na €ioTe MPOOEKTIKO{ OTAV XPNOILOTOIEITE EQAPHOYES TIOU €xOUV TTPOORacH oe
TIOMEG NETOUPYIEC 1) OTA TTPOCWTTIKA 0O OTOIXEICL.

+ Na eNéyxeTe TAKTIKG TOUG TTPOOWTTIKOUE GOG AOYOPLACHOUG. AV EVTOTIIOETE TUXOV
€eVOEICEIC KATAYPNONG TWV TTPOCWTTIKWY GAC OTOIXEIWY, {NTAOTE amod ToV TAPOXO TNG
umnpeoiag va dtaypayet ry va aMdgel Ta oTolyeia Tou Aoyaplaopol oag.

« Av n ouokeun oag xabei ) Kharei, aMate Tov Kwdiko MpdoPacng Tou Aoyaplacpou
00G WOTE Va SI00PANCETE Ta TIPOOWTTIKA 0AG OTOIXE(Q.

+ Mnv xpnolHOTIOLEITE EPOPHOYES TTOU TIPOEPKOVTAL ATTO AYVWOTES TINYEG.

A Eiomoinon yla tThv avtikatdotaon th pmatapiog
+H umatapia 1dviwv AiBiou eivat emkivéuvn kabwg pmopei va mpokahéoel

TPAUHOTIOO.

H avTikatdotaon TG umatapiag amo pUn KatapTIopEVO EmayyeAUaTia pmopel

Va TIPOKANEDEL (NG 0T GUCKEUT 00C.

+ Mnv avtikaBiotarte tn pmatapia pévol oag. Mmopei va mpokAnOei BAaBn otn
umatapia mou Ba odnyroel o€ unepOEpuavan Kat TpavpaTiopd. H pmatapia
TIPEMEL va avTikataoTaBel amd katapTiopévo enayyeApatio. H pmatapia
TIPETEL VA AVOKUKAWVETAL ) VOl AOPPITTTETAL EEXWPLOTA ATTd Tal OIKIAKA
amoppippaTa.

3TNV MEPIMTWON oV TO TIPOIGV S1aBETEl EvowpATWEVN UaTapia TTou &g
umopei va agatpebei amd To xpriotn, n LG oag mpoteivel va ameuBuvBeite
0€ EMAYYENUATIO YIa TNV AQAipEDN TNG Umatapiag, Qv MPOKELTaL va TV
QVTIKOTOOTHOETE I Va TN OTEINETE Yl aVAKUKAWON 0T0 TENOG TG (WG TG,
Ma v mpoAnwn BAGRNE 0To POV, KAl yia T Ao@ANEL TOU XPROTN,

MNV ETIXEIPHOETE VOl APAIPECETE TN prmatapia. AmeuBuvBeite otn Mpapun
BonBeiag g LG, fj o€ dA\o emayyehuaria.

+ Hagaipeon tng pmatapiag mpoumoBétel amoouvapuoAdynon
TOU TEPIBARLATOC TOU TTPOIOVTOG, AmOCUVEEDN TWV NAEKTPIKWV
KaAwSiwv/ EMaPWV, Kal TPOCEKTIKK AMOPAKEUVON TNG Umatapiag
e e€e10IKeUpéva epYaNeia. EQv XpelGleaTe TIG EMmayYEAUATIKES
odnyieg yla TV agaipeon g pmatapiag, emokepOeite T SievBuvon
http://www.lge.com/global/sustainability/environment/take-back-recycling.
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XapaKTnpioTIKd EPICTPOPNG

Nertoupyia meploTpoPng
Mriopeite va mePIOTPEYETE TO TIPOIOV yla va Xpnotpomolrioete U0 0BSveC.
MePIOTPEYTE TO TIPOIOV OTIWC PAEMETE OTNV EIKOVAL.

MeprotpéYPte mpog ta mavw
XpnotpomotioTe Tov §€10 avTixelpd 0ag yia va oTIPWEETE EAAQPWE TTPOG TA EMAVW
TO KATW PEPOC TNG KUPLag 0B6vNnc.

Kupia 08évn

0,

AeUTepn 006vN

E « Mnv aokeite umepBoAikr Suvapn, Kabwg n kupla 086vn avoiyel
nuautopaTa.

+ Tpocé€te va unv KAEICETE TOV QVTiXEIPd GOG OTAV OTIPWYVETE TIPOG TA KATW
v KUpla 08ovn.
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Apyx1kr} 006vn Aertoupyiag mepIGTPOPIG

H apyikr) 086vn T¢ Aettoupyiag meploTpoPrg givat n TPWTN apxikr 086vn mou
epavifeTal apou MEPIOTPEPETE TO TIPOIOV. L€ QUTHV TN AelToupyia, umopeite
Va XPNOIUOTIONOETE TNV KUpLa 006vN Kat Tn Seitepn 006vn Eexwptotd 1y padi,
a&lomolwvTag Tig 006veC Ue Sidpopoug TPAToUC.

Kupia 086vn
Aeitoupyiag
TIEPIOTPOPAG

AeuTepn 086vN
Aeitoupyiag
TTEPIOTPOPNG

Kupia 086vn

H apyikr) 086vn T kuplag 086vng eppaviletal dmwg PAEMETE 0TV EIKOVA.

Ewkovidla epappoywv
EmAé€Te Kat EEKIVAOTE Jia EQAppOYH OUPOVTAC TO EIKOVIOIO TNG OPIOTEPA KAt

Se€1a. Kamoteg epappoyég oty KUpla 086vn umopolv va xpnaotpomoinbolv otnv

KUpLa Kat 0Tn Seutepn 0Bovn,.
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Alapdpewon apxikng 00ovng
MoTAOTE MAPATETANEVA OE KEVO XWPO 0TNV KUPLa 006vn Kat SIapop@WoTE TNV
apxkr 086vn omwg embupeite.

Aiaypaen
£IKOVIBiWV C
EQPAPHOYWV I I i
Aiaudpewan Kadog
POvTOU Kall QATTOPPIPHATWY
BepaTwv £QapHOYAg
Alapépewon
pubpioewv
AerToupyiag
TIEPIOTPOPHG

Xpnon eiovidiwv epappoywv

Mothote mapatetapéva éva ikovidlo epappoyns. Mmopeite va Slaypdapete
TNV EQapHOYR amoé Ty apxIki 086vn 1 va XpnotpomolioeTe dueca SIaQopEC
SuvatdTNTES TG EPAPHOYAG.
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Ag0tepn 006vn
H apyikr) 086vn g Seltepng 086vNng eppaviletal dmwg PAEMETE 0TV EIKOVA.
Xpnotporoleite Tn deUtepn 086vn pe Sidpopoug TpdmouC.

Eikovidia vpr’]vopng — =
TpooRacng ————«— [pappn mhorynong

priyopn pUOuIon deutepng 0B6vng
Mriopeite va oUpeTe To EMdvw PEPOG TNG SEUTEPNG 006VNG TTPOG TA KATW Yia vVa
avoiete To MapPAbupo ypriyopwv pubpicewv.

+ Mnopeite va natioete 1o /9 yia va mpoobéoete 1 va Slaypdpete éva eikovibio
070 TaPABbuPo YPryopwv PUBHIcEWV 1 va aMEEEeTe Tn Béon Tou.

- Matiote mapatetapéva éva eikovidlo ato mapabupo ypriyopwv pubuicewv kat
Ba epgaviotei n 086vn Siapdpewong.
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Emegdvela apri¢ LG

Xprion emeaveiag —
agrig LG

XpAon pe TrovTiki

ey Xprion
ETMQAVEIAg
agng LG

Ao evepyomoloete TNV em@dvela apric LG otn Sevtepn 066vn, otnv Kupla
006vn epgaviletat éva mMKTPo ToVTIKIOL 6mw¢ o€ éva PC, To omoio umopeite
VO LETOKIVELTE Kal va EMAEYETE elKovibla.

E181kég Aertoupyieg 20



Xprion kK\ewdwpatog Aapng
+ Mmopeite va natioete to G via va evepyomolroete 1o Kheidwpa Aapric.

of — ATTEVEPYOTTOINON
kAeIdwpaTog Aaprg

+ H deltepn 086vn Khedwvel av €xete evepyomolroel To Kheidwua Aapng.
+ Mmopeite va v Eexheldwoete amevepyomolwvtag to KAeidwua Aafng.
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MoAvepyaaia oTn Aeitoupyia MEPIGTPOPNG

H xprion moA\uepyaaciag pe Tnv MEPIOTPOPH TOU IPOIGVTOG OAG EMTPEMEL va
XPNOOTOLEITE pial Eappoyn Kat oTi¢ SU0 006veC 1 SU0 EQapUOYE, pia Ot KA
066vn, Tautdxpova.

E + Auti n Aertoupyia evOéxeTal va unv umootnpileTal o€ OPIoUEVES EQAPHOYEG.

Mey£0uvon Bivteo

1 Natrote @8 oy KOpia 066w,

7 Em\é€te éva Bivieo mou Bélete va avamapaydei kat matfote Avamapaywyr
Bivteo.

3 Matfote (| otn Sevtepn 066vN.
+ X1 Seltepn 086vn Ba eppavioTei n 006vn XelpIopou Bivteo.

‘EAEYXOG TOU — )
Bivreo otn
deuTePN 086VN
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Eméktaon tng epappoyng YouTube

T Notiote 3 oty kOpa 066V,

7 Emé€re o mepiexdpevo amé to YouTube mou BéAete va avamapdyete Kat
avamopAyeTeE To.

3 Matfote (| otn Sevtepn 06OvN.
21N 6eutepn 006vn Ba eppavioTei n 006vn ENeyKTAG péowv.

— ATmevepyoTroinan Tou
EAeykTth péowv on
OdeuTepn 086vNn

E181kég Aertoupyieg
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Xprion moANamAwv Qappoywv

Ao eMEEETE EQAPUOYEG UE TO YPAPIKO OTOolKEl0 MOANAAEG EQappOYEG OTN
SelTepn 0006V, UMOPEITE Va XPNOILOTOIETE TIG EMAEYUEVES SUO EQAPLIOYES
TAUTOXPOVA KABE POPA TIOL TTATATE TO YPAPIKO OTOIKED. OPIOHAG TWV EYAPHOYWY
TIOU XpNGlUoTOLE(TE OUXVOTEPA WG MOANATAEG EQAPHOYEG.

T Notote mapatetapéva oe évav Kevo xwpo otn Seltepn 006vn.

T Oplopég MoAAaTTAWY
E£QAPHOYWV

&

2 Natrote PuBpiogig moAanm@v epappoywv (g,
3 Kuhjote pog Ta Katw TN NioTa epappoy@v Kai emAEETe 500 EQOPUOYEC yia va
TIC XPNOIHOTOINOETE WG MOMNATAEG EQAPHOYEC.

N
- e
s -
MpoBoAf D o EmiAoynA dUo
TIPOETTIOKOTINGNG ‘ (-] EQAPHOYWV
MoAAatAwv
EQAPUOYWV m L’..,
@ 1
A\ 2/
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/' Natote E@appoyn.
5 Zmv apyikr 086vn g Seutepng 086vng Oa Snpioupynei To gikovidio
MoMNan\EC eQapHOYEC.

Xprian Tou eiKovidiou —
MoAAaTTAEG EQapUOYEG

E « Tla va Slaypagete To €ikovidio MoMATAEG EQapUOYEC, TATHOTE
TIOPATETAUEVA TO ElKOViSIo ot SeUTepn 086vN, matrote Katdpynon amd
TV apxikn 086vn kat énetta matriote Katdpynon.

E181kég Aertoupyieg
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XapaktnPIoTIKA KApEPaAG

Xpnon NG KApEPag ot AetToupyia mePIOTPOPAE
Mriopeite va XpnolOTOINOETE Ta EISIKA XAPAKTNPIOTIKA £yypa®rig Bivteo mou
TIOPEXOVTAL OTAV TO TIPOIOV BPICKETAL OE AEITOUPYIQ TTEPIOTPOPNG.

Nertoupyia otabepomointi
Mmopeite va XpNnOILOTIOICETE TV KAUEPA OOV VA TNV EXETE €lOAYEL OE
Bdon otabepomoinonc. Mpayuatomoiote eyypaen Bivieo otn Aettoupyia
otaBepomoInTh yia va EAaxIOTOMOINCETE T S6vnon.
T AMGEre T0 poidy 0T Aertoupyia TEPIOTPOPRC.
+ Mnopeite emiong va EeKIVOETE TNV KAUEPA TNG AEITOUPYIOC TTEPIOTPOPNS
TIEQIOTPEPOVTAG TO TIPOIOV OTNV EQYAPHOYN KAPEPAC.
2 Natrote (&) oty kupla 0Bovn.
3 Emé€te Aertoupyia oTaBepomoinTh) amd TIC AelToupyieg KApEePac.

/ Natfote @ Y10 va TepUaTIoETE TV £yypagr 0N Aettoupyia otabeporomn.

PuBpioeig Avahuon
AeiToupyia HETATOTTIONG — T Pubuioeig pAag
Kal TTapakoAolénang o
Aeno;.v\pvicx FPV — AZ:ZE‘;’;Z
£ITOUpYia — — )
TrapakoAoUdnaong KAEIBWHATOG
HynTikG e@é — T XepIoTApIo
KatdAoyog Asitoupyiv |
QpwToypagiag
Tpappn mhoriynang —

+ TNava tpaPrgete pia pwtoypagia katd Ty eyypaen Bivieo, matiote 10
xoupi @.

« T val SIaKOPETE TIPOoWPIVA THY yypagr Bivteo, matriote To koupmi @.
Mot va ouvexioeTe TV eyypaen Bivieo, matrote To koupri @.

5 Natote 1o koupni @) yia va teppatioete v nyoypdenon.

E181kég Aertoupyieg
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Aerroupyia FPV

O1 mePIOTPOPEG 1y OL KIVOEIG 0aG AMOTUTIWVOVTA HE

(mpoBolr oe mpwto QUOIKS TPOTIO, WOTE Va UMTOPE(TE VOl KAVETE EyypaPn
Tpoowno) Bivteo pe pubuo kat Suvapiky.
O1meploTPOPEC MAVW/KATW Kat Se§looTpoPa/
Aerroupyia aploTePOOTPOPa oTaBEPOTOIOUVTAL KAl N Ywvia KIVeiTal
HETATOMONG KAt aplotepd/Se€id. AmoSoTIKNA AelToupyia yia Ty Kataypapn
napakohovBnang QWTOYPAPIWV i BivTeD OTaV avePaiveTe OKANA 1 KIVEIOTE
péoa o€ €va autokivnTo, Slatnpwvtag TV optlovtia Béon.
O1meplotpopég 6e§100TPOPa/apIoTEPOTTPOPA
otabeporololvTal Kal N ywvia KIveital mavw/Katw Kat
Aertoupyia aplotepd/Sedia.
napakohovBnong AmoSoTIKA AeIToupyia yia TNV Kataypagr Quwtoypaplwv
1 Bivteo TNG OUVONKAG EPPAVIONG EVOG EYGAOU
QVTIKEIUEVOU, OTIWG HIAG GUVAUNIAG 1} EVOE KTIpiou.
Mmopeite va UETAKIVOETE TO XEIPIOTHPIO TIPOG OTTOLA
, KaTeuBuvon BENETE, WOTE VOl PETAKIVEITE TN ywvia Tavw/
Xeplotiplo i ; ; ., .
KATW Kall aploTePA/SeIa Xwpig va TIEPIOTPEPETE TNV
KAUEPQ, EAAXIOTOTIOIWVTAC TO PAOUTAPIOHAL.
Nerroupyia TMoTAOTE MOPATETAPEVA VIO VO KAEIOWOETE TN Ywvia
k\eldwpatog n e Hevay nyevid.
+ Baotko: Mmopeite va mpayuatomnolroeTe eyypagn Pivieo
He OTAOEPO OTEPEOPWVIKO NYXNTIKO EPE.
+ ASMR gyypa@ni: Xpnolpomolrote autryv T Aertoupyia
yla va eVIoXUOETE ToV fj}0 Tou BéuaTtog atnv 086vn, woTe
HynTIk £9¢ va TipayUatomoloeTe eyypaen Biveo pe kabapoug,

SlakptToug fXOUG.

« Bokeh @uwvrc: Xpnotpomotrjote autrv tn Aeitoupyia yia
VO TIPAYHOTOTOIOETE EYypaQr| BIVTEO LEWVOVTAC TOUG
1X0UG Tou TEPIBANOVTOG Kal TovifovTag T Guwvr Tou
B¢uatoc.

E181kég Aertoupyieg
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Eyypaen apync kivnong

AnpoupynoTe éva S1aokedaoTIkO Bivieo EAéyxovTag TNV TaxUTNTA MIAG Kivnong.
Mmopeite va EQapuOCETE Eva EQE KIvnONG TTO apYRG amod TO KAVOVIKO.

T ANGETe To Mpoidv 0T Aertoupyia MEPIOTPOPAC.

7 Matiote G oTnV KOpLa 006vn.

3 Em\é€te Apyn Kivnon amd Tig Aerroupyieg KApEePaC.

4 Natiote © 1/ QO yia va emMECeTe SIAPKeLa Yia TO EQE apyrg Kivnong.

OpIOPOG ETTIAOYWY —
Kapepag

T— Oplopdg emAoywv
PAag
EmAoyn didpkelag —

AN ——

+ TuARpa apyn Kivnon: Zag emTpEnel va epapUdoETe Eva e@é apyng Kivnong oe
£€V0l GUYKEKPIUEVO TURAUA To BivTeo.
- Mothote © OTav BENeTE va EQAPUOOTEL TO £QE apynG Kivnong. Me éva
OUVTOMO TIATNA, TO EQE apyNE Kivnong epappoletat yia 0,5 SeutepoAemTa.
Me éva mapatetapévo mdtnpa, To € apyn¢ Kivnong epapuoleTat péxpt va
a@noete 1o SAXTUAG oac,
- 'O\eg o1 Apyn Kivnon: Zag MTpEMEel va EQAPUOCETE Eva EQE APYNE Kivnong oe
0AOKANpO 1O Bivteo.
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Eyypaen xpoviopou
Mmopeite va mpaypaToToIoETE yypa@n BiVTEO XpOVIOHOU TTou
BeAtioTomolovvTal avdhoya e TV KATAoTaon.

Ta Bivieo pmopouv va eyypapouy Ue BEATIOTN TaxuTnTa Kat aTabepr Kivnon
avahvovtag Siagopa mepiBaAovta Aqyng. H Taxutnta Xpoviopol Pmopei va
pubpiCetar autépata avaloya He Tov 0TdXo Kat To TEPIBANOV AYng.
Eivau emiong Suvatr n xelpokivntn emAoyn Tng TaxUTNTag XPOovIGHoU.
T ANGETe To poidy 0T Aettoupyia MEPIOTPOPNAC.
2 TNatrote (&) oty kOpia 086vn.
3 EmAé€te XpovIoHAC amd TIC AETOUPYIEC KAUEPQC.
+ X1 Seltepn 0B0vn, emAEETE T peyEBuvon 086vng Tng oknvrig mou Ba
KaTaypagei.

m— EmiAoyn peyéBuvang
086vng

—— EmAoyn Taxutntag
Xpoviopou

+ X1 Seltepn 0806V, EMAEETE TV TAXUTNTA XPOVIGHOU.

E « Edv em)\é€ete Autoparo, Ba pubuioTei autdpata n TaxuTnTa mou &ivat
KOTAMnAN yia tnv 086vn oty omoia Ba yivel yypagn.

E181kég Aertoupyieg
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A Natote @ yia va eyypayete éva Biveo.

+ Mmopeite va aMd&eTe Ty pey£Buvon Kat Ty TaxiTnTa Xpoviopou Katd thv
£yypagn.

+ AV TIATACETE TNV EMBUUNTY TaUTNTA, N TAXUTNTA XPOVIGHOU
TIPOCAPUOLETAL KATA TV EYYPAPH.

- Tiava Slakéyete mpoowpvd Ty eyypagr Bivieo, matriote 1o koupri @).
MNa va ouveyioete T eyypagn Bivteo, matiote 1o koupri @.

+ Katd tnv eyypagr evog Bivteo, UMopEiTe va TEVIWOETE 1) va TACETE SUO
Saytula yia peyéBuvon 1 opikpuvon.

Katd v eyypaen Bivteo, umopeite va ayyi€ete Tnv emBuuntr meploxr yia
va puBpicete T wtevOTNTA.
5 Nartrote 1o koupni @ yia va TeppatioeTe Ty eyypagn.

+ To katayeypappévo Bivteo Ba amoBnkeutei 0To AAUTOULL.

E + Aev eyypAgeTal YOG KATA TNV £yypaer e Xpoviouo.

+ Mnopeite va matroete (€ yia va mpaypatonoiioeTe eyypagn Bivieo atn
Aettoupyia NUXTEPIVOC XPOVIOUOG.
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Mpayuaromoinon StmARG eyypaen¢ Bivteo
Mmopeite va xpnoIOTIOIOETE TAUTAXPOVA TNV EUTTPOG KAl TNV TTIOW KAUEPQ Yiat
va paypatonoioeTe eyypagn Bivieo. Mmopeite va anmobnkeuoete Ta Bivieo amd
KABe KapePa w¢ éva 1 we dUo EexwPLoTd apyeia.
T ANGETe To poidy 0T Aettoupyia EPIOTPOPNAC.
2 Matiote () oy Kpia 086vN.
3 EmAé€te AmhR eyypa@n amo TIC AETOUPYIEC KANEPQC.
+ H eumpog pop-up Kapepa avadueTal autopara.
A TNatote @ yia kataypagn Biveo SImAAC eyypagrc.

Eptrpdg 086vn eyypagrig Miow 086vn eyypaeng
Alaxwpiopévn %E e — PIP
-

« Mnopeite va maTHOETE MOPATETAUEVA TNV KUPLA 086VN KAl VA GUPETE yia va
aMGEeTe T Béon Twv 0BovwV TNG EUMPAC Kat TNE oW KAUEPA.

+ Mo va SlakOYEeTe MPoowpIva Ty eyypagn Bivieo, matrote To koupri @.
MNa va ouveyioete T eyypaer Bivteo, matiote To kouuri @.

5 Natote @ yia va teppatioete Ty eyypagn.

E « Eav emé€ete EexwploTr) amoBrikeuon, Ta BiVTED TNG EUITPOG KAl TNG oW
Kauepag amobnkevovTal wg EExwPIoTd apyeia.
« Eav em)\é€ete va amoBnkevoete akpIBWE auto mou PAEMETE, Ta Bivieo TG
EUMPOG Kall TNG TTiow KAUEPAG amoBnkevovTal wg pia 08ovn.

Edv evepyomolroete tn Aeitoupyia SIMAAG eyypagnc, avadvetat n
EVOWHOTWHEVN EUMPOG pop-up KApEPa. H kauepa pmopei va xaAdoel av Thv
TpaPn&ete ) v méoete pe umepBoAIKn Suvaun.

A
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An{n PIP (eikdva péoa o€ elkéva)
Eav matfjoete 1o (g) otV 086vn eNéyxou Tng Seutepng 086vng, n 08évn
eyypagrc aAalet yia va kataypdpel pia eikdva péoa oe ikova (PIP).

- EQv motjoete 1o (2), pmopeite va alGEeTe Tig B€aeig 0Bovwy TG eUmpog Kat
g miow Kauepag.

- Mmopeite, av BéAete, va matrioete mapatetapéva Ty 086vn PIP kaiva
OUPETE O€ pia amo TIG TECOEPELG YWVIEG.

— Adyn PIP

Edikég Aertoupyieg
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Aerroupyieg eyypagng nxov

Eyypaen Bivteo pe e€€10IKEVMEVEC EMAOYEC EYYPAPNC

nxov

Mriopeite va KataypAyeTe éva BivTeo XpNOILOTOIWVTOG TPEIG SIOPOPETIKEG

EMAOYEC EYYPAPNG GWVAG AVANOYQ LE TIC ATTAITATELS OAG.

1 NatAote (5) kat emé€te Bivreo o0povTag TIC AerToupyieg Tng Kapepac,

2 Natote @ kat em\é€te Baoikd, ASMR eyypagn 1 Bokeh @wvrig alaloviag
EMAOYEC 11XOU.

Baoiko
Mriopeite va kataypayete éva Bivieo pe oTaBepd OTEPEOPWVIKO HXO.

ASMR eyypapn

Me 800 guaiobnTa LIKPOPWVA 0T GUCKEUN, UOPEITE va KataypdyeTe éva Bivieo
ASMR.
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Bokeh @wvng
Mriopeite va TovioeTe Tn Qv evdg Bépatog pelwvovtag to 86pufo Tou
niepIBANovVTOC,
- Ta va peioete 1o 06pufo Tou TEPIBANOVTOC, LETAPEPETE TO PUBLIOTIKS OTN
B¢on ).

Eyypaen nxwv ASMR
AuTr n AeIToupyia oag EMTPEMEL VO EYYPAPETE X0 KaBapd Kal Le akpiPela,
€VIOXUOVTOG TOV X0 amd Ta MIKPOPWVa.
T Noatote LG> Eyypaer fixou HD kat matiote = > ASMR.
7 TNatrote @ yia va eyypdyete Tov Hyo.
- Tava Slakéyete mpoowpvd Ty eyypagn, matrote 1o kouprni @. Mava
OUVEYIOETE TNV EYYPAPH, TIOTAHOTE TO KOUMTT .
3 Natote 1o koupri @ yia va TepuatioeTe T eyypagn fxou.

Tpiobiaotarog "Hyo¢ Mnxavn LG
H Aertoupyia Tpiodidotatog "Hyog Mnyavi LG oag emtpémnel va akoUuTte
0TEPEOOKOTIKS Kal BeATioTomoInpévo 0. Katd tnv avamapaywyr HOUGIKAG i
Bivteo, umopeite va amoAaUoETe OTEPEOCKOMIKOG Kal KABNAWTIKS X0 oav va Tov
COKOUTE OTOV XWPO.
1 Z0pete Tov mivaka e180MOIROEWY TPOC T KATW.
7 Matiote @ Y10 va EVEPYOTIOINOETE 1} VOl OTIEVEPYOTTIOIOETE TO XAPAKTNPIOTIKO
Tpiodiaotarog "Hyog Mnxavn LG.
'H matriote PuBpioeig > ‘Hyog > Motdtnta fixou Kat £pé > Tpiodidotartog
"Hxo¢ Mnxavi LG kai matriote Y10l VO TNV EVEQYOTIOINOETE.

E « Edv ouvdéoete e§wTEPIKT) GUOKEUN X0V OTIWE AKOUOTIKA 1} NEia oTn
OUOKeUN, eppaviCeTal éva avaduouevo mapdBupo yia Ty evepyomoinon TG
Aertoupyiag Tprodiaotarog "Hyog Mnxavij LG.
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Google Assistant

Google Assistant Emokomnnon

H ouokeun oag €xel evowpatwpévn ™ Suvatotnta Google Assistant. Bpeite
QMAVTACELC KAl KAVTE TIC SOUAEIEC 0O EKTOC OTITIOU ) YPOPEIOU.

5 « [0 va XpnoILOTOICETE AUTHV TV SuVATATNTA, TPEMEL TTPWTA VA GUVOEDEITE

o070 biktuo.

Exkivnon tou Google Assistant.
1 ZOpete Saywvia amd Ty KATw ywvia e 080vne.
2 Ayyi€te 1o ZEKINHETE.
3 AkohouBroTe Tig 0dnyieg mou epgaviloval atnv 086vn.
+ H ouokeur amoBnkevel Ta wvnTika oag dedopéva yla avayvaplion.

A EmMé€te av Ba XpNOIUOTIOIROETE T SUVATETNTA PWVNTIKAG AVAYVOPLONG

+ ‘Otav éyel evepyomoinBei auTr| n AEIToUpPYia, UMOPEITE VOl EKTENECETE TO
Google Assistant Aéyovtag “OK Google” otnv apyir) 086vn.

5 Matiote Téhoc,

I'IpooBaor] ME Qwvi
‘Otav n apykr 086vn gival amevepyoroinpévn 1 KAebwpévn, meite “OK
Google” 1} “Hey Google.".

7 Otav epgaviotei n 086vn tou Google Assistant, Tigite uia eVTONr 1} KAVTE pia

£pWTNON.

E181kég Aertoupyieg
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NpdaBacn amo tnv apxikn 086vn
1 ZUpete Saywvia amd v kATw ywvia e 086vne.
7 Meite pia evioAr f pWTNON 6TAV SEITE TO * * - * 0TO KATW UEPOG TNG 000VNG.

E « Xe évamepiBaihov dmou n ovveon Tou acupuatou Siktvou Wi-Fi rj Tou
SikTUoU KIvnTAG TNAEQVIaE gival xapnAiig molotnTag, n Aettoupyia Google
Assistant evexopévwg va meplopiletal kat 0 puOHOE TIOTHAG avayvwplong
opNiag va givat xapnAdTePoG.

«+ EdQv n opiNia gival aoa@ng, To MIKPO@wVo KAAUTITETAL, AEITOUPYED il
GUOKEUN avamapaywyng Héowv rj o mepiBaMwy fxog eivat Suvatdg, o
PUBHAC MOTHG avayvwplong optiag propei va givat xapunAotepog. Otav
XPNOHOTIOLEITE TO TIPOIOV E PWVNTIKEG EVTONEC, MIANOTE pE KA} Ipo@opd
o€ riouyo mePIBANOV yia peyahuTePN akpiBela avayvwplong opNiag.
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Baoikég
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E€aptiparta kat a§eocovdp Tou mpoiovtog

Ta mapakdtw otolyeia mepNapBdvovTal 0Tn GUOKEUH GO,

+ ZUoKeun + QopTioTAG
- Kalwdio USB + O8nydc ypriyopng ekkivnong
+ Kapeitoa e€aywyng + Onfkn TAepwvou

A .

Ta oTolygio Tou TePIypAPoOVTal O TAVW MITOPEL VAl Eival TIPOAIPETIKG.

Ta oTolyEl0 TTOU TIAPEXOVTAL ME T OUOKEUH Kat Tuxov Slabéaipa agecoudp
umopei va SlapéPouy, avaloya UE TV TTEPLOXT KA TOV TIAPOXO UTTNPECIWV.
Na xpnotporoleite mavtote yviola ageooudp LG Electronics. H xprion
a&eooudp ANWVY KATAOKEUAOTWY EVOEXETAI VOl ETTNPEACEL TNV amoS00n
TwV KAOEWV 0TN OUOKEUN 00 1} va TIPOKAAETEL TIPOPAfaTA KATA TN
Aertoupyia. H emokeur) evog Tétolou mpoBAHaTOg EVOEXETAL VA PV
KAAUTITETAL QMO TNV UTINPEDIA EMOKEVWY TG LG.

+ MepIKd amo Tal PEPN TNG CUOKEUNG £XOUV KATAOKEUAOTE( OO EVIOUUEVO

YUoi. EGv n cuokeur| oag méoel mavw G€ pia okANpr emM@Avela i
TIPOOKPOUGEL KATTOU e SUvapn, umopei va mpokAnBei {nwud oto
OKANPUHEVO YUONL. Z€ QUTHV TV TTEPITTTWOT, SIAKOYTE AUECWGE TN XProN TNG
OUOKEUNG KAl EMKOWVWVAOTE e éva Kévtpo e§umnpétnong mehatwv tne LG.

« Edv Aeimel omolodrmote amd autd Ta BaCIKA OTOIXEID, ETMKOIVWVIOTE UE TOV

aVTITPOOWTIO Amd TOV OTI0I0 AYOPACATE TN CUCKEUH.

« Tava ayopdoete mpooBeta oToIKElD, EMKOIVWVAOTE pE éva KEvipo

e§unnpétnong mehatwv Tne LG.

+ Oplopéva atolxeia mou mepIAapBavovTal TN GUOKEUAGIO TOU TIPOIOVTOG

evoExeTal va aMd&ouv xwpig mpogidomoinon.

H gpgpavion Kat ol mpodiaypagEg TG CUOKEUNG 0ag evoéxetat va aldgouv
Xwpic mpogidomoinon pe oToxo TN BEATILGCN TOU TTPOIOVTOC.
O1mpodiaypa@ég TG GUCKEUNG EVOEXETaL va Sla@épouy, avdhoya pe TV,
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.

AQQIPEDTE TNV IPOCTATEUTIKK LEUBPAVN amd Tov aiobntripa AaKTUA.
ATIOTUTIWHATA TIPOTOU XPNCIHOTOICETE TN AEITOUpYia avayvwpiong
AakTtul. AoTuniwpaTa.
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Emokoénnon otoygiwv

Pop up Camera

AioBnTipag — —T — AkouoTikd
£YYUTNTAG/QWTIOHOU
TepIBaAAovTog

]» MAAKTPa évtaong rfxou (+/-)

e— loxUG/MAAKTPO KAEIGWHATOG

o——————— 0606vn agrig

—— A1I06nTAPag SaKTUAIKWY
ATTOTUTTIWHATWY

®

Bupa popTioT/kaAwdiou
UsB

Mikpédpwvo ———

Dakoi Tiow Kapepag — ‘ @

0
drag — +— OrKn KapTag
T mmm e 3 Nano-SIM/uvrung
: +—— NFC
b { ,,,,,,,,, ;
— Mepioxn kepaiag
acUppaTng eopTiong

[ S  E——— —
Hxeio | —— Mikpdpwvo
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A MHN emiyelprioeTe va a@alpEGETE POVOL 0AG TO TTOW KAAUHAL.

e Sl0pOoPETIK TIEPITTWON, EVOEXETAL va UTTOCTEL GoBapr| {NId n umatapia
Kal | CUGKEUT TIoU MMTOpE( val 08Ny o€l o€ umepBEppavan, TupKayld
Kal Tpaupatiopd. To Tiow KAAUPA Kal N Hratapia auTrig TnG OUOKEUNG
Sev mpémel va agatpouvTal fj va avtikabiotavtal and pn KatapTIopévo
emayyehuaria.

+ To Aé@uwvo oag ival pia NAEKTPOVIKY) GUCKELN TTou TTapayel BeppdtnTa
Katd tn SIGPKELD TNG KAVOVIKAG Aettoupyiag tng. H dpeon emagr pe 1o
S€ppa yla eEAIPETIKA PEYANa XPOVIKE SlaoTrhpaTa, ENEIPEL EMAPKOUG
€€aepIopoU, umopei va odnyroel o Sucopia fj ykavpaTa mPWTou
Babpov. Zuvenwg, va xelpileoTe To TNAEQWVO HE MPOTOXT) TOGO KATA TN
XPON TWV AEITOUPYILV TOU GO0 Kal AUECWG HETA.

MAnkTtpa évtaong rixou

Mriopeite va TPOOAPUOCETE TNV €vTaon Twv AXwY KAONG, Twv KARCEWY A

TwV €I60TOINCEWV.

- Evw xpnolpormoleite Tnv kAuePa, matoTe amaAd KAmolo amd ta MARKTPa

€vTaong Nxou yla va Tpapngete pia pwtoypagia. Ma ouveyeic Muelc, ayyi€te

Kall KOATAOTE TO MARKTPO €VTaong fixou.

Mo va eKKIVAOETE TN e@appoyn Kdpepa dtav n 086vn eivat kKAeldwpévn i

QTTEVEPYOTIOINEVN, TIATAOTE TO MAMKTPO HEiwong TG évtaong fxou Suo

@opéc. Na va ekKIvAoETe TV epappoyr Capture+, TATAOTE T0 TARKTPO

avénong e évtaong fxou 6Uo PopéEc.

+ lox0¢/MARKTPO KAEBWHATOG

- Matiote ouvtopa 1o MAKTPO GTav BENETE Va EVEPYOTIOINOETE 1 va
QMEVEPYOTIOINOETE TNV 0006V,

- TatoTe To MARKTPO TAPATETAMEVA OTAV BENETE Va EVEPYOTIOICETE A
emMoyn eNéyxou Aettoupyiag.

AoBNTHPAG SAKTUNKWV AMOTUNWUATWY

- Mnopeite va xpnolpomoloete Tov aloBntrpa Aaktul. Amotunwpata
KATW Kall 0TO KEVTPO TNG 080VNG Yia va EVEPYOTTOICETE T A&lToupyia
avayvwplong AakTtul. Amotuniwpata. Mo AemTopépeleg, avaTpéTe oTnv
evotnta Avayvwpion Aaktud. Amotunwuata - [lapouvoiaon .
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5

Baoikég Aertoupyieg

« Oplopéveg Aettoupyieg pmopei va meplopifovTal, avaloya LE TV TEPLoX Kal
TIG TPOBIAYPAPEC TOU TIPOIOVTOG MO SIAPOPETIKOUG TTAPOXOUG UTINPECIWV
TNAEMKOIVWVIWV.

+ XT0 TMiow P€POG TOU TPOI6VTOC evowuatwvovtal éva toirm NFC Kat kepaieg
acUppaTNG POPTIONG. XEIPI(ETTE TPOTEKTIKA TO TIPOIOV WOTE Va NV
KataoTpEPeTe 1 kahumtete To Toum NFC Kal TIG KEPAiEC acUppaTNG POPTIONG.

+ Mnv TomoBeteite Bapld avTIKeipEVa TAVW 0T CUOKEUN 1} PNV KABeoTe Mavw

0€ QuTHV. X avtibetn mepimwon, umopei va mpokAnBei BAGRN otnv 08évn

agic.

H xprion mpootateuTikig MepBpavng 08ovng fy ageooudp evdéxetal va

TipokaAéoouv mapepBoAEG aTov alebnTripa eyyuTnTag.

Eav xpnolpomoleite aecoudp WG MPOOTATEUTIKEG MEUBPAVES, KAAUUMATA

Kat Brike¢ mou Sev eivat yvota mpoidvta g LG Electronics, Oa mpémet va

TIPOCEXETE KABWG TA MAKTPA, Ol AIOBNTAPES KAl Ol YAKO{ TOU TTPOIOVTOG

€VOEXETAI VOl LN AEITOUPYOUV OWOTA. Z€ EKEVN TNV TTEPITTWOT, SEV UMOPEITE

Vv XPNOILOTIOINOETE TV UTINPETia £yyUnong e LG Electronics katn

LG Electronics 6ev mapéxel eyyunon yia {npiég omwe SucAeitoupyia Tou

TIPOIOVTOG.

« Edv n ouokeun oag ivat uypr| 1} XpnOIHOTIOIEITAL O UEPOG UE LYPATIa, N
006vn 1} Ta Koupmd agrg evoéxetal va unv Aelroupyolv owoTd.
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3T0 TPOIOV EVOWHATWVOVTAL SUO UIKPOPWVA. MPOCEKETE WOTE VA NV KAAUTITETE
Ta HIKpOYwva. Evw pihdte 0To TNAEQWVO, PNV KAAUTITETE TO HIKPOGWVO LE TNV
moAdun fy Ta SAXTUAG oag,

Mnv xpnotpomoteite Orkn TNAEPwvoU Tou Sev gival Yoo TTPOIOV Kal pnv
KOAOTITETE TO UIKPOPWVO HE aeooudp, Tawvia, K.A.

Kpatdte 1o mpoidv owoTd 4Tav To XPNOIUOTIOIETE, OTIWG UTOSEIKVUETAL OTNY
€lkova.

Mikpdpwvo Mnv KaAUTITETE TO HIKPOPWVO.

0o

S~ P~

Mikpdgpwvo Mnv KaAUTITETE TO PIKPOPWVO.
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Evepyomnoinon 1) anevepyonoinon

Evepyonoinon
‘OTav n OUCKEUN Eival ATIEVEPYOTTOLNEVN, TIATAOTE TTAPATETAUEV TO TTARKTPO
evepyomoinon/KAEIOWHATOG.

5 + 'Otav n oUOKEUR evepyomolLEiTal YIa TTPWTN POoPA, TTPAYUATOTOLETAL N

apxikn Slapopewon. H mpwtn ekkivnon tou smartphone evééxetal va
Sl0PKETEL TTEPIOOOTEPN WPA ATTO O,TL CUVIHBWG.

Amnevepyomoinon
MotAoTe mapaTeTapéva To MARKTPO AEIToupyiag/KAEISWHATOC Kat EMAEETE
Anevepyonoinon.

Emavekkivnon tng 6UoKeURG
‘Otav n cuokeur 6ev AeITOUPYE OWOTA ) GV AVTATIOKPIVETAL, EMAVEKKIVAOTE TV
aKoAoUBWVTAC TIG TAPAKATW 08nyieC.

1

MoTAoTE Kat KPATHOTE TATNUEVO TO TTARKTPO EVEPYOTTOINONG/KAEIOWHATOG
KOl TO MARKTPO HEIONG TNG £VTOONG X0V TAUTOXPOVA LEXPL N GUCKEUN Val
amevepyomolnOei.

7 ‘Otav n ouokeun emavekkivnBei, aprioTe Ta MAAKTPA.

EmMoyéc eAéyxou Aettoupyiag
MatAoTe MapaTETAUEVA TO TARKTPO AeIToupyiag/KAESWUATOC Kal eMAEETE, 0N
GUVEXELQ, EVEPYOTIOINOTE LI ETMAOYH.

- Amevepyomoinon: ATievepYOTTOLEl T CUOKEUN.

+ Amevepyomoinon Kat EMaveKKivnon: EMaVeKKIVEL T OUOKEUH.
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TonoBétnon tn¢ kaptag SIM
TomoBetriote tnv kdpta SIM (Subscriber Identity Module) mou oag éxet

TIPOUNOEVGEL 0 TAPOXOC UTNPETIAV YIa VA EEKIVIOETE VA XPNOILOTOLEITE TN
OUOKEUN 00,

+ Na €i0Te TPOOEKTIKOI KATA TOV XEIPIOHO TNG KAPPITaaC §aywyng KaBuwg éxel
aunen akpn.

1 Tomobetiiote v akiba oTtnv omr ¢ BriKNg KAPTAG KAl TATAOTE Thv akida,
émerta paprte ™ Orkn kapTag PG Ta £€w.

7 EuBuypappiote Ti¢ kapteg Nano-SIM otn BrjKn KAPTag Kat TATAOTE TV KApTa
TIPOG TNV KaTeVBUVON TOU BENOUG OTIWG PAIVETAL OTNV EIKOVA.
Képta Nano-SIM 2

Kapta Nano-SIM 1

5 + HOnkn kdptag SIM 2 xpnotuevel miong wg Brikn T KAPTAG UVAKNG.
Q01600, SV UMOPEITE VA TOMOBETHOETE TAUTOXPOVA TNV KApTa SIM Kat T
KAPTA UVARNG (TPOIPETIKA).
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3 Ewodyete TN 61KN KAPTAC 0T0 TNAEPWVO OTIWE PaiVETaL TNV EIKGVA.

Baoikég Aertoupyieg
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E .

Autr n ouokeur umooTnpilel povo Kapteg Nano SIM.

Nano Micro Kavovikr

o @

« Ta amedoon Xwpig MPoBAATA, CUVICTATAL VA XPNOILOTIOLEITE TN

OUOKEUN e ToV owaoTo TUMO TG KdpTag SIM. Na xpnaotuomoleite mavta tnv
£PYOOTAOIOAKIG KATAOKEUNG KapTa SIM TTou mapéxeTat amd Tov mdpoyo.

+ Mnv xdoete v kapta SIM. H LG Sev pépel kapia euBovn yia PAABES kat

AaMa ripoBArjuata mou mpokaAouVTaL aré TV anwAELd 1 T petaBifaon tng
Kaptag SIM.

Katd tnv eloaywyn A tnv agaipeon tng kaptag SIM mpénel va iote
TIPOCEKTIKOI yla val Unv mpokAnBei {nuid.

'Otav eloaydyete v kdpta SIM A TNV KapTa PvApnG, TomoBETAOTE TNV
0woTd oTn Brikn kdpTac,

'Otav eloaydyete T OrKkn kdptag avd otn cuokeur, TomoBeTHoTE

v op1lévTia PG TV KateuBuvaon tou BéNoug, driwg amelkoviletal.
BeBaiwBeite oTi n kdpta mou €xel TomoOeTnBel 0T Brikn KapTag dev éxel
@UyeL am6 T Béon TG

+ TomoBetriote TV kApTa SIM PE TIG XPUOEC EMAPEC OTPAUHEVES TTPOG Tal

KATW.

+ BePaiwBeite 6Tt dtav Tonmobeteite TV kdpta SIM 0Tn GUOKELN, akoAouBeite

TIG 08nyieg 0To eyxEIPISIO XPrioNnG.

« ‘Otav TomoBeTeite 1 apalpeite T OrKn KAPTAG AMd TN GUCKEUT, TPEMEL Val

TIPOGEXETE VA PNV TIEPACEL VEPO 1} AN LYPA Péoa aTnv umodoyn KapTag.
Eav n Brikn Kaptag 1 n kapta mou Ba TomoBEeTHOETE 0T GUOKEUH €ivat uypr),
TOTE eVEXETAL VA TTPOKANBEL (LA 0T GUOKEUN GG,

+ HKapta pvApng gival TPOAIPETIKT.

H ouxvi eyypaen Kat dlaypa@ri Se5opévwv pmopei va UEoEL Tn SlapKELa
QWG TNG KAPTAG UVRAHNG.

OpIOPEVEG KAPTEG LVAKING MITOPET VAl LNV €ival TARPWE CUMBOTES ME TN
ouokeur. H xprion piag pn cupBatrg Kaptag umopei mpokahéoel BAARN g
GUOKEUNG i} TG KAPTAG pvApNG, 1 va KataoTpéPel Ta dedopéva mou gival
amoBnKeupéva o€ AUTHV.
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TonoBétnon tng Kaptag PvMNG
TomoBeTAOTE TNV KAPTA UVIUING 0T GUOKEUN 00C.

Avdoya e TOV KATAOKEVAOTH Kal TOV TUTTO TG KAPTAG UVANG, KATTIOLES KAPTES
MVIALING UITOPEL va PNV €ival CUMBATEG LE TN GUOKEUH 0.

T TomoBethote v Kap@itoa e§aywyrg oTn omr Tiou Bpioketal otny umodoxr
NG KAPTAG,

2 Tpapréte mpog ta £&w v umodoxn T¢ KApTac.

3 TomoBetAoTE TNV KAPTA UVAKNG 0TV UTIOS0X TNE KAPTAG KE TIC XPUTEC
EMAPES OTPAUUEVEG TIPOG TA KATW.

( )
Kapra pvipng .
(TTwAEITaI EEXWPIOTA, TIPOQIPETIKE)

Képta SIM

. .

A

A Emotpéyte Ty umodoxr TS KAPTag otnv apyIkr g Béon.

-

A + OpIOPEVEG KAPTEG MVAUNG MITOPEL va UNnV gival MAPwE CUUBATEG UE TN
ouokeun. H xprion piag pn oupBartric kaptag pmopei mpokaléoel BAGBN g
OUOKEUNG ) TG KAPTAG MVANG, 1 va KaTaoTpéel Ta Sedopéva mou givat
amoBnKeupéva o€ AUTHV.

E « Houyvi eyypaen Kat Slaypagri SeSopévwv pmopei va UEICEL TN SIApKELa
WG TNG KAPTAG UVAHNG.
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A@aipgon TG KAPTAG UVIUNG

la AOyouc ao@aleiag, amevepyomoloTe TV KAPTA UVAKING, TIPV TNV AQAIPEDETE.

T Zmv apxikr 066vn, matiote Pubpioeig > AoBNKeUTIKOG XWPOg >

7 TomoBetriote T kap@itoa e€aywync otnv omr mou Bpioketal oTnv umodoxn
NG KApTag Kat émetta TPAPAETE TN BrKN TG KAPTAC TTPOE Ta £§W.

3 AQaIpéoTe TV KAPTA PVAUNG amoé Tn Brkn KApTag.

/A Emotpéyte Ty umodoxn TG KAPTag otnv apyIkr g B£on.

A + Mnv agaipeite TV KAPTA PVARNG, EVW N CUOKEUN HETAPEPEL 1} XPNOIHOTIOLE!
Sedopéva. Mmopei va mpokAnBei amwAela iy KataoTtpogr dedopévawy, i
BAGPN TG KApTAG PVAHING 1 TG ouokeunc. H LG dev euBuvetar yia amwAeleg
TIOU €ival amOTENEGHA KAKNAG ) AKATAANANG XPONG TWV KAPTWV UVAKNG,
oupmeptAapBavopévng tng anwAelag SeSopEvwy.

Mnatapia

Odption TN prarapiag
TPtV XPNOILOTOIOETE TN GUOKEUN, POPTIOTE APWE TNV UraTtapia.
Oopriote T ouokeun e To Kahwdio USB tumou C.

Akpodéktng KaAwdiou PdpTiong
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A « Eav umdpyet uypacia otnv umodoxn POpTIoNG, o€ ANEG EKTEDEIIEVEG
UTOSOKEC, 0TO KAAWSIO POPTIONG, GTOV TTPOCAPHOYEA POPTIONG KATT,,
MNV XPNOLUOTIOLEITE I PopTI(ETE TO MPOIGV. To MPOIGV EVEKETAL Val
mapouatalel Suohermoupyia iy va éxel ahdoel 1) pOapei Kat umapxel Kivouvog
TpaupaTIopoL amd nAektpomAnéia, wtid, umepBéppavan, ékpnén, K.a. Eav
TIAPATNPHOETE LYPATIA O€ TETOLA ONpiEia, SIOKOYTE TN Xprion i T eopTIoN
TOU TIPOIOVTOG APECWG KOl AITOUAKPUVETE TIApWG TV UYPaoia.
« Mnv a@aipeite To KAAUpPaA NG pratapiag.
AuTO TO TIPOIOV XPNCIHOTOLEL PN apatpoUpevn pmatapia. Mnv agatpeite ry
uNV avTIKaBloTATE To KAAUUHA umatapiag 1 Thv pmatapia. EGv apaipéoete
I QVTIKOTAOTIOETE TO KAAUPHA prmaTapiag iy T patapia, umdpyel
mOavotnta PAAPNG, umepBEppavang i €Kpnéng Tou mPOIdVTOG.
« Xpnotgomoleite povo 1o kahwdio USB Kal Tov TposapHoyéa 9OPTIONG TTOU
TIOPEXETAL IE TO TIPOIOV.
H ouokeun oag Slabétel eowTepikn emavagopTi{dpevn pmatapia. Ma Sikr
00G AOPANELD, LNV APAIPEITE TNV EVOWUATWHEVN PmaTapia.
Y€ TEPIMTWON XPrONG TG OUOKEUNG VW auTr YopTilel, evoéxeTal va
mipokAnBei n\ektpomAnéia. MNa va XpnOIHOTOIOETE TN GUOKEUT, OTAHOTHAOTE
N POpTION.

AQaipéaTe Tov PopTioTH amd Ty mpila apol ohokAnpwbei n épTIoN TG
OUOKEUNG. ETOL amoTpémeTal N AOKOTTN KATavaAwan VEPYELQG.

Madi pe to mpoidv mep\apBAavetat évag mPOoapHOYENS POPTIONG TTOU
umooTtnpiCel T ypriyopn @option. H Asitoupyia Taxeiag ¢opTiong pmopei va
unv Aettoupyei edv xpnatpomotnBei AANOG TPOCAPHOYENG POPTIONG EKTAG
TOU YVOlOU TTPOCAPOYEX TIOU GUVOSEUE TO TIPOIOV.

‘Evag AMog TpOTIoE yia va QopTiOETe Ty umatapia ivat va ouvdéoeTe

€va kaAwd1o USB petay Tng ouokeung Kat evog emrpamédiou 1y gopntou
umohoyloTn. H evépyela auTr| Umopei va ival TEpIocOTEPO XpovoRdpa amo
TN QOPTION TNG PmaTapiag o€ emroixia mpila.

Mn @opriCete Tnv pmatapia xpnotpomolwvtag USB hub mou dev

Sovarat va Slatnpriogl oTabepr) TNV ovopaoTik Taon. Evéxetat va pnv
mipaypatomoinBei popTion 1 va Slakorei.

« ‘Otav EMOKEMTEDTE TO KEVTPO EMOKEUWV YIa KATTOL0 TPOBANUa 0TV
umatapia, mpémet va €xeTe padi oag To MPOIOV Kal ToV pOPTIOTH TIOU
XPnolporoleite. Emeidn n pumatapia givat avaAwotpo mpoiov, n Siapkela
(WG TNG MIMOPE( VOl LEIWVETAL JE TO TIEPATHA TOU XPOVOU.

i
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HPO(pU}\GEElC Kot m Xpnon e O'UOKEUT]C

- BeBawBeite ot ypnopomoleite To mapexdpevo Kahwdio USB. Mnv
Xpnotpomoteite KaAwdia USB fj popTIOTEG TPITWV KATAOKEUAOTWY HE TN
OUOKeLN 060G, H meplopiopévn eyyunon e LG Sev KahUmTel T xprion
a€e00VAP TPITWV KATAOKEUAOTWV.

Tuxdv aduvapia Thpnong Twv odnylwv mou mepthapBdvovTal oTo mapdv
€YXEIPIBI0 Xpriong Kat n akatdAANAN Xprion EVEEXETAL VA £XOLV WG ATTOTENECHA
v mpdkAnon BAAPNG 0Tn GUOKEUH.

AcUpuatn @opTion

H ouokeun umootnpiel T Suvatotnta acuppatng options. PopTioTe T
OUOKEUN L€ €vav EYKEKPIEVO aoUppato @opTioth Qi (mpoalpeTikd, mwAeiTal
Eexwplotd).

Doption pmatapiag pe acUPUATO POPTIOTH
T TomoBetAioTE T GUOKELN| GAG OTO KEVTPO TOU AOUPHATOU POPTIOTH, £T0L WOTE
N KEPAia acUPUATNG POPTIONG OTO TTHOW UEPOG TNG CUOKEUNG KAl O POPTIOTAG
va gival EUBUYPAUIOUEVOL.
« Ta va Bpeite TNV ePPENeLa TG KEPAIAG AOLPUATNG POPTIONG, AVATPECTE
0TNV €VOTNTA E7TIOKOTTN 0N OTOIKEIWV.
7 Otav n unatapia gopTioel MARPWCE, aPalpéoTe T CUOKEUN amd TOV QOPTIOTH.

A « ‘Otav @opTileTe TNV Unatapia oW acUPUATOU GOPTIOTH, Unv TomoBeTE(Te
HayvNTIKG, METAANKA 1) AANa aywyia UNIKA avapeoa 0T GUOKEUT Kal
TOV QOPTIOTH, AUTO eVOEXETA VA SNULoUpYET TAPEUPBONEG OTN POPTION
TNG CUOKEUNG KAl 0 POPTIOTAG Mmopei va umepOeppavOei. Ze autrv T
Tepimwon evéxetal va mpokAnBei BAGBN oTn GUOKELN, TOV QOPTIOTH 1 TIG
Kapteg SIM/pvApne.
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5 « Avn Beppokpaacia tng umatapiag unepPei To kaBoplopévo 6plo Katd Tn
SIAPKELD TNG POPTIONG, N POPTION EVEEXETAL VA OTAUATIOEL.

+ Av 010 TTioW PEPOG TNG CUOKEUNG £XOUV TTPOCAPTNOE! MayVNTIKG, METOANKA
1) GAa aywyIpa OTOIXEID, 1) TTPOOTATEUTIK BriKN, TOTE N CUOKELN EVEEXETAL
Va UnV @opTiCeTal KAVOVIKA.

+ Edv @optileTe TV pmatapia pe acUPUATO YOPTIOTH OE TIEPLOXES OTTOU N
100G Tou orpaTog SIKTUOU gival XapnAr, n amddoaon SIKTUOU 0T CUOKEUH
oag evoéxeTal va HEWBE] TEpAITEPW.

+ DopTiOTE TN CUOKEUN PE Evav EYKEKPIPEVO aoUppaTo @opTioTr Qi
(mpoatpeTika, mwheital EexwploTd). H meplopiopévn eyyonon e LG
Sev KANUTTTEL TN XPron a§ecoudp TPITWV KATAOKEVOAOTWV. Mol TuyOV
TIPOPAHOTA, EMKOWVWVIOTE UE TOV EKAOTOTE KATAOKELAOTH.

+ AuTo T0 TIPOI6V UTooTNPIlel acUpuatn edpTion. PopTioTe TO TPOIGV
JE évav aoUpUaTO YopTIOTH pe motomoinon Qi (MwAeital EexwploTd).
OplopEVOL EVOUPUATOL POPTIOTEG EVOEXETAL VA UNV UTTOoTNP{(ouV acupuUaTh
@opTion. Ot acupuatol popTioTéG mou umoaTtnpiouv EPP (Extended Power
Profile) emtpémouv Tnv acupupatn @opTIoN VYNARG TaxUTNTAG.

+ HLG Electronics 6ev @épet kapia euBOvn yia mpoPAfjpata mou oxetiCovat
ue ageooudp ANwv etatpelwv. Na tétola Bépata, aneubuvbeite otov
KOTAOKEVAOTH TOU QVTIOTOLXOU TIPOIOVTOG.

Amnoteleopatiki Xprion Tng pmatapiog
H 8idpkela {wng TnG Umatapiag Pmopei va Uelwdei Gv 0Tn 6UOKEUR eKTENOLVTAL
TIOMNEG EQAPLOYEG Kall AEITOUPYIEG TAUTOXPOVA KAl OUVEXWG.
Mo va augroete n Sldpketa {wiig TG Umatapiag, TEPUATIOTE TIC AEITOUpYIEC TTOU
EKTENOUVTAL OTO TTAPACKAVIO.
Mo va eENayIoTOTOINOETE TNV KATAvAAwoN TNG LoXVOG TNG Uratapiag, akohoubnote
TIC TAPAKATW CUUBOUAEG:
+ Na amevepyomoleite tn Suvatotnta Bluetooth® r Siktvou Wi-Fi 6tav Sev Tig
XPNOIHOTIOLEITE.
+ PuBpiote 10 Xpovikd 6plo TnG 088vng 0T HikpdTEPN SuvaTH TIN.
+ PuBpiote T pwtewotTa TG 006vng 010 EAAXIOTO.
« Evepyomoliote 1o kAeidwpa TG 006vng 6Tav Sev XpnOILOMOIETaL N GUOKEUR.
« ENéyETe Tn 0TABUN pmatapiag evw XPNOLUOTIOIEITE EQOPUOYEG TTOU EXETE
KateBaceL
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006vn agn¢

Mriopeite va e§oikelwBEeiTe PE TOV ENEYXO TNG CUOKEUNC GAG XPNOILOTIOIWVTAS TIG

KIVAOELG TIOU UMTOPEITE Va KAVETE e Ta SAKTUNA oag oTnv 006vn agnc.

Matnua
MNotAote ENa@EA T0 SAKTUNS GOC Yia VAl KAVETE ia emhoyn fi va eMAEEETE Kat va
EKTENEOETE LA EQAPHOYN.

Mapatetapévo matnua
Mo va ePPAVIOTEL TO PevoU e TIC SlaBEateg EMAOYEG, ) EVEPYELD TIOU AmaITELTaL
€lval TO dyylypa Kol To KpATNUA YIa APKET SEUTEPOANETTAL.
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A\ matnua
MatAoTe ypriyopa SU0 GOPEC yia va LEYEOUVETE 1} va OUIKPUVETE Jia LIOTOOEAISA 1y
Evav xaptn.

Metakivnon

Ayyi€te Kat kpatrioTe €va oTolyElo, OTWCE Lia epapuoyn 1 éva widget Kat, 0Tn
OUVEXELD, METOKIVAOTE TO SAXTUNG 0ag og GANo onueio akolouBwvTag pia
e\eyxopevn kivnon. Mmopeite va xpnotpomoloeTe auTrv TV Kivnon yla va
METAKIVAOETE £Va OTOIXEIO.

KaBetn kohion

Ayyi€te Tnv 006vn e To §EXTUNS GaC Kall PETAKIVAOTE TO YPryopa Xwpic Kapia
Tavon. Mmopeite va XpnoILOTOINCETE QUTH TNV Kivnon yia va LETAKIVNOE(TE Ot pia
NoTa, pia 1oTooeNiBa, TIC PWTOYPAPIE, TIC 00GVEC Kal ANAQ.
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Avotypa Kat KA€io1p0 Twv SakTUAWV

KAeioTe Ta U0 SAKTUAG 0aG YIa va GUYETE amo Wi EQAPOYH, OTIWG Yid
TapAdelypa amd pia pwtoypagia fy évav xaptn. MNa va peyeBovete Kamolo oTolxeio,
avoite ta SAKTUAA oag.

A + Mnv ekbétete TV 006vn a@rig o€ umePBOAIKA SuvaToUE KPABAGHOUG.
Mmopei va mpokAnOei PAGBN otov alodntrpa agric.

E « XemepImwaon XPriong TG CUOKEUNG KOVTA GE HAyVNTIKO, METAANIKO 1y
QYWYL0 UAIKG, n 086vN agrig EVEEXETAL VA UNV AMOKPIVETAL.

Y& MePIMTWON XPrioNG TNG CUOKEUNG KATW A6 £VTOVO PWTIOHO, OTIWG TO
Apeco NNakoO Gug, n 086vN Hmopei va pnv givat opatr, avaloya pe T Béon
00C. XpnOUOTIOIEITE TN CUOKEUN O€ ia OKlEPH TomoBeaia 1 pia TomoBeaia
E HETPIO GWTIONO, O€ EVTAON TIOU APKEL yia TNV avdyvwon evog BiBAiou.

+ Mnv matdre mdvw otnv 086vn pe umepBoNikr Svvapn.

Motrote amaAd pe To SAKTUNG 6ag TV MOy o BENETE.

0 éNeyx0G aPriC EVOEXETAL VA NV AEITOUPYNTEL CWOTA OE TIEPITTTWON TTOU
(POPATE YAVTIO 1} TTATATE IE TO AKPO TOU VUXIOU Ga.

0 é\eyx0G aprg EVOEXETAL VA NV AEITOUPYHOEL CWOTA €GV OTNV 006V éXel
OXNMATIOTE( bypacia.

« HoB06vn agrig evdéxeTal va pnv AEIToUpyEi GwOTA £V 0T OUOKEUN EXEL
TomoBeTnBel MpooTaTEUTIKN HEUBPAVN 1) a§E0OUAP TTIOU TIPOUNOEVTAKATE
amnd Tpito KataoTna.

+ Hepgpavion piag oTaTiKig EIKOVAG YA TOPATETAPEVA XPOVIKA SlaoTApaTa
umopei va 08nyroel 0tn Snpioupyia HETEIKAOHATOG 1 EI6WAOL 0TV 086V,
AnevepyomoloTe TV 086vn 1) amo@UYeTe TV mPooAr TG idlag ikovag
yiat peydho Sldotnpa otav Gev XpnGILOTIOIETE Tr) CUOKEUN.
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Apxikn 086vn

Emokonnon apxikrig 086vng

H apykr) 08évn gival To onpeio ekkivnong yia tnv mpoopaocn o S1apopeg
AEITOUPYIEC KOl EQAPUOYEC OTN CUOKEUN 0OC. ZUPETE TO SAKTUNO amd TO KATW
pépog omotadnmote 08dvng yia va petapeite aneubeiag otnv apxikri 00ovn.
Mmopeite va SlaKeIPIOTEITE ONEG TIG EQAPUOYEC Kal Ta widget aTnv apyikr 0Bovn.
YUpeTe T0 HAKTUNG 0ag 0TV 086VN TIPOC Ta aploTePd 1y Pog Ta Se€1d yia va Seite
ONEG TIG EYKATETTNHEVES EQAPHOYEG E HIOL HOTIA.

Aidtagn apxikng 066vng
Mmopeite va Seite ONeG TIC EQAPHOYEG KAl Va 0pYaVWOETE Ta widget Kat Toug
(aKENOUC 0TV apxIKr 006vn.

pappr KaTaoTaong —+ R
[ |

Widget katpod _.

+ Be— [paQikod oToIxEio
Avadntnong Google

Eikovidio oeAidag

i~ MMepioxn ypriyopng
TpéoPacng

= a8
[pappn TAofynong ——— |

E + Hapyikr 086vn evoéxetat va Slagépel avaloya pe TV TTOAITIKF TOu
KOTOOKELAOTH, TIG PUBUITELS XProTN, TV €K500N TOU AOYIGMIKOU 1 TOV
TIGPOXO UTINPECIWV.
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- Tpappn katdotaong: eppavilel eikovidla KaTdoTaong, TNV WEA Kal Tn oTAdun

NG pmatapiag.

Widget KatpoU: egavion mMnpo@opiiv Kalpol Kat XpOVOoU Yio GUYKEKPIHEVN

TIEPLOXN.

- Tpagiko atoiyeio Avalritnong Google: Aaktuhoypdgnae iy pika yia va
avoielg v Avadrtnon Google.

+ Odakelog: Mmopeite va Snpioupyeite pakéNoug yla va TomoBeTeite Tnv
€pappoyn pe Baon ta emBupnTd KpiTipla.

« Eikoviblo oghidag: ppavion Tou ouvolikou aplBuou Twv KapBddwv otnv
apxIkn 086vn. Mmopeite va ayyi&ete To emBupnTo elkovidio oehidag yia va
petapeite otn oehida TG emAoync oac. Oa emonuavOei o ekovidlo mou
eppaviCel Toug KapPBASEC EKEVNG TG OTLYUNG.

- Meproxn ypriyopng mpdaBaong: TomoBeTrioTe PACIKES EQAPHOYEC OTO KATW
Uépog TG 086vN¢ yia va gival Suvath n mpdoRaon oe AUTEC amd omolovanmoTe
KOPBA TG apxIkrg 006vNnc.

« Tpappn morynong: Mmopeite va petapeite otnv mponyoUpevn 08évn f tnv
apyIKr} 006vn v XPNOILOTOLETE TNV EQAPOYR Kat va eEAéyEeTe TN NioTa Twv
EQPAPHOYWV TTOU XPNOIUOTIOICATE TPOoPATA.

Xprion ¢ Fpappric morynong
AkolouBei 0 08NnYA¢ XelpovopIwY yia Tov ENeyxo TG lpapur morynon.

- Ta va petapeite otnv Apyikr 086vn, GUPETE TPOG TA TAVW ad TV KATW Ywvia
NG o0ovng.

[0 va emMoTPEPETE 0TNV TTPONYOUpEVN 08OVN, GUPETE TTPOG TA éCA amo TV
aptotepn f Tv Se€1d dkpn ¢ 08dvNc.

Mo va petafeite otnv 086vn EMoKOMNong, CUPETE TPOE Ta TAVW KAl KPATAOTE
amd TV KAtw MAEUPA TG 086vNC.

Mo ypriyopn evallayn HETa Twv EQappoYwy, CUPETE TPOG Ta Sedid amd To
KATW PEPOG TNG 086VNG yla va LETAREITE OTIC EQAPHOYEC TIOU XPNOILOTION0ATE
TIPONYOUUEVWG,

5 + O1 Xelpovoplieg ival n mpoemAoyr yla T ypappr morjynong. Ma va to
aMaéete oe Mévo koupma <]/ ) /[ omv apxki 086vn, matiote
PuBpiogic> MpoPoAr > Mpapun monynang, otn cuvéxela emAéEte Movo
Koupmd.
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Ewkovidia katdotaong

Otav umdpyel pia idomoinon yia éva adidaoTo privuua, éva cuppav
nuepoloyiou 1 umvntripy, N ypappn katdotaong epgaviel To avtiotolyo
elkoviblo eidomoinong. EAéy&Te TNV KaTAoTaon TNG GUOKEUAG 0OC UECW TWV
elkoviSiwv e1domoinong mou eppavifovtal 0T ypauur Katdotaong.

‘A Aev uapyel ofjua

56 H petddoon dedopévwv mpaypatomoleitat péow SIKTUOU
[c] ‘Exet pubpiotei unvntrpt

L\l ‘Exel evepyoroindei n Aerroupyia ddvnong

b4 ‘Exel evepyoroindei 1o Bluetooth

g YOv8eon pe umoloyloTh péow USB

[ | 2140un ynatapiag

4+ AerToupyia TTACNG EvepyoTIOINUEVN

-4 Avanévtnteg KAOELC

= ‘Exet ouvdeBei To Wi-Fi

i ‘Exel evepyomoinBei n Aertoupyia oiyaong

' ‘Exel evepyomoinBei 1o GPS

(‘IB ‘Exel evepyoroindei To gpopnTto onueio mpdopaong
N Aev unapyel kapta SIM

[N H Aerroupyia NFC givat evepyomoinpévn

+ Oplopéva amo autd ta ekovidla evogxetal va epgpaviCovtal Sla@opeTIKA iy
va pnv epgavifovtat kaBoAou, avahoya LE TV KATAOTACN TNG CUOKEUNG.
AaBaote Ty meplypagn Twv eikoviSiwv avaloya He To mePIBANOV Kat Thv
TIEQLOXT| OTTOU XPNOIHOTIOLETE TN GUOKEUK KOl TOV TIAPOXO UTTNPETLWV.

+ Ta eovibla mou epgpaviovtal evdéxetal va Slagépouv avaloya He Thv
TIEPLOXI) KOl TOV TTAPOXO UTINPECLWV KIVNTHG TNAEPWVIAG,

Wil
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Mivakag eidomoloewv
Mriopeite va avoieTe Tov mivaka EI50MOICEWV GUPOVTAG TN YPAUUN KATAGTAONS
TIPOG Ta KATW 0TNV KUpla 08dvn.

+ Mmopeite va 6UpETE POG Tl KATW TO TIAPABUPO EI80TTOICEWV 1) VO TTIATHOETE
T0 €IKovidlo BENoug yia va avoifete T AioTa pe Ta elkovibia ypriyopwv
puBpioEwv.

+ Mnopeite va natroete /2 yia va mpooBEoETe, SlaypAYETE 1 TAKTOMOWOETE Ta
€lkovidla aTo mapdabupo eldomoIoEWV.

- Edv matioete mapatetapéva To eikoviblo, Ba epgavioTe n 08évn pubpicewv
yla TV avtioTolyn AtToupyia.

E « Mmopeite va XpnOoILOTOICETE TOV Tivaka EI50MOICEWY aKOUa Kal dTav
n 086vn givat KAeWGwpEVN. ZUPETE TOV Tivaka 60O 0EWY VW N 086vN
eival KAeldwuévn, yla va amoKTHoETE ypriyopn mpooRacn oTig SuvatotnTeg
Tou BéNeTE.
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Evalayn otov mpocavatoAoué g o0dévng

Mriopeite va opioete va aAAalel auTOpaTa 0 TPOCAVATONOMOC TG 086vNng
QVANOYQ [IE TOV UOIKO TIPOCAVOTONGHO TNG CUCKEUNG.

2oV mivaka eidomotjogwy, emAEETe Mepiotpo@n amd tn Aiota Twv elkoviSiwv
ypryopnc mpoéofaong.

Mriopeite emiong va matriote PuBpioeig > MpoPoAn kat vepyomoiioTe Tnv
Autopatn meploTpoPr 086vNG oTNV apXIKr 08N,

Ene€epyacia tng apxikng 00ovng
TNV Apxikr) 086vn, ayyi€Te Kal KpATAOTE O€ éva KEVO ONKEIO KA, OTN GUVEXELD,
€MAEETE TNV EMBUUINTI EVEPYELD OO TIC TIOPOKATW.

- Ta va aMagete ™ didtaén Twv kapPddwv otnv apxikr 086vn, matioTe
TaPATETAPEVA TAVW OF évav KAUBA Kal CUPETE Tov O€ pia AN Béon.

la va mpooBéoete éva widget atnv Apxikry 006vn, ayyi€te €va kevo onueio TG
ApxIKG 086vng kal kpatroTe To emiéyovtag Widgets.

Mo va aMaéete Tametoapieg, O¢pata, ikovidia kat AOD, ayyite mapatetapéva
i Kevi TiEpLoxH TG apxIKnG 08dvng kal, oTn ouvéxela, emiécte Povto &
Oépa.

Mmopeite emiong va matrioete PuBpiceig > Povto & Oépa otnv apyikr 086vn
Kal, 0Tn OUVExELD, va emAEEeTe TameToapieg, O¢para, ikovidia kat AOD mou Ba
EPOAPUOOETE OTN OUOKEUN.

Mo va aANGEeTe To MAEYPa, TATAOTE MAPATETAUEVA OE €VO KEVO ONUEIO TNG
ApxIKAG 086vng kal, oTn ouvéxela, emAéCte MAéypa. Matriote To emBupnTo
m\éypa, katdmy matrote Epappoyn.

Baoikég Aertoupyieg 59



Mo va SIapopPWOETE TIG PUBHIOELS TG ApXIKNG 000vNG, ayyi€Tte éva Kevod
onueio TG ApXIKiG 006vNG KAl KPATAOTE TO EMAEYOVTAG OTN CUVEXELD
PuBpioeig apyikrig 006vng. Mo Aemtopépeleg, avatpé€te oTnv evotnTta
PuBioeic apyikric 08ovng .

+ Ta va Seite 1) va eYKATAOTAOETE EQVA TIC LN EYKATECTNEVES EQAPLOVEC,
ayyi€te éva kevo onpeio TG ApxIKing 086vNng Kal KPATAOTE TO EMAEYOVTAG
Zkoumibia epappoy. Ma AeMTOUEPELES, AVATPECTE OTNV EVOTNTA ZKoUTTidIa
EQAPLIOY. .

Mo va aAa&eTe Ty mpoemiheypévn 006vn, ayyi€Te Kal KOATAOTE HIa KEVH

meplox TNG ApXIKNG 006vNg, petakivnBeite otnv emBupntr 086vn, ayyi€te To

koupi 1Y, Kal 0N ouvéxela ayyi€Te TRy 086vn yia AN Wia Gopd.

L — [lpoemmAeypévn 0Bévn
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MpofBoAn Tov Béuarog pévtou
H mpoBoAi TG EIKGVAC POVTOU €ivat SuvaTr LOVO e TNV amdKpuyn Twv
€QAPUOYWV Kal Twv widget otnv apxikri 086vn.
Am\woTte ta 800 SAKTUNG oag 0TV apxIKr 086vn.
- o va emoTpéPeTe oTnV apyIkr 006V HE TIC EPappoYEC Kat Ta widget, evwoTe
70 SAKTUAG 0aG EVW) T OKOUPTTIATE 0TV APKIKI 086VN 1 GUPETE TTIPOG TA TIAVW
— amé TV KATw AKpn TG 080vng.

Metakivnon epappoywv oTnv apxikn 086vn
SNV apyxikr 08vn, TaTOTE MAPATETAPEVA TTAVW OF HIa EQOPHOYI KAl GUPETE TNV
O€ Jia AA\n Béon.

+ 10 va KOPPITOWOETE TIG EQAPHOYEG TTOU XPNOIOTIOIOUVTAL GUXVA OTO KATW
UEPOG TNG aPXIKAG 0B8OVNG, TIATAOTE MAPATETAUEVA TIAVW OE HI0 EQAPLOYH, Kal
OUPETE TNV 0TNV TEPLOXT| YPIYOPNE TPOGRaoNG 0To KATW PEPOG TNG 006VNG.

- Nava apaipéoete éva gikovidlo amod v meploxn ypriyopng mpooRaong, oUpeTe
0 €1KOVibIo 0TV apyIkri 086vn.
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Xprion @akéAwv amd Tnv apyIikni 086vn
Anuovpyia akélwv

TNV apxIKf 006vn, TATHOTE MAPATETAUEVA TTIAVW OF MOl EQAPHOYI KOl CUPETE TV
TIAVW OE [t GAAN EQAPHOYN.
+ Anuioupyeital évag vEog PAKeNOG KAl Ol EQAPHOYEC TPOOTIOEVTAL OTOV PAKENO.

Ene€epyacia pakélwv

TNV apxIKf 006vn, ayyi€te £vav GAKENO Kal, EMEITA, EKTENEDTE pia amd TIG

OKONOUOEG EVEPYELEG.

« T va ene§epyaoTeite 10 GVopa YaKENOU, TATAOTE OTO AVOA YAKENOU.

Mo va eme€epyaoTEiTe TO XPWLA, TATHOTE 0ToV eMAVW Se€i KUKNO.

« [0 va mpooBEoeTe EQAPHOYES, ayYIETE Kal KPATAOTE TO EIKOVIOIO HIAG
E(QAPLOYNG, CUPETE TO TIAVW ATTO TO PAKENO Kal, 0T GUVEXELD, AQHOTE TO.

+ [0 va aQaIPECETE JIa EPAPHOYR ammd TOV QAKENO, TATAOTE TAPATETAPEVA
TIAVW 0NV EQAPHOYN Kal CUPETE TNV £§w amod Tov PakeMo. EGv n katapynBeioa
€pappoyn givat n Hovadikn epappoyr oTo QAkeNo, o pdakehog Ba KatapynBei
autdépata.

- Emiong, pmopeite va mpooBECETe 1 va apaipéoete eQappoyég matovtag ().

E + Aev pmopeite va aMAEETE TO XPWHA TOU PAKEAOU GTAV XPNOIUOTIOIEITE
Kamolo Bépa mou €xete KATeRATEL
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PuBpioeic apxikiig 086vng

Mmopeite va TPOCAPHOOETE TIG PUBICELS TNG apXIKAG 086vNG.

T Zmv apxikr 086vn, matiote Pubpioeig > MpoBolr > Baoikr apxiki 066vn.
2 MpocappooTe TIG TapaKATw pubpicel:

- EmAé€re Apyikn oghiba: emAECTE Wi Aettoupyia amo Ty apxikr 086vn.

+ E@é 006vng: emAéETe TO €€ TIou Bat epappdleTal Katd TV evahayn Kappd
oTnV apyIkr 006vn.

+ IxnHata eikovidiwy: emAECTe £Gv BENETE Ta glkovidla va éxouv
TETPAYWVIOUEVEC 1] OTPOYYUNEEVEC AKPEG.

+ Por Google: ppdvion ota aplotepd The Kuplag ApxIkrg 08évne.

+ Ta&ivopnon epappoywv avd: Seite pe molov Tpomo TagivopouvTal ot
EQAPLOYEG OTNV QXK 0BVN.

+ ATOKpUYN EQAPHOYWV: EMAEETE TIC EPAPHOYEC TTIOU DENETE VO AMOKPUYETE
amoé v apxikr 08ovn.

+ Na emrpénetat KUKAIKN emavaAnyn ApXIKwV 08ovwv: evepyoroloTte
QUTAV TNV EMAOYN YO va EMTPEPETE T CLVEXT) KONION 0TV apxIki 086vn
(emoTpéPTE HéOW BPOXOU OTNV MPWTN 006V PETA TNV TEAEUTAiA 006vN).

+ YUPETE MPOG Ta KATw oTo Ap)IKN 006vN: Evepyomoirote v avalritnon
£QapUOywV 1 TiEPLEXOpEVOU ) TIPORBANAETE EI8OTIOINTEIG GEPVOVTAG TTPOG TA
KATW 0TNV apyIKr 006vn.

« XUpete mpog Ta EMdvw oTo ApxIKi} 086vn: Evepyororote Ty avalitnon
EQAPLOYWV 1} TIEPIEXOHEVOU CUPOVTAG TTPOG T EMAVW OTNV ApXIKY) 006vn.

+ Kheibwpa Apxikr 086vn: EvepyomoirioTe To yia va pnv yivetat avadidtagn
1 amopdkpuvon epappoywv kat widget.
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Mpocappoyn apxikrg 000vng Aeltoupyiag mepIoTPOPNG
H apyikr) 086vn T Aettoupyiag meploTpoprg givat n mpwTn 086vn mou
epaviCeTal apou TEPIOTPEPETE TO TPOIOV. MITOPEITE va PN OO OETE

TIG apyIkég 0BvVeC TG KUpLag 08ovng Kat TG Sevtepng 086vng pe Sidpopoug
TPoMOUG.

=

Kaipog
y % Kupia 086vn
—

mAorynang

Aeutepn 086vn —

— Eikovidia ypriyopng
TpéoBaong

Tpappn mhorynong —x

Polot kat katpdg: Mmopeite va Seite Ty Tpéxouca wpa Kat TANPOPOpIES yial
TOV KaIpo.

SUVTOUEUCEIG EQaPUOYWV: MIOPEITE Val EEKIVIOETE YPriyopa TNG EQAPUOYEC
¢ Aiotag.

pappn mhorynang: MmopeiTe va XpnOIUOTIOIOETE XEIPOVOIES Yia va
petapeite otnv apxiki 006vn, otV mponyouuevn 086vn, oTnv 08vn
TIPOEMOKOMNONG 1 yia ypriyopn evalayr METAEY TWV EQAPUOYWV.

Meproxn ypriyopng mpoopaong: Mmopeite va xpnoIOTOIOETE TIG EQAPHOYES
TIou BAETE yla va EEKIVHOETE AUEOWC.
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Alapdpewaon g apxIKig 006vng Aettoupyiag

TIEPICTPOPNG

Mriopeite va aMdEeTe TIG pUBLITELC TOU aPopoUV TV apxIKA 006V TG

\erToupyiag mepIOTPOPNC.

T Zmv apxikr 0086vn, matiote Pubpioeig > MpoPoli > Apxikr 086vn

Aertoupyiag meploTPOPNG.

7 Em\é€te v emBupnti Aertoupyia yia va kaBopioete Tig puBpioeig Te.

+ ZUPETE IPOG Ta KATw 070 ApXIKN 006vN: EMAESTE TL BéNeTE va epgavileTal
oTav OUPETE TIPOG Ta KATW 0TNV KUPLA apxIKr 086vn 0T Aermoupyia
TIEPIOTPOPNC.

Multi App Shortcut: Mmopeite va emAé€ete va extelouvTal SU0 EQAPLOYEG

TauTdXpova oTnv KUpLa 086vn kat oTn Seutepn 0Bvn.

+ ZUPETE IPOG Ta KATW 0T0 ApXIKK 006VN: EMAEETE TL OéNeTE VL
eppaviletal OTav CUPETE TPOG TA KATW 0T SeUTEPN 006VN TN AsiToupyia
TIEPIOTPOPNAG.

+ E@é 000vng: EmA£CTe éva emBUUNTO OMTIKG €€ OTAV TIEPIOTPEPETE TO
AéPWvO.

Eikovibia ouptaplol epappoywv: Evepyomolrote Ty eugavion Tou
eikovidiou ouptaptol epappoywv @ ot devtepn 0Bovn.

K\eidwpa Apxikr 006vn;: Evepyorotrjote To yia va uny yivetai avadiataén
1) AMOPAKPUVON EQapHoywv Kat widget.
- BonBeia: Mpofolr Tng Bondelag yia T Aertoupyia MEPIOTPOPNAC.
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KA&idwpa 006vng

Mapouaciaon kAeibwparog 00ovng

H 086vn tn¢ oUOKEURG 0aG AmEVEPYOTIOLEITAL KAl KAEIOWVEL AUTOUATA OV TIOTHOETE
70 M\AKTPO Aettoupyiag/kheldwpatoc, To iSlo oupPaivel emiong kail 6tav n GUoKeUH
Tapapeivel o adpavela yia éva kaBoplopévo Xpovikd Sldotnpa.

Eav matroete 10 MAKTPO evepyomoinonc/KAEIOWHATOS XwpiG val €XEL
evepyoroinOei To KAeibwua 006vng, Ba epgavioTei autopata n apyikr oddévn.

MNa va e€ao@aNioeTe TNV A0PAAEIA TNG CUCKEUNG KAl VO AMTOTPEWETE avemOUUINTN
TPOGRAON O AUTH, EvEPYOTTOINOTE TO KAEIdwHa 086vNG.

E + To KAeibwua 006vNG AMOTPEMEL TNV TIEPITTH EI0AYWYI| EVIOADV QPRG0N
GUOKEUH KAl MEIWVEL TNV KATAVAAWON 10XU0G TNG PmaTapiag. Zuviotatal
Vvl EVEPYOTIOIOETE TO KAEISWHa TG 006vNG 6Tav SV XPNOILOTOIETE TN
OUOKEUN.

PUBuIoN KAe1dwpaTog 006vng
AlaTiBevTal ApKETEC EMAOYEC Yia TN SIAUOPPWON TwV PUOLIcEWY KAEISWUATOC TNG
obovng.
T Zmv apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & ao@aleia
> AloAé€te KAeidwpa 080vNG Kal, 0T OUVEXELD, EMAEETE TN PEBOSO TTou
TIPOTIMATE.
2 MpocappooTe TIG TapaKATw pubpicelc:
- Kavéva: amevepyomoinon Aetrtoupyiag KAeldwpatog 08évng.
+ ZUPETE: COPWOTE 0TNV 006VN yia va EeKNEIBWOETE TV 086vn.
+ Morifo: oxediaote éva potifo yla va EekheldwveTe Tnv 086vn.
+ Kwdikog kKAaldwpatog;: eloaydyete évav aplBuntikd kwdikéd mpdoBaong yla
va ekAeldwoeTe TV 0B6vn.
Kwd1kog mpooPaong: eloaydyete évav aApaplOpnTIko Kwdiké mpooRaong
yla va EEKAEIOWOETE TV 0B0vn.

+ AakTtul Amotunwpata: EEKAEISWOTE TV 006V XPNOIUOTIOIWVTAG TO
SaKTUNKG 0O amoTUMWA.
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Mapapetpomoinon kKAedwpatog 006vng KAEIdwuaTtog
Mmopeite va mpooapudoeTe Tnv 086vn KAEISWUOTOC.
1 Zmv apxikn 086vn, matfiote PuBpioeig > Kheibwpa 006vng & ac@daheia >

Mapapetpomoinon kAeidwpatog 006vng.

7 EmAé€te pa Aerroupyia mou Béhete va puBpioete.

+ PolOt: Zag emtpénel va opioeTe To pPéyeBog Tou poloylol oTny 08ovn
KAe1dwpaTog.

+ ZUVTOUEUOEIG: XaG EMTPEMEL VAl EMAEEETE TNV EQAPUOYN TTOU Ol EKTENEDTEI
otV 086vn Kheldwpatog oag. Autr n pUBpIon eival opatr pdvo oTav €xel
oploTei To KAeidwua 08évne.

+ Kwvoupevn €1k6va katpoU: Evepyomolrote autrv Ty moyn yia va
elpavioeTe KIvoUpeva axédia kalpoU yla tnv Tpéxouaa Béon otnv 006vn
KAeLdwpaTog,

ZTOIYEl0 EMAPTIC OTNV TEPITTWOT AMWAELAG TOU TNAEPWVOU: Zag Sivel
n SuvatdtnTa va opiceTe Keipevo otnv 086vn KAEWOWHATOG yia va
TIPOCSIOPICETE TOV KATOXO TOU TNAEPWVOU.

PuBpioeic ao@alol¢ KAeldbwpatog

Mmopeite va opioete ao@aleic pubuioelc KAEIGWUATOC.

T Zmv apxikr 086vn, matfiote PuBpioeig > Kheibwpa 006vng & acgaleiag
ao@dlela > PuBpiogig acpaloug Kheldwpatog.

7 Em\é€te wia Aerroupyia mou BéNeTe va puBpioeTe.

+ Na @aivovtat ta potifa (eppavietal povo otav to MotiBo éxel oploTei wg
KAeidwpa 086vng): EvepyomotrioTe yia va KAvete 1o poTio opatd.

+ Xpovodiakdmtng KAESWpaTog: Xag emtpémel va pubuileTe To Xpovikd
SlaoTnua TPV TO AUTOHATO KAEIBWa TNG 080VNE agou KAEIoETE ToV
omioBio PWTIoUO (xPOVIKO 6plo Adyw adpdvelag).

- To koupmi Tpogodoaiag kKAeWwvel oTiypiaia: Evepyomoriote auth v
emAoyn yla va KAEWOWOETE apéowe T 006vn OTav TMECETE TO KOUTT
gvepyomoinong / KAEGwHaTog. AUt n puBLION umepLoXVEL TNG pUBHIONG
XPOVOSIOKOTTN KAEIOWHATOC Ao@aAEiag.

+ Epgavion emhoync kAeldwpartog (pgaviletat pdvo dtav €xel oploTel
KAeidwpa 086vNg): Evepyomorote autry Tnv emAoyr yia va epgaviletal
TO €IKOVISI0 KAEISWHATOG OTAV KPATATE TTATNHEVO TO TIAAKTPO loxvog/

KA WpaToC, MatoTe TO €1KOVIBIo KAEISWHATOC YIa VA ATIEVEPYOTIOOETE
70 £§UMvo KAEIdwUa, TO PIOUETPIKO EeKAeidwpa Kal TIG E150MOINOELS TNV
006vn KAeWdWHATOG.
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+ Smart Lock: Za¢ Sivel Tn Suvatotnta va opiceTe aIOMOTn GUOKELN,
TomoBeoia, pwvr kat / i avixveuon 0To cwpia Tou Ba emTpéPel 0TO
TNAEPWVO 0ag va mapapével EEKAeISwuévo.

+ O18100é01ueg emMoyEg pevol evdéxeTal va Slapépouv avaloya pe Thv
emAeypévn péBodo 006vNG KAEISWUATOG.

Evepyomoinon 006vn¢
MropeiTe va EVEPYOTIOINOETE I VA ATTEVEPYOTIOINOETE TNV 006vVN pe SIMAG matnpa
mavw TG,

E « Auti n emoyn eivat Slabéoiun pdvo atnv apxikr 086vn e LG. Aev
Aertoupyei owoTd o€ Kamola e18IKN EQapuoyn EKKIVNoNG 1) 0TV apxIKn
086vn mou éxel eykataoTabei amd Tov Xprotn.

+ Ta va matroete v 086vn agrig, xpnotpomolrote To SAKTUAS oag. Mnv
XPNOILOTIOLEITE TO VUYL 0OC.

« Tlava xpnotpomolroete tn Aeitoupyia Evepyomoinon 08ovng, PePaiwbeite
oT1 0 ALoBNTAPAG EYYUTNTAC/PWTIOHOU Sev epmodileTal amod kdmolo
QUTOKONANTO 1 GAAN évn ouaia.

Evepyomoinon 086vng
MatrioTe pe 1o SAKTUNG oag 800 Popég 0Tn Péon Tng 0BdvNg.
- EQv matAoeTe 0T0 EMAVW 1} 0TO KATW PEPOC TNG 006vNE, 0 Babudc avayvwplong
NG Kivnong evaEKeTal va NV €ival EMOPKAG.

Amnevepyomnoinon 006vng

Ayyi€te pe 1o SAKTUNS 0aG SU0 PoPEC TTAVW OF €val KEVO Onueio oTnv ApXIKH
066vn kat otnv K\etdwpévn 0Bovn.

EvaakTikd, matriote S00 popég o€ évav Kevo XWPO OTN YPauur KATtdoTaong.

Anevepyonoinon Evepyomoinon 086vng

Eav 6ev BéNete va xpnotpomoleite T Aertoupyia Evepyoroinon 086vng, kavte Ta
ednc

v apxikn 086vn, matriote PuBpioeig > Emektaoeig > Evepyomoinon 086vng kat
OUPETE YI0 VO ATTEVEPYOTIOIOETE TN AEITOLPYIAL.
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Avayvwpion SaKTUAIKWY amoTUNMWHATWY

Avayvwpion Aaktul. Amotunwpartd - Mapouciaon
MpoToU XPNOILOTOINCETE TN AelToupyia avayvwplong AakTul. ATOTUTIWHATOC,
TIPEMEL VA KATaXWPIOETE Tal SAKTUNKA GO AMOTUTTWUATA 0T GUOKEUH.
Mriopeite va XpnoloTOIoETE TN AEIToupYia avayvwplong AaKTuA.
ATIOTUMTWHATOC 0TI AKOAOUOEC TIEPITTWOELC:
« Ta Eexeibwpa tng 086vNg.
« Ta va deite Ta KAelbwuéva meplexopeva 0T Astoupyia AAUToup f otV
gpappoyn QuickMemo-+.
« o emPeBaiwon piag ayopdg Péow tng oUVEECNC O€ LIa EQAPHOYN i
TOUTOTOINONG e TO SAKTUNIKO 0ag amoTUMWHAL.

5 + Houokeur umopei va xpnotuomolei To SaKTUNKO cag amoTunwia yia
Aoyoug tautomoinone. O aloBntripag AAKTUA. ATOTUNIWHATOC UMOPE( va

unv Eexwpilel SOKTUNKA QOTUTTIWUATA TIOU AVAKOUV O SIAQOPETIKOUG

XPOTEC AANA £XOUV TTOAEG OHIOIOTNTEG, Kall VAl Ta avayvwpilel wg To iS1o

anotinwpa. Ma mpooBeTn ao@alela, pubpioTe To KAEIdwHa TNG 086VNG e

éva poTifo, kwdiko PIN 1 kwdikd mpdoPaonc.

Av n ouokeur| dev avayvwpilel Ta SayTUNIKA GaG AmOTUMIWUATA 1) AV

EexaoeTe TNV KABOPIGHEVN TIHI YIO TNV KATAXWPLOT), EMKOIVWVIOTE PE

10 E§ouatodotnpévo kévipo e§unnpétnong mehatwv tng LG éxovtag

OUOKEUN KOl TNV TAUTOTNTA 00G.
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Mpo@uldager yia tnv avayvwpion Aaktul. AMOTUMWHATOG
H akpipela avayvwpiong SAKTUNKOU QmOTUNMWUATOG UOPE( va HElwOE yia
S1apopoug Aoyouc. Na va peytotomolnBei n akpifela tng avayvwplong, eNéyéte Ta
aKoouba TPV XPNOIOTIONOETE TN GUOKEUN.

+ Kétw Kat 010 KEVTPO TNG 086vNG TOU TPOIBVTOC, UTIAIPXEL £VAC EVOWHATWHEVOG

aleOnTrpag mou avayvwpilel SaKTUAKE amotunwpata. MPOCEXETE WOTE
va pnv ypatouvioeTe 1) mpokaléoete pBopd oTov alodntripa AaKTuA.
ATOTUNIWHOTA PE METANIKA QVTIKEIUEVA OTTWE KEPHATA 1) KAELSIA.

« Tpwv TV ayopd Kat Xprion Hiag TPooTATeUTIKAG HEPPpavng, ameuBuvBeite

TIPONYOUUEVWE OTO KATACTNHA Ayopdg yia va eMPBEPAIWOETE EQV TO

TPoidv umootnpilel T xprion alodnTipa SAKTUNKOU AMOTUNIWHATOG. Z€
oplopéva TIPoIoVTa eVEEXETaL va Ny givat Suvath n avayvwplon SaKTUNKoU
QMOTUMWLATOG 1) EVOEXETAL TO TIPOIGV VA TAPOUCIATEL SUCAEITOUpPYia. Z€ eKeivn
TNV TEPIMTWON, S€V UMOPEITE VA XPNOIUOTIOINCETE TNV UTINPEDIA £YYUNONG

NG LG Electronics kat n LG Electronics Sev mapéxet yyunon yia {npiég omwe
Suoherroupyia Tou mPOIGVTOC,

Edv avTIKATAOTAOETE TNV TPOOTATEUTIKN UEUBPAVN TIOU UMAPXKEL OTO TIPOIOV LE
pia moAwpévn pepBpAvn Tou SlayEel To GG A ia HEPBPAvN peyalou mdyoug,
evOEXOUEVWC VA PELWBET 0 pUBUOC avayvwPIoNg SAKTUAKWY AmOTUNTWUATWY.

« Edv tomoBetnBei oTo mpoiov okAnpupévo yuahi r GAn Tiaxid PO TATEUTIKY

uepBpavn, n Aerroupyia avayvwpiong SaKTUMKOU amoTuNUATOS VOEXETal
vl PNV A&IToupyei owoTa. Xe ekeivn TV mepimwon, BePaiwdeite mwg Ba
QPAIPECETE TNV TIPOCTATEUTIKK MEUBPAVN TTIOU €XETE TOTTOBETHAOEL 0TO TIPOTIOV
TIPWV VO XPNOIMOTIOINCETE TN AEITOUPYIa KATAXWPNONG Kal avayvwplong
SOKTUAIKOU ammOTUTTHATOC.

Edv umapyouv &éveg ouaieg (15pwTtag, Aoolov, vepo, okovn, Aimm, K.4.) oTov
aeOntrpa Aaktul. Amotuniwpata 1y 0to SdyTulo miou Ba TomoBeTnBei oTov
alednTpa, n avayvwplon AakTul. AMOTUNWHATO EVEEKETAL VA UNV AEITOUPYEI
OWOTA. LKOUTTOTE TOV aloBNTrpa Kat To SAXTUAO Kal apaipéoTe KABE ixvog
vypaociag mpiv TomoBeToeTe To SdKTUAO OTOV ALEBNTHPA.

Edv n emeaveta tou Saytulou givat okAnpr emeldn €xel OUNEG 1 €xel {apwIoEL
amoé 10 vePd, 0 ALoONTAPAG EVOEXETAI VO PNV PITOPET VOl aVayVWPIOEL TO
SaKTUNIKO amoTUMWA. L€ TETOLO TIEPITTTWOT, KATAXWPIOTE TO SAKTUAIKO
amotimwua dAou daytUou.

Edv \uyiCete T0 SAKTUNS GG 1 XPNOILOTOLEITE MOVO TNV dKP TOu SAKTUAOU
00, T0 SAKTUAIKS amoTUMWHA 0aG EVOEXETAL VA INV avayvwploTei. BeBalwBeite
OT1 70 SAKTUNG GO KAAUTITEL OAOKAN PN TNV EMIQAVELD TOU aloBNTrApa AaKTUA.
AmoTtunwpata.
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+ 2apwoTe Povo éva SAKTUMO Yia KdBe kataxwpton. H 6dpwon mepIocotepwv
SAKTUAWV PMOpE va €xel EMMTWOEL 0TN Sladikacia Kataxwplong Kat
EYYPAPNC.

H ouokeun evdéxetal va Snpioupyei 0TaTIKO NAEKTPIONS O TEPIMTWon mou
Aertoupyei og mepiBAaNov e Enpd aépa. Edv o mepiBaMwy aépag eivat Enpog,
QMOUYETE T 6ApWAon Tou SAKTUNKOU 0ag amoTUNWUATOG iy ayyiTe éva
UETANNIKO QVTIKEIMEVO, OTIWG éva VOIOUA 1} éva KAELSI, TIpLV TN 0dpwaon Tou
SAKTUNKOU OITOTUMTWATOG YIat VA EE0USETEPWOETE TOV OTATIKO NAEKTPIOWO.

Kataywpion Aaktul. Amotunwpara

Mriopeite va KataxwpioeTe Kat va amoBnKeVOETE TO SAKTUNKO 0AG AMOTUNIWHA

0T OUOKEUN YO VO TO XPNOLUOTIOIELTE PE TV avayvwpLon AaKTUA. AMOTUWUATA.

1 Zmv apxikn 086vn, matiote PuBpioeig > Kheibwpa 006vng & ac@daheia >
AaKTUN ATOTUTTWHOTA..

E + Auti n Aertoupyia givat StaB€atpn povo epdcov gival evepyomoinuévn n
Aertoupyia KAeldwpatog 006vng.
- Khewdwote ™ ouokeun pe éva poTifo, éva PIN fj évav kwdiké mpoopaonc.
« Av bev éxel oploTei kAeidwpa 086vng, akoAouBroTe TG 08nyieg aTnv 086vN
Y10 TO EVEPYOTTOINOETE. Mol AemTopépeleg, avatpé€te otnv evotnta PUbuion
KA&lbwuatog 066vng.

7 Evrtomiote T 8£0n Tou aloBntripa AakTul. ATOTUNIOLATOG KATW Kall 0TO
KEVTPO TNG 006VNG Kall AKOUMITROTE ENAPPWC To SAXTUAO OToV aloBnTrpa.

E « To SayTtulo mpémel va KOAUTTTEL T PpWG Tov alobnTripa AakTUA.
ATOTUTWUOTOG,
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3 AkohouBRoTe Tic 0dnyiec ou epgavilovral otny 086vn.
+ AKOUMTOTE To SAYXTUAG 0ag 0ToV aloBNTAPA Kal KPATHOTE TO MéXPL VA
aoBavBeite pa dovnon.
+ Metakiviote ehagpwg To 610 SayxTulo oTov alobnTripa péxpt va
oNokANpwOEi n Kataxwpton Tou SAKTUNKOU amoTUNWHATOG,

/I "Otav n Kataywplon Tou SakTuNKoU amotunipatog oAokAnpwosl, matfote
OK.

+ Matriote Npoabnkn emmA. yia va kataywpioete AANO SAKTUAIKS
anotunwpa. EQv éxete kataywpioel povo Eva SaKTUNKS amoTunwpa Kat
10 avtioTtolyo ddkTulo Sev gival o€ KATAAANAN KATACTAON Yia 6Apwon,
N avayvwplon evoéxetal va un Aertoupyrogl owoTd. MpoAnTrtikd,
KotaxwpioTe TOMA SAKTUNKA amoTUTWHATA.

Awayeipion AakTul. ATTOTUNTWHATOG

Mriopeite va emefepyaoTeite 1 va SlaypaPeTe KataxwpIopéva SAKTUAKA

QMOTUTTWHATA.

T Tt apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & ac@dheia >
AakTul AOTUTTWHOTA..

7 ZekAelBWOoTE CUMPWVA WE TNV KaBOPIOWEVN UEB0SO KAEIGWDUATOC.

3 A6 Nota Twv AakTul. ATIOTUTIOUATA, TTIATHOTE TAVW OF £Val SAKTUAIKO
QAMOTUMWLA Y10t VA TO METOVOUAOETE. 10 val TO SlaypAYETE, TATAOTE TO KOUWTTE

0.

Epgavion tou ikovidiouv SaKTUAKoU amotunwpatog otav

n 006vn givai ofnoti

Mmopeite va puBpioete mwe Oa epgaviletat n O¢on Tou alednTrpa SAKTUAKOU

AmoTUNWUATOG 0TV 086VN 6Tav n 086vn eivat ofnoTh.

T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & acdheia >
AaKTUN ATOTUTTWHOTA..

7 ZekAelbWoTe GUMPWVA HE TNV KABOPIoEVN UEBOSO KAEIGWUATOC.

3 Tava evepyomoloete autrv TV emhoyn, Tatiote T puBpion MathoTe yia
va epgaviletat eikovidio dtav n 066vn givat ofnoTh.
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E@é eikovibiou

Mriopeite va emAé€eTe éva é Tou paviletal KABE opd ToU TTATIETAL TO

€IKOVISI0 SAKTUNIKWV QITOTUTTWHATWV.

T Zmv apxikr 086vn, matiote Pubpioeig > Kheidwua 006vng & ac@dheia >
AakTul AoTUTTWHOTA..

7 ZekAelbWoTe GUMPWVA WE TNV KaBOpPIopEVN UéB0SO KAEIGWUATOC.

3 NatAote E@é eikovidiou kat emAEETE TO EMBUNTO EQE.

ZekAeibwpa tnG 006vNng pe xprion dakTuhikol

ATTOTUTIWHATOG
Mriopeite va Eexheldwoete Tnv 006vn 1 va Oeite To KAEIOWHEVO TIEPIEXOHEVO
XPNOOTOIWVTAG TO SAKTUAIKS GaC amoTUMWUA.
T Zmv apxikr 086vn, matiote Pubpioeig > KAeidwua 006vng & ac@dheia >
AakTul AoTUTTWHOTA..
7 ZekAelbWoTe CUMPWVA WE TNV KaBopPIopEVN UéB0SO KAEIGOUATOC.
3 v 0B6vn pubpicewv AaKTUN. ATOTUTIOATO, EVEPYOTIOW|OTE TNV eMOUNTH
Aertoupyia:
- Kheibwpa 006vng: yia va Eexheldwvete tnv 006vn He Xprion SaKTUAKOU
QAMOTUTIWHATOG.
+ Kheibwpa mepieyopévou: MpoomeNdoTe MEPIEXOUEVO TTOU EXETE KAEIOWOEL
oto Ahpmoup kat To QuickMemo+ pe To SAKTUAIKG Gag amoTumwua.

Evepyomoinan 00dvng

MMOpE(TE VO EVEPYOTIOINTETE I VA ATIEVEPYOTIOICETE TNV 006VN pEe SIMAS maTnua
TIAVW TNG.

TV apxik 086vn, matriote PuBpioeig > Emektdaoelg > Evepyomoinon 086vng yia
VOl EVEQYOTIOINCOETE TNV EMAOYN.
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5 « Auti n emoyn givat Slabéotun pdvo atnv apxikr 086vn e LG. Aev
Aertoupyei owoTd o€ Kamola E101KN) EQappoyn EKKIVNONG 1} 0TV apxIKn
0B6vn mou éxel eykataoTabei amd Tov Xprotn.

« Ta va matioete v 086vn agng, XenotHomolroTe To SAKTuNd oag. Mnv
XPNOIHOTIOLEITE TO VUXI 0OC.

« Tla va xpnotpomolroete T Aermoupyia Evepyoroinon 08ovng, PePaiwbeite
0TL 0 AlEONTPAG EYYUTNTAG/ PWTIoUOU Sgv epmodileTal amo Kamolo
QUTOKONNTO 1) AAAN §évn ouaia.

Evepyomoinon 086vng
MatAote pe 10 SAKTUNG oag SU0 POPEC 0TN uéon TG 086vVNG.
- Edv matrogte 0T0 £MAvw 1y 0TO KATW péPOg TG 086vNng, 0 Babudc avayvwplong
NG Kivnong evaéxeTal va Inv gival EMOPKAG.

Anevepyomnoinon 006vng

Ayyi€te pe 1o SAKTUNG 0ag U0 Popég MAvw o€ éva Kevd onpieio otnv ApxIKA
086vn kat otnv K\etdwpévn 08ovn.

EvaakTikd, matriote S00 popég o€ évav Kevo XWPO 0T YPAuur KatdoTaong.
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Aertoupyia moAudigpyaciag

006vn MpoécPaTWV XPoEWY
TUPETE TN YPAULK TTAOAYNONG — TPOG Ta TAVW KAl KPATAOTE TV yla va Ogite To
TIPAOPATO IOTOPIKO XPHONG.

Avaduopevo mapdbupo

Mmopeite va avoifete TOMEC eQapuoyég oTnv 006vn Kat va eVAAAICOETTE VKON
QVAUEDA TOUG O€ KAOE OTIYU.

1 ZUpete mpog Ta mavw Kat KpatoTe — amd To KATw PEPOC TS 006vVNG.
7 TNatAoTe To EIKOVIBIO TNE EQAPHOYRC OTNV EMAVW apIoTEPH Ywvia T 086vng
NG EQappoyng kat emAé§Te Avaduopevo mapabupo.
+ AV TIATAOETE TO €IKOVISI0 TNG EQAPUOYNG, EUPavilovTal ol EMAOYEC
MAnpogopieg epappoyrig, MoAamd mapdbupa, Avaduopevo mapdbupo
Kat Kapegito. epap.

3 Hegpapuoyn eppaviletal ue T Hop@r avadudpevou mapabipou otnv 086vn.

np

5 + Autr n SuvatdTnTa evaExETal va pnv givat SI0B€otun O€ 0pIopEVEG
EQAPHOYEC I 0BSVEC.
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Xpnon tou avadudpevou mapabipou
- —:Ehayiotomolei To avaduopevo mapabupo. To avadudpevo mapdBupo
€NOXIOTOTIOIEITAL OTO QlWPOUHEVO EIKOVISIO EQappoyn¢ aTnv 08ovn, To omoio
umopei va petaxivnOei omoudrmote BéNeTe.

« T 1:Enexteivel v epappoyn og mipn 086vn.
« X :Kheivernv epappoyn.

- [0 va PETAKIVAOETE TO avaduopevo mapdbupo: TUPETE TO EMAVW PEPOG TOU
avaduopevou mapabupou.

- Nava puBpioete To péyedog Tou avadudpevou mapabipou: IUPETE TV
aplotepn, T 8e€1d iy TV KATw MAELPA TOU avadudpevou Tapabupou.

E +  Mmopeite va avoi€eTe £wg 5 EPUPHOYEC XPNOIUOTIOIWVTAG TA AVASUOHEVA
mapabupa.

« Ta va eMAEEETE WIa EQAPOYT OTIO TIC AVOIXTEG EQAPHOYEG, TIATHOTE OE
€va amo ta avaduopeva mapdBupa. To emeypévo avaduopevo mapdbupo
£pXETAL OTO TIPOOKAVIO.

+ Taavadudpeva mapdabupa Sev pmopolv va PETaKivBouv oTn ypapun
Katdotaong i otny meploxn T Mpapun morjynon.
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Xpnon tTou @aké\ou e@appoywv yia avaduopeva mapabupa
Av matfjoete — o070 avaduopevo mapabupo, To avaduduevo mapabupo
€NAXIOTOTIOIETOL OTO EIKOVISIO TNG EQAPHOYNG.

Mropeite va LETAKIVATETE TO €lKOViSI0 EQappoyng omoudnmoTe BéNeTe, GUPOVTAG
0.

Eav ehayiotomoinBouv 6o i meplocdtepa avadudpeva mapdBupa, dnuioupyeitat
0 PAKENOC EQAPHOYWV VIO VA TIEPIEXEL TA EIKOVISIA EPAPHOYWV.

E « To €IKoviblo TNG EQapuUOyRG ToU XpnatuomoliBnke mpéoeata
XPNOILOTIOLETA WG TO EIKOVIBI0 TOU PakéNoU pappoywv. Eav matroete oto
€1Koviblo, 6Aa Ta lKovidla yia Ta ehayloTomolnpéva avaduodpeva mapdbupa
eupaviovtal 0To PAKENO EQAPHOYWV.
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DAkeAOG EQAPHOYWV
avadudpevwy
TTapadUupwv

5 « Edv matrioete mapatetapéva Tov QAKENo EQapUOoywV yia avadudueva
TapAabupa Kal GUPETE TOV PAKENO EQaPHOYWY aTnV emAoyn Alaypagn, o
@AaKeNo¢ epappoywv Ba Slaypagei.

« Tlava SlaypAgeTe pia amo TIG EQAPHOYEG ATTO TO PAKENO EQAPHOYWY,
QVOIETE TOV (PAKENO EQAPHOYWY KAl CUPETE TO EIKOVISIO TNG EPAPHOYIG
EKTOG TOU PAKENOU EQAPHUOYWV.
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MoA\amAd mapdBupa

‘Otav XpnOIHOTOIEITE TAOIYNGN HE XEPOVORIEG (o

mpoemAoyn)

1 ZOpete mpog Ta Mavw Kat KpatioTe — amd To KATw PEPOC TS 006vNC.

+ Epgavilovtal ol mpdo@ata XpnolUOTIOINUEVES EPAPUOYEC.

+ AV TIATAOETE TO €IKOVISI0 TNG EQAPUOYNG, EPPavilovTal ol EMAOYEC
MAnpogopieg epappoynig, MoAamd mapdbupa, Avaduopevo mapdbupo
kat Kapegito. epap.

7 TMatioTe T0 £IKOVIBI0 TS EPAPUOYAC OTNY EMAVW APIOTEPR Ywvia TG
€pappoyng mpog mpoRolr) og moMamAd mapdBupa kat emAéETe MoAamAd
mapdbupa.

+ HemMeypévn epappoyn Ba epeavioTei 0To mavw Wiod g 0Bdévng.

3 MatAote 0TV AAn epappoyr o BéAeTe va epgaviletal ota oA\
mapdbupa.

+ HemAeypévn epappoyn Ba peavioTei 0To KATw oo TG 08évng.

‘Otav xpnotponolgite morjynon pe Movo Koupmad
1 Natote ] oty yoapun morynonc.

+ Epgavifovtal ol Ipdo@ata XpNnOILOTIOINUEVEG EQAPHOYEG.

AV TIOTAOETE TO €1KOVIBIO TNG EPAPHOYNAE, ERpavifovTal oL EMAOYEC
MAnpogopieg epappoynig, MoAamd mapabupa, Avaduopevo mapdbupo
kal Kapeito. epap.

7 NatoTe To €IKOVIBI0 TNC EQAPHOYHC OTNV EMAVW APICTEPY Ywvia TG
£@appoyn¢ mpog mpoPoAr oe ToMam\a napdBupa kat eniééte =,

+ HemMeypévn epappoyn Ba eppavioTei 0To mavw piod tng 0Bévng.

3 Matriote oty G\ gpappoyn mou Béete va epaviletat ota moAMamd
mapdbupa.

E « [0 va TpooapUOOETE To pPéyeBOG Twv TUNUATWY 0Tn Slaywplopévn 086vn,
OUPETE TN YPAUMR 0TO KEVTPO TNG 08dvNg.
« [la va amevepyorolroete Tn Aerroupyia moAMam\wv mapaBupwy, GUPETE TV
KEVTPIKI YR TTPOG TA TIAVW 1 KATW WG TO TENOG TG 086vVNC.
+ H duvatétnta moMamwv mapabipwy Sev umooTtnpileTal amé oplopéveg
£QappoYEC LG 1y amo epappoyEg mou kateBadete amo To Play Store.
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Kpumrtoypdgnon kaptag pvAaung
Mmopeite va KpUTTOYPAPHOETE KAl VA TTPOOTATEVCETE Ta dedOEVA TTOU
amoBnKevovTal 0TV KAPTA MVAKNG. Agv givat Suvatr n mpooBacn amo AMn
GUOKEUN 0T KPUTTToypa@npéva Sedopéva otV KAPTa Pvipne.
T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@pdheia >
Kpumrtoypdgnon & diamateutripia > Kpumrtoypdgnon kaptag SD.
7 AlaBAaoTe TV mapousiacn yia Ty KpUItoypaenon TS KAPTAg UvAipng mou
eu@aviCetal oTnv 086vn Kal TatroTe ZUVEXELD YIa VA GUVEXIOETE.
3 Evepyomotjote pia emoyn kat ayyifte Kpunrtoypagnon:
+ Kpumnrtoypd@nan véou apyeiou: yia va KPUTTOYPOPHOETE HOVO
Ta Sedopéva mou amoBnKeUTNKAV 0TV KAPTA PVAHING HETA TV
KpurToypagnon.
+ MAPNE KPUTTTOYPAPNON: VL0 VA KPUTTTOYPAproeTe OAa Ta Sedopéva Tou
lval amoBnKeupéva oTnV KAPTA VNG T SeSopévn OTIyUN.
- E€aipean apyeiwv MOANUPESWV: yia Va KPUTTTOYPAPHOETE OAa Ta apKeia,
EKTOC AMO APXEIN TTONUPESWVY, OTIWG APXEIQ LOUOIKNAE, PUTOYPAPIWY KAl
Bivteo.

E « Mg Eexvrioel n KpumToypdgnon TG KAETAG VNG, OPIOUEVEG
\ertoupyieg kaBiotavral un Stabéotpeg.

« Edv n ouokeun amevepyomnoinBei evw n kpumtoypagnon Ppioketat
o€ e€ENIEN, n Sladikaoia kpurtoypd@nong Ba amotUxel kat evoéxeTal
va KataoTtpagouv oplopéva dedopéva. MNa autd, mptv EEKIVACETE TNV
KPUTTTOypa@non, ENéyETe Katd mooov n oTabun The umatapiag givat
EMAPKNAG.

« Ta KpumToypa@nUEVa apxeia gival TPOoRAaIHa LOVO amd Tn CUOKEUR OThV
omoia £YIVE N KPUTITOYPAPNOT) TOUG.

+ H kpuntoypagnuévn Kapta pvipng dev pumopei va xpnatpomoinbei oe
AMn ouokeun LG. Ma va xpnotoToloETE TNV KPUITTOypa@npévn Kapta
MVIAUNG O€ KATola AN GUCKEUN KIVNTOU TNAEPWVOU, TIPETTEL VOl EKTENEDETE
pop@omoinon TG KApTac.

+ Mmopeite va evepyoTOICETE TNV KPUTTTOYPAPNON TNG KEPTAG PVANG
AKOUA KI OTaV SEV UTIAPXEL KAPTA UVAKING OTN GUOKEUT. KABe KdpTa puviung
iou Ba TomoBeTnBei peTd TV KpuTToypAPnon Ba KpunToypageiTal
autépara.
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AQYn oTiypiotunwy

Mmopeite va SnpioupynoeTe oTtyidTuma TG 006vng mou PAEMETE.

Méow ouvtopguong
MaTAOTE MAPATETAEVA TO TARKTPO EVEPYOTIOINONG/KAEISWHATOC KL TO TIARKTPO
MEILONG TNG £VTAONG X0V TAUTOXPOVA Yia ToUAdxioTov SUo SeutepolemTa.
+ Mropeite va Seite Ta oTiypidtuna 08évng mou éxete Tpapnéel otov GAkero
Screenshots 010 pevoy AApmoup.

Méow ZTiypiotumou 00dvng

Evw BpiokeoTe otnv 086vn To oTiypidTumo TG omoiag BéNeTe va TpaPngeTe,
OUPETE TN YPAUMH KATAOTAONG TTPOG Ta KATW Kal TATHOTE ()

E « o Nemrtopépeleg, avatpé€te 0N evotnTta Anuioupyia ONUEIDOEWY OF va
OTIyHIoTUTO 000VNC.

Eyypagr 086vng

Mriopeite va mpayUOTOMOIOETE £yypagn TnG 08ovng.

T Metagépete T ypappn KaTaotaong mpog Ta KATw yia va avoifete tn Niota
elkoviSiwv ypriyopng mpoéofacnc.

7 (EQv xpelaoTei, mepdoete To SAKTUNO apIoTEPE EMAVW ard T TIEPLOXT TwV
eiovidiwv ypriyopng mpéoBacnc.) NMatiote to koupri (@).

3 AaBaote T SAwon amomoinong eudivng kai matrote Evapén. H kataypagr
Ba &exviioel o 3 Seutepolena.

EmAoynA eutrpdg pop-up Kapepag —l AlakoTTr) yypageig
00:00:05 o P
‘ 20¢
Qpa eyypagrig 086vng Emioyn eyypagng ewvig

+ ‘Otav natdrte 10 9 N EUMPAC pop-up KAWEPA avaduETal Kat 0Tnv
Kataypa@n mepINAPBAVETAL N EyYPAQY ATTO TNV EUTTPAC KAUEQQ.
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4 Nava SlakdYete mpoowpiva Ty eyypaen, matrote (8). To katayeypappévo
Bivteo Ba amobnkeutei 010 ANUTTOURL.

E « Eav mapapiacete ta Sikaiwpata dGAou atépou, omwg to Sikaiwpa
Moptpaitou rj To SiKaiwpa MVEVUATIKAG IS10KTNGIaG 1) SIaBANETE T QRN
AU aTOHOU XPNOILOTIOLWVTAG TIG AEITOUPYIES TTOU TTaPEXOVTal Yia TV
UTINPETIa Kataypagrg 086vng, VEEXETAL VA UTIOOTEITE AOTIKN I} TIOWVIKT
Siwén 1 SIOKNTIKO TPOOTIHO CUUPWVA UE TOUG LOXVOVTEG VOpOUG. H LG
Electronics dev pépel kapiia euBOVN YIa TIG EVEPYELEG TWV XPNOTWV.

Elcaywyn keipévou

Xprion Tn¢ ypaupng epyaleiwv Smart

Mriopeite va xpnotpomnoljoete Slapopeg peBoSouG el0aywyng MANKTPOAoYiou o€
éva Pépog. Mmopeite va emAé€eTe TV emBupnT HéBodo eloaywyng amd To enavw

UE€POC TOU TMANKTPOAOYIOU.

T EmAé€re ™ péBodo eloaywyng minktpoloyiou mou BENETe amo T ypauun
epyoheiwv Smart.

7 Motiote* « - kat emAEETe T péBOSO loaywync mou BéNeTe va eppavileTal

OTNV Ypapn epyoheiwv Smart fi aMa&Te tn Slatagn twv pebddwv elcaywyne.

" (i e e P S | T T T e e |
Tpopu —' e & @ 2 & & - S - I
epYaAgiwv
Smart [ B -]
+* a o
— +

E « Oplopéveg umootnpi{Opeveg pébodot eloaywyng evaéxetal va Slagépouv
avANoYa HE TN GUCKEUN 0ag.
«  MmopeiTe va EVEPYOTTOIOETE 1) VO ATEVEPYOTTOIOETE TN AeIToupyia
YPAUUNG Epyaleiwv Smart amé Ti¢ pubuicel mAnktpoloyiou.
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- ©:Mpoacbrikn emojis.
&5 : Matrote yla va mpooBéceTe Kivoupievo emoticon 1 yla va
SnpIoupynoeTe Ta S1Kd Gag emMoji XPNOIUOTIOIWVTAG TV KAPEPQ.

+ @ : Mriopeite va pnolHomoIoeTe To MANKTPOAGYI0 elkovwv GIF Tng Tenor.
Motrote Amodéxopat yia va XpnoIUOTOICETE QUTHY TN SuvatoTnTa.

« 22 Avolyua ouvopiNiag Draw.

- : Eloaywyn Kelévou pe T Xpron ewvic.

- §63: MpdoPBaon ot pubpioe; Mnktpooyiou.

. :Avotypa tou Clip Tray.

« /P Eloaydyete Kelpevo e ypagpovTag pe To XépL. Amatteitat n Myn twv
SebopéVwY YAWooaG El0aYwYNG yia ypa®n e To xépl. Mathote Aqyn yia
va IPOXWPHOETE 0TN AN Twv S50PEVWY YAWOTOG EI0AYWYRG Yl ypadh
HE TO XépL

- [E): Evepyomoinon Tou atwpoUpEvou MNKTpooyiou 6Tav XPnoIUOTIOIETE
™ A&rtoupyia moAamwv mapabupwv. MIopEiTe EMONG Vo LETAKIVAOETE TO
TANKTPOAOYI0 oty emBuuntr Béon.

. : MaTAOTE yla va XPNOIOTIOOETE TN AEITOUPYIa XEPIOUOU LE TO éva
XépL.

« 1 Narqote yia va ald€ete To péyeBog Tou minktpoloyiou.

. : NaTAOTE Y10 VA IPOCAPUOCETE TN SIAPAVELD TOU TTANKTPOAOYIOU.
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Méow tou Aertoupyia Smart Keyboard

Mmopeite va xpnotpomoloeTe To MANKTPOAGYIO Smart yia Vol EI00YAYETE Kat val
EMECEPYOOTEITE KE(UIEVO.

Meé to mnkTtpoAdylo Smart, umopeite va BAEMETe T0 Keipievo kaBwg mnktpoAoyeite
Xwpig va xpelaletal va evaA\AooEeoTE avApesa 0Ty 080vn Kal To cUMBATIKG
TIANKTPOAOYL0. ME QUTOV TOV TPOTIO, UTMTOPEITE EVKOAX VA EVTOTTIOETE Kall Vol
S10pBwaoeTe AABN eV TANKTPONOYEITE.

Metakivnon tov Spopéa

Mé 1o MANKTPOAGYI0 Smart, WMOPEITE VOl LETAKIVEITE TOV SPopEd aKPIBWE 0N
Béon mou Béhete. Otav MANKTPONOYEITE KeipEVO, ayyi€Te Kal KPATAOTE TO IAKTPO
S100TAHATOC KAt 0TN CUVEXELD oUPETE Se€Id 1y apIoTEPA.

< Smart keyboard >

5 « Auti n emoyn SlatiBetat Povo yia to mnktpoAdylo QWERTY.

Baoikég Aertoupyieg 84



Mpotdoeig Aé§ewv
To mMAnKTpoAdylo Smart avalVel auTopaTa Ta HoTiBa Xpriong 0ag yia va oag
nipoteivel KaBwg MAnKTpoloyeite AEEeIC TTou xpnotpomoleite ougvd. Oco
TIEPIOOATEPO XPNOILOTIOLEITE TN OUCKEUN 0aG, TOOO TIO AKPIBE(C gival oL
TIPOTEIVOUEVEC NECEIC.

MANKTPOAOYNOTE KEIUEVO KAl TTATAOTE TIAVW OF L0 TIPOTEIVOUEVN AéEN 1y oUpETE
amald v aplotepn 1 T Se€1d MAeuPA TOU TANKTPOAOYIOU TIPOG Ta TAVW.

- Eloayayetat autopata n Aé€n mou eméyete. Aev xpetdletat va

TIANKTPOAOYNOETE £0EiG KAOE YpAupa auThG TG AEENG.

Smartphone |; o o, smarphone_ Smari| Sartphones

l'!‘lllllll IIIIIII'!-‘I
T

AvTtiypagn Kot EmKOANGN

Mmopeite va amokOYeTe i va avTlypdPeTe KeiPEVO amd pia epappoyr Kal, otn

OUVEXELD, Va EMKONOETE To Keipevo otnv idia epappoyn. H, umopeite va avoifete

AN\EG EQAPHOYEG KAl VO ETTIKONOETE TO KEIUEVO OF AUTEG.

T Notote mapatetapéva oe éva onpigio KOVt 0To Keipevo Tiou BEAETe yia
QaVTLYpa@r iy amoKor.

7 S0pete ta dpla @/ B yia va oploBeTroeTe TV epIoyr TIou Tipoopiletat yia
avTlypa@n i amokorr.

3 Em\é€e eite Amokom eite AvTiypagn.
« To keipevo Tou éxel mMAEYE( Yl avTlypagr 1} ArmoKom mpooTifeTal

autépata oto Clip Tray.

/. NatAote mapatetapéva 1o mapdbupo El0aywyrS KEMEVOU, Kal EMAEETE
EmkoMnon.

« Edv bev umdpyel oTolxEio TIOU EXEL EMAEYED yla AVTLYPAPH 1) ATTOKOTT, N
emMoyr EmkoAnon Sev Ba epgavietar
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Kown xprion mepiexopévou

Avanapaywyr mepLEXOHEVOU ammo AAAN cUGKEUN

Mriopeite va mTpayUOTOTOICETE AvVAIapaywyr GwToypapLwy, BIVTEO 1) LOUGIKAG

TIOU €XOUV AMOBNKEUTEL GTN GUOKEUN OO pia TNAEOPAON.

T Zuvbéote v tn\edpaon kal T cLoKeLr oTo i61o Siktuo Wi-Fi.

7 Evw yivetai mpoBoi meptexopévou amd Ty epappioyr AAUmoup f Mouoikr
natote 1o kouuni Cg R + > Avamapaywyr g GAAn GUOKEUR.
'H, otnv apykn 006vn, matote > Pubuioeic Zuvdedepéveg cuokevég > Koy
XPrion 080vng kat petd motioTe Y10 Va TNV EVEQYOTIOIOETE.

3 Em)\é€te Ty tNAedpacn otnv omoia OéNeTe va ouvSeDsite.

« Ta xprion pe ouokeury Chromecast, ot unpecieg Google Play mpémet va givat
EVNUEPWHEVEG.

MpoBoAn mepleXOHEVOU AMO KOVTIVEG GUOKEVEC
Mriopeite va Seite mepiexdpevo amd SIAQOPES GUOKEVEC, TL.Y. UTTOAOYIOTH, GUOKEUN
NAS 1} opnTr) GUCKEUN, XPNOIHOTOIWVTAS TIG EPAPHOYEG AApTOUU i} MOUOIKH.

Z0vbeon TwV CUCKELWY

SUVOEOTE TN GUOKEUN 0OC Kall Lot GANAN CUOKEUH TTou umooTnpiel Tnv unnpeaia
DLNA oo {610 acUppato Siktuo.

+ BePaiwBeite 6T n Aertoupyia kovng xpriong apxeiwv (DLNA) ivat
evepyomoinuévn Kat otn SIKr) 0ag GUCKEUN Kal 0T OUVSESEUEV GUOKEL.

Avalitnon KovTivwv GUCKEVWV

Mrmopeite va Seite pia AioTa pe Tig ouokeuég DLNA mou gival ouvdedepéveg oto
{810 SikTUO EMAEYOVTAG TO pevoU = > KovTIvég GUOKEUEG OE KABE EQappOYN).

XPNOIUOTIOIOTE TO TIEPIEKOUEVO ATTO TIG KOVTIVEG OUOKEVEG OTwG Bal TO
XPnotpomolovoate v PPIokATAV 0TN SIKN) GAG GUOKEUN.
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AmootoAi ) AjYn apxeiwv
Mmopeite va KAVETE Kolvr) Xprion apxeiwv HETAE TG GUOKEUNG 0ag Kat AANG
OUOKELNG LG 1 evog tablet.

AnooToln apxeiwv
An6 to Ahuroup 1y ané GAAn epappioyn, tatiote + > Kown xprion 1 «< kat
eMAEETE Hia ouoKeLr amd T NoTa KOG Xpriong apxeiou.

AAYn apyeinv

TUPETE TN YPOAUUN KATAOTAONG TPOG Tal KATW Kal TaTAoTe To Koupri Kowviy Xprion
Apyxeiou.

Eav n ouokeun oag dev umootnpilel TV Ko Xprion apxeiwy, oTnv apxIkr
0606vn, matrjote Pubpioeig > Tuvdedepéveg ouokeuég > Koviy Xprion Apyeiou >
SmartShare Beam

+ Mmopeite va HolpAaleoTe apyeia e CUYKEKPILEVEG CUOKEUEG TIOU
umootnpiCouv DLNA.

Mnv evoxAeite
Mriopeite va TIEPLOPICETE 1) VA ATIEVEPYOTIOINTETE TIC EIGOTOINTELC IO VA NV GOG
€VOXAOUV Y10 €VO GUYKEKPIUEVO XPOVIKO SIAoTnua.
SV apxikr 086vn, matriote PuBpioelg > 'Hyog > Mnv evoyAeite.
- Nerroupyia Kat emAEETe TN Aertoupyia mou BéeTe:
- Mdvo mpotepatdtnta: mpaypatomoleitat Ajyn idomotioewy Ke fxo f
86vnon yla TIG EMAEYUEVEC EQAPUOYES. AKOUN KL dTaV €ival evepyomoinpuévn
n emoyr Mdvo mpotepaldtnTa, e§akohouBolv va nxoLv e150moINCELG.
- Tuvolikd aBopufo: amevepyorolei Kat Tov X0 Kat T dovnon.
- Emoyn mpotepatotritwv: AdBete £160MOINTELC Kal TIG ELSOTOINCELS YIa TIG
EMAEYUEVEC EQUPHIOYEC.
- K\jogig amd: Pubpiote pia ogipd eidomonrioewv Katd T APn KAogwv.

E « Emavalappavopevn kKhjon: Méoa o€ 15 Aemtd, n SeUtepn kKAon amd tov
{510 kahoUvTa Sev gival olwmnEN.

Baoikég Aertoupyieg 87



- Mnvupata amd: PubpioTe pia ogipd eiomotogwy Katd T AMin unvupdtwy.
« Xprion Mnv evoyAeite: Evepyomolnote T Aettoupyia Mnv evoxAeite.
+ Yrvog: OpioTe To MPOYPApKA Yia TO OTToi0 BENETE Va EVEPYOTIOIOETE TN
Aertoupyia Mnv evoyheite.
- BonBeia: MpoPoln ¢ BorBeiag yia ™ Aettoupyia Mnv evoyheite.

AOD (Always-on Display)

Mmopeite va Seite TNV nuEPOUNVia, TNV WPA 1 TV UMOYPAPR OTAV N KEVTPIKNA

0606vn eivat oBnotn.

JUPETE TO KATW PEPOC TNG 006vNn¢ Always-on Display yia va evepyomolroete

Aettoupyieg 6mwg n kapepa, To Capture+, To Wi-Fi, ot puBpioeig hyou, to Bluetooth,

TO QAAG, N HOUGIKI KAl AN

T Zmv apxikr 086vn, matiote Pubpioeig > MpoBohr > AOD (Always-on
Display).

7 Em\é€te v edva mou Bélete va epgaviletal kai matriote AmoBrikeuon.
+ MatAoTe TV EMOUUNTH €IKOVA PETACY TV EMAOYWV Wn@lakd poAdt,

Avaloyiko pohol, Aimho poldl, Ymoypaen 1y Eikéva.

Matote Epgavion kai emAé€Te MatioTe yia va epgavioTei yia 10
Seutepolenta ri Na epgavilerar mavra.

Matiote IpriyopaEpyaleia & mpoypappa avamapaywyng HOUGIKAG yia
VQ TTATACETE TA EKOVISIA KATAOTAONG YO Ta EPYAAEIN YPriyopNG EKTUTTWONG
Kalt To Mpdypappa avamapaywyrg HOUCIKAG.

[0 va eVIoXUOETE TN wTeVOTNTA Yia Tn Suvatdtnta Always-on Display,
emAé€te Mo @wtevr 004vn.

« NavampoPdAete ™ BoriBeta yia Ty Suvatdtnta Always-on Display,
notote BonOeia.

E « H pmotapia evdéxetat va e§avtAnBei ypnyopotepa £Gv XpNOIUOTOLETE TN
Aertoupyia Always-on Display. Amevepyomolrjote autrv T duvatdtnta yia
va e€olkovoprioete Sidpkeia {wiig TG pmatapiac,

« Tla va amevepyormolroete tn duvatotnta Always-on Display, oTnv apxikr
086vn, matriote PuBpiceig > MpoBoAr > AOD (Always-on Display) kai, otn
ouvéxela, matrjote @ ).
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Xpnoipeg
EPAPHOYEG



Eykatdaotaon Kal aneykataotacn
EPUPHOYWV

Eykatdotaon epapuoywv
Mrieite o€ éva KATAoTNHA EQAPHOYWV Yia va avalnTAOETE KAl Va KATERAOETE
EQAPHOYEG.
« Mropeite va xpnotporotfjoete 1o SmartWorld, To Play Store fj To katdotnpa
EQAPHOYWV TOU TIAPOXOU UTINPECIWV.

E + [lo opIopEVa KATAOTHHATA EQAPHOYWY EVEEXKETAL VA AmaITETaAL N

Snuioupyia Aoyaptacpou Kat n o0vSEan O QUTOV.

+ Tl0 OPIOPEVEG EQOPHOYEG EVOEXETAL VA UTIAPXEL XPEWDT.

« Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN Xprion Sedopévwy, avaloya HE To TPOYPAUMA XPEWTEWY
TIOU €XETE EMMEEEL

+ HAerroupyia SmartWorld evééxetat va pnv umootnpietat avaloya pe Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Katdpynon eyKatdotaong eQappoywv
Katapynote amo Tn OUOKEUN 0ag TNV EYKATACTAC EQAPHOYWV TIoU Sev
XPNOUOTOLOUVTAL TIAEOV.

AMEYKATAOTOON PE MAPATETAMEVO AT A
MoTAoTE TAPATETAMEVA OF HI0L KEVE TIEPLOXT) OTNV 08OV KAl 0TN OUVEXELD TIOTAOTE
10 € TG £Qappoyn¢ o BéAeTe va SlaypayeTe.

Ameykatdotaon He XPron Tou pevol pubpicewv
SV apxikn 086vn, matriote PuBpioelg > Epappoyég > MAnpogopieg papuoyng,
€MAEETE Lla eappoyn Kat matriote Katdpynon eykatdotaong.

E « Aev gival Suvatr n KATAPYNON OPLOUEVWY EGAPOYWV OO TOUG XPHOTEG.
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Katdpynon eykatdotaong epappoywy amd 1o Katdotnpa
EQAPHOYWV

Mo va KaTapyHOETE TNV EYKATACTACN HIAG EQAPHOYAG, UMEITE OTO KATAOTNHA
EQAPHOYWV ATTO TO OTTO{0 KATEBACATE TNV EQAPHOYN KAl KATAPYAOTE TV
€yKATAoTAOH TNC.

Eykatdotaon Kat Katapynon eyKataotaong EQapUoywyv
KaTd T pLOuIon

‘OTaV EVEPYOTTIOIEITE T GUOKEUN IO TIPWTN YOPJ, UMOPE(TE va KATERAOETE TIG
TIPOTEIVOUEVEC EQAPOYEC.

Mmopeite va TapaKAUYETE AUTO TO BrKA KAl VA TIPOXWPNOETE OTO EMOUEVO XWPIG
V0l EXETE OAOKANPWOEL TNV EYKATACTACH.

Zkoumibia epappoy.
Mriopeite va Seite TIC epapuoyég ou €xouv ameykataoTtabei. Emiong, pmopeite va
EMAVEYKATOAOTHOETE TIC EQAPLOYES TTOU £XOUV aMEYKATAOTABE! TIC TEAEUTaES 24
WPEG.
T Zmv 0Bovn apyikn, matiote LG > Zkounidia pappoy..
Mmopeite akopa va ayyi€eTe pia Kevr TIEPLOXH 0TNV apxIKr 086vn Kat va thv
Kpatroete ayyi(ovtag To Koupni Zkoumidia epappoy.
7 Evepyoroinon emBuuntric Aertoupyiag:
+ Emavagopd: emaveykataotaon eMAEyUEVNG EQAPOYAC.
- {II] : KATAPYNOTE MOVIPIA TIG OMEYKATETTNLEVES EQAPUOYEC ATTO TN GUOKEUN.

E Ol ameyKaTeoTNUEVEG EQAPHOYEG KATAPYOUVTAL AUTOUATA OO T CUCKEUN
24 MPEC UETA TNV ameyKaTdoTaor) Toug. Edv BéAeTe va eykataoTrioete Eava
TIC AITEYKATEOTNHEVES EQApPLOYEC, Ba mpémel va Ti¢ katefdoete Eava amod To
KOTAOTNUO EQOPHOYWV.

+ Auti n Aettoupyia givat vepyoroinpévn HOVO 0TV MPOEMAEYHEVN APXIK

006vn. Edv ameykabloTdte eQappoyEG Katd tn xprion tng 08évng EasyHome
1) GANOU TTPOYPANHOTOG EKKIVNONG, AUTEG KATAPYOUVTAL ad T GUCKEUN
QMEOWG KA HOVIPAL.

XPAOIUEG EPAPHOYEC 91



ZUVTOHEVCELG EPAPHOYWV
TNV apxIkr 086vn, ayyi€Te Kat KpATHOTE MATNHEVO £val €IKOVISIO EQaPHOYNG,
onw¢ Ta eikovidia KAron, Mrivupa, Kapepa, ANumouy, PUBICELG, yia va eavioTei
70 avTioTolyo Hevou ypriyopng mpdoPaong. Kavte mo 0koAn T xprion
EPAPHOYWV A&IOTOIWVTAC TIC CUVTOHEVTEIS EQOPHOYWV.

+ NatAote &) yia va pubuioete Ta widget yia Ty epappoyn.

+ Matiote (§) yia va Seite TIg TANPOPOpiES TG EQAPHOYAG.

E + Autij n Suvatdtnta givat S1aBE€otn MOV Yia GUYKEKPILEVES EQOPHOYEG.
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TnAépwvo

OwvnTikn KAjon

MpaypatomoloeTe TNAEQWVIKY KAON XENOILOTTOIWVTAG KATTOLA OO TIG
Slabéoipeg peBddoug, Gmwg TNV MNKTPOAOYNoN Tou aplBoU TNAEPWVOU HE TO
XEPL, Kat emAéyovTag pia emagr amd tn Aiota enagwv 1 T Aiota mpdo@atwy
KA OEWV.

Mpayuatomoinon KAGng amo 1o MANKTPoAGylo
T Zmv apxiki 086vn, matiiote (B > KAfjon.
7 MpaypatonolfoTte pia KAon xpnotpomolovTag t uébodo e emhoyrg oag:
« TAnktpoloyaTe évav apiBud TAe@wvou kai matiote To koupri (®.
« Ayyi€te Kat kpatoTe €vav apiBpd taxeiag KAong.
+ AvalnTAOTE Hia EMOQH TTATWVTAG TO APXIKO YPALA TOU OVOUATOG TG
EMAQPNE 0TN NOTA EMAPWY, KAl TIATAOTE TO KOUTT Q

E « [la va eloaydyete 1o oUPPOMO «+» OTav mpaypatomoleite SieBveic KAOELS,
TIOTAOTE MAPATETAPEVA TOV APIOPO 0.

« BA. [lpoafikn ema@wv yio NemTOUEPELEG OXETIKA LE TOV TPATIO TPOOBRKNG
apIBuWV TNAEPWVOL GTN NioTa HE TIG Taxeieg KAOELC.

Mpayparomoinon KAoEwVY amo emagEg

1 v apxii 086vn, matote (B> Enagéc,

7 A@oU emAéEeTe Tov apIBPO TIoU BENETE val KAONEDETE a6 TN AioTa EMOPQY,
natiote &..
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Amndavtnon o€ KA\fjon

M0l VOl amaVTAOETE O€ Jia KAON, CUPETE TO KOUWTTE Q 0NV 006VN EL0EPXOUEVNG
Khnonc

‘Otav gival ouvSedepéva Ta OTEPEOPWVIKA AKOUOTIKE, UMTOPEITE va
TIPAYHATOTOIEITE KAOEIG XPNOUOTIOIWVTAG TO KOUTT KAYONG/TEPHATIOHOU
0TO OKOUOTIKG.

Mo va TeppatioeTe pia KAon xwpig va k\eioete Tv 08vn, matrote Sladoxika
PuBpiogig > Aiktuo & internet > PuBpiceic kK\jogswv > Amavtnon Kat
TEPUATIOHOG KAJOEWV Kall, 0TN CUVEXELD, EVEPYOTTOIOTE TN SuvaTtotnTa
Teppatiopdg KAjoNnG pe To mMAKTpo Tpopodoaiag.

E « Xnv apxikr 086vn, matrote PuBpioelg > Aiktuo & internet > PuBpioeig
KAOEWV > ATAVTNON KAl TEPUATIONOG KARGEWV > TEPUATIONOG
KAjoNnG pe To MARKTPO Tpogodoaiag kal Ba umopeite va Teppatioste
ot KAjon mativTag To MARKTPO KAEIGWHATOG/evepyomoinong 600 &ival
evepyomoinuévn n 08évn kKA\ong o€ EENEN.

Anéppupn KArjong
Mo va amoppiPete pia el0epXOMEVN KAON, CUPETE TO KOUTT ° otnv 0Bovn
E€10EPKOHEVNG KAONG.
Mo va oteilete éva privupa amdppiyng, CUPETE TV EMAOYH PNVOHOTOG
anoppltl)nc o€ OAn TNV 086vN.

« TampooBrikn n eme§epyacia pnvupatog améppupng, oTnv apxikr 086vn
matrote Pubpicelg > Aiktuo & internet > Pubpioeic kAoewv > Opayn
KAoNG Kat améppPn HE PAVUHA.

+ Katd tnv eloepyopevn KAon, MAtRoTe To MARKTPO alénong Tne évtaong
X0V, TO MAKTPO HEIWONG TNG €VTAONE XOU 1 TO MARKTPO evepyomoinong/
KAEISWUATOG Yial 6iyacn Tou fXou KARoNG 1 TG 6vnong 1y yia 6éon g kARong
o€ avapovh.

'EAeyxo¢ E10€pXOMEVNG KANGNG EVW N e@appoyn BpiokeTal
o€ Aertoupyia

OTav €XETE 0 EI0EPXOUEVN KAON EVW XPNOILOTIOLEITE Hia Epappoyr, Ba
EUPAVIOTEL i avaduopievn €160moinon 0To EMAvw PEPOC TG 006vng. Mmopeite
va SeTElTe TNV KAON, VAl TV amoppieTe 1 va OTENETE purivupa amd Ty
avaduopevn 00ovn.
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5 TtV apxiki 086vn, matrote > Pubuiocelg Aiktuo & internet > Pubpiceig
kAjoewv > Mpo6aBeteg pubpioeig > MAaicio avaduong l0pXOUEVNG
KAong kat mMAEETE Tov TPOTTO TIou BEAETE val eppavileTal n El0EpKOHEVN
KA|on 6TV XPNOIUOTIOIEITE UIa EQAPHOYY].

MpoBoAr avamavinTwv KAoEWV

Eav undpyel avamavintn KAon, n YPAUr Kataotacng 0To EMavw HEPOG TG
086vn¢ eppaviCer v €voeign X,

lNa va Seite oTolXEl YIa TIC AVATTAVTNTEG KA OELG, CUPETE TN YPAUUK KATAGTAONS
TPoG Ta katw. Mmopeite emiong va matroete (§ > Apxeia katayp. KAfo. oTnv
apxikrj 08ovn.

MpooBdoipeg Aertoupyieg katd tn Sidpkeia KARong
Kata tn Sidpketa piag kKAjong, pmopeite va éxete mpdofaon oe 0o
AEITOUPYIWV TTATWVTAG TA KOUUTIA TToU gpgaviovtal otnv 086vn:
Emagéc: Seite T Niota emaguwv katd T Stdpkela piag KAjone.
Avapovny: Balet tnv Tpéxouca KAON O avapovn.
MANKTP: yla va eUQavioeTe 1 va KPUYETE TO TANKTPOAGYIO KAONG.
Hxeio: yia va evepyomoiioete Tn Aettoupyia nyeiwv.
Ziyaon: yla va TpayuaTomoIoeTe olyacn 0To HIKPO@wVE 0ag €101 WOTE N
QWVN} 00C VA LNV OKOUYETAL OTOV CUVOUIANTH 0ag.
Bluetooth: mpowBroTe Tnv kKAron o€ Wia ouleuypévn kat ouvdedepévn
ouokeun Bluetooth.
. ° 1yl0 VO TEQUATIOETE TNV KAjon.

: :mip6opaon oe MPOBeTeC eMAOYEC KAFONG.

E - Ta 8l0Béoipa otolyeia pubpicewv evdéxetal va Siagépouv avaloya pe Ty
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.

XPAOIUEG EPAPHOYEC 95



Mpayuaromoinon TpiUePoUE KARONG
Mriopeite va mpayUaTomoIoETe KAMON G€ AN EMAQR Katd T SIGEKELD oG
KAjong mou Bpioketat o€ eEENEN.
T Katén 8idpketa piag kAfong, matfote to kouprni : > Mpoodrikn kKAjong.
2 Mnktpohoynote évav apiBpd TAepwvou kat athote To koupri .

+ O16vo K\joelg eppavifovtal oTny 086vn TauToXPOVa Kal N TPWTN KAjon

Umaivel o€ avapovn.

3 Tiava EekivAoeTe pia kAo ouvSIdokePng, ayyi€te Zuyxwveuon.

E « Ta kaBe KArjon evdExeTal va IoXVEL XpEwan. MNa TIEPIOOOTEPEG TANPOYOPIES,
OUMPBOUNEUTEITE TOV TAPOXO UTINPECIWV.

MpofBoAn apxeiwv KAfoEWV
Mo v mpoBoAr) Twv apxeiwv MPAoPaTWV KAGEWY, 0TNV apxIKf 006vn TaTHoTE
> Apxeia katayp. KAAo.. Emerta, Pmopeite va XpnolOTOIOETE TIG TOPAKATW
\ertoupyieg:
« Tava Seite AemtopepéC I0TOPIKS KAoEwy, eMAEETE ia emagn. MNa va
TIPOYMATOTIOICETE Ia KAON TTPOC TNV EMAEYMEVN EMAPH, TIATHAOTE TO KOUTTE

- T va Slaypaete apyeia KAjoewy, TOTHOTE + > Alaypagn.

E + H Sidpketa K\jong mou epgaviletal evoéxeTat va Slagépel armo Tn SIdpKela
L0l TV OTToial XPEWVEDTE. [1a TIEPICOATEPES TTANPOPOPIES, CUMBOUNEUTEITE
TOV TIAPOYO UTTNPETLWV.

« Aev gival Suvatr N amoKaTAoTaAoN TOU SIAYPAUUEVOU IOTOPIKOU KANOEWV.
« [la va TpocapUOOETE To péyeBOG YPAHOTOOEIPAG TwV NUEPONOYiwV
KAOEWV 1} TwV EMaQWY, TETE pe SUo SayTula fj am\woTe Ta SAXTUNA oag.

Alopdép@waon Twv emMAOYWV KARONG

Mrmiopeite va puBpioeTe Ti SiIdQopeg emAoyEC KAONG.

T Zmv apxikr 0086vn, matiote (B > Khjon 1y Apxeia katayp. KAAG..

7 Natiote 1o koupni : > PuBpioeig KANfoEWY Kay, EMElTa, SIapopeUOTE TI
EMAOYEC CUUPWVA LE TIG TIPOTIUINCELG 0AG.
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MnviOpata

AmooToA pnvUpaTog

Mriopeite va SnpIoupynoeTe Kal va OTEINETE UNVUKATA OTIC ETAPES 0O
XPNOIOTIOIWVTAG TV EQappoyn «Mnvipata.

E « [0 TV amooToA UNVULATWY 0TO EEWTEPIKO EVOEXETAL VA LIOXUOLY EMTMAEOV
XPEWOELG, M0l TEPIOOOTEPES TANPOPOPIES, CUMPBOUNEUTEITE TOV IAPOXO
UTTNPECLWV.

1 Zmv apxikn 066vn, matriote ).
2 Natiote 1o koupni Cham-
3 Opiote mapaAATTTN Kat SNUIOUPYHOTE £val VLA,
+ T va XpNOIHOTIOAOETE TI EMAOYEC TONUHEOWY, TIATHOTE ().
+ [0l va amoKTrioeTe MPOGPaoN O TPOALPETIKA OTOIKEID LEVOU, TTATHOTE TO
Koupi «.
/A EmAéEte To B> (AMooTOM) yia va OTEINETE T urivupa.

Avayvwon pnvopatog

Mriopeite va Seite T pnvupaTa ou €XeTe AVTAANAEEL avA ETOQN.
1 Zmv apxikn 066vn, matriote ).

7 Em\é€te wa emagr armo tn \ioTa pnvupatwy.

E « ‘Otav Bpiokeote 0T AioTa pnvupdtwy fj o€ éva mapaBupo cuvopiNiag,

UMOpE(Te va pUBICETE To PéyeBOG TNG YPAUUOTOOEIPAC av BAeTe SUo
SayTuha otV 086VN Kal T AMOUAKPUVETE 1) TANCIACETE PETAEY TOUG.
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Alapdpewaon Twv pUBUIcEWY PNVUHATWV

Mrmopeite va aM3EeTe TIC pUBITELC aVTAMAYNG UNVULATWY TOL WOTE VAl
QVTOTTOKPIVOVTAL OTIG TIPOTIUACELG.

1 Zmv apxixr 066vn, matriote ).

7 Natiote o koupni + > PuBpioeig amd Tn NoTa MvupdTwV.

E « Mmopeite va em\é€ete puBpITELC yia To TapaBupo E150TOINCEWY, TOV
amoKAEIOS KAOEWY, TNV EI80TTOINGN KATAGTPOPNAG, TA NvUKATa
TIONUUEOWY, KT,

Kapepa

Ekkivnon ¢ kapepag

Mriopeite va TpaPriete pwtoypagia ry va eyypavete Bivieo yia va anabavartioete
OMeG TIG a€€XQOTEC OTIYUEG OQG.

TV apyikr 066vn, matriote ().

E « Tlpv amd T Aqyn HIag puwToypagiag 1 Tnv eyypaer evog Bivieo, okoumiote
TOV QOKO TNG KAUEPAG HE Eva amalo mavi.

+ TPpooéTe va pnv AeKIACETE TOV QAKO TNG KAHEPAG HE Ta SAXTUAG oag 1) GNn
&évn ouoia.

« Ot IKOveg ou mepIAapBavovTal G€ auTd To EYXEPIBIOo XPriong MMopEi va
Sla@éPouV amod TNV MPAYHATIK) GUOKEUN).

« Mmopeite va mpoBANETE Kal va EMEEEPYAOTEITE TIC YWTOYPAPIEG KL TAL
Bivteo péow Tou ANumoU. Mo AemTopEPELES, VaTPEETE 0TV EVOTNTA
Emokdmnon epappoyn¢ AAumouy .

+ Mnv XpNnOIHOTIOIEITE AUTO TO TIPOIGV IOl GKOTIOUG TIOU EVOEXOHEVWG
mapaptalouy To ISIWTIKO andpEnTo 1 Ta SiKalwpata GAAwV.
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Aqn ewtoypapiog
Mriopeite va TpaPrEeTe QTOYPAPIES HE TV KALEPA GTO TIPOIOV.
1 NatAote (5) kat e0TidoTe 070 Bépa oag.

« Mmopeite va ayyi&ete T 086vn 0To B€pa yia va £0TIAOETE € QUTO.

+ Mmopeite va avoiete 1 va evwoete Vo ddyTula yla peyébuvon f
Opikpuvon.

2 MNatfote @ yia va Bydhete pia pwtoypagia.

+ Mmopeite emiong va matroeTe To MAKTPO avénong TG EVtaong fxou 1y 1o
TIANAKTPO HEiwong TG évtaong fXoU yia va TPaPHEETE pia wToypapia.

+ Mnopeite va TparEeTe pia wToypagia eVw YPAPETE BivTEO TATWVTAC TO

© oTnVv 0Bévn.

+ Otemhoyég mou epgavifovtal otnv 086vn AMPng evdéxetat va Slagpépouv
avahoya e TV EMAEYUEVN KAPEPA (UMPOOTIV 1) TTHOW) Kal TN A&ttoupyia
Kduepag.

+ Hkapepa Ba anevepyomoinOei autdpata av Sev TV XPNOIHOTOIOETE yia
Niyo HETA TNV eKTENEDN TNG EPappoyic Kapepa.

Egappoyr| epé @iATpou
Opiowbg avatoyiov AMNayr pubpicewv gAag

o0Bovng

OpIoPOG ETTIAOYWY ——)
KapEPaAg

&—— AMayn puBpioswv
XPOVOUETPOU

EmAoyn peTagl TuTrikig
ywviag x1.0 {oup/TuTTIKAg
ywviag x2.0 {oup/eupeiag
ywviag x0.5 {oup

Evepyotroinon - & — Avolyua Tou Google Lens
duvatdtntag Al yia
QUTOOTN EQAPHOYH
i "
péloaleot vt O EvaMlayi erat
UTTPOCTIVAG Kal TTow

Kapepag
AQYN QWTOYPAPILIV

Avolypa cuhhoyng
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5 + Mmopeite va eKTENETETE TNV EQapUOYH KAUEPAG TTATWVTAG Ypryopa SUo
(QOPEG TO TIAKTPO TPOYodoaiag. ETnv apyikr 08ovn matrote Pubpiceig
> EmeKTao€1g > ZUVTONEVOEIG Kall, 0T OUVEXELD, TATHOTE Avolypa
Qwtoypa@ikiig MnXaviig yia va Ty EVEPYOTIOIOETE.

+ ‘Otav n 086vn €ivat amevepyomolnuévn 1 KANESwEVN, HOpE(Te va
EKKIVIOETE TNV KAUEPA TTATWVTAS SU0 POPEG TO MARKTPO MEIWONG
NG évtaongc. Ztnv apxikr 08ovn, matrotePubuioeig > Emektaoeig>
ZUVTOHEVTEIG Kal, OTN GUVEXELD, TATHOTE Avolypa OwToypagIKng
Mnxaviig QD) yia va Ty evepyomoIfoETE.

Mpocappoyn Twv emAOywv TNE KAPEPAS
Mmopeite va mpooappooete mMARB0G emMAOYwY KAUEPAG avAAoya HIE TIG

TIPOTIUNTELG 0AG.

Ayyi&te To koupmi §33 otnv 086vn.

E « O18100¢01pec emMoyég Slapépouv avaloya Ke TV eMAeypEVN (UmpooTvi iy
TMow) KAUEPa Kal TV MAeypévn Aertoupyia Kapepag.

Autopatn AvayvwpilovTag Tn oknvi TG omoiag yivetat yypagn,
BeAtiwon oknvig £@appolel Tn BéNTIOTN PUBMION avauong auTopaTa.
TUvBeon Me Teyv. AvayvwpiCovtag Tnv avBpwrivn @ryovpa Katd T Angn
Nonp. Moptpaitou, ouviotd T BéAtiotn olvBeon.
. EiSomolei Tov xpriotn otav Ta pdtia tou Bépatog eivat KAEloTd
TupBoulég . L , , .
1| 6tav N €IKova eivat BoAr yia BEATioTn QwToypdgion.
Méyebog Yag emrtpénel va eMAEEETE To péyeBog TG pwToypagiag Kat
puroypagiag v avaloyia Sl0oTacEWV.
TpaBa putoypagieg pe {wnpd xpwHata Kat Snpioupyei pé
QAVTIOTABIONG aKApa Ki Tav ol pwToypagieg TpaBiovvtat
HDR HE KOVTPA PWC. AUTEG O AEITOUPYIEG TapéxovTal amod TV
Texvohoyia uPnAou Suvapikou elpoug (HDR) pe Ty omoia
eival e§omAiopévn n Kapepa.
Ai6pOwon
mapapdpewong Al0pBuwvel TNV Mapapop@wan 08évng Katd ™ Aqyn
e€alpeTIka PWTOYPAPIWV UTTEP EVPEING ywviag.
£UpLYWVIAE AYNG
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E€olkovopiei amoBnkeuTiko xwpo oupmélovTag To apyeio

::I(;enxsuon we €1kdvag o€ poper HEIF. ANEG GUOKEUEG evOEXETAL VA NV
umootnpiCouv apyeia eikévag oe poper HEIF.
Zwvtavi Kataypayte tn Spdon mptv Kat META T Ayn piag
puwroypagia PpwToypaPiag.
Opiel 6T n kApePa Ba MapaApEVEL EOTIOOHEVN OTO
Mapakohovbnon QVTIKEiMEVO TTOU ayYileTe 0TV 000V, AKOUN KL av QUTO
gotiaong Kiveital. (AlatiBetal dtav XpnoIHOMOIETal N KAMEPQ LE TOV
TUTTIKO QAKO.)
Epgaviote otnv 006vn kaBodnyntikd méyparta yia Aqn
Méypa PWTOYPAPIWV 1) Eyypan Biveo Pacel Twv opI{OvTIwy Kal

KATOKOPUPWV YPAUUWY aVAQOPAG.

Epappoyn 'Cheese'

Yag Sivel tn Suvatotnta va TpaPreTe wa pwtoypagia
Aéyovtag ‘Cheese; 'Smile, ' Whiskey; ‘Kimchi' i 'LG'

Mpoobnkn
udatoypagrpatog

EpgaviCel éva udatoypd@npa 0TI pwToypapieg

TomoBeaia eTIKETAC

AmoBnkevel TV eikova elodyovtag Ta Sedopéva Tomobeaiag
GPS.

Em\é€te edv BéNeTE va amoBNKEVETE TIG WTOYPAPIES KAl

Amnobrkeuon Ta Bivteo otov Eowtep. amob. xwpog 1y otnv Kdpta SD.
(AwatiBeTat 6tav €xel TOmoOeTNBEl KAPTA UVANG).
Bonfsia Mapéxet BorBeia yia KABe pevou TG KAUEPAG.

MpdoBOeteg emAoyég 0TV PMPOCTIVI KAPEPQ

A6pBwon

TapapdpPwong A10pBuwvEL Ta TAPAUOPPWUEVA UEPN TOU TIPOCWTIOU.
Selfie

Amnobrkeuon ATOBNKEVEL TIG EIKOVES WG AVESTPAUHEVEG KATA TNV AN
avaoTPOYNG iag selfie.

selfie Tpapréte pia selfie emAéyovtag eite Aqn pE XElpovopia

XEPLoU ite Autdpatn Aqyn.

XpriolpeG papuoyeg
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5 « Mmopeite va eQpapuooETe To £9€ pakiylad otav tpafdre pia selfie
XPNOIHOTIOIWVTAG TN MMPOOTIVA KAUEPQ.
« HARYN pe xepovopia XEPIOU EKTENEITAL UE AVAYVWPLON TOU OXHOTOG EVOG
XEPLOU Kat n Autopatn Mjgn Yivetal pe avayvwplon VoG TPOCWITOU.

EmAoyn Aettoupyiag

Mriopeite va eméyete UKONA TN AelToupyia mou BENeTe amo TIC AerToupyieg mou
eppavifovtal otnv 08évn, ot omoie EMAEyoVTal GUUPWVA HE TO TTEPIBANOV
Mune.

Natiote (=) kal 00peTe TIC Aertoupyieg TG KApePac aplotepd  8e€1d 1 0UpETE TV
086vn aplotepd 1y 5e€1d yia va emAECETE pa AerToupyia KAPEPAG.

e — /eIToupyieg
KAPEPOAG

Xprion A&lToupylwv KAMEPSG
Eyypaon Bivteo pe Xpoviopo

Mriopeite va mpaypoTomoloeTe eyypaer Bivieo Xpoviopou mou
BetioTomolovvTal avéhoya e TV KATAoTaon.

Ta Bivteo pmopouv va eyypapouv Ue BEATIOTN TaxUTNTa Kat oTabepr Kivnon
avahvovtag Sidgopa mepiBdAlovta Apng. H taxutnta xpoviopol pmopei va
pubpileTal autépaTa avaloya Le Tov oTOXo Kal To EPIBAMOV Ayng.

Eivat emiong Suvatr n xelpokivntn mAoyn Te TaxUTNTAS XPOVIGHOU.
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1 Natote (5) kat emAé€re Xpoviopdg 60pOVTaG TG AETOUpYieg TG KAPEPQC.

OpIoPOG ETTIAOYWY — 23] . frle— Emihoyr/AkUpwon

KAPEPAG l pUBHIONG PAag
Opiopég avaAuong 086vng 41 NUXTEPIVOG XPOVIOPOG
Evepyorroinan / —=
ATtrevepyoTroinon oTabepng | -
KGPEPAG 2
e — EmiAoyn peyéBuvong

ETIAOYA TNG TOXUTNTAG —spuer s RE - S

Xpoviopou e e — Tpéxouoa Aeitoupyia

pwToypaPiag
ol — EvaAlayn eptrpog/miow

KAPEPOAG
]— Eyypaer Bivreo
2 Natrote @ yia va eyypapete éva Bivteo.
+ Mmopeite va aMA&eTe TV pey£Buvon Kat Ty TaxiTnTa XPoviopoU Katd thv
EyypaQn.
+ AV TaTAOETE TNV EMBUPNTY TaUTNTA, N TAXUTNTA XPOVIGHOU
TipooapuoleTal KATd TV eyypa®n.
- Tiava Slakéyete mpoowpvd Ty eyypagr Bivieo, matiote to koupri @.
Ma va ouveyioete v eyypagr Bivteo, matrote o koupni @.
Katd v eyypagr evag Bivieo, UMOpE(Te va TEVIWOETE fy va AoeTe SU0
Saytula yia peyeBuvon 1 opikpuvon.

+ Katd tnv eyypaon Bivteo, pmopeite va ayyi€ete Ty embBupntr meploxn yla
va puBUicETE TN PTEVOTNTA.

MPOETTIOKOTINGN —==eke

3 Moatriote 1o koupni @ yia va TepuaTioeTe TV eyypa@n.
+ To katayeypappévo Bivteo Ba amobnkeutei 0To AAUTOULL.

E « Aev eyypageTal fX0G KaTd TNV £yypapr Ue Xpoviopo.
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Eyypaon Bivieo
1 Natiote (5) kat emé€te Biveo o0povTag T Aertoupyieg Tng Kapepac.
7 Natote @) yia va eyypdvete éva Bivieo.

PUBHION KAUEPAG n% Emmioyr) pupiong eAag
| .

Opiopo6g avéAuang = Epappoyr| e@é @iATpou
086vng ’
Evepyortroinon /
Atrevepyotroinan
oTaBepng KAPEPag

MatAoTE yia va oAAGEeTE —2 : EmiAoyn peyéBuvong
TIG ETTIAOYEG FXOU avApETa
oe BaoikAj, ASMR
€yypagr| kai Bokeh
Pwvng.

MpoemokoéTnon . [SE— Eyypaen Bivieo

EvaAayr| eptrpog/Tmiow
Kapepag

Mo va TpaPnéeTe pa utoypapia Katd T eyypaen Bivieo, matioTe to
koupmi @).

MNa va Slakdpete Mpoowpvd v eyypagr Bivieo, matiote to koupri @.
MNa va ouveyioete v eyypagr Bivteo, matrote o koupni @.

Katd v eyypagr evag Bivteo, UMOpE(TE va TEVIWOETE Ny va AoeTe SU0
Saytula yla peyeBuvon r opikpuvon.

Katd v eyypaen Bivteo, umopeite va ayyi€ete Tv emBupntr meploxr yia
va pUBLICETE TN QWTEVOTNTA.
3 Moatiote 1o koupni @ yia va Tepuatioste Ty eyypaen Bivteo.
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AN Moptpaito
Mropeite va TpaPriete pwtoypagieg iy Bivieo mou Kavouv To Bépa meplocdtepo
SlaKpLTo Kat e€€xov e B0Awan Tou PvToL.
T Nathote () kat emAéte MopTpaito GUPOVTAC TIG AEITOUPYIEG TNG KAUEPOG.
+ EmAé€Te To emBUNTO €€ 0UPOVTAG TIG EMAOYEG £9E Yia MopTpaito.
2 Natote @ yia va papriéete pia pwtoypagia rj matiote napatetapéva 1o @)
yia va eyypayete éva Bivteo.

+ o va SlakoYeTe MPoowpIva Ty eyypaen Bivteo, matrote 1o koupri @.
MNa va ouveyioete T eyypagn Bivteo, matiote 1o koupri @.

PUBuion kapepag —gg s — EmmiAoyr pubpiong
XPOVOUETPOU
v - OPIoPOG TIHAG

Siappdypatog

OpIoP6G avaloyiwy —
086vng

*— EmAoyn @é

3 MNatiote 10 koupuni @) yia va Teppatioete Ty eyypagn Bivieo.

E + ‘Otav deite 1o privupa «H Aertoupyia moptpaitou gival Stabéoun.»,
EekiviioTe T AP pwrtoypagiag.
« H\erroupyia Moptpaito evéyetat va pn AeltoupynoeL €Gv n Kapepa dev
umopei va avayvwpioet to 6éua.
+ Katam Myn ewtoypagiag, dtatnpeite pa amdotacn 0,5 pe 1,5 pétpo amd
10 Bépa oac.
« Auti n Aertoupyia Sev givat S1aBéatn oe oY oKoTeo mepIBAANOV.
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Xprion AutokoAAnto

Mriopeite va mpocbéceTe S1dpopa AUTOKOANTA OE PwTOYPAPiEC 1 Biveo.

Mmopeite emiong va amoAaUoeTe éva SUVANIKO EQE PEOW TNE Kivong

auTtokOANTWV AR 3D.

1 Natnote (5) kat eméEre AUTOKOAANTO CUPOVTAG TIG AEITOUPYIEC TNG KAUEPO.

7 NatAote €5 yia va TpaBhEeTe Lo QuToypagia 1 TATAOTE MAPATETAUEVA TO 3
yia va eyypaypete éva Bivteo.

- Tiava Slakéyete mpoowpvd Ty eyypagr Bivieo, matiote to koupri @.
MNa va ouveyioete v eyypagr Bivteo, matrote o koupni @.

3 Matiote 1o koupni @) yia va TEPATIOETE TV NXOYPAPNON.

AutokoM\nTo AR 3D

H kauepa BaBoug oo miow PEPOG TNG CUOKEUNG OAG EMTPETEL VAl SNIOUpYE(TE

peaMoTIKd AR E@é 3D avayvwpilovtag mepLypappaTa TPOCWITOU HE

TIEPIOOOTEPEG NENMTOUEPELEC,

1 MNatote (5) kat emAéEre AUTOKOAANTO GUPOVTAG TIG AEITOUPYIEG TNG KAUEPO.

2 Natote @.

3 ZUpete T NoTa pE T AUTOKOAANTa aploTepd 1 Be&id yia va emAéEeTe éva
autokOMnTo AR mou Ba xpnotpomotnOei.

+ To mpdowmo Mo aviXVeLETAL ad TV KAEPD OaPWVETAL O€ 3A.
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A TNomote @ yia va TpaBrEeTe o @wToypagia A TATHOTE TAPATETAUEVA TO
& yia va eyypduete éva Bivteo.
+ H @wtoypagia AapBdavetat pe Ty epappoyr Tou AutokoMnto AR 3D.

E + HAerroupyia 3A odpwong tng Z-kapepag sival S1aBotun POV yia KovTivég
Myeic Moptpaitou.

Xpnon mpooBetwv AelToupylwv KAPEPAC
Natote (=) kat emhé€te MeproodTepa 0UPOVTAG TIC AEITOUpYiES TNG KApEPAC,

Nuxtepivi Oéa
Mriopeite va Byalete (wvTavég kat kaBapég vuxTepIvEC pwToypagies. H Nuxtepiviy
0¢a Oa exteNeoTel auTdpaTa OTAV BYAAETE idt WTOYPAPIO GE CUVONKES XapUNAoU
QWTIOPOU.
Mrmiopeite emiong va ByAlete KaBapEQ VUXTEPIVEC OKNVES XPNOILOTIOIOVTAC N
autépata ™ Aettoupyia Nuxtepivi Béa.
1 Nardote (&) kaw em\é€re NepiocdTepa GUPOVTAG TIC AETOVPYIEC TNG KAHEPOL,
2 Natrote 1o koupmi (.
3 Matote @ yia va Pydhete wa pwtoypagia.
+ T va puBuioeTe TN PWTEVGTNTA TNG PwToypagiag, oupete To €, Tpog Ta
aplotepd 1 Ta Sedla.
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E + Kpatjote 01aBepd, WOTE N KAKEPX VA NV KIVETAL KATA TN AN
QwToypagiac.

Mavopapa

Mmopeite va SnIOUPYNOETE pid TTAVOPAMIKE QWTOYPAPIa METAKIVWVTAC TV

KAUEPA TTPOG Hia KaTtewBuvon yia AN wToypapLwy Kal CUPPAPH TWV GUVEKWV

MUewv piag evpuywviag mPoBoAng.

1 Natiote (5) kat emé€te NeproodTepa 0OPOVTAG TIG AerTOUPYiES TNG KAUEPQC.

7 Natiote o koupri 3.

3 Matiote 10 koupri @) Kay, EMELTa, HETAKIVAOTE TV KALEPT TTPOG pia
KatevBuvon.

A Matqote 1o koupri @ yia va SIaKOPETE T TAVOPapIKA AN,

PUBpIon kapepag —-

5 - 'Otav petakiveite T kdpepa mpog pia kateuBuvon, BePaiwbeite 6tin
086vn otnv omoia Kavete TNV Ay Sev Bpioketal EKTOC TG YPOHUAG
KaBodrynong.
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Xeipokivntn Kapepa
Mropeite va SnIoUPYNOETE WTOYPAPIEG EMAYYENUATIKNG TOIOTNTAG
XPNOMOTOLWVTAG TTARBOG TIPONYHEVWY AETOUPYIWV.

1
2
3

MNatrioTe (&) kat emAégTe MeplocdTepa cUPOVTAG TIC AEITOUpYiES TNG KAPEPAC.

Natiote B.

MpocappdoTe TIG MapAKATW PUOLICELS TS KAPEPAC.

+ Av emAé€eTe AUTOHATO, Ol EMAOYEC TPOCAPHO{OVTAL AUTOUATWG avaloya
€ TOV 0TOX0 AUNG Kal To TTEPIBAAAOV.

- Edv emAé€ete Kopupwon goTiaong, n meploxr €0Tiaong emonuaivetal

e xpwua. Autr n duvatétnta sivat Stabéotun pdvo otn Aertoupyia
Xepokivntn Eatiaon (Manual Focus - MF).

PUBpIoN KAPEPAG —g2 &— EmiAoyr puBuiong

» XPOVOUETPOU
Opiop6g avaloyiwy -
Emidoyn pUBuiong eAag

086vng
E@appoyn e@é @iATpou

Emavagopd Epgpavigel
TwV pubpicewv BIGPOPES
€TmAOYEG
Graphy
Mpocapuoyn lMpocapuoyn
100pPOTTIag ME 0 1o TaxuTnTag
AeukoU ]7 —_ . KAgiOTpOU
Mpooappoyr .
Mpooappoy TaxutnTag
PWTEIVOTNTAG
MNatrote o koupni @) yia va Tpaprete pa pwtoypagio.

4
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5 « Edvmatroete (®) kau em\é€ete éva egé Graphy, O epueavioTel pia Mota pe
OUVIOTWUEVEC PWTOYPAPIEC LE SIAPOPES PUOLITELC,

Eméyovtag ta e@é Graphy, umopeite va AaPeTe pwtoypapieg

XPNOIHOTIOIWVTOG TNV IG0PPOTTICl AEUKOU, TV TaXUTNTA KAEIOTPOU Kal TIG

TIEG pubpicewv I1SO mou epapudloval 0TV IPOTEIVOEVN puToypaPia.

+ Hduvatdtnta Graphy eivat StaBoipn pévo o Xelpokivntn Aertoupyia
KAUEPQG.

« Mmopeite va bite S1GPOPES TPOTEWOLEVEG PWTOYPAPIES AV ANABETE TV
gpappoyn Graphy and to Google Play Store.

« Edv xpnotuomoleite Sedopéva Kivntrg TnAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN XPrion SeSopévwy, avaloya HE TO TPOYPAUMA XPEWOEWY
TIOU €XETE EMMEEEL

- Tlava anevepyomolfoeTe T SuvatéTnTa, maTHoTe §53 Kal £MErTa maTHoTe
Graphy owtoypagio @ .

Xepokivnto Bivteo

Mrmiopeite va eyypdyete éva Bivteo mpooappolovTag Xelpokivnta SIGQopeg
emMoYEC. [pooapudOTE TV I00PPOTTIC AEUKOU, TNV £0TIOON, TN QWTEVOTNTA, TNV
TN 1SO, TV TaxuTNTa TOU KAEIOTPOU Kt TOANG AN

1 Natiote (&) kau em\é€re MeplacoTepa GUPOVTAC TIC AETOUPYIES TG KAHEPDS.
2 Natmjote [

PUBuion kauepag — Esg—— Emidoyn pubuiang gAag

Oplopég avaiuong
086vng

E@appoyr| epé @iAtpou

Emavagopd Mpocapuoyn
TwV pubpioewv 100ppoTTiag
nxou

Mpooapuoyr —=— [pooapuoyn
ic0ppoTTiag Tax0tnTag
AgukoU KAgioTpOU

Mpooappoyr i

eaTiaong Mpocapuoyn

Mpocapuoyn Taxutnrag ISO
PWTEIVOTNTAG
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3 MpoocapudoTe Kelpokivnta TIC pUBIOEIC TN KApEepag av xpetdleTal.
A Natfote @) yia va eyypaygete éva Bivteo.

Apyn kivnon
Mriopeite va dnpioupynoete éva SiaokedaoTikd Bivieo ahalovTag Tig TaxUTNTES
Kivnong Twv Bepdtwv mou CUPETEXOLV OTO BivTeo.
1 Natiote (2) kau em\é€re MeplacdTepa GUPOVTAC TIC AETOUPYIEG TG KAHEPDS.
7 Natote 1o kouuri @.
3 MpocapudoTE TIC TAPAKATW PUBICEIC TNC KApEPAC.
A MNarqote © 1 L yia va emMé€ete Sidpkela yia 10 £QE apync Kivnone.
+ TuRpa apyn Kivnon: Zag emTpémnel va epapuooeTe €va Q€ apyng Kivnong
O€ €VOl GUYKEKPIUEVO TURAA TO BiVTEO.
- Matote © dtav BéNeTe va EQapUoOTEi T Q€ apyng kivnong. Me
€va 0UVTOWO TIATN A, TO Q€ apyNG Kivnong epapudletat yia 0,5
SeutepdhenTta. Me éva apaTeTapévo MATNHA, TO EPE APYAC Kivong
€QapUOTETaL PEXPL VA AP OETE TO SAXTUNG 0aG.
+ 'O\eg o1 Apyn Kivnon: Zag eMTPENEL VO EQAPUOCETE EVal EQE apyNG Kivnong
o€ OAOKAN PO TO BivTeO.
5 Natfote @ yia va EekivioeTe TV eyypagn.
- Tava Slakéyete mpoowpvd Ty eyypagr Bivieo, matiote 1o koupri @).
MNa va ouveyioete v eyypagr Bivteo, natrote o koupni @.
6 Edv Béhete va ohokAnpwoete T Aqen, natrote @.
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YouTube Live

Mriopeite va kataypAyeTe éva Bivieo kal va To amooTeileTe ameubeiog oTo
YouTube.

Mo va XpnotUomoIoeTe auTh TRV SuvaTtoTNTa, MEEMEL Va TTANPEITE TIC
nipoumobéoelg emAe§iuoTnTaC. EMKovwvrote pe 1o YouTube yia Ti¢ mpoUmoBéaeic.
1 Zmv apxikn 066vn, matriote ().
7 Emé€te Neproodtepa aMdlovtag Aertoupyieg TG KAUEPAS KAl TIATHOTE (o).
E « To YouTube Live givai SiaBéotpo povo 6Tav n GUCKELN oag ival
ouvdedepévn ato Sladiktuo. Edv xpnotpomoleite Sedopéva Kivntig

TNAEQWVIaC, UMopEi va MPBAPUVOELTE [E XPEWTELC yia TN XPrion Sedopévwy,
QVANOYQ E TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAECEL.

Xpriolpa XapaktnpioTIKa KAPEPOG
NqYn ewtoypagiag pe ™ Aettoupyia Al
Katd tn Aqyn pag gwrtoypaegiag, n Aerroupyia Al avayvwpidet éva 6éua kat

XPNOOTOLE TO KATAMNAOTEPO EQE OTN PUTOYPAPICL.

E « Matrote ‘ Yl va amevepyoroloeTe Tn Aettoupyia Al.
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K\eidwpa autopatng ékBeong/autopatng eotiaong

Mriopeite va TpooapHOsETe To Tpéxov eminedo ékBeong kat Tn Béon eotiaong
TIATWVTOC TTOPATETAMEVA TTAVW OTNV 08V, Ia val amevePYOTTOIOETE TN
\erroupyia, ayyi€te pia Kevr meploxn Tng 08ovng.

KAgidwpa autépatng
1 £kBeang/auTopaTg
€oTiaong

E + AutA n duvatotnta gival SlaBéotun HOVO O CUYKEKPIUEVES AEITOUPYIEC.

MeyéBuvon 1 opikpuvon
Mriopeite va avoiete 1 va evwoete U0 SdyTula yla peyéBuvon A opikpuvon 6tav
NapPdvete pwtoypaeieg n Bivteo.

E « Hertoupyia peyéBuvong/opikpuvong Sev sivail Slabéoiun otn Aermoupyia
selfie (umpoaoTivi) KApePa).
« AutA n Aertoupyia dev umooTtnpileTal o€ APKETE KATAOTAOEIG AelToUpYyiag.
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Xpnon e Aetroupyiag MoAamhi Aqyn
Mriopeite va TpaPr&ete GUVEXOLEVEC PUITOYPAPIEC Kall VAl TIG SEITE WG KIVOUUEVES
€IKOVEG 0TO ANUTTOUH.
1 Natiote (5) kat emééte Owtoypaeia.
2 Natjote kai oUpete 0 @) MPog Ta aploTepd 1 pog Ta Se€id.
+ Evw) Kpatate matnpévo To Koupmi AapBavovTat ToMEG, CUVEXOUEVEG
pwTtoypagieg (Ewg 100 puToypaied).

NAYnN pe xerpovopia xeptov
Mmopeite va tpapriéete selfie ivovtag eVTONEG pe AMAEG KIVIOELG TWV XEPIWV OO,
Avoi€Te TNV TOAGPN 060G OTPAUUEVN TIPOG TNV UITPOCTIVH KAKEPA Kal, EMELTA,
KAeioTe Ta SAKTUNG oag o€ ypoBid.
Mrmopeite akopn va kAeioeTe Ta SAXTUAG 0ag o YpoBid Kal va Ta avoi€eTe mpog Tn
UTTPOCTIV KApEPQ.

- YeTpia SeuTEPONEMTA MPAYUATOTIOLETAL AN PWTOYPAPIAG.

W

"

E « Tla va xpnolpomoloeTe autrv Tn Aeitoupyia, peTapeite otn Aettoupyia
HITPOOTIVIIG KAPEPQG KA, OTN GUVEXELD, ayyiETe Sladoxika §63 > Selfie >
AAYn pe xelpovopia xeptov.
« BePawBeite 6Tt n maAdun oag kat n ypobid oag BpiokovTat Viog Tng
YPOUUNAG QVapOPAS YIa Va UTTOPEL N KAPEPA VA TIG avaYVWPIOEL
Autr n Aertoupyia evoéxetat va pnv givat Slabéatun dtav XpnoIUoToLETE
OPIOPEVES a0 TIG AEITOUPYIES TN KApEPQG.
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Autopatn Aqgn

Mropeite va XpnOILOTIOIOETE TN AEITOUPYIQ AViXVEUONG TIPOCWITOU YIa VAl

Tpapnéete selfie ypriyopa ki ebkoha. Mmopeite va puBpiceTe Tn GUOKEUR £TOL

WOTE, OTAV KOITATE TNV 086VN, N UMPOCTIVH KAUEPQ QVIXVEVEL TO TIPAOWIO GAG Kt

Tpafdel autopata pia selfie.

+ MONG n pmpooTivi KApEPa avixveloel To IPOOWO oag, epgaviletat éva

Aeukd maiolo-o8nyoc. Eav o Bépa evtdg Tou mhaiciou-o06nyol otapatrioel
Va KIVEITAL, TO XpWHa TOU MAQLGIoU-08nyoU YIVETaL KITPIVO, KAt TOTE N KAUEPQ
Tpapdel pwToypaPia.

E « Ayyi€re S1a801kd $33 > Selfie > Autépatn Aqyn yia va evepyonolioeTe T
Aertoupyia «Autopatn Ajdny.

MeooSiaotnua AqPng
Mmopeite va tpapriéete selfie pe xpovikn amooTaon UeTagu Toug.
Evw XpNOILOTOIETE TV PIPOOTIV KAWEPQ, AVOIETE TNV TAAALN GOG OTNV KAHEPA
Kal, €merta, KAgioTe Ta SAKTUAG 0ag ypriyopa o€ ypoBid emavaappdvovtag thv
id1a kivnon dvo popéc.
+ ©aAneBouv Téooepig pwToypaPie SladoyIka META amd KaBuoTéPNON TPIWV
SeuTEPONEMTWV Yial KaBepiaL.

AnoBnKeuan avaotpoPig
Mpwv TPABAEETE LA GWTOYPAPIX LE TV UTPOCTIVH KAMEPQ, QYYIETE TO KOUWTTI $G3 >
Amnobrkeuan avaotpo@nc. H eikdva avaotpépetat oe opl{ovtio d§ova.

E « Katdn xprion TG WmpoaTiviG KAUEPAG, UMOpE(Te va aMAEETE Tov TpoTo

Mg Twv selfie oTig emMoyég kapepag. MNa AemTopépeleg, avatpé€te oty
evétnta lMpooappoyr) Twv emAoywv ¢ KAUEPAC .
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AApmoup

Emokonnon epappoyng ANumoup
M TI¢ pwToypapieg Kat Ta Bivieo mou €xouv amoBnKeUTEN 0T GUOKEUH Gag
napéxovTal SuvatotnTeg mPoBoAig Kat SIaxeipIong Toug.

MpofoAr pwTtoypaPIwV
Mrmiopeite va SeiTe TIC pTOypaPieS TTOU EXOUV AMOBNKEUTEL TO TTPOIOV.
1 Natiote € kat emé€te Tov emBupntod @akero.
7 Matiote oty emBupNTA QwToypaPia.
O @dakehog Ahumoup mepiéxel Ta Qwtoypagia, AApmouy, Egé Avapvioeig
Kat Avamap.

1— Avolyua ®akoi Google.
e
EmoTtpogr oty — « «— [lp6oBacn oe GAAeg

TTponyoUpevn 0Bévn. €TMAOYEG.

R — ooemoxsmon

—| GApTIOU,
MpoaoBrkn 1 kardpynon —e ¥ 1] o= Aiaypa@n eIkOVwyY

aTro Ta ayaTTnuéva. [
Koivr) xprion eikévwv

Eme€epyacia eikévwy

E + To pevou Aemtopepelwv eppaviCetal dtav ayyilete Ehappwg TV 086vn. Av
ayyi€ete Tv 086vn akopa pia gopd, To pevou Ba e€apavioTei.

XPAOIUEG EPAPHOYEC 116



Avamnapaywyn Bivteo
Mmopeite va Seite Ta Bivieo mou éouv amobnKeuTel 0TO MPOIOV.
1 e—— [poéoBaon oe GAAeg

EmoTtpogr oty — ¢
TrponyoUuevn 006vn. ETTIAOYEG.

Mavon ri avamrapaywyn
Bivreo.

e— [1poEMIOKOTING T GAPTIOUN

Mpoodrikn N kardpynon —* 4 1] =— Aiaypa@r] eIkOVWY
amé Ta ayaTnpéva. e —
I— Koivi xprion eikévwv
Emegepyaoia eikévwy

E « Tla va puBpioete TV évtaon tou Yo, TpaPrte T 6e§id meupd oty
006vn vog Bivteo mPOG Ta KATW 1 TTPOG Ta IAVW.
« Tla va puBpIoETE TN PWTEIVATNTA TNG 006VNG, CUPETE TNV APIOTEPK TTAEUPA
0TV 086vn P0G Ta ENAVW I TTPOG TA KATW.
+ Av oUpete TV 086vn Tpog Ta aploTepd atnv 086vn avanapaywyng Bivieo,
7o Bivteo Kiveitat mpog Ta miow (REW) kat av oUpete mpog Ta Se€14, Umopeite
Val KIVAOETE TO BivTeo oG Tal UmPOG Kat ypriyopa (FF).
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Emagég

Enagéc - Mapouoiaon
Mriopeite va amoBnKeVoETe Kal va SIAXEIPIOTEITE TIC EMOAPES.
SV apxikn 086vn, matiote LG > Emagég.

MpocOnkn emagwv

MpooBnkn véwv emapwv
T Zv 0B6vn e Niotag Mgy, mathoTe To KOUUTT—-.
+ Oa gppaviotei éva avadudpevo mapdBupo yia va emiéEete T Béon
amoBrikeuong yla va Tnv kovorolnoete. EmAEETe Tn B€on mou BéheTe.

7 Eloaydyete ta otolyeia enmkowwviag kai matote AmoBrikevon.

Eicaywyn emagpwv

Mmopeite va eloayayete emagég amo pia AGAAn GUOKEUN amoBrikeuonc.

T Zmv 0B6vn e Niotag emagawy, ayyite Sladoyika ¢ > Maxeipion emagwv >
Ewcaywyn.

7 Em)\é€te TIc TomoBeaieC poEAELONC Kal TTPOOPICHOU Yia TV EMAQH TV
mipoopiletal yla elcaywyn kai matriote OK.

3 EmMé€te TIc emagéc kat ayyi€te Eloaywyn.

MpocBrikn ema@wv otn Aiota Taygiag KAjong

T Zmv 086vn e Niotag enagav, TatioTe 1o koupni + > Tayeia KAjon.
7 Ayyi€te NMpoaBrkn ema@ic and évav apiBuoé Tayeiag KAonc.

3 Em\é€te pua emagn.

« ‘Otav mpooBETeTe pia KavoUpyla emagn, TaTHoTE (57 yia va mpooBéoete
évav aplBuo tayeiag KAong.
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Avalfitnon emagwv
Mmopeite va mpaypatomoloete avadtnon MA@V XpNOOToLWVTag pia amd Tig
TOPAKATW EMAOYEG:

+ MotAoTe T ypaupr avaditnong oto endvw PéPog tng 08évng Emagwv kat
EI0AYETE TNV EMAPH ) TOV APIBUO TNAEPWVOU Yia Ta omoial BENETE va KAVETE
avalrtnon.

Mpaypatomnotiote KUAIoN TG NOTAC EMAQWV TIPOE Ta TIAVW 1 TTPOG TA KATW.
« A6 10 €UPETAPIO GTNV 006V TNG NOTAG EMAPWY, TATHOTE TO APXIKO YPAUUA
yla pia emagn.

E « Eav matrioete ot ypappn avaditnong oto emdvw uépog tng 08ovng
Emagwv Kat elodyeTe pia emagn 1 évav aplbuo epwvou, Ba eupaviotov
Ta anoteNéopata avalfitnong amd To (0TopIkd KAoEWV Kal T AioTa
EMAPWV TTOU €ival AmOBNKEVUEVN OTN GUOKELN.

Niota ema@wv

Ene€epyacia emagpuwv

1 Zv 086vn e NoTag ema@wy, eMAEETE pia emagn.

7 v 0B6vn Twv OTOIKEIWV WAG EMAPRC, TATAGTE TO KoupTi /7 Kat
€MECEPYAOTEITE Ta OTOIYED.

3 MNatAote AmoBAKELON yia va anoBnKeUoeTe TIC AANAQYEC.

Awaypa@n emagwv
Mriopeite va SlaypAaYeTe EMAPES XPNOILOTIOIWVTAG Mot artd TIG TAPAKATW
emAoyéc:
+ 2TV 006vn TG NioTag emaguwy, ayyiTe Kat KpatioTe TV emagr| mou BéNeTe va
SlaypayeTe Ka, 0T OLVEKELD, ayYiETe ],
- Ayyi€te Siadoxika : > Alaypagn mou Bpioketat atnv 086vn Notag enagav.

E Ol amOUAKPUOHEVEG ETTAPES EVOEXETAL VA [NV AITOKATACTABOUV.
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Mpocbrikn ayammpévwv

Mmopeite va KATaxWPICETE TIG EMAPES TTOU XPNOLUOTIOLEITE GUXVA WG AYATTNEVEG.
71 Zmv 006vn e NoTag ema@wy, emMAEETE pia emagn.

7 v 086vn Twv OTOIXEIWV WOG EMAQAC, IATAGTE TO KOUTT 1.

Anpiovpyia Opadag

T 2 Nota opadwv enagav, matrote Opadeg kau émetta natiote -
2 MAnktpoloyroTe éva véo dvopa yia Ty opdda.

3 NatAote MpooBikn pehwv, em\éEte emagéc kat matrote NMpooBRkn.
/' Natfiote AmoBrikeuon yia va anoBnkeVoeTe T véa opdda.

QuickMemo+

Mapouaiaon TG e@appoyng QuickMemo+

Mriopeite va @TIAEETE SNUIOUPYIKES ONUEIWOELS XPNOILOTIOIWVTAG TV YKAUA
emAoywv mou S1aBETEL AUTA N TIPoNYUEVN SuVATOTNTA TOU ONUEIWHATAPIOU, OTTWG
n Siaxeipion ekévwv Kat otiypdtunwy. Ot emioyé auté Sev umootnpilovtat amd
TO GUUPBATIKO ONUEWUATAPLO.

Anpioupyia onueiwong
T Tt apxikr 086vn, matiote LG > QuickMemo+.
7 Natote 1o koupri @ yia va SnuoupyACETE pia onpeiwon.
. Q : anmoBrikeuon onueiwong.
+ < Avaipeon Tng mponyoUpevng evépyelag emegepyaciag.
7 :EmavéAnyn Twv Mo mpdoQaTwy eVEPYEIWY Slaypaprc.
« T :e100ywyr OnUeiwong XpnoIUOTOIWVTAG TO TANKTPOASYIO.
+ 9 : AIOBNKEVOTE TOUG ayamnpévoug 6ag TUTIOUE OTUAD.
+ /: 8npiovpyia XEPOYPAPWY ONUEIDTEWV.
A : Siaypagr XEPOYPAPWY CNUEIDCEWV.
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+ G AN\GETE O€ YpappaTooElpd KaMIypapiag KaBwG YPApeTe e TO XépL.
- ¢ :TpdoPaon oe GMeC emAOYEG.
3 Natote o koupmi @ yia va amoBnkevoeTe T onpEiwon.

Anuovpyia ONUEIWCEWY G€ éva OTIYIOTUTTO 000VNG
T Kot mv mpoBolr tng 086vng mou BENETE va AMOTUTIWGETE, GUPETE Tr) YPAUUN
KATAOTAONG TTPOG T KATW Kall, 0T GUVEXELD, ayYiETe To kKoupmi O
+ H 0B86vn amotunwvetat kat ppavifeTal we PIKpoypagia oto Se€16 KaTw
Hépog Tng 08ovne.
M0 va YpAYETE ONEIDOELS 0TV 080N, TATNOTE (..
TPAYTE ONUEITELS XPNOILOTOIWVTAC Ta Epyaeia.
- 19 : Kavete peyébuvon 1y opikpuvon A mpooappdoTe Ty meplox Mung.
« / :8nuioupyia XEIPOYPAPWY ONUEIDCEWV.
& : iaypagr XEPOYPAPWY ONUEIDCEWV.
+ €1 Avaipeon Tng mponyoUUEVNG evépyelag eme€epyaaiac.
« ¢ : EmavaAnyn Twv mo mpoo@atwy evepyelv Siaypagric.
+ (35:Nepik6yte TNV 086VN CUPWVA KE TIC AMAITATELG 00,
A Natiote v/ Kal anoBnKeVOTE TIG ONUEIWTELG.
+ Mmopeite va OeiTe TIC ONUEWOELS TTou anoBnkevuoate 0To ANUTTOU.

w N
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MpdoOeta XapaKTNPIGTIKA META TN ARYPN OTIYHIOTUTTOU 000VNG

© @ lgcom/us L1110 ¢

D0 MORE AT DNCE

MatAoTe yia va
QTTOTUTTWOETE OAOKANPN
v 086vn
XPNOIHOTIOIWVTAG TN
duvatétnTa KUAIONG.

I'IaTr’]ch yia va )
Mariore yia va ypaweTe KaTaypayeTe TNV 086vn.
ONUEIWOEIG OTO
QATIOTUTIWHEVO OTIVHIOTUTIO
oovng. MatAoTE yia va SlaypayeTe
MaToTe yio va JoIpaaoTeiTe TO QTTOTUTTIWHEVO
TO QTTOTUTTIWHEVO OTIYMIOTUTIO 086VNG.
OTIYHIOTUTIO 086VNG.

Mmopeite va amoTtunwaoete OAOKANPN TV 086V XPNOILOTOIWVTAG T
SuvatétnTa KUNoNG.

Katd tn xprion piag epapuoyng, 6mwg ot Messaging kat Chrome, cupete

T0 TAQO10 E160TOINCEWVY TIPOC T KATW KAl KATOTIV TIOTHOTE () Emena,
TITAOTE L, Yl Va anoTunidoeTe oMOKANpn T 0Bvn miou BAEMeTe ekeivn
TN OTIypr WG €va POVo apxeio.

Autr n duvatotnta gival SIaBECIUN HOVO Yia OPIOHEVES EQAPUOYEG TIOU
umootnpiCouv Tn SuvatoTnTa KUAIONG,

Midote SUo SaxTula 1 amioTe Ta SAXTUAG oag yia va aAagete T diataén
TWV ONUEiwv.

5
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PoAot

A@unvion

Mriopeite va opioete va xtummoet To umvntript pia kaBopiopévn wpa.

T Zmv apxikr 066vn, matiote LG > PohéL > Agunvion.

7 Natote 1o koupri -} yia va pooBEoeTe £va kawoupylo umviTrpL.
3 Alapop@woTe TIG pUBICEIS apUMVIONG Kat TIaTroTe ATToBAKEUON.

E « EQv em\é€eTe pia Kataywpion apumviong mou &ixe puBpIoTEl aTo TTAPENBOV,

UMOPEITE Va EMEEEPYAOTEITE Tal OTOIXEID TNG.

« Tava Slaypawete pia emhoyn apUmviong, TOTAOTE TO KO &
> Aaypa@r. oTo eMdvw UéPog NG 086vng. EVOMAKTIKE, TaTrioTe
TIOPATETAPEVA TNV AQUTIVION.

Maykoaouo poAdt

Mmopeite va Seite TNV TpéKouca WPa OTIG IOAELG O€ OAO TOV KOGHO.
T v apxiki 086vn, matriote LG > PoAdt> Maykdopto poot.

7 Natiote o Koupri -} Kat TpooBEaTe pia mOAN.

AvTtiotp. Xpovop.
Mriopeite va opioete va XTummoel To umvnTript META amod €va KaBoplopévo
XPOVIKO SidoTtnua.
T Zmv apxikr 086vn, matiote LG > PoAdL > Avtiotp. Xpovou.
7 Pubuiote Tnv wpa kai matiote Evapén.
- Ta avaoToAr Tou xpovodiakdmtn, matriote Mavon. Na cuvéyion Tou
XPOVOSIOKOTTN, TIATAOTE ZUVEXELD.
3 Matfote AlakomH yia va SIOKOYETE TOV XPOVOSIOKOTTH.

XpriolpeG papuoyeg
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Xpovopetpo
Mmopeite va XpnOIOTIOIOETE TO XPOVOUETPO YIa VO LETPHOETE TOV XPOVO yla
£vav yupo.
T Zmv apxir 006vn, matiote LG > PohdL > Xpovopetpo.
7 Matiote 1o Kouuri Evapé&n yia va EEKIVHOEL TO XPOVOUETPO.
+ Tova PETPROETE TOV XPOVO yia €vav YUpo, TaToTe Lap.
3 Matfote Mavon yia va avacTe\eTe TO XPOVOUETPO.
+ [0l va OLVEXIOEL TO XPOVOUETPO, IATAOTE ZUVEXELQD.

+ Ta va dlaypdpete ONeG TIG £YYPAPES KAl VA EEKIVAOETE TO XPOVOUETPO OO
v apxn, ayyi€te Emavagopd.

Movucikn

Mriopeite va aKoUGETE Kal va SIaXEIPIOTEITE TPaAYOUSIA I} LOUCIKA AAUTIOUL.
T Zmv apxikr 066vn, matiote LG > Mouoikn.

7 Em\é€te wia katnyopia.

3 Em\é€te éva apxeio HOUGIKAG.
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Avoige/KAgioe To Dwg
®Aag.
PuBuIon NXNTIKWY EQE.

EmoTpoer otnv —
TrponyoUpevn 0Bévn.

MarroTe yia avamapaywyr] —
aTé TNV apxr Tou

‘e— MpooBaon o€ aAheg

€TTIAOVEG.

— [Mavon f avatrapaywyn.

AvaTtrapaywyn o€ Tuxaia —

Mpocapuoyn TNG éviaong —e=
AXou.

o —_|
Mpoaobrikn rj dlaypaen atrd

5

XpriolpeG papuoyeg

TPEXOVTOG apXeiou /
MarroTe U0 PopPES yia
avatapaywyr Tou
TrponyoUlevou apxeiou /
MaTtoTe TapareTapéva yia
£TMOTPOPN OTNV apXh.

MarroTe yia avatrapaywyr
TOU ETTOPEVOU apyEiou /
I'Iayr’wn Trapqnwus'va yia
ypriyopn Trpowenon.

— Emhoyn Aeitoupyiag

oeipd. €TTaVAANYNG.

=e— MeTdBaon otn AioTa
Avatrapaywyng o€ egEAIgn.

ot

Ta ayaTrnUéva.

OpIOPEVEC LOPPEC apxEiwV evOEXETaL va Unv umtooTtnpilovTal avdhoya pe To
EYKATEOTNUEVO AOYIOUIKO.

Apyeia mou urepPaivouy To EMTPEMOHEVO OpIO HeEYEBOUG EVOEXETAL Va
TIPOKAAéGOLY OQANUaTA.

Ta apyeia HoUoIKrG evOéxeTal va pooTatelovTal amod SIEBVEIC KATOXOUG
TIVEUMATIKWY SIKAIWHATWV 1} TOUG VOUOUG TTEPT TIVEUHATIKWY SIKAIWUATWV.
la va avTypAYETe KAoLo apXeio MOUGIKNG, UMOPEL va XPElaoTEl va AaBeTe
vopIpn adeia. Na va mpaypatomoljoete AjPn fj aviypagr vog apyeiov
MOUGIKNG, ENEYETE TTPWTA TN VOUOBEDIA TTEPI TIVEUUATIKWY SIKAlWUATWY OTN
Xwpa émou BpiokeoTe.

AuTo T0 povTéNo umooTnpilel avamapaywyn fxou Hi-Fi. Ta apyeia rixou Hi-Fi
epgavifovral pe o ekovidio Hi-Fi.

Eav evepyomolroete o pAag, Ba avaooprivel CUMPWVA E T HOUGIKI TTIOU
avamapdyetat.
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ApiOpopnxavn
Mriopeite va xpnotpomoljoete SU0 TUTTOUG UTOAOYIOTWV: TO AITAG KOMTTIOUTEPAKI
KOl TN UNXQVIKN apiBpopnyavn.
T Zmv apxikr 066vn, matiote Google > AptBpopnxaviy.
7 XpnOOTOIROTE TO TANKTPOAGYIO VI VOl KAVETE £VAV UTTONOYIOHO.
« Edv Bé\ete va yivel véog umohoyiopdc, atroTe mapartetapéva 1o {XJ.

ThinQ

Mriopeite va ouvdEoeTe UKONA TO TTPOTOV e CUOKEUVES |oT yia va Tig
TAPaKOAOUBE(TE Kall val TIG XPNOILOTIOIE(TE e Aveon.

YV apyikr 086vn, natiote LG > ThinQ,

E + Mmopeite va KataxwpioeTe MUVTAPIO POUXWY, OTEYVWTHPLO, CUCTNHA
@povTidag eviupdTwy styler, TALVTAPIO TATWY, YOUPVO KAt GKOUTTA POTIOT
OTaV TO TIPOIOV BPICKETAL OE KATAOTAGN AVAUOVAG.
« Avalntriote to orjpa ThinQ oTo TPOIGV yia Vo KATONABETE av MIopEi va
ouvSeBei pe v epappoyn ThinQ.
« MNatjote = yia va udbete MePIOOOTEPA Yia SIAPOPEC NEITOUPYiE TG
gpappoynic ThinQ.
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LG Health

Mriopeite va SlaxelploTeite Bépata mou agopolv Thv uyeia oag kat va LIoBeTHoETe
KOAEG OUVAOELEC CWHATIKAG AOKNONG TAPAKOAOUBWVTAG TIG AOKNATELS TIOU
EKTENEITE.

Eiocaywyn otn Xxprion g epappoyn¢ LG Health

Mmopeite va mpooapuOoETe TiC puBIoELS TNG pappoync LG Health dtav exkiveite

TNV EQAPOYH YIa TIPWTN POPA LETA TV EMAVAPOPA TNG.

T Zmv apxikr 086vn, matiote LG > LG Health.

7 AkolouBrioTe Tic 08nyieg mou epgavifovTal 0T 086vn yia va ONoKANPWOETE
N Slapopewon.

Xpnon ¢ epappoync LG Health
v epappoyn LG Health pmopeite va Seite Baoikég minpogopieg kat va
SlOXEIPIOTEITE TO EVPOG TWV TTANPOPOPIWV UYEING KAl QUOIKAG AOKNONG.
1 v apyii 086vn, matfiote LG > LG Health.
7 AatiBeval ol mapakatw eMAOYEG.
= : 8eite T0 apyEio KATAYPAPHC TWV CWHOTIKWY AOKAOEWV 00C TN
OUYKEKPIUEVN NUEPA TIOU BENETE va eENéyEeTE.

- Q : &exviote va mapakolouBeite pia doknon. Kataypagetai n Siadpoun
Kat n évtaon TnG OWHATIKAG AoKNong yla KEBe TUTIO AOKNONG TTOU EKTENEITE.
: 1 0pIOTE TOUG NHEPHOIOUC TTEXOUG OWHATIKAG AOKNONG, TG Beppideg ou
Bé\eTe va KatavohWVETE Kal Ta Brpata 1y opioTe Sidpopeg pubuioeg otnv
gpappoyn LG Health.

5 « O1mAnpoopieg o€ BEpaTa LYEIaG TOU TTAPEXOVTAL Amd TV EQAPHOYH
LG Health mpoopiCovta yia tnv eukolia Tou XprjoTtn Kai Sev mpémel
va xpnotpomotnBolv yia tnv mpoAnyn, tn Bepaneia kat tn Sidyvwon
acBeveiv 1 Awv PoRANUATWY IATPIKAC PUONG.

« Hepappoyn LG Health evdéxetal va Slagépet iy va pny givat Slabéatpn,
QVANOYa E TN XWPA Kal ToV TIAPOYo umnpeativ. Ot Aettoupyieg mou
SatiBevtat yia v epappoyr LG Health, kaBwg kat AANEG epappoyEg
TIOU UMOPOUV va TpooTeBoUV oty epappoyr LG Health, evdéxetat va
Slagpépouv avahoya pe TN xwpa. AUTO OQEINETAl 0TOUG S10POPETIKOUG
VOUOUG KAl KAVOVIGUOUE TIOU IOXUOUV.
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Eyypaen nxov HD

Me v Eyypaon fixou HD umopeite va SIapop@uveTe elpokivnta TIg puBicElg
X0V, £T01 WOTE N EYYPAPK| TOU 1XOU va TPooapuoleTal KAbe popd oTo
niepiBdov oag.

Nertoupyieg eyypagpng

Mriopeite va eyypdgete éva apxeio ixou uWNAng avaluong emAéyovtag
Kal Slapop@wvovTag T AerToupyia fixou mou BéNeTe, woTe va Taiplalel oTo
miepIBEANOV EYYPOPNG.

SV apyxikn 086vn, matiote LG > Eyypaen nxouv HD >=.

Kavoviko
Mriopeite va eyypAapeTe X0 Xwpic va opiceTe emmAéov pUBIOELG.

ASMR
Mmopeite va kataypaypete fxo ASMR.

Tuvavhia
Mriopeite va eyypAapeTe X0 OE pia GUVALNIA 1} GNAN HOUGIKT EKSHAWO.

Mpocappoouévo
Mriopeite va Sl0pHOPPWOETE TIG EMBUUNTEG PUBHICELC Yia TNV EyYPAPH HXOU.

Aertoupyia XtouvTio

Meé TN Aertoupyia ZToUVTIO, UMOpEITE Vo TIAIEETE €val apXEio XOU f} LIOUGIKNC

KOl TAUTOXPOVA VA NXOYPAPEITE TN GV 60¢, va SnoupynoeTe pia cuyxopdia
NXOYPAPWVTAC TN @wVr) 6ag TOAEG POPEG, Kall VO NXOYPAPHOETE Ta OXONA oG
TIAVW amo TO ApXIKO OPXEIO X0V TOU TAPOUGIAOTH 1} TOU OMIANTH.

T Zmv apxikr 006vn, matiote LG > Eyypagn fixou HD > =>
Mpocappoopévo.

MatAoTe To Koupni d 4

Em\é€te €va apyeio xou mou Ba XpNnOIOTOICETE WG MOUGIKY POVTOU.
Ayyi€re o koupmi @ yia eyypagr fyou.

Ayyiéte 10 koupni @) yia anoBrikeuon Tou nxoypagnuévou apygiou.

b wN
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5 + Havamapaywyr HOUGIKRG @OvVTOoU ival Suvath HOVO PECW OKOUGTIKWV.
BeBaiwbeite OT1 éxeTe GUVOETEL TA AKOUOTIKA TPOTOU XPNOILOTIOIOETE
auTtv tn AerToupyia.

« Ta va aMd€ete Tig mpoobeteg pubpioelg, ayyifte > PuBpioeig, ka

0T OUVEXELD TIPOCAPUOOTE TOV TUTTO apxeiou, To BABoc bit, To pubud
SetypatoAniag Kat AMEG puBIoEIC.

« ‘Otav emAéyete Tn Aettoupyia Concert ri Mpocappoouévn dtav €XeTe
OUVGEDEL AKOUOTIKG, EMPAVICETAI TO (. AvyiETe TO KOUpT Qg Katom
OUVEXELD EMAEETE TO HIKPOPWVO TTOU BENETE VOl XPNOIHOTIONOETE.
Mrmiopeite va eENéyXETE TNV TTOLOTNTA TOU X0V LE TO CUVOESENEVO OKOUTTIKO
EVW EYYPAPETE TOV 1X0. Katd TV €yypaer Xou o€ Aetoupyia ETouvTio,
n Aertoupyia mapakohouBnang ryou dev umootnpietal. Mmopeite va
OKOUOETE POVO TN HOUOIKK POVTOUL.

Npoypappa Exkiv. Mayvid.

Mmopeite va emAé€ete av Ba xpnoipomoteitat To Mpoypappa Ekkiv. Maiyxvid. dmou
umopeite va Seite T AioTa pe ta maixvidia mou éxouv eykatacTabei oTo mpoiov
Kai va em\éyeTe pubuioelg yia Ta mavidia, OTwg amevepyomoinon Tou fYou Twv
TIOAUHEGWV, TIEPIOPIOHO EIGOTTOICEWV, KA.

T Zmv apxikr 006vn, matiote Npdypappa Ekkiv. Matgvid..
7 Em\é€te v emoyr ou BéAeTe.

Smart Doctor

Mriopeite va xpnotpomotrjoete 1o Smart Doctor yia va SlayvwoeTe Ty KataoTtaon
TNG OUOKEUNC KAl VOl TN PEATIOTOTIOINOETE.
SV 086vn apyikn, matjote LG > Smart Doctor.

XPAOIUEG EPAPHOYEC 129



LG Mobile Switch

Méow tou LG Mobile Switch petagépete elkola Sedopéva amod Uia METOXELPIOHEVN
GUOKEUN O€ L0 VEQ GUOKEU).
T Zmv apxikr 086vn, matiote LG > LG Mobile Switch.
Mmopeite emiong va matrioete PuBpioeig > Zuotnpa > Avtiypag@o ac@aleiag
> LG Mobile Switch.
+ EdQv n epappoyn Sev éxel eykataotabei oto mpoidv, AaBete Kat
€YKATAOTAOTE TNV €Qappoyn LG Mobile Switch amé to Google Play Store.
7 Akoloubriote T 08nyieg Tn¢ 006vng yia va emhé€ete T emBupunT pébodo
UETAPOPAG.

E « Aev Ba SnuoupynBouv avtiypaga acpaleiag yia ta dedopéva ot Evav
Moyaptacpd Google. Otav cuyxpovilelg Tov Aoyaplacud cou ato Google, ot
epappoyéc Google, ot emapég Google, To Huepohdyio Google, ta Sedopéva
NG EPapHOYNG onpeiwpdTwy Google Kal ot EpapHOoyEG TTou KatePaivouv
an6 To Play Store amoBnkevovtal otnv epappoyr Drive autépata.

+ QoptioTe MAjpwG TV Umatapia eV amo T HETaPopd Twv dedopévwv yia
Va amo@eUBEL n AOKOTTN amevepyomoinon TNG CUOKEUNG KaTtd T SlapKEla
¢ Sadikaciac.

Zkoumidia epappoy.

Mrmopeite va Seite pia NioTa pe SlaypappéVeS EQAPHOYES 0TV apxIKr 080vn.
Mriopeite va QVaKTAOETE WA EQapuoyr TTou SlaypAaPnKe TiG TEAEUTAIEG 24 WPEC.
SV 086vn apyIkn, matiote LG > Zkoumidia epapuoy..

M0 TEPIOOATEPEG AEMTOUEPELES, AVATPEETE OTO I KOUTTIOIA EQAPLIOY..
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SmartWorld

Mriopeite va KatePACETE pia PEYAAN YKApA TIAKVISIWY, NXNTIKOU TIEPIEXOMEVOU,
EQAPHOYWV KAl YPAUUATOCEIPWY TIou TiapéxovTal and tnv LG Electronics.
MpPocappdOTE T GUOKELR AVANOYA HE TIC TTPOTIUATELS GOC XPNOIHOTOLWVTAG T
Béuarta g apyIkng oBévne.

E « Edv xpnotpomoleite Sedopéva Kivntrig TNAepwviag, pmopei va emPBapuvBeite
ME XPEWOELG Yia TN XPrion SeSopévwy, avaloya HE TO TPOYPAUHA XPEWOEWY
TIOU £€XETE EMAEEEL
« Autr n Aertoupyia prmopei va unv umootnpieta, avaloya HE Ty TepLoxr f
TOV TIAPOYO UTTNPETIWV.

YV apyikn 08ovn, matriote Smartworld.
Matiote : > Aoyaplaopoi LG kat ouvdedeite.

EmAéETE Kat IpayHATOTOIOTE AN TWV OTOIXEIWY TEQIEXOUEVOU TNG
QPEOKEIOG 0aG.

WN -

RemoteCall Service

Mropei va yivel amopakpuopévn S1ayvwan TG CUOKEURG 0OE yla TV €mAucn
Twv PoPANudTwy. ApxIKA, KaéoTe To Kévtpo e§urmpétnong mehatwv e LG
AKOAOUOWVTAC T MAPAKATW BripaTat:

5 « [la va XpnoILOMOICETE AUTHV TN AEToupYia, TPEMEL TTPWTA Val
OUMPWVIOETE HIE TOUG OPOUE XPHONG TNG AetToupyiag.
« Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
JE XPEWOELG y1a TN Xprion SeSopévuwy, avaloya HE TO TTPOYPAHHA XPEWTEWY
TIOU €XETE EMAEEEL

T Zmv apxikr 086vn, matiote LG > RemoteCall Service.
7 Mpaypatomolfote kKA\jon poc To Kévtpo e€umnpétnong mehativ tne LG.
3 Otav amavinBei n kKAon, akoAouBHoTE TIC 08NyieC TOU CLVEPYATN EMOKEVWY
yla va eloayayeTe évav eEaPrielo apiBpd.
+ EKTENE(TAl AMOMAKPUGHEVN GUVEEDN 0T GUOKEUN 0aG Kal EEKIVAEL N
QMTOUOKPUOHEVN UTTOOTHPIEN.
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Exmopnn KupéAng

Mriopeite va SeiTe TIC EKTTOPTTEC KEIUEVOU O TIPAYHATIKS XPOVO OE KATAOTACELG
£KTOKTNG QVAYKNG, OTIWG TUQUWVES, TANUUUPEC KAl GEIGHOUC.

TV apxikr 086vn, matriote Ekmopmn KupéAng.

Epappoyéc Google

Mrmiopeite va xpnotpomnolroete epappoyéc Google opilovtag éva Aoyaplaoud
Google. Otav xpnaotpomoleite pia epappoyr Google yia mpwtn gopd, epeavifetat
éva mapabupo kataywplong Aoyaplacpou Google. EGv Sev éxete Aoyaplaoud
Google, SnpioupynoTe évav amd T CUOKEUN 0ag. [a AEMTOUEPELE OXETIKA ME TN
XPrion Hiag epappoyng, cupBouleuteite Tn BorBela otnv idla v epappoyn.

E + OPIOPEVEG EQAPHOYEG EVOEXETAL VOl LNV AEITOUPYODV, AVANOYQ JE TNV
TIEPIOXN 1 TOV TTAPOXO UTINPECIWV.

Huepohoyio

H epappoyr} Huepoldyto oag emtpénel va mapakoloubeite To mpdypauua
oupBAvTwY oag (mou eoeic Snuioupyroate), opyavwpévo avd Huépa, ava 3
Hpépeg, EBSopdda i Mrjva.

Chrome
‘Evag ypriyopog, am\og, Kt ac@alng mepinynTig, @TIayUEVOG yia TOV GUYXPOVO 10TO.

‘Eyypaga

To Docs ival éva cuNoyIkd epyaleio emeepyaciag KelpEvou TTOU eVIOXVEL
TNV MapaywylkotnTta. Xpnotponorjote 1o Docs yia va SnUoupyroeTe, va
EMECEPYUOTEITE KO VO GUVEPYUOTEITE OE TIPAYMATIKO XPOVO.

Google Drive

To Drive gival xwpog amobrKeuong apxeiwv Kat KOG EQAPHOYRG TTou O€
S1eUKONUVEL VO BPELC, Va OLPACTEIS KAl OUVEQYAOTEIC O projects SOUAELAC amo
mavtou, dpeoa.
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Duo
Kdve amég, upnAri¢ molotntag BIVTEOKANTELG GTOUG GIAOUG GOV Kal 0TV
OlkoYéVela pe Ta TNAé@wva Android kat iPhones.

Gmail

To Gmail eivat pia eUkoAn oTn xprion epappoyr email mou Siatnpei Ta pnvopatd
060G A0Qar, KAVEL TO YPAHaTOKIBWTIO oag eEunvaTepo Kal 6ag BonBdet va giote
OPYQAVWHEVOL.

Google

H epappoyn Google o€ KpaTAEL EVALEPO YO TA TIPAYHATA TIOU OE EVOIAPEPOUV.
Bpeite ypriyopeg amavtnoelC, eEepeVVHOTE Ta EVOLOQEPOVTA 0ag, Kal PABeTe
LOTOPIEC KAl TTAPTE EVNMEPWOELG Y10l OEUATA TIOU 0AG EVOLOPEPOLV.

Xapteg

Mdte kamov; Mnyaivete pe Toug XAPTES, N EPAPKOYH 0TV OToia PMopE(Te
va BaotOTETE Yia TAOyNon O TIPAYHATIKS Xpdvo, yia Thv KukAogopia, Tn
OUYKOWVWVIQ, KL Y10l AETTTOUEPELEG YA EKATOUUUPIA LEPN, OTIWE KPITIKES KAl
Snuo@INeic WpEC.

Owroypagieg
To omiTi yla OAEG TIC QWTOYPAYIES KAl Tal BIVTES 0AC, AUTOUATA OPYAVWHEVD ETOL
WOTE VO YITOPE(TE va HoIpACeDTE Kall val amoBnKeVETE O,TL £XEL OHaciol.

Tawieg Play
XpnotpomolioTe Tov Aoyaplacué oag Google yia evoikiaon 1 ayopd Taviwy.
Mmopeite va ayopAoeTe EPIEXOEVO Yia avamapaywyr mavtou.

YT Music

Mia véa urmpeoia streaming pouoikrig amo 1o YouTube.

YnoAoyIoTIKA @UANG

To Sheets eivat éva cUNOYIKO epyaleio eme€epyaoiag UTOAOYIOTIKWY QUANWV
TIOU EVIOXVEL TV TAPAYWYIKOTNTA. XPNoIomolnote To Sheets yia va el0dyete, va
OPYAVWOETE Kalt va avaAUoETe TANPoPopieg padi 0€ TPAyUaTIKO XPOVO.
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Mapouaoidoelg

To Google Slides €ivat éva cuNoyiKo pyaleio Snpioupyiag mapousiaong mou
€VIOKVEL TNV TTapaywylkotnTa. Xpnotpornotiote to Slides yia va opyavwoete
TIANPOPOPIEC, VO TTAPOUCIACETE AMOTENESHATA, KAl VA TTaipveTe amo@doelg padi og
TIPAYHATIKO XPOVO.

YouTube

MapakohouBnoe Ta ayarmuéva oou KavaAia, AKOUOE TN MOUGCIKH o ayamdc, Kat
avéBaoe BIVTEO yia va HOIPAOTEIC e avOpwmoug amd GAo Tov KOGHO.

Bonbdg
H ouokeun oag €xel Tov BonB6 Google evowpatwpévo. Bpeite amavtroeig Kat Kave
TIPAYMATA 0TV TIOPE(a.

E « O BonBd¢ Google dev gival S1aBETIHOC OE GUYKEKPILEVEG YAWOOES Kal
XWPEC.

Files
Mriopeite va mpoBANETE Kall va SIOKEIPIOTEITE T APXEiD TTOU EXOUV amOBNKeUTE
0TN OUOKEUN 0aC.
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PuBpiosig

Mmopeite va TpooapUAOETE TIC PUOUITELS TNG CUOKEURC CUUPWVA HE TIC
TIPOTIUNCEIG 0QG.

SV apxikr 086vn, matrjote PuBpioeic.

« Edv ei0ayete Mé€n k\eidi oto mapdBupo avaditnong 0To endvw pépog
NG 006VNG, UMOPEITE va EKTENECETE TTO EUKOAA TOL OTOIXEIC TIOU TIPETTEL VOl
pubuioTOLV.

Aixtuo & Internet

AmmAA kapta SIM

Mrmiopeite va Slapop@WaoeTe TIC puBLicel SIMAG KapTag SIM.

T Zmnv 086vn Pubpioeig, matrote Aiktuo & Internet > Aumhr képta SIM.

7 Mmopeite va pooappuoETE TIC TAPAKATW AEITOUPYIEC:

Kapta SIM 1: Mmopeite va aMAEeTe To dvopa Kal To €IKoViSIo TG KApTag
SIM 1.

Kapta SIM 2: Mmopeite va aMAEeTe To dvopa Kal To €IKoViSIo TG KApTag
SIM 2.

+ Xpwpa Béparog kaptag SIM: ANGETE Ta XpWHATIKA BEUATa YIa TIG KAPTES
SIM.

Nertoupyia e€oikovopnong: EvepyomolroTe 1 amevepyomoloTe T
Aerroupyia e€oikovopunong. Ztn Aerroupyia €0IKOVOUNGONG, OV KANEOETE
U0l EMa@r 0TV oToia £XEl AVTIOTOIXIOTEL Al CUYKEKPIUEVN KapTa SIM,
Ba xpnotuomoinOei autr n SIM yia Ty KAjon akopa Kt av givat evepyn n
AN SIM ekeivn T oTtypn (€medn .y Xpnotpomotei Ta Gedopéva KivnTig
Aepwviag).

Agdopéva KivnTrig TNAepuwviag: Mmopeite va emAé€ete Tnv kdpta SIM
oV Bt XPNOIMOTIOLELTE Yia TV UTTNPEGia GEG0UEVWY KIVNTHAG TNAEPWVIO.
Mmopeite emiong va amevepyomolroeTe auTryv T AeToupyia.

Mepraywyn 6edopévwv: OpioTe AUTHY TNV EMAOYN YO VO EMTPENETE OTN
OUOKEU 00¢ va Xpnolporolei ta Sedopéva Kivn g TNAepuviag dtav
BpiokeoTe o mePLAYWYI EKTOG TOU KAVOVIKOU GaG SIKTUOU.
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- Agdopéva KIvnTHG TNAEPWViag Katd th Sidpkela TG KARoNG: ATIOKTHOETE
npoowpIva mpooBacn oe dedopéva KIvNTAG TNAEQWVIAS XPNOIUOTIOIWVTAG
Hia pn mpoemAeypévn Kapta SIM Sedopévwy Katd tn SlapKeLa piag
@wvNTIKAG KAjong HD pe v idia kapta.

Wi-Fi

Mrmopeite va uvOEDEITE pie KOVTIVEG OUOKEVEC PEow SikTuou Wi-Fi.

Tuvdeon oe diktuo Wi-Fi
T Zmv 066vn pubuicewy, matriote Aiktuo & Internet > Wi-Fi.
7 Natote To Kouuni yla evepyormoinon.
+ Ta diaBéotpa diktua Wi-Fi epgpavifovtal autdpata.
3 EmAéETe éva Siktuo.
+ Mmopei va xpelaoTei va eloaydyeTe Tov Kwdiko mpooaong Tou SIKTuou
Wi-Fi.
+ H ovokeun mapaleinel autrv T dadikacia ya diktua WI-Fl ota omoia
elye ouvdeDei oTo MaPeNBOV. Av Sev BéNelg va ouvdeDeic autdpata pe éva
oplopévo Siktuo Wi-Fi, méta 1o Siktuo Kat petd mdta Ataypaen.

PuBpioeg Siktoou Wi-Fi
3V 086vn pubpioswy, matrote Aiktuo & Internet > Wi-Fi.

« Metafaon o€ Siktuo KivnTAg TNAEPwViag: dv n Aertoupyia TG olvoeong
Sedopévwv KIvNTAG TNAEQuVIAE ival evepyomoinpévn, aAAd | CUOKEUN
Sev pmopei va ouvdebei oo Internet péow g olvdeonc Wi-Fi, n cuokeun
ouvdEeTal autopata oo Internet péow tng ovvEeong Sedopévwy KIvNTAG
TAepwviag.

E + Autij n Suvatdtnta e€aptdTal amod ToV TAPOXO UTINPECILV.

+ :MpooappooTe TIC PuBicES Tou Sikthou Wi-Fi.
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Wi-Fi Direct
Mriopeite va GUVOEDETE T GUOKEUN GaG O& GANEG GUOKEUEC TIou UmooTnpi{ouv
Wi-Fi Direct yia ameuBeiag kovr xprion Sedopévwy pe autég. Agv gival amapaitntn
N xprion onueiov mpoofBaong. Mmopeite va cuvdebeite e meploodTepeg amod dUo
OUOKEVEG xpnotpomolwvtag Wi-Fi Direct.
1 v 086vn pubpioewy, natiote Aiktuo & Internet > Wi-Fi> & > Wi-Fi yia
npoxwpnuévoug > Wi-Fi Direct.
+ O1KoVTIVEC OUOKEUEG Tou umooTnpiCouv Wi-Fi Direct epgaviovrtat
autépata.
7 Em\éETe wia OUOKEUN.
+ YUvdeon mpaypatomoleital 6tav n cUoKeur anodexTel To aitnpa ouvdeong.

E « H pmatapia evdéxetat va eavtAnBei ypnyopotepa dtav Xpnoluomoleitat
Wi-Fi Direct.

Aebopéva KivnTAG TNAEQWVIaG

Mropeite va evepyoroleite Kal va amevepyomoleite Ta dedopéva Kivntrig
TAepuwviag. Mmopeite emiong va SlaxelploTeite Tn xprion Sedopévwv KivnTtrg
Aepwviag.

Evepyomoinon deSopévwv KivnTig ThAEQwviag

T Zmv 0Bovn pubuicswy, matfiote Aiktuo & Internet > AeSopéva Kivntig
TAepwviag.

7 Matiote To Koupmi yla evepyomoinaon.

Mpocappoyn Twv pubpicewv dedopévwv KIvnTAG TNAEQWviag
T Zmv 0Bovn pubuicswy, matriote Aiktuo & Internet > AeSopéva KivnTig
mAepuwviag.
7 MpooappooTe TIC TapaKATw puBpicElC:
- Agdopéva KivnTrig TNAEPwviag: pUBIoN yia xprion cuvdéoewv dedopévwv
o€ KivnTd SikTua.
+ Meplopiopdg xprong perddoong dedopévwv: Béote éva dplo yla ) xprion
SeboPEVWY KIVNTAC TNAEQWVIAC. L€ TIEPITTTWON TIOU PTACETE AUTO TO OPIO,
Sev Oa empémetat mAéov n xprion SeSopévwy KIvNTAG TNAEQWVIAG.
: :TIpocappOYr TwV PUBHIcEWY SeSopévwy KIVNTAG TNAEPWVIAC,
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0 dykog xpriong Sedopévwy umoloyiletal e BAon To mMPoidv Kal 0 OyKog
10U UTTOAOYI{EL 0 TIAPOXOG 0agG EVOEKETAL VA SIAPEPEL

PuBuioeic kKAjogwv
Mropeite va TPOGAPHOCETE TIC PUBHITEIG KAOEWVY, OTIWE Y10 TIG QUVNTIKEG
KANOELG Kalt TIC eMAOYEC S1EBVAV KAOEWV.

E « Oplopéveg Aertoupyieg evoéxetat va unv umootnpilovtal, avaloya pe tThv
TIEPIOXN 1 TOV TTAPOXO UTINPECIWV.

1 Zmv 086vn pubuicswy, matfjote Aiktuo & Internet > Pubpiosic KAoswv.
7 MpooappooTe TIC PUBKITELC.

Tethering

Z0vbeon Péow KIvNTNAG OUOKEVRG e USB

Mriopeite va 6uvSEDETE T GUOKEUN 0€ AN cuoKeun Léow USB yia kovi xprion

Sedopévwv KivnTg TNAEPWVIAG.

1 Zuvbéote T oUOKeUN 0OC e ANEC OUOKEVEC PEoW Kahwdiou USB.

7 Znv 0Bovn pubpioswy, matiote Aiktuo & Internet > ZUvSeon péow KvnTAg
OUOKEUNG > ZUvEon péow KIVNTHG cUoKeLG pe USB kat 0Tn ouvéyela
matioTe 1o Koupri () ) yla evepyomoinon.

E « Ta autv Ty emoyn xpnotpomolotvtal Sedopéva KivnTrig TNAEQwVIag
Kal umopei va emBapuvoeiTe e XPEWTELS yia TN Xprion Sedopévwy,

QVANOYQ E TO TIPOYPAUUA XPEWOEWY TTOU EXETE EMAEEEL M TEPIOTATEPES

TIANPOPOPIES, CULBOUAEVTEITE TOV TTAPOYO UTTNPETIWV.

la oUvdeon og uTOAOYIOTH, KATERAOTE TO TPOYpPapua odrynong USB amd

TNV TomoBecia Www.lg.com Kat YKATAOTIOTE TO GTOV UTIONOYIOTH.

«Aev gival Suvatr n amooToAr i N AP apxeiwv PETagl TG CUOKEUNG
0ag Kal VoG umooyioTr dtav eivat evepyomoinuévn n ovvdeon USB.
Amevepyoroljote T ouvoeon USB yia tnv amootoAr i APn apxeiwv.

« Ta AerroupyIka GUCTHAUATA IOV UTTOOTNPI(OUV AUTOV ToV TUTIO CUVSEDNG
givat ta Windows XP 1 petayevéotepn ékdoon, fj To Linux.
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®opnto onpeio mpooBaong Wi-Fi
Mriopeite va 0piOETE TN GUOKEUN WG AOUPHATO SPOPONOYNTH, £T01 WOTE Ol ANNEG
GUOKEVEG va pumopolv va ouvdeBoulv oo Internet xpnotpomolwvtag ta dedopéva
KIVNTAG TNAEQVIag TG CUOKEUNG 0ag.
T Zmv 0B6vn puBpicewy, matiote Aiktuo & Internet > Tethering > ®opntd
onpeio mpdaBaong Wi-Fi kal émeta matriote yla evepyomoinaon.
Ayyi€te PUBHion popntou onpeiov mpooPacng Wi-Fi kat kataywpiote 10
QAVayVWPIOTIKO Katl Tov Kwdikd mpdoBaong tou Ovopa Wi-Fi (SSID).

2
3 Evepyomotfjote to Wi-Fi 0TtV G\ 0UOKEUR Kat EMAEETE TO Gvopa ToU SIKTUOU
NG ouokeung otn Aiota Wi-Fi.
/A MAnktpoloyrote Tov Kwdikd mpdoBacnc SIKThou.
E « [a autv Ty emdoyn xpnotpomolobvtal Sedopéva KIvnTrig TNAEQWVIag
Kal Umopei va mBapuvoeiTe pe XPEWOELS yia TN Xprion Sedopévwy,
QVANOYQ LIE TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIES, CULBOUAEVTEITE TOV TTIAPOYO UTTNPETIWV.
« Mmopeite va Bpeite mepIoodTEPES TANPOPOPIES OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#wifi

Xpovodiakdmtng amevepyomoinong gopntol anpeiov mpooBaong Wi-Fi

‘Otav 1o onpeio mpooRaong Wi-Fi Sev éxel xpnotpomolinei yia oplopévn mepiodo,
amevepyoroleital autdpata. Mmopeite va opioeTe Ty wpa o BEAETE va
EKTENEOTEL AUTOMATN AMOCUVOEDN.

Bluetooth tethering

Mia ouvdedepiévn e Bluetooth cuokeun pmopei va cuvdebei oto Internet

XPnotpomolvtag ta Sedopéva KivnTrg TNAEPWVIAG TG CUOKEUNG 0aG.

1 Zmv 086vn pubuicswy, matfjote Aiktuo & Internet > ZUv8eon péow KIVNTAG
ouokeung > Bluetooth tethering kat otn cuvéyela matriote To koupmi yla
gvepyormoinon.

7 Evepyorolfote To Bluetooth kai 0TIC 500 GUOKEUEC, Kal TIPAYUATOTIONOTE
Cevén.
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5 « Ta autv Ty emoyn xpnotpomolobvtal Sedopéva KIvnTHiG TNAEQwVIag
Kal propei va emPBapuvBEeiTe Pe XPEWOELS yia Tn xprion dedopévay,
QVANOYQ HE TO TIPOYPAUMA XPEWOEWV TTOU £XETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIEC, CUMBOUAEUTEITE TOV TAPOXO UTINPECIWV.

« Mmopeite va Bpeite mepIoodTEPES TTANPOPOPIE OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#Bluetooth_tethering

BonBsia
Mriopeite va mpoBahete T BoriBeta oxeTIKA pe TN Xprion cuvdéoewv kat hotspot.
SV 086vn pubuiogwy, matrjote Aiktuo & Internet > Tethering > Borjfeia.

Nertoupyia mtRong

Mriopeite va amevepyomnoloeTe TG Aettoupyieg KAjong kat SeSopévawv Kivntrig
Agpwviac. Otav autr n Aertoupyia gival vepyoroinpévn, ot AEIToupyieg ou
Sev amartolv T xprion Sedopévwy, OTwg matkvidia Kat avamapaywyr LOUCIKAG,
Tapapévouy SlaBEoIpEC.

1 Zmv 0Bovn pubuicewy, matiote Aiktuo & Internet > Aertoupyia mTriong.

7 Matiote otnv 086vn empePaiwonc.

Aiktua KIvNTAG TNAEPWViag
Mriopeite va TPOGAPHOCETE TIG PUBHITELG SIKTUWV KIVNTAC TNAEQWVIAG.
1 Zmv 006vn pubuicewy, matfjote Aiktuo & Internet > Aiktua Kivn TG

TAgpwviag.

2 MpocappooTe TIG TapaKATW PUBpIcEL:

+ Aertoupyia Siktvou: EmAéEte TUMO SikTUOUL.

+ Ovopata onpeiov mpooPaong: Na epedavion rj alayr Tou onpeiov
TIPOOaONG Yia TN XPron UMnEeatwv SeSopéVwY KIVNTAG TNAEQviac. Na
va aMGEeTe To onpeio mpooBaong, emAégTe éva atolyeio amd tn Aiota
onueiwv mpooBaong.

Etaupeieg Sitoou: Ma avalritnon mapdxwv SIKTUOU Kat autopath cuveon
o€ Kamolo SikTuo.

PuBuioeig 141



VPN

Mmopeite va ouvdebeite o€ éva ao@aNég eIKOVIKO SiKTUO, TIX. O EVa ECWTEPIKO
€TAPIKO SiKTUO. MMTOpE(TE £MONG Vol SIOKEIPIOTEITE TA GUVSESEPEVA EIKOVIKA
1SlwTiKa SikTua.

Mpoaodnkn VPN

1 Zmv oBovn pubuicewy, matfjote Aiktuo & Internet > VPN.

2 TNatrote o Koupmi .

3 Ewaydyete ta otoixeia tg ouvdeong VPN kat matriote AmoBrikeuon.

Alapoppwon twv pubuicswv VPN
1 % Niota VPNS, em\é€te éva VPN.
7 Ewoaydyete ta otolyeia hoyapiacpol xpriotn VPN kai atiote ZovSeon.

- Ta va anoBnkeVoETe Ta OTOIXEIA TOU Aoyaplacpoy, emAEéETe To mAaiclo
ehéyyou AmoBrikeuan atolxeiwv Aoyaplacuov.

I61wTikd DNS

Mriopeite va Slopop@woeTe TiG emhoyég IS1wTikol DNS (Domain Name System).
1 Zmv 0B6vn pubuicewy, matfjote Aiktuo & Internet > I81wtikd DNS.

7 Kavte v emhoyr mou Bé\ete kai matriote AmoBrikeuon.
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Tuvdedepéveg CUOKEVEG

Bluetooth

Mriopeite va GUVOEDETE T GUOKEUN GOG O€ KOVTIVEG CUOKEUEG TIou umtooTnpilouv
Bluetooth yia avtaMayr SeSopévwv e QUTEC. ZUVOEDTE T GUOKELN 00 O éva
OKOUOTIKS Kat éva MANKTPOAOGYI0 He Suvatdtnta Bluetooth. Etot o éNeyxog Tng
OUOKELNC Bal gival EUKONOTEPOC,

Z0Ceuén pe AN cuokeun
1 Zmv 0B6vn pubuicewy, matiote Zuvdedepéveg ouokevéc > Bluetooth.
7 Matiote 1o Koupmi yla evepyomoinaon.

+ O18100¢01pEC OUOKEVEC ppavifovTal auTopaTa.

- Tava avaveqoete  Nota ouokeuwy, atfote ().

E + Movo 01 GUOKEUEG TTOU €XOULV OPIOTE! WG 0paTEC EPaviCovTal ot AioTa.

3 EmAé€Te pia ouokeur amd tn Aiota.

/I AkohouBroTe TIC 08nyie¢ Tou pgavifovtal atny 006vN yia va
TIPOYHOTOTIOIOETE EAEYXO TAUTOTNTOC.

E + Autd T0 Bripa TAPCAAEITETAL YIa CUOKEVEG OTIG OTIOIEG EXEL UTTAPEEL
TP6oPaon oTo MaPeNBoV.

Anootoln edopévwy péow Bluetooth
T EmAé€te éva apyeio.
« Mmopeite va oteilete apyeia MOAUPESWY 1) OTOIXEIQ EMAPWV.
7 Natiote < > Bluetooth.
3 EmAEETE ot GUOKELK TIPOOPIGHOU VLA TO apXEiD.
+ To apyeio amooTENETAL LONIG YiVeEL AOSEKTO A Tr CUOKEUK TTPOOPICHOU.

E «+ O181ad1Kacieg Kovrg xpriong apxeiwv evoéxetat va Slapépouv avahoya e
TO apxeio.
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Kowvn xprion 0066vng
Mmopeite va avamapaydyete Tnv 08vn Kal Tov X0 TG OUOKEUNG OF i
Sl0(OPETIKI) GUOKELN, OTIWE Jia TNAEOPacn, Tou umooTnpilel Tn Aettoupyia
Miracast.
T Zmv 0Bovn pubpiccwy, matriote Tuvdedepéveg cuakevég > Ko xprion
006vnc.
7 Matiote 1o Koupmi yla evepyomoinon.
3 EmAéETe pia GUOKEUR a6 Tn Ai0Ta TWV KOVTIVGV GUCKEUWV.
+ Edv n ouokeun mou Béete Sev epgaviletar, matriote Avalitnon yia va
QVAVEWOETE TN NioTa.
« Agou emteuyOei oUvdeon, oTn ouokeun Ba eppavioTei n 08évn Tou
TNAEPWVOU 0aC.

E « H epappoyn Kovig xpriong 086vng amevepyomoleital autopata eav dev
UTTAPXEL KOVTA CUOKEUH GUUBATH HE TN SuVaTOTNTA KOG XPHONG.

NFC
Mriopeite va XpnOIOTIOICETE TN GUOKEUH WG I KAPTA Yia Ta Uéoa MalIKNG
METOQOPAE 1 WG TMOTWTIKA KApTa. Emiong, umopeite va kotvomolroete Sedopéva
o€ AN\EC CUOKEUEC,
1 Zmv 006vn pubuicewy, matote Zuvdedepéve ouokeuég > NFC.
7 Matiote 1o Koupmni yla evepyomoinaon.

« Ayyi€te ™ ouokeun oag pe AMn cuokeun iou umooTnpilet NFC yia

avtoAayr dedopévwv.

E « Hkepaia NFC umopei va Bpioketat o€ SIaQopeTIkd onpeio avaloya Ue Tov

TUMO GUOKEUNG. MO AETTTOEPELEG OXETIKA E TNV TIEPLOXT TG Kepaiag NFC,
avatpé€te 0NV evotnTa EMOKOTNON OTOoIXEWV.
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Mivakag kovomoIoewv

Mmopeite va KoOToIOETE EPIEXOUEVO a6 To ANUTTOUR, TN MOUGIKR Kat T
Alayeipion apyeiwv oag og KOVTIVEG OUOKEVEG. Mmopeite emiong va KovomoloeTe
TO TIEPLEXOUEVO OE OUYKEKPIUEVA ATOHO OE EQAPUOYEG TTOU UTTOOTNPI(oLV TN
Suvardtnta dueong kotvomoinong tng Google (Google Direct Share).

T Zmv 086vn pubpicewy, matriote Zuvdedepéveg ouokevég > Nivakag

KOIVOTIOINCEWV.

7 Anevepyornojote kGO emoyn xpnotponotwvtag 1o puduoTikd @ .

+ Kovtivég ouokevég: Mmopeite va EPQAVIOETE TIG KOVTIVEG OUOKEUEG HIE TIG
OTIOIEC UMOPEITE VAL IOIQAOTEITE TIEPIEXOLEVO QMO TIC EPAPHOYEC ANUTTOUY,
Mouaikn kat Alaygipion apyeiwy,

+ Apeon kovomoinon: Amd pia pappoyr mou umootnpilel T duvatdtnta
Apeong Kowvoroinon tng Google (Google Direct Share), pmopeite va
EUPAVIOETE €Va €IKOVISIO TIOU GAG EMTPETEL VA POIPACEDTE TTEPIEXOUEVO LIE
OUYKEKPIUEVOUC avOpWIToUC.

Kowvi Xprion Apxeiou
Mriopeite va oteileTe 1 va AAPETE apyeia avapesa 0Tn GUOKEUN 0ag Kal 08 ANAN
ouokeun 1 tablet tng LG.

1 Znv 0Boévn pubuicewy, matote Tuvdedepéveg ouokevég > Ko Xpron
Apxeiou.

7 MpooappdoTe TIC TapaKATw puBpicEl:
+ WING: yia va aAAEETE To GVOa TG CUOKEURG.

- AmoBrKeuon GE: 0PIOTE TOV PAKENO TIPOOPIOHOU YIa TNV ATTOBNKEVON TWV
apxeiwv mou amooTéNovTal armd AANEG GUOKEUEC.

+ Kown Xprion Apxeiou: yia va emrpépete T Ajbn apxeiwv mou
anootéNovtat and AAEC GUOKEVEC.

- SmartShare Beam: yla va HOIPAGTEITE APXEID e ANNEG CUOKEUEC LEGW TOU
SmartShare Beam.

- BonBeia: umopeite va Seite T BoriBeta yia Tnv kovomoinon apxeiwv.
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Alakopioti¢ mMoAUpEowY

Mriopeite va oIpAOTEITE TIEPIEXOMEVO TTOAUMEOWV OTN CUOKEUN| 0QG HE KOVTIVEC
OUOKeVEG Tou umooTnpiCouv DLNA.

1 Zmv 006vn pubuioswy, matote ZuvSESEUEVEC CUOKEVEC > AIOKOUIOTAC
TOAUHECWV.
7 Mpocapp6oTe TIG TapaKATw pudpicel:
+ Kotwn xprion meplexopévou: HoIpaoTEiTe TIEPLEXOMEVO TTOU BPIOKETAL OTN
GUOKEUTN 00 € AANEC KOVTIVEG GUOKEVEC.
+ WING: opioTe T0 dvopa TG CUOKEUNG 0ag

E « Av@hoya e TO TIPOIOV TOU XPHOTH, TOl OVOHATA TWV MEVOU EVEEXETAL Va
Slapépouv.

+ To MEPIEXOHEVO MOV OE KOIVH XPrON: EMAEETE TOV TUTIO TOU TIEPIEXOHEVOU
TIOAUHEOWV TIOL Ba OLPATEDTE e ANNEG CUOKEUVEC,

E€oucio80tnpéveg oUOKEVEG: OeiTe ia AoTa JE TIC CUOKEVEG TTOU

EMTPEMETAL VA £XOUV TIPAG OO OTO TIEPIEXOUEVO TNG OUOKEUNG OOIC.
+ Mn-eyKeKPIPEVEG GUOKEVEC: OeiTe pial NioTal LIE TIG OUOKEUEG TToU Sev
EMTPEMETAL VA £XOUV TIPOOBACT OTO TIEPIEXOMEVO TNG CUCKEUNG 0AG.

Extomwon

Mmopeite va ouvdéoete Tn ouoKeun oag o€ évav ektunwth Bluetooth kat va
EKTUTIWOETE TIC WTOYPAPIES 1} TO EYYPOPA TIOU £XOUV AMOONKEUTEL 0T GUOKELN).
SNV 086vn pubpicswy, matrote Zuvdedepéveg GUOKEVEC > EKTUTIWON.

« Matriote NpoemAeypévn UNNPEGIa EKTUMIWONG Yia va yivel avaltnon
EKTUTIWTOV LE TOUG OTIO{0UC popeite va ouvdeBeite. H natiote + >
MpocBKn EKTUMWTWV yla va TPOCBECETE XEIPOKIVNTA évav EKTUNTWTH.

- Natfote (+) NMpoobrkn urnpeoiag yia va ANaPete TV Qappoyn TOU EKTUNWTA
o BéAeTe.

E « Aut n SuvatotnTa eivai Siabéaiun pévo 6tav To Siktua KIvnTHg
Aewviag i n Aerroupyia Bluetooth givat evepyomoinuévn.

« Tava NdBete Ty epappoyr extunwtr oto (+) Mpoadiikn ummpeciag, 6a
TIPEMEL MPWTA VA 6UVSEDE(TE TOV Aoyaplacpo aag Google.
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Hxo¢

Mriopeite va TpooapHOCETE TI PUBITELS ixou, Svnong kal eildomotioewv.

SV 086vn pubuioewv, matriote HYog Kal TPOCUPHOGTE TIG TAPAKATW PUOLICEIG:
« Hynmikd mpoil: aA\d€te T Aettoupyia fixou o€ ‘Hxog, Mévo dévnon, ry

Tiyaon.
‘Evtaon;: puBpion tng évtaong fixou yia ta Sid@opa oTolyeia.

+ 'Hxog kAfong: EmAE€Te évav xo KAong yia eloepxopeves KAoeLS. MpooBéote

1) Slaypayte rixoug KAjong.

« 'Hyog ei8omomoewv: EmAé€Te évav fixo eidomoinong. OpioTe éva pouaiko

KOUMATI TTOU £€XEl AmOBNKEUTEL 0TN GUOKELN WG X0 e18omoinoNG.

+ 'Hyot cuatApatog: EmAéETe KABE Y0 CUCTAUATOG Y10 VOl TOV EVEPYOTIOINTETE 1

QMEVEPYOTTOINOETE.

+ 'HYog kAfjong pe d6vnon: Pubpiote T ouokeur yia dévnon Kat avamopaywyn

X0V KAoNG TauToxpova.

« Ringtone ID: dnpioupyei évav rixo KAong yla pta El0EpXOHEVN KARON Ao pia

OUYKEKPIUEVN EMOQN.

+ To @Mag avapet otav umdpyxet el0epXOpevn kKAfjon: Pubpiote va avaBooprivet

TO QAAG CUUPWVA PE TOV i1X0 KAong TG LG.

+ Mnv evoyAeite: OpioTe TV wpa, Tn SIAPKELD Kal Tov TUTTO EpappoYG yia Ta

omoia 6a AapBavete unvopata eidomoinong. Mmopeite va AapBavete unvopata
€160TOIOEWV POVO OE GUYKEKPIPEVEG NUEPEC TNG ERGOUASAC.

+ ModTNTa RXOU Kalt £@E: XpNnOIUOTIOIoTE TN AgToupyia yia va pubuioeTe Tnv

TOLOTNTA X0V Kall TA EPE KATA TV avamapaywyr vog Tpayoudiou 1y Biveo.

- 'Evraon: puBuion g évtaong nxou yla ta S1agopa oTolxEia.

- Kavovikomoinon évraong: XpnouomotoTe T Aertoupyia yia va
OUANOTIOINCETE TNV TOOHTNTA SIAYOPETIKWV TINYWV HXOU.

- loooTabuIeTAG: XpNnolpomoloTe T AEIToupyia yia va MPOCapUOCETE TIG

puBbuioel loooTABUIOTH.

Tpiadidotarog "Hyog Mnyavn LG: Xpnolpomoinoe Tv Aeitoupyia yia va

mai€elg pouoikn A Bivteo oe Tpiodiaotarto, ePPuBIOTIKO Kat {wvtavd fixo

OTAV AKOUOTIKA, NXEIO 1} GANEG EEWTEPIKEG CUOKEVEC fixou Eival ouvOedeéval.

Mo Aemrtopépeleg, avatpé€te otny evotnta Tpiodidotatog ‘Hyos Mnyavi LG.

+ Autdpartot umétithot: PuBpioTe Tn oUOKEUR WOTE va avayvwpilel Tn ewvr oTa

TIOAUUEDA Kall VAl SNoupyel autdpata umdTITAouG.
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- 'Evtaon 80vnong: mpooapuooTe Ty évtaon g S6vnong.

- TOmog 66vnong: pumopeite va emAEEETe Tov TOTO G6vNnong mou Ba
EVEPYOTTOLETAL KATA TN AN KAOEWV.

+A6vnon Katd To matnpa: opioTe T GUOKELN va Goveital dtav ayyilete
0pIOEVA OTOIYEID OTNV 0006V,

Eidonomoeig

Mriopeite va Seite pia NioTa eyKATAoTNHEVWY EQAPHOYWV KAl VA SIAHOPQWOETE
TIC pUBHioEIC yia e80TI OELC,

T Zmv 086vn pubuicswy, matriote EIGomoIRoEL.

7 ANAETE TIC pUBUIOEIC CUPPWVA UE TIC AMTAITAOELC 0OC.

MpofBoAn

Mriopeite va TpooapHOCETE AeMTOPEPEIG PUBLITELC yia KABE TUTO 0686VNG.

TV 086vn pubpioswy, matrote MpoBoAn Kal TPOGAPHOOTE TIG TAPAKATW

puUBpioElC:

+ ApXIKR 006vn: TPOCAPUOOTE TI PUBICELS yia TV apXIkr 086vn. MNa

Aemtopépeleg, avatpé€te otnv evdtnta PUbioeic apyiknc 086vnc.

Ztpo@ry Home: mpooappudoTe Ti¢ pUBIOELS yia TV apXIkr 08vn Tng

Aertoupyiag mePIOTPOPNC.

lpappn moriynong: Alapop@woTte T Fpapur morynong. Mo AemTopépeleg

BAéne Xprion e lpaupric morjynong

AOD (always-on display): va epgavi{ovtat mavta mAnpogopieg Omwg

N NUEPOMNVIQ, N WEA Kat Ol EI50TOINCELC, AKOpA Kat 6Tav n 08dvn eival

anevepyoroinpévn. Na Aemtopépeieg PAéme AOD (Always-on Display)

+ Aeutepn 006vn: OpioTe TN WTEIVOTNTA 1 TO XpwHa 088vNnG TG SeiTtepn(
obovng.

« Avetn mpofolr: puBLIOTE TN CUOKEUH £TOL WOTE VOl JEIWOETE TNV TOCOTNTA
TOU MIMAE QWTAC 0TNV 086V Kall VO TIEPIOPIOETE TNV KATATTOVNGON TWV HATIGV.

- Aerroupyia vuxTdg: Mmopeite va eQapUOCETE éva ayxvo Béua 08évng yia va
amo@UYETE T évtovn Aappn tng 086vng Katd tn SIdpKela TG vOXTag.
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- Xpwpa 080vng: Pubuiote To xpwia, T Oepiokpacia xpwHaTog yia Thv
emOBuuntr} 0B6vn.

E « Matrote O Y10 VO EMAVAQEPETE TIC PUOLIOELC,

Evioyutrig Bivteo: Kata v avamapaywyr evog Bivieo og Aertoupyia mApoug

0006vng, pmopeite va aMAEETE TIG pUBIoEIC WOTE Ta ¥pwHaTa va mpofdAloval

TTO PWTEIVA Kall SUVAMIKA.

« Tpappatooelpd: ANAETE TO PéYEBOC TNC YPAUMATOOEIPAC, TV VTAON TNG
YPa@NG 1 T YPapUATOCEPA.

+ XpwHaTIKAG TOVOG: ANAETE TOV XPWHATIKO TOVO yia TIG pUBLICELS, Ta HEvoy, Ta
mapdBupa eI50MOICEWY, KNTT.

- MéyeBog 006vng: Opiote To péyebog Twv oTolxEiwv 0TV 006VN OTTWE 6ag

Bolevel Kamola otolyeia evdéxetal va aldEouv Béon.

MARpEng 086vn epappoyég : EmAéSTe pappoyEg mou Ba avoiyouv og APNG

00ovn.

QuwTevoTNTA: XPNOIHOTIOIOTE TN YPAPHK KUAIONG Yia val aAAEETE TN

PWTEVOTNTA TNG 00OVNG TNG CUOKEVAC.

AutopaTo: pUBIOTE T CUOKEUN £TOL WOTE N PWTEVOTNTA TNG 086VNG va

puBUiCeTal aUTOUATA CUUPWVA LIE TNV EVTAOH YWTOC TOU TIEPIBEANOVTOC.

MpooBetn putevoTnTa: EMtpénel otnv 086vn va gival mo Qutewvr ano

UEYIOTN PUBUION QWTEVOTNTAG.

Aijén xpovikou opiou 006vNG: AmevepyomolEiTal AUTOMATA N GUCKEUN OTav

TIAPApEVEL 08 adPAVELd Yia éva KaBopIopévo Xpovikd Sidotnpa.

Autopatn meplotpo@ri 080vng: MeploTpépetal autdpata n 08évn avaloya pe

TOV TIPOGAVATONIGHO TNG CUCKEUNC.

Mpog@uhagn 006vng: Epgavietal mpo@uAagn 0Bévng 6Tav n oUCKEUN €xel

ouvdebei otn Bdon ry Tov @opTioTr. EmMAECTE Tov TUTO TPOPUAAENG 006VNG

o BéAete va epgavietal.

000vn pe 1o éva xépt: MikpUVeTe To péyeBog Tng 08dvng, £T01 WOTE va

UMOPEITE VA XPNOIUOTIOLEITE Tr) GUCKEUN HIE TO £Val XEPL.
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dovro & Oépa

Mmopeite va emAé€ete povTo, Bépa 086vng, oTul ikovidiwv i} AOD (Always-on
Display) yia tn ouokeun oag.

T Zmv oBovn pubpicewy, matriote ®ovTo & Oépa.

7 Matiote ®6vto, Oépa, Ewovibio 1) AOD yia va aMAEeTe TIC pUBUITELC.

KAeidwpa 006vng & ac@paleia

Mmopeite va TpooappOoETe TIC pUBUIELS TNG 00OVNG KAEIGWHATOC KAl TNG
ao@ealelag.

T Zmv 06ovn pubpicswy, matriote KAeidwua 006vng & ac@dheia.

7 MpooappooTe TIC PUBKITEIC.

- Google Play Protect: ZapwoTe Tn cuoKeUn 0a¢ KaBnpepva yia moavawg
BAaBepéc epappoyéc.

- EOpeon ouokeunq: Mapakoloubriote Tnv TomoBeoia TG GUOKEUNG
QMOUAKPUCHEVA. MTOPEITE EMONG va TPOOTATEPETE PIE AOPANELD TAl
Sedopéva oag edv XAoATE Tr) GUOKEULN GG,

+ Evnpépwon ac@dleiag: Eheyxog yia evnuépwaon AoylopIKoU Kal
Slapopewon PUBUIcEWY AUTOUATNG EYKATAOTAONG.

+ Aaléte KAeibwpa 006vNng: EmAEETe Tn péBodo kKheldwpatog 086vng mou
BéAete. Mo NemTopépeleg, avatpé€te otnv evotnta PUbuion KAeibwpatog
066vng.

- Mapaperpomoinon KAEWSWpaATOg 000vNn¢ KAEISwpaTog: ANy Twv
TIANPOYOPILWV TTOU Eppavilovtal TV KAEIGWHEVN 006V,

+ PuBpioeic ac@aloug KAeWdwpatog: ANAETE TIC pubuioelg KAEISWUATOg
ao@aAeiag.

+ AAKTUA ATTOTUNIWHATA: XPNOILOTOIOTE TO SAKTUNKO 0agG OmoTUMWHA yia
va Eekheldwoete TV 086vn 1 To TEPLEXOUEVO. Mol AeTTOpEPELEC, avaTpESTE
otnv evotnta Avayvwpion Aaktul. Amotunwuarta - lapouaoiaon .

+ K\eidwpa mepIegopévou: Lag MTPEMEL va OPITETE TUMTO KAEIOWHUATOG
(kwd1kd mMpdoPaong 1 poTtiBo) yia Ta apxeia oag Zuloyric.

- Kpuntoypdgnon & Siamoteutipia: Alapop@woTe TiC pUBUIoELS yia TV
KPUMTOYpA@non Kai Ta SlamoTeuTrpla T kdptag SD.

- Kpumntoypd@non kdptag SD: Kpuntoypa@rioTe TV KAPTA PVAKNG Yl va
QMOTPEPETE TN XPHON TNG 0€ AN GUOKEUN. Mo AETTTOUEPELEG, VaTPELTE
otV evotnTa Kpurroypdenon kaptag UvALnG.
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- Mpootagcia Siamoteutnpiou: TPoBOAr TUTOU TOU XWPEOU amoBriKeuong
6mou Ba amoBnKeUTEl TO MOTOTOINTIKG AOPAAEIAC.

- A&iomota Siamoteutrpia: Mpoolr Twv pilikwv motomontikwv CA
TOU GUOTAHOTOE 0aG KAl Twv ToTomolnTikwv CA mou €xouv eyKataoTtadei
amnd 1o xpriotn.

- MamoTteutipia xprio: Mpofo kat aAayn Twv aceav

TANPOYOPLWV TIOTOTOINTIKOU TTOU €ival amoBNKEVUEVES OTN CUOKEUN

oag.

Eykatdotacn amd tov amoOnkeutiké Xwpo: Eykatdotaon evog

a0QANoUG OTOTOINTIKOU Ao pia Povada amobrKeuong.

EkkaBdpion Siamoteutnpiwv: Alaypar ao@alwy TMOTOMOINTIKWY TTOU

£XEL EYKATAOTIOEL O XPrOTN KOl TWV OXETIKWVY SIOMIOTEUTNPIWV.

AloXEIPIOTEG GUOKELWV: EKYWPNOTE SIKAIWHATA YA VO TTEPIOPIOETE TOV

€NeyxO0 N} TN XPON TNG OUCKEUNG OE CUYKEKPIUEVEG EQAPUOYEG.

+ Trust agents: EugavioTe Kal xpnotpomorote ta trust agent mmou €xouv

£yKATAOTAOEL 0T OUOKELN).

Kapgitoa 006vng: Pubpiote Tnv 006vn epappoywv €101 WOTE va gival
Suvatr HOvo N xPron TNG EGAaPUOYNE TTOU €ival evepyr) TNV eKAOTOTE
otiypn.

MpoaBacn xpnong: Seite AeMTOPEPEIEG OXETIKA HE TN XPON EPOPHOYWY
OTN OUOKEUH.

Anoppnro

Mriopeite va Bpeite kat va aM3EeTe ONeC TIG pubioelg amoppriTou 6ag.

1 Zmv 0B6vn pubuicewy, matjote AéppnToO.
7 NpooappooTte Tig pubuicelc.

« SlaxelplotigAdeia: ag emrpémel va deite kal va aMdeTe Ta Sikaiwpata
IOV €XETE SWOEL OTIG EQPAPHOYEC.

+ K\eibwpévn 0006vn: Zag emTpEmNel va 0pIOETE TIG E60MOINOELS TTou Ba

epgpavifovtal otnv 086vn KAeldwpaTog.

Na @aivovtai ot kwdikoi mpooPacng: Evepyomoirote autrv Ty emoyn
yia va eppavietal yia cUvTopo SIdoTnua KABe XapakThpag Tou Kwdikoy
TPOORaoNG KaBWG Tov MANKTPOAOYEITE WOTE va BAEMETE TL EIOAYETE.
YTinpeoieg e§aTOHIKEUONG CUOKEVNG: Zag eMTpémel va AABETE Wia mpoTaon
Ue BAon Toug XPrOTEG, TIG EPAPHOYEC Kall TO SladpacTIKO TEPIEXOUEVO.
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+ Aut. ZupmAfRpwon amod v Google : Evepyomolote autriyv Ty emioyn
yla va yivetal eloaywyr Twv MANPOQOPLWV TOU gival amoBnKEUUEVEG
070 Aoyaplaopoé oag, omwg Kwdiko mpdoPaong, Sievbuvon ry
aplOPoL MOTWTIKAG KAPTAG HE éva pdvo mdtnua. Mmopeite emiong va
QITEVEPYOTIOIOETE AUTHY TNV EMAOYH, Va XPNOILOTOINCETE TN AetToupyia
AutopaTng oupmiipwong tng Google iy va mpooBéoeTe éva véo
Noyaplaopd urnpeoio.

« lotopiko TomoBeciag Google: Lag EMTPEMEL VA EVEPYOTIOINOETE 1 va
amevepyomoloeTe To loTopiko TomoBeaiwv. Otav €xel evepyomoindei, n
Google amoBnkevel MePIOSIKA Kal XpnOIOTIOLEL Ta IO TTPOo@aTa Sedopéva
TomoBeaiag Tou TNAEPWVOU 0ag og GUVEUACHO LUE TO AoYaPIAoHd Gag
Google.

TtV 066vn loTopikd TomoBeoiwy, MaTAOTE * yia va Seite Kayf va
Slayelploteite Ta Sedopéva TomobeoIV 0.

- Ztoixeio eNéyxou SpaotnpioTnTag: EMAEETE TIg SpaoTnEIOTNTEG KAl TIG
TANpopopieC Tou BéNeTe va amobnkevel n Google.

+ Alagnpioelg: Zag emrpénel va SeiTe To avayvwploTIKO Sla@npicewy kai va
0pIoETE EEATOUIKEVEVES DlOPNUIOELG.

+ Xprion kat SiayvwaoTikd: Evepyomolote autrv Ty emAoyn yla va
ouvteNéoete 0Tn BeNTiwon TG epmelpiag Tou Android Péow TG autopaTng
amooTo¢ SlayvwoTiKwy dedopévwy, SeSopévwv GUOKEUNE Kal Xprong
gpappoywv otn Google.

TomoBecia

Mriopeite va eNéyEETE TOV TPOTIO TIOU KOVOTIOIOUVTAL Ol TANPOQOPiEC TomoBesiag
00€ Kal va puBIoETe Ta Sikalwpata mpoopaong oTig mMnpogopieg Tomobeaiag
oag,

TV 086vn pubpioswy, matrote TomoBeoia kat pubpioTe Tn Aettoupyia mou
Béhete.
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Enextaosig

Smart Doctor

Mriopeite va xpnotpomotrjoete 1o Smart Doctor yia va SlayvwoeTe Ty KataoTtaon
TNG OUOKEUNG KAl Vol TN PEATIOTOTIOINOETE.

YV 086vn pubuicgwy, matriote Emektaoeig > Smart Doctor.

Context Awareness

Mriopeite va aAdleTe autopaTa TIC pUBHICEIG TNG CUCKEUNG 00G avAAoya e TO

potifo xpriong kai tnv Tomobeaia.

T Zmv 0B6vn puBpicewy, matiote Emektdoelg > Context Awareness.

7 Evepyorolrote Ta oTolxeia yia ta omoia OéAeTe ot pubuioelg va aAalouv
autopara.

+ AYTOMATA: Mmopeite va puBpioeTe T GUOKEUH £T0L WOTE Va aANA{ouv
autépata ol emioyEg mpo@il nxov, Bluetooth kat Wi-Fi og Slagopetikd
nepiBaMovta, dmwg Oikia, EkToc olkiag, Epyacia, Ektoc epyaciog. Mmopeite
£MMONG va pUBICETE va avoiyel Jia Qappoyr 6tav cuvdeBolv AKOUOTIKA i
Hia cuokeun Bluetooth.

E « [l0 va XpnOILOTOIOETE AUTHY T SuVATOTNTA, TTPETEL VA EXETE OPIOEL OTN
pUBIoN Ta uépn pou TNV TomoBeaia TnE oIkiag 1y TG Epyaciag oag. ZTnv
006vn pubpicewv, matriote TomoBeaia > Ta pépn oL yia va pUBUICETE TiG
Tomobeoiec.

E€atopikeupévn unnpecia

Mriopeite va AdPete £§unva amoTeNéopaTa 6Tav XPNOILOTOIETE TNV
evowpatwpévn avaditnon.

T X 086vn pubuicewy, natriote Enektdoelg > E€atopikeupévn umnpeoio.
7 Matiote 1o Koupmi yla evepyomoinaon.
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Extetapévn mpofBoAn otn Aeltoupyia mePIOTPOPNS
Ol eQappOoYEG umopolv va emekTaBouv Kat oTi¢ SUo 08Oveg oTn Aettoupyia
TIEPIOTPOPHG.
1 Zmv 0B6vn pubuicswy, matfjote Enektdoelg > Ektetapévn mpoBolr otn
Aertoupyia mepIOTPOPNG.
7 Natiote 1o Koupmi yla evepyomoinaon.
- EMEKTAZH AMO MPOENIAOIH: Mmopeite va Seite pia epappoyr o€
EkteTapévn mpoBolr 6tav avoiyeTe TV epappoyn oty KUpia 08dvn.

Mawyvidt

Mmopeite va SlapopPUOETE TIG PUBITELS yia epYalEia Kal Ypa@Ikd matxviSiwy,
KaBwg Kat yia tn SuvatdtnTa E0IKOVOUINONG UMATAPIaG.

T Zmv 0bovn pubuicewy, matriote Enektdoelg > Mayvidt.

7 MpooappooTe TIC TapaKATW PUBIcEIC:

- Mpdypappa Ekkiv. Nouxvid.: Matriote Y10 VOl XPNOIHOTIOIOETE TO
Mpdypapua Ekkiv. Maigvid..

+ Epyaleia magvidio0: Mmopeite va ekteléoete Tn Aettoupyia otav mailete
matgvidia matwvTag Ta epyaleia maixviSiol amod Ta KOUPA agn¢ NG
apxIKrG 086vNG

« Tpagika matxvidiou: Pubpiote ta ypagikd Tou maixvidiov.

E + Eav aMd€ete Tv avdhuon og opiopéva maiyvidia, n Suvatdtnta mpoBoArg
0006vng evEéxETaL Va PNV AEITOUPYET OWOTA.
+ Auti n Aertoupyia evoéxetat va unv gival SIaB€01pn O EQAPHOYEG
TIAKVISIWV.

Atdheppa: MEWoTe T QUTEVOTNTA TG 006VNG Kat Ty amodoon Kabe
POPA TTOU SIOKOTITETE TO TalYVIOL Yia TIEPIOGATEPO A 5 AemTd.
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Evypagr 086vng
Mriopeite va Slapop@waoeTe TIC puBUicelC yia Eyypagr 0B6vnc.
T Zmnv 066vn pubuicewy, matriote Enektaoelg > Eyypagr 006vng.
2 MpocappooTe TIG TapaKaTw pubpicelc:
+ TupmepINABETE TOV £AUTO 0aG 0TO Bivteo: KAvTe pia amod TIC mapakdTtw
€MOYEC.
Ewoéva: MepthapBavel Ty iova mpo@il oag oto Pivieo katd v
Kataypagn. AQGTou Kavete autiv Ty emhoyn, natiote @ kat em\ééte
Jia e1Kova mPo@il. LTn ouvéxela, puBuioTe To PEyeBOG TNG EIKOVAG
XPNOUOTIOIWVTAG TO PUBUIOTIKG.
MmpooTivi) Kapepa: JuumePINAUBAVEL KATAYPAPT) TOU EAUTOU GOG
XPNOIHOTIOIWVTAG TNV MITPOCTIVH KAPEPT, KATA TNV KaTaypagr TG
oBovng.
- MNoté: Aev mepthapBavetal Timota.
« Tnyn rixou: EmAEETe TV yn riou peta&h Mixpogwvou kal
Mepiexopévawv.

+ Avaluon Bivteo: EmAé€Te Ty avaluon yia Ty Eyypaeri 08évng.

AwAi E@appoyn

Mrmiopeite va eykataoTrioeTe SU0 POPEG A EQAPHOYH AVTAAAAYAG UNVURATWY

07O TIPOIOV Kal va Xpnotporoleite SU0 Aoyaplacpoug Tautdypova.

1 Zmv 0Bdvn pubuicewy, matfjote Enektdoeig > A EQappoyn.

7 Metd v avdyvwon ¢ Sh\wong amoroinong, natriote EmBefaiwon.

3 2 Niota Slabéoipwv epappoywy, matiote Eykatdotaon yia va
€YKATOOTAOETE éva QvTiypaQo TNG EQAPLOYNS Kal aKoAoubroTe Ti o8nyieg
ou epgaviovtal otnv 08dvn.

TNV 086vn eppaviletal n Aiota Twv Slabéopuwv Simwv epappoywv. Kata
TN SIAPKEL TN EYKATACTAONG, OTNV apXIKr 080vn mpooTiBevTal eikovibla
TWV EQOPHOYWV.
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Mpotaon epappoyiic

Mmopeite va TPOOTIENACETE YPIyOPa EQPAPUOYEG TTOU UMOPE( va XPEIGLeDTE eKeivn
™ otiypr} otnv 086vn Emokomnnon.

2tnv 006évn pubuicswy, matiote Emektdoelg > Mpotaon eQapuoyne.

PR 1)V}

Mriopeite va puBioeTe TIg EMAOYEG yia TN Xprion evog Evepyol oTUNS (mwheitat
£eXWPLOTA TIPOAIPETIKG). INUEIWOTE OTL AUTH 1 CUOKELN UmooTnpilel To Evepyd
0TUNG AES2.0 (Active ElectroStatic - Evepyo H\ekTpOOTaTIKO).

1 Zmv 0B6vn pubuicewy, matfiote EmekTaoelg > ZTUNG.

7 TNpocappooTe TIg Mapakdtw pubpicels:
+ K\e1di Ztuld Zuvtopevoelc: PuBpioTe TIC CUVTOUEVODELS yia KABe Kouumi 0To

Evepyo oTuld oag.

YuvTopeLoel EQappoywv: EMAEETE TToleC eQapHOYEC (EwG Kal TTEVTE)
Ba epgavifovTal w oLVTOPEVTELS OTav N Ypapida Slaypdpetal amd T
OUOKEUN.

- [poemokonnon onpeiwong: Evepyorolrote yia Ty mpoBoAr Twv

TIPOOPATWY CNUEIWUATWY OTO AyylyHa TOU ZTUNG.
"Hyog oxediaong: EvepyomolioTe yia va eQapudoETe NXNTIKA EQE 0N
Aertoupyia oxediaong.

- MpoPon deiktng: Evepyomolrote yia va Seite éva Seiktn 0TUAG TAvw amd

TO ONeio OOV ALWPEITAL TO OTUAO.

MapaBAeyn xeipovopwv Mpappr morynon: AMOKAEIOHOG E10aywyng
amo TIG XELPOVOUIES 0N Ypappr) TAoriynong, Tmou givat Xprolpog Katd to
oxeSI00O 1) TO YPAYIO OTO AKPO TG 08OVNC pE €va Evepyd 0TUAO.
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ZuvTopEeUCOELC
Mmopeite va xpnoIOTIOLEITE KOUPTTIG OTIWG TO KOUTT vepyomoinong /
KAEIBWHATOC, TO KOuTTi £vtaong rxou Kat 1o Google Assistant yia dpeon ektéheon
OUYKEKPILEVWV EQAPHOYWV 1 AEITOUPYLLV.
T Zmv 0B6vn pubuicewy, matiote EMeKTAOELG > ZUVTOUEVOELC,
7 MpocappooTe TIG TapaKATw puBpiceL.

+ Avotypa Qwtoypapikiig Mnxavig: Matiote 6U0 PopE To MARKTPO
EVEPYOTTOINONG VIO VA AVOIEETE TNV KApEPQ.
Avolypa Inueiwon opnotig 006vng: Matrote 500 PoPEC TO MARKTPO
avénong TN €vtaong HXoU Yia va avoi&eTe Tn Asttoupyia Inueiwong
006vng, tav n 006vn eival KAEWGwEVN 1y amevepyomoinuévn.

« Avoiypa Owtoypagikig Mnxaviig: Matiote to miiktpo Meiwong évtaong
SU0 Popéq yia va avoiéete Tn Aettoupyia Kapepa otav to Khedi ival
KAEIOWUEVO 1) AmEVEPYOTTOINEVO.

E + To Google Assistant dev umootnpiCel OAEG TIG YAWOOEG.

Evepyomoinan 00dvng

Kavte S1m\o matnpa otnv 086vn yia va VEPYOTIOINOETE 1 VOl ATTEVEPYOTIOIOETE
Tnv 0Bdvn.

Mo AemTopépELEC, avaTpéETe 0TV evoTnTa Evepyormoinon 08ovng.

Auénon evaicOnoiag agng

Mmopeite va kdvete TV 006vn a@rg Mo guaiodntn oTo dyytyud oac. Mpoteivetat
Va EVEPYOTIOIEITE TO XAPAKTNPIOTIKO AUTO OTAV XPNOLUOTIOLEITE TTPOOTATEUTIKO
oBovne.

3TNV 086vn pubpicswy, matrote Emektdoelg > AvEnon evaiebnaiag agng.
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Epappoyeg

Mmopeite va Seite pa NioTa eyKaTaoTnHéEVWY EQAPUOYWVY KAl VA SIAHOPYWOETE
TIC PUBHICEIS Yia £160TOINOELS, SIKAWUATWY EGAPUOYWV Kat GANQL

T Zmv 066vn pubuicewy, matriote EQappoyéc.

7 MpooappooTe TIC PUBKITEIC.

Mnatapia
Mriopeite va SeiTe TIC TPEXOUTEC TANPOYOPIES YA TNV prmaTapia 1 va
evepyoroloeTe T Aeltoupyia €0IKOVOUNONG EVEPYELQC.
1 Zmv oboévn pubuicewy, matote Mmatapia.
7 MpocappooTe TIG TapaKaTw pubpicelc:
+ Xprion pmatapiag: Seite AeMTOPEPELEG YIa TN XPAON TG MmaTapio.
+ Bektiotomoinpévn @option: NMpocappdote Ty TaxlTnTa pOpTIoNG

OULQWVA LIE TOV TPOTIO POPTIONG Yia va HelwBE( n BeppdtnTa Kat va
napatabei o xpdvog (wn¢ TG prmatapiag.

+ PuBulopevn pmarapia: Emrpénel e€oikovounon evépyelag Slakdmrovtag

TN AEITOUpYia EQAPUOYWV OTO TTAPACKIAVIO.

Meplopiopioi ovTou: EvepyomoloTe auTrv TNV EMAOYI YIa VA TIEPIOPIOETE
TNV EKTENEON EPAPHOYWVY OTO TTAPACKIVIO YIa EE0IKOVOUNCN EVEPYELQG
KaTd TN XPron TG cuokeung. Ot epapuoyég mou meptopiovTat yia Adyoug
£€0IKOVOUNONG EVEPYELAG EVEEKETAL VA PNV AEITOUPYOUV OWOTA 1 va UNnv
00G OTEAVOUV €ISOTIOINTELC,

- E§olkovopnon evépyetag: MeioTe T katavaAwan 1ox00g TG pmatapiag

emAéyovTag XapnAOTePN TIUN O€ OPIOPEVES PUBLITELS TG GUOKEUNG, OTTWG
TN EWTEVATNTA TNG 08OVNG, TV TAXUTNTA TOU AEITOUPYIKOU OUGTHHATOS
Kat v évraon g dévnonc.

- E§aipéoeig e€oikovopnong evépyelag: EmMAEETe TIC epappoyEG TTou

O€NETE VA XPNOIHOTIOLEITE XWPIG KAVEVAV AEITOUPYIKO TIEPIOPIOHO TIOPA TN
Aertoupyia e§oikovdpnong Loxvog 1y BeAtioTomoinong pratapiag.
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AnoOnkevon

Mriopeite va mpoBAAeTe Kall va SLOXEIPIOTEITE TOV ECWTEPIKO XWPO ATOONKEUONG
0TI OUOKEUN 1} TOV OMOBNKEUTIKS XWPO 0NV KAPTA UVAMNG.

T Zmv 066vn pubpicewy, matriote AMOBNKEUTIKOG XWPOC,

7 MpooappooTE TIC TaPaKATW PUBIcEIC:

+ EowTePIKAG amoOnKEVTIKOG XWPOG: AEITE TOV GUVOAIKO XWPO
amoBKeVONG Kal ToV ENEVOEPO XWPO OTOV ECWTEPIKS XWPO amoBrikeuong
TNG OUOKEUNG. Agite pia NoTa e TIC EQapUOYEC TIOU XPNCIoToLoUVTaL Kall
TOV XWPO amoBrKeuong mou KatavaAwvel n kabepia.

+ Kapta SD: Agite Tov GUVOAIKO XWPO amoBriKeuong Kat Tov eAeVBepo
XWPO OTNV KAPTA PviuNG. AUTr n emhoyn eppavietal ovo oTav €xel
TomoBeTnBei kApTA PvARNG. Ma Va ameEVEPYOTTOICETE TNV KAPTA PVAKING,
TIATAOTE

Noyapracpoi

Mriopeite va mpocBEoeTe PrOTEC HE TOUG omoioug Ba XPnOIHOTIOLEITE O KOlVoU
TN GUOKEUN Kat va SnptoupynoeTe va hoyaplacud oto cloud.

T Zmv obovn pubuicswy, matriote Aoyaplacuoi.

7 MpooappooTe TIC PUBKITELC.

Digital Wellbeing kot yovikoi é\eyyot

Mropeite va Seite Tov Xpdvo Xpriong Tou mpoidvTog Kat va pubpiceTe 1o
XPOVOUETPO Yia KABe epappoyr. Mmopeite emiong va SIaxeLpIOTEITE TOV XpOVo
XPioNG TOU KIVNTOU TNAEPWVOU XPNOILOTIOIWVTAC TIG AEITOUPYIEG YTTVOU Kal
Eotioong.

EmAé€te Digital Wellbeing kat yovikoi é\eyxot otnv 086vn pubuiogwv kat
puBpiote Tn Aertoupyia mou BéeTe.

PuBuioeig 159



Google

Mriopeite va xpnotpomoloeTe TG pubpioeLl; Tou Google yia va SIaxeIPIOTEITE TIG
€pappoyéc Google Kal Tig puBLIcELS Tou AoyapLaopou.

SV 086vn puBpioswy, matiote Google.

Zuothua

Kévtpo evnpépwaong

Mriopeite va TpoBANETE Kall VOl YKATAOTAHOETE TNV TEAeUTaia €KSoon TG
€(QapUoyNG 1 Tou AoyIopIKoU Tiou mapéxel n LG.

1 Zmv 086vn pubuicswy, matfote ZOoTnpa > KEvtpo evnuépwonc.

7 Mpooapp6oTe TIC TapaKATW pUBIcEIC:

+ Evnuépwon pappoyng: EAeyxog edv undpyel SlaBéotpn evnuépwon
£QApHOYNG. EQv umdipxel, UMOpEiTe va EYKATAOTHOETE TNV EVNUEPWHEVN
ékdoon.

+ Evnpépwaon AoyiopikoU: Eheyxog eGv umdpyel S1abéoipn evnuépwon
Noytopikou. Edv umdipyel, UTOPE(TE Va EyKATAOTAOETE TV EVNHEPWUEVN
£kdoon.

Mwooa & mAnktpoAdylo

Mmopeite va mpooapudoETe TIC pUBUITELS YA\WOOAC Kat TANKTPOAOYIOU yia T
OUOKEUN 00,

T Zmv 0bovn pubuicgwy, matrote Zuotnpa > NAWooa & TANKTPOAGYIO.

7 MpooappooTE TIC TAPaKATW PUBIcEIC:

- M\waooa: EmAéETe Y\wooa yia T GUOKEU.

- Aayeipion minktpoloyiwv: Mmopeite va aAagete T pubuion yia 1o
Baotko MANKTPOASGYLO TOU TIPOIOVTOC, Va pUBIcETE Ta EPIBANOVTA
XPoNC yia To MANKTPOAGYI0 LG 1} GANa eyKATESTNUEVA TTANKTPOAOYIA KAl VOl
puBpioeTe TN Asrtoupyia avayvwpiong opthiag yia €ioodo pe Ty epappoyn
Google Voice. Mmopeite emiong va emAéEeTe av To Koupmi MAnKTpoloyiou
Ba eppavifeTal 0TV MEPIOX TWV KOUUMWY aPriG 0NV apxIkr 086vn, wote
Va UMOPE(Te va PETaBeiTe ypriyopa o€ AN TANKTPOAGYLO.

+ Mpaypatiké MAnKTpoAoyto: EMAECTE yia va XpnOIUOTIOIGETE TO KAVOVIKO
TIANKTPOAOYIO 1 yia va TTPOBAANETE TG GUVTOEVTELG TTANKTPOAOYIOU.

PuBuioeig 160



+ Ymnpeoia autopatng cupmAnpwong: Evepyomolote authyv Ty emioyn
yla va yivetal eloaywyr Twv MANPOQOPLWV TOU gival amoBnKEUUEVEG
070 Aoyaplaopoé oag, omwg Kwdiko mpdoPaong, Sievbuvon ry
aplOPoL MOTWTIKAG KAPTAG HE éva pdvo mdtnua. Mmopeite emiong va
QITEVEPYOTIOIOETE AUTHY TNV EMAOYK, VA XPNOILOTOICETE TNV AUTOHATN
ouumA\npwon tn¢ Google iy va mpocBéaeTe éva véo Aoyaplaouo umnpeciag.

MeTatpomn KeIpévou o€ QwvI: AlapOpPWOTE TIC PUBKIOELS Yia HETATPOTT
KEWWEVOU O€ OpIAiaL

+ Tayotnta tou Seiktn: Pubpiote Ty TaxUtnta Tou Seiktn Tou TOVTIKIOU
Tou trackpad.

+ AVTIOTPO®N TAKTPWV GTO TTOVTIKL: QVTIOTPEPTE TO Se€i Koupi Tou
TIOVTIKIOU Y10 Va EKTEEL PACIKES EVEPYELEG ALIETOU XEIPIOHOU.

Huepopnvia & wpa

Mrmiopeite va TPOOAPHOCETE TIC PUBHIOELG NUEPOUNVIAG KAt WPAG YL TN CUOKEUN
oag,

1 Zmv 0B6vn pubuicewy, matfote ZooTnua > Hugpopnvia & wpa.

7 Mpooapp6oTe TIg pUOKITELC.

Mvrpn

Mropeite va Seite évav uéoo Opo yia TNV KATavaAwon PVipnG yia éva

GUYKEKPIUEVO XPOVIKO SIA0TNMA, KaBWE Kal TNV TOGATNTA MVAUNG TTOU

KOTAVAAWVEL IOt EQAPUOYH.

T Zmv 0bovn pubpicewy, matriote ZuoTnua > MvApn.

7 TlatAoTe TO KoUMW yia Vol OpIOETE pia povoBupiba yia avaktnon
Sedopévwv.

Avtiypago acpaleiog
Mriopeite va SnpioupynoeTe avtiypaga acpaleiag yia Sedopéva mou givat
amoBNKEVPEVA GTN GUOKEUT GOC O€ pid GAAN GUOKEUT 1] A\oYapLaoo.
T Zmv 066vn pubuicewy, matriote ZuoTnua > Avtiypago ac@aleiag.
2 MpocappooTe TIG TapaKATw puBpIcEL:
+ LG Mobile Switch: Zag emrtpémel va petagépete Sedopéva amo pia malid
ouokeun LG oe pia véa ouokeun LG. Ma Aentopépeleg, avatpédte otnv
evotnta LG Mobile Switch .
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A .

Anpioupyia avtlypd@wv ao@aleiag Kat emava@opd: Snpioupynote
avtiypaga ao@aleiog Twv GES0HEVWY TNG GUCKEVNG 1 EMAVAQEPETE
Sedopéva 0T GUOKELT 0ag amd KAToLo avTiypa@o ac@aleiag.

Meé v emavagopd TG CUCKELNG EVOExeTal va Slaypapouy apxeia
avTIypa@wv acpaleiag mou éxouv amobnKEeUTEl 0TOV XWPO amoBrKEUONG.
BeBaiwBeite oT1 éxeTe avTlypdel Kat amoBnKeVOEL GTOV UTOAOYIOTH 0ag T
avTiypa@pa ao@oAEag Twv ONUAvVTIKWV apxeiwv oa.

Avtiypago ac@. Google: ANayr Twv pubuicewv avtypd@ou acealeiog
Tou Google drive. Mmopeite emiong va mpofdAeTe Tov Aoyaplaoud
Snuioupyiag avtypa@wv ao@aleiag o Xpnolpomoleital i va mpoobéoete
€vav Véo Aoyaplacpo dnuioupyiag avTlypd@uwv ao@aleio.

Emavekkivnon & Emavagopd

Mriopeite va KAVETE EMaVAPOPA TNG CUOKEUNG TEPINABAVOLEVWY TwV PUBHIcEWY
SIKTUOU KAl EQOPHOYWV.

1 Zmv 0Bo6vn pubuicewy, matiote ZooTnpa > Emavekkivnon & Emavagopd.
7 MpocappooTe TIG TapaKATw puBpicel:

+ Autépatn emavekkivnon: AuTOpaATn EMAVEKKIVNON Kat TTPOoappoyn

5

TOU TNAEPWVOU OE KABOPIOUEVO XPOVO. [ATAGTE TO KOoupTi ylava
gvepyomoloeTe auth Tn Aettoupyia. H cuokeun emavekkiveital autdpata
o€ KaBoplopévo xpdvo kai BeAtioTomoteital autdpata. EmAéETe T
NUEPOUNVIO Kal TNV wPa Yia T BIoypa@Iko onuEiwpa.

+ Mmopeite va puBpioete T ouokeur va Eekiva Eava pia @opa tnv eBdoudda. H
OUOKEUI EMAVEKKIVEITAI QUTOMATO OE Hidt wpa amd Ty mpokabopiopévin wpa.

+ MeTd TV EMaveKKivnon TG CUOKEUNG, Ot EI50MOIACES Kal Ta epPARpaTa
Katapyouvtat. AmoBnKeUoTe onuavTika Sedopéva mpv amod v
TipOKaBopIopEVN Wpa.

+ H \erroupyia autdpatng emavekkivnong Sev ivat evepyr| oTig akONoubeg
nepImTwoel: Otav n 086vn eival evepyoroinpévn, 6Tav n CUCKEUN €ival oe
Xprion, 6tav n otabun tng pmatapiag ivat 30% 1 Ayotepo 1y 6tav n kapta USIM
€ival KNS wpEVN.

- Avd\oya e ToV TTAPOXO UTINPESIWV TNAETKOWWVIWY, N AETOUPYI QUTOUATNG
€MaVeKKivnong evOéxeTal va Unv givat Slabéotpn.
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- Emava@opd twv pubpicewv SIkTUou: emavagépel Ti¢ pubpioelg Wi-Fi,
Bluetooth kat d\\eg pubpioeig Siktuou.

Mnd&eviopog mpotiuoewy epappoyng: Emavagopd twv pubpicswy yia pia
epappoyn. Aev Ba Siaypagouv ta dedopéva mou ivat amobnkeupéva otny
£pappoyN.

Emavagopd pubpicewv: Emavagépete OAEG TIC PUBHIOELG GUCTHLOTOG OTIC
TIPOEMAOYEC,

- Emavagopd epyootactakwv SeSopévwv: emavapépel ONEC TIC pUBIcELG
yla T cuokeun kat Staypdget ta dedopéva.

E « H emavekkivnon Kat n emava@opd ThG CUOKEURG 00U Slaypagel OAEG
Ta SeSopéva mavw 6" auTrV. BANTE TO GVoua TG OUCKEUNG 0ag, TOV
Noyaptaopéd Google kat ANeG apxIKES TANPOQopie; Eava.
+ Metd v apyiomoinon Twv Sedopévwy, Sev gival duvatr n Emavapopd
TOUG.

ZXETIKA JE TO TNAEQWVO

Mrmiopeite va Seite MANPOQOPIES OXETIKA LIE TN OUOKEUN 0ag, OTIWG TO OVOUA TNG,
TNV KATAOTAON, TA OTOIYEID YI0l TO AOYIGUIKO KAl VOUIKEG TANPOQOPIE.

TNV 086vn pubpiocwy, mathote ZOOTNHA > ZXETIKA ME TO TNAEPWVO Kal SEiTe TIG
TIANPOPOPIEG TTOU 0aG EVOIaPEPOUV.

PuBuioTiko maicio & Ao@pdleila

Mriopeite va SeiTe TIC PUBIOTIKEC ETIKETEG TIC OXETIKEG TANPOPOPIES OTN CUOKEUN
oo

3TNV 086vn pubpioswy, matrote ZVoTnpa > PuBpioTikG mhaioto & AogpdAeia.

Mpocfacipotnta
Mriopeite va SlaxelploTeite TI TPOCONKeS TPOOaCIUATNTAG TTOU £XOUV
€yKaTOOTAOE! OTN OUOKEUN OAG,
T Zmv 0bovn pubuicewy, matrote MpooPacipdtnta.
7 MpooappooTE TIC TAPaKATW PUBIcEIC:
- 'Opaon > TalkBack: Pubpiote T cuokeun va oag ei6omolel Eow PWVAG yia
TNV KATAOTA0N TNG 006VNG I Y10 EVEPYELEC.
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+ ‘Opaon > Owvnrikég elomomoeig: Pubpiote T ouokeun va SlaBalel ta
OTOIXElO EI0EPXOMEVNG KAONG HEOW QWVNAG.

+ 'Opaon> lpappatooelpd: ANGETE To péyebog TG YPAUUATOOEIPAG, TNV
£VTaon NG YPAPAG N TN YPAUUATOOEIPA.

- 'Opaon > Méyebog 006vng: OpioTe To PéyeBog Twv OTOIKEIWV 0TV 086VN
omwg oag BoAevel. Kdmota otolyeia evdéxetal va aMda&ouv Béon.

- 'Opaon > MeyéBuvon a@ng: yia peyéBuvon 1y GUIKPUVON TTATWVTAC 0TV
0006V TPEIC POPEC.

- 'Opacn > Meyébuvon mapabupou: TPAYUATOTOINOTE Peyébuvon 1y
OpiKpUVON EVTOE TOU TAPaBUPOU Kal AVTICTPEYPTE TO XPWHA.

+ 'Opaon > Meydahog Seiktng movTikioU: peyeBuvete Tov Seiktn Tou
TIOVTIKIOU.

+ 'Opacn > 006vn uPnAiig avTiBeang: OKOUPUVETE TO XPWHA YOVTOU yia

006vn uPnAng avtiBeonc.

‘Opaon > Avtiotpo@r Xpwpdtwy 080vng: Au€hote v avtiBeon

XPWHATWY TNG 086VNE yla ATOMA PE TIEPIOPIOHEVN Opaoh.

- 'Opaon > PUBHoN xpwpdtwv 080vng: MpooapuooTE To XpWHA TG
00évng.

+ 'Opaon > Movoxpwun: aAate T Aettoupyia TG 086vng o€ KAipaka Tou

YKPL

‘Opaon > TepHaTIOHOE KAONG KE TO TTARKTPO Tpo@odoaiag: TeppaTioTe

Mo KAon e To TATNA TOU TTARKTPOU EVEPYOTTOINCNG/KAEISWHATOC.

+ Akon} > Zwvtavoi umdtithot: PuBpioTe T GUOKELN WOTE va avayvwpilel T
PwVN 0Ta TOAUPEDA Kall va Snuioupyei autdpata umdTitAoug.

- Akon > Npotipnoeig Ae{avtag: Evepyorolote Ty unnpeoia umotitAwv
KOt TV avamapaywyn Biveo yia dtopa pe mpoBAHaTa akonG.

Akon > Eiomotfjoeig @Aag: pubLioTe T GUOKEUN VA 0O EVNHEPWVEL LE
QWG IOV avaBooPrVEL Yia EI0EPXOUEVEG KAATELS, UNVUUATO KOl AQUTTVIOELG.
+ Akor} > ATopovWwan GAWV TWV AXWV: AMOUOVWON OAWV Twv AXWV Kal
XOUNAGTEPN OTABKN évTaong fixou oTov SéKTN.

Axkor > Kavat rixou: emAEETe Tov TUTTO fYoU.

Axor) > loopporia NXou: TPOCAPHOOTE TV IGoppoTTia 650U fYou.
XpNOMOTOIOTE TN VPO KOMONG Yia va aANAEETE TNV I60PPOTTIL.

+ Kwnuikétnta kat yvwon > Touch assistant: evepyomolr|ote Tov mivaka
QPG YIa EVKOAGTEQN XPHON TWV KOUUTTIIWV KOl TWV KIVAGEWV.
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+ Kwntikétnta kau yvwon > Eloaywyn a@ig: KataxwproTe Keiuevo
TIOTWVTAC TOPATETAUEVA TNV 000VN 1} TPOTIOTTOIOTE TO TATWVTAC ATAd TV
o6ovn.

Kivntikotnta kat yvwon > Mpaypatiké mMAnKTpoASylo: mpooapUOoTE TIC
puBUioEIC TOU MANKTPOAOYIOU.

+ Kivnuikétnta kat yvwaon > Autopato KAIK TovTiKoU: SnuloupynoTe
auTdpaTa KNIK Tou S€iKTn TOU TTOVTIKIOU O€ TEPIMTWON anouaciag Kivnong.

+ Kivnuikétnta kat yvwaon > Ayyi€te mapatetapéva yla va KAvete KAon:
QMAVTAOTE 1) AmoPPIYTE KANOEL TOTWVTAC TAPATETAMEVA TO KOUMTT
KAjong, Kat Ox1 Je 0apwary Tou.

+ Kivnuikétnta kot yvwaon > Afjén xpovikol opiov 086vng: va
QITEVEQYOTTOLETAL AUTOMATA ) CUOKEUN OTaV Tapapével oe adpdvela yia éva
KaBopIopEVO XpoviKG SidoTnua.

+ Kivntikétnta kat yvwaon > Meploxri eAéyXou a@ng: mepLopioTe TNV TEPLOKT

QPNG £TOL WOTE 0 ENEYXOC APC Va Eival SuvaTOC IOVO OE VA GUYKEKPIUEVO

TUAHA TG 006vNG.

TuvTOpEUON AEIToupYIWV TTPOoBactpdTnTag: yia ypriyopn mpdofaon oe

NETOUPYIEC TIOU XPNCIUOTIOLELTE OUXVA TIATOVTAG TPEIS POPEG TO Koupi Q).

+ Autépatn meplotpo@r 080vng: aAAlEl QUTOATA O TIPOCAVATOMOOE TNG
0006vn¢ avaloya Ui Tov MPooavatoMopO TG CUOKEUNG.

EmAESTE yia EKQWVNON;: ZaC EMTPENEL VA TTATATE OPICHEVA OTOIXEID Yia val
NapBAvete TPOYOPIKN avatpo®odoTnon.

« MpdoPaon pe Stakdmtn: Anpoupyriote cuvduacHoUE MARKTPWV Yia va
€ENEYXETE TN OUOKEUN 0.
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PuBuioeic y\wooag
Em\é€te Y\OOA yla TN GUOKEU.
« XV apyikn 08ovn, matriote Pubpioei > Luotnpa > Nwooa & MAnKTpoAoyio
> MNwoaoa > MpocOrikn yYAwooag kat mAEETE pia YAwooa.
- Ayyi€Te Kal KPATAOTE TO KOUMTTI == Kal GUPETE TO OTO EMAVW PEPOG TNG
NoTaG Y\wOoOoWV Yia Vo TO 0PIOETE WG T YAWOOoa POEMAOYNG.

LG Bridge

LG Bridge - Mapouaiaon

Mrmiopeite va SnIoUpYHOETE QVTiyPaQa AOPANEIRS TWV EMAPWY, TWV
QWTOYPAPIWV KAt GAWV OTOIKEIWV OTOV UTTONOYIOTH 1} VO EVNUEPWOETE TO
MOYIOUIKO TNC OUOKEUNG.

E « [la mepLoooTePEG MAnpogopie BorBelag, avatpé€te oty evotnta LG
Bridge.
Ot umootnpI{OuEeVeC AerToupyieg eVOEXETaL va Sla@éPOouV avAaloya HE TN
OUOKEUN.
« To mpoypappa odrynong USB LG gival amapaitnto yia va ouvSéoeTe To
smartphone LG pie Tov umoAoyloTr Kat ykabiotartal Katd Ty eyKataotacn
Tou LG Bridge.

Netroupyieg Tng e@appoyng LG Bridge
+ AnpoupynoTe avtiypaga ao@aleiag Twv SeSopévwy amod T GUOKEUH Ot évav
umohoyloTh 1} emava@épete Ta Sedopéva amd évav UMOAOYIOTH OTN GUCKEUN
péow ouvdeong kawdiov USB.
+ Evnuépwan AoyiopikoU TnG GUOKEUNE amd évav UMOAOYLOTH Héow oUvEeon(
kaAwdiou USB.
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Eykatdotaon epappoync LG Bridge og umoloyloth

T MetaBeite otn SiebBuvon www.lg.com amé Tov umoAoyIoTH 0aG.

7 Em\é€te v mepioxn oac.

3 MatAote YIooTthpi€n > AOYIOUIKO Kat UNIKOAOYIGMIKO.

/' TANKTPONOYAOTE TO OVOUA TNG GUOKEUNC 0ag.
H
EmAé€te TV katnyopia mpoiovToc.

5 Tava kateBdoete 1o apyeio puBiong, emAéCte Zuyxpoviopog PC> LG Bridge.
« EmAé€Te Aemropépeleg yia va Seite TIG ENAXIOTES OMAITATELS Yia TV

£yKaTAoTaON TNG EPapHoy¢ LG Bridge.

Evnuépwon AoylGHIKOU THAEQWVOU

Evnuépwan Aoyilopikou Kivntol TnAepwvou LG améd 1o
Internet

M0l TEPIOCATEPES TANPOPOPIES OXETIKA HIE TN XPr|0N AUTAG TG AelToupyiag,
emoke@Oeite Tn dievbuvon http://www.lg.com/common/index.jsp kat emAEETe T
XWpa Kat T yAwooad 6.

Meé autrjv Tn Aertoupyia pmopeite e0koAa va evnUEPWVETE Péow Internet To
UANIKONOYIOMIKO OTO TNAEPWVO 0aG OE HIat TTO TIPOoPATN €kS0on XWwpic va
XPEdleTal va eMOKePOEITE KATTOLO KEVTPO EMOKEVWV. AUTH N Aeltoupyia

Ba eivat Slabéoiun edv kat 6tav n LG diabéoet otny ayopd veotepn ékdoon
UNIKOAOYIGHIKOU Yla TN GUCKEUN G0,

Eme16n n evnpépwaon Tou UNIKOAOYIGHIKOU TOU TNAEQWVOU TIpoUmoBETEL

TNV E0TIOOPEVN TTPOCOKN TOU XPNOTN KaBOAN TN Sidpkela Tng Stadikaciag
evnuépwong, PePatwbeite 6Tt SraBalete mpooeyTIKA ONeC TIG 08NYiES KAl TIC
ONUEIWOELS TTOU epgavi{ovTal oe KABe Bripa PV MPOKwPENOETE TNV EKTENEDH
Tou. Adfete umoYn 6T edv agatpéoete To kahwdio USB katd tn Sidpkela tng
Sladikaoiag avaBabpiong, evoéxetat va mpokAnBouv coBapd mpoBAfjuata oto
TAéQWVO 0ag.

E + HLG em@uldooetal Tou Sikaiwpatog va S1abétel, katd tn SlakpiTikn
TNG EVXEPELD, TIG EVNUEPWOELG TOU UNKOAOYIGHIKOU MOVO Yia EMAEYUéVa
povtéha kai Sev eyyudral Tn S1aBeoiudTNTA TG VEOTEPNC £KSOONG
UANIKOAOYIGHIKOU Y10l OAG TOl LOVTEAD TNAEPWVWV.
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Evnuépwan Aoylopikou Kivntol ThAe@uwvou LG péow
Over-the-Air (OTA)

AuTH N AeToupyia 0AG EMTPETEL VA EVNUEPWVETE EVKOAA TO AOYIOMIKS TOU
TNAEPWVOU 0ag o€ pia o mPooath ékdoon péow OTA, xwpic ouvdeon Kahwbdiou
USB. Auth n Aertoupyia Ba givat StaBéoiun eav kat 6tav n LG diabéoel otnv ayopd
VEOTEPN €KOOGT UNKONOYIOHIKOU YL TN GUCKEUN 0OC,

M0 Vol EKTENEOETE EVNUEPWOT TOU AOYIGHIKOU TOU TNAEQWVOU, aKOAOUBAOTE TV
€€nc Sladpoun:

PuBpioeig > Z0otnua > Kévipo evnuépwong > Evnuépwon Aoyiopikou >
‘EAeyxog evnpépwong Aoylopikou.

5 + Katd  1ad1kaoia evnpépwong Tou AOYIGHIKOU TOU TNAEQWVOU Gag
evdéxeTal va xaBolv Ta poowmika oag SeSopéva amo Tov ECWTEPIKO
XWPO amobrjKELONG TOU TNAEPWVOU, OTIWG YIal TAPASEIYUA, OL TTANPOPOPIES
OXETIKA UE TOV TIPOOWTTIKO 0ag Aoyaplacpd Google Kat GANoug
Aoyaplaopoug, Ta Sedopéva Kat ot PUBHICEIC TOU CUCTAKATOC KAl TWV
EQAPHOYWV 0aG, Ol amoBnNKEUpEVES EQappoyEC amo To Internet kai n ddeia
xprionc DRM. Emopéviwg, n LG 0dg ouviotd va dnpioupyeite avtiypapa
ao@aleiag Twv MPOCWTIKWY 6ag SeS0HEVWV TIPIV aTtd TV EVNUEPWON TOU
MoyiopikoU Tou ThAEpwvou oag. H LG ev pépel euBuvn yia evdexdpevn
QMWAELD TIPOCWTTIKWY SESOpEVWV.

« Auti n Aertoupyia eaptatal amd v mEPLOKT 1) TOV TAPOXO UTINPECIAV.
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06nyo¢ kata NG KAOmNG

PuBpiote Tn ouokeun oag va Pnv eMTPEMEL TN XEroN amd dANa ATopa £4v Exel
TIPAYHATOTOINOEL EMAVAPOPA EPYOCTACIOKWY PUBHICEWV XWwpig TV Adeld oag. MNa
TaPASELYHa, EQV N OUOKELR oa¢ xabei i KAamei, 1 edv Slaypagpolv ta dedopéva
NG, HOVO KATolog ke Aoyaplaopo Google fy Minpogopieg yia To KAEidwua Tng
086vn¢ Ba pmopei va xpnoIUOTOIOEL TN GUCKEUH.
To povo mou ypetdletat va Kavete yia va Befatwbeite 61 n cuokeur oag gival
TIPOCTOTEVPEVN €ival Ta E§1G:

+ Na opioete KAeibwpa 086vnc: dv n cuokeur oag xabei fy kKharmei, al\d éxete
opioel kAeidwpa 086vng, Sev gival duvatn n Slaypaer Twv dedopévwy
TIou BpIOKOVTAI OTN CUOKEUT HEOW TOU pevoU pubpioewv mapd pévo v
EekheldwOei n 0Bovn.

Na mpooBéate Tov Aoyaplacpd oag oto Google 0T cuoKeLr 0ag: £Gv Ta
Sedopiéva TG UOKEUNG oag Slaypapoly alAd ExeTe opioel Aoyaplaopo
Google, n cuokeur gv umopei va oAokANpwael Tn Sladikacia pUBUIONG UEXPL
va gloayBouv avd ta oTolxgia Tou Aoyaplacpou oag oto Google.
A@OU TIAPETE TA AMOPAITNTA HETPA VIO TV TIPOOTAGHA TNG CUOKEUNG 0ag, £4v
XPELOOTE VO TIPAYMATOTIOIOETE EMAVAPOPA TNG OTIC EPYOOTACIAKEC PUBicELS, Oa
Tipémel va EeKAEIOWOETE TV 086vN 0ag ) va EloaydyeTe Tov KwdIKO TpooBaong
yia Tov Aoyaplaopd oag 0to Google. Me autév tov Tpdmo Siacpahiletal 6T n
EMAVOPOPA UTTOPE( VO EKTENETTEI IOVO QMO KATTOIOV TTOU EUMIOTEVEDTE.

E « Tpwv ekteNéoETe EMaVaPOPd TwV EpYOoTaCIaKwY pubpicewy, Befaiwbeite
6T BupdoTe Tov Aoyaplacpo oag oto Google Kat Tov KwdIKo mpooBaong
TIoU éXETE MPOOBETEL OTr GUOKELN 0ag, EQv Sev Umopeite va mapéxete autd
Ta oTolkEia Aoyaplacpou katd T Sladikacia puBpiong, Sev Ba umopeite
VOl XPNOILOTIONOETE T CUOKEUT KaBONOU HETE amd TNV eKTENEON TNG
ENAVAPOPAG EPYOCTACIAKWY PUBHICEWV.
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MAnpo@opisg onueiwong yia to
AOYIGHIKO AVOIKTOU KWOIKA

MNa ™ AN Tou mnyaiou kwSika mou Siémetat amd TG adeleg xpriong GPL, LGPL,
MPL kat GAeG adeteg xpriong avolytou Kwdika, o omoiog mepthapBavetat 6To
Tipoidv, emoKeTeite Tn SlelBuvon http://opensource.lge.com.

Ext0¢ amo Tov mnyaio Kwdika, Slatibevtat mpog An 6Aot ot avapepdpevol 6pot adelmv
XPONG, Ol AMOTOICEIG EYYUOEWV KAl Ol ONPEIGELG TIVEUHATIKWV SIKAWHATWV.

H LG Electronics Ba oag mapéxel emiong Tov Kwka avolx g mnyng o poperi CD-
ROM évavtt xpéwaong mou Ba kaAumTel Ta €€06a TG Slavopnic (OMwe To KHOTOC Twv
TIOAUHECWVY, TNG AIMOOTOAG Kalt TNG SLayeiplong), KATomy artuatog Yéow email
otn SievBuvaon opensource@lge.com.

H mpoopopd 1oxUEL yia TEPInS0 TPIWV ETWV amd TNV TEAEUTAIN LA ATOCTOAN
auTou To TTPOIGVTOG. H poo@opd 1oXVEL yia GAOUG TOUG TTAPAAATITES AUTHG TG
TIANPOYOpIaC.

MAnpo@opieg OXETIKA UE TOUG
KaVOVIOHOUG (ApIOROC avayvwploTIKOU
KAVOVIOMOU, NAEKTPOVIKEG ETIKETEC KAL)

Mol NeTTTOPEPELEC OXETIKA LE TOUG KAVOVIOpOUG, emAEETe Sladoyikda PuBpioeig >
Y0oTnua > PubpioTiko maicio & Ac@alela.
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Epmopikd ojpara

+ Mveupartikd Sikawpara ©2020 LG Electronics Inc. ONa ta Sikaiwpota
npooTtatevovTal. H emwvupia LG kat o Aoyotumo LG eival oripata katateBévia
Tou Opilou LG Kal Twv OXETIKWY OVTOTATWY TOU.

Ta Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Owtoypagiec Google, Google Play Protect, Huepohdylo Google,
Google Docs, Google Drive, Google Sheets kit GAMa OXeTIKA orjpaTa Kal
Noydtuma givat epmopikd orjpata g Google LLC.

To Bluetooth® amotelei ofjua katateBév Tng Bluetooth SIG, Inc. maykoopiwg.
H enwvupia Wi-Fi® kai to Aoystuno Wi-Fi eival ofjuata katateBévta g Wi-Fi
Electronics.

‘O Ta UTIGNOITTAL EPTTOPIKA CUATA KAt TIVEUHATIKG SIKaIwUaTa anmoTtehoiv
1I510KTN G0 TWV AVTIOTOIWV KATOXWY TOUG.

HE HEVC \dvance”

Covered by Patents at patentlisthevcadvance.com
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AnAwon acpaleiag Aélep
Mpoooxn!

Auto To Tpoidv xpnaoiuomolei cloTnpa Aéilep. MNa va BePaiwbeite mwg
XPNOlHoToLEiTe KATANNAa AUTO To TTPOTOY, SIaBAOTE MPOTEKTIKA TO EYXEIPISIO
XPOTN Kat QUAGETE TO yia HENOVTIKH ava@opd. Ze mepimTwaon mou n povada
XPEIOOTE GUVTAPNON, EMKOIVWVACTE PE E§0UCIOSOTNHEVO KEVTPO ETIOKEVWV.
H xprion otolxeiwv eAéyxou, pubpicewv r n ektéAeon Sladikaotwy mou dev
TIEPYPAPOVTAL 0TO TTAPOV EVOEXETAL VA EMPEPOLV eMmKivouvN €kBeon o
padievépyela.

Mo va amo@UYeTe Tnv dpeon €kBeon otnv aktiva Aéilep, unv mpoomabroeTe va
avoiete To mePiBAnUa fy va ExETeE APEDN EMAQN Ue TO AéIlep.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

AHAQZH ZYMMOPOQXHX

Meé 1o mapdv, n LG Electronics SnAwvel ott to mpoidv LM-F100EMW
GUUMOPQWVETAL E TIC BACIKES AMAITACELS KAl LIE TIG UTONOUTEG OXETIKEC SlATAEIG
NG Odnyiag 2014/53/EU.

‘Eva avtiypago tng Afdwong Zuppdpewong SatiBetal otn Sievbuvon
http://www.lg.com/global/declaration
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AevOuvon evnpépwong yla Oépata
GUHHOPPWONE WG TTPOC TN XPHON TOU
TPOIOVTOG

LG Electronics European Shared Service Center B.V.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

H ouyxvétnta 5150 - 5350 MHz mpoopileTat amoKAEIOTIKA yia Xprion O
EOWTEPIKOUG XWPOUG.

AT | BE | BG | CH|CY|cz|DE|DK|EE| EL
Q ES A |{FR|[HR|HU|[E | 1S | m|Uu L
W |w M| N|NO|PL|PT|ROJSE] S

SK | AL | ME | RS | MK | TR | BA | XK |UK(NI)

A -

H duvatotnta 5G e§aptatat amd my mpaypatikn Stabeoipotta Kat cupBatotta

Tou SIKTUoU 5G pe To TPoidv. EAEyETe TV Katdotaon oupPatdtntag oto
www.lg.com/it
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http://www.lg.com/it

Meproootepeg MAnpoopicg

E€aptipara and okAnpupévo yuai

Ta e§aptripata auTrig TG CUOKEURG ammd OKANPUEVO Yuai Sev xouv SIdpKela ¢’

6pou {wrig, CUVETWC, EvOEXETAL Va BAPOUV e TNV TTdPodo Tou xpdvou.

+ Edv n ouokeun oag méoel TAvw O€ pia OKANPN EMEAVELD 1) TPOOKPOUGTEL KATTOU
e Svvapn, wmopei va mpokAnBei {nptd 6To oKANPUHEVO YUaA.
Ye QuTAv TV TePImTwan, SIaKOYTE APESWE TN XPHON TNG CUCKEUNG Kall
EMKOWVWVAOTE PE éva Kévtpo e§umnpétnong mehatwv tng LG.

TNV ayopd KUKANOQOPOUV TIPOOTATEVTIKEG BIKEC TTOU UMTOPEITE Va
TIPOUNOEUTEITE YIa VA TTPOOTATEVOETE Tr) GUOKELN 0ag amd Tn {npid.
N&Bete umOYN OTL AUTEC OL TTPOOTATEUTIKES Brikeg Sev KaAUTTOVTAL amd TV
€yyunon ¢ LG Electronics kat 6ev eyyuwvTal Tnv ao@alela.

Noyo¢ Slaotdoewv

Evdéxetal kamoleq An@Beioeg EpapHoyEC va Unv umooTni{ouv TO GUYKEKPIUEVO
Noyo SlaoTdoewv.

Y autiv TV mepimwon, emAEETe Ti¢ BEATIOTEG avahoyieg 086vng yia v
gpapuoyn i anotabeite oTov MEPOYO TNG EPAPHOYAC VIOl TIEPIOOATEPES
TIANPOPOPIEC.

lNa mep1ocoTePE MANPOPOPIEC
mAepwviiote oto: 801 11 200 900
i and Kwnto oto: 210 4800564
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06nydc yia petagopd dedopévwv
+ Ta Sedopéva mou Pmopouy va LETaPepBouv PETay cuokevwy LG iy petay
Uiag ouokeung LG Kal piog GUOKEUNG TPITOU KATAOKEUAOTH, GUUBOUAEUTEITE

Tov mapakdTw mivaka.
ZuoKeur Tpitou
SUOKEUH LG KatooKeuaoT ZugKeun
e AerToupyIko i0S
Tumog Nemtopépeleg oTOIXEIOU — Android .
Zuokevn LG - Zuokeun LG
Tuokeu LG
Emagéc, unvopata, apxeia
KAOEWV, NUEPOAOYIO, @) O O
Mpocwmka PWVNTIKEG EYYPAPES
Sedoptva 2nUEWUATAPIO X O
=umvntipla X X
Agdopéva | Dwroypagieg, Pivteo, o o o
mohupéowv | Tpayoudia, éyypaga
PU’QHIOEIC apiknc 066vng o X X
(pakehot kat widget)
PU?““’E'C PUBpioEIC KAEIS(PATOC
086vng ¢ 086vNC (e€apouvTat o X X
ol puBpioelC KAeldwuatog
006vng)
An@Beioec epappoyég @) e)
Egappoyéc Mpoowmika dedopéva yia .
. . @) X
™ An@Beioa epappoyn
Anpdoto moTtomoNTIKd O @) X
PuBpioeig (Wi-Fi,
ANa Bluetooth, kAroelig,
X0 Kat E80TTONCELG, @) X X
mpooBacipotnta,
umatapia)
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E + Evééxetatva pny eivat QKT N LETaopd oplopévwy SeSopévwy aviloya
ME TV €KGOCN AOYIGHIKOU KAl EPAPHOYIE, TO AEITOUPYIKO GUOTNHA, TOV

KOTOOKEUAOTH 1} TV TONTIKI) TOU TIAPOXOU UTTNPECIWV.

Ynootnpi{6peve {WVeG GUXVOTHTWY loxug e€680u mopmov

GSM 900 33.7dBm
GSM 1800 30.7 dBm
WB1 24.2dBm
W B8 25.2dBm
LTEB1 25.2dBm
LTEB3 23.7dBm
LTEB7 23.7dBm
LTEB8 25.2dBm
LTE B20 25.2dBm
LTEB28 25.2dBm
LTEB38 25.2dBm
LTE B40 25.2dBm
5GSub6n1 25.2dBm
5G Sub6 n3 25.2dBm
5G Sub6 n7 25.2dBm
5G Sub6 n28 25.2dBm
5G Sub6 n78 22.7 dBm
BT 2.4GHz 12dBm
WLAN 2.4GHz 19dBm
WLAN 5GHz 20dBm
NFC - 23 dBuA/m

Mriopeite va Bpeite mAnpo@opieg yia 1o @optioT Tagidiou otn SieBuvon
http://www.lg.com/global/support/cedoc/cedoc
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Anoppudn tng maAidic cag GUOKEVNG

1. AuTo o Slaypappévo oUPBOAO TOU TPOXOPOPOU KASOU UTTOSEIKVUEL OTL
Ta amoBANTA NAEKTPIKWV Kat NAEKTPOVIKWY TTpoiovTwy (AHHE) mpémetva
amopP{MTOVTAl XWPIOTA OO Ta YEVIKA OIKIAKA AmoppipuaTa.

B 2 TanaNd NAeKTPIKA TPOIGVTa UMOPE( va TIEPIEXOUV EMIKIVOUVEG
0UOIEC KAl WG EK TOUTOU N 0WOTH AmoppiPn TG MaNAG 0ag GUOKEUNG
QMOTPEMEL EVEEKOUEVEC APVNTIKEG CUVETTELEG Yiat TO TIEPIBANOV
Kat v avBpwmivn uyeia. H maAid 6ag GUOKEUR PMOPE( va TIEPIEKEL
EMAVOXPNCIUOTIOOIA AVTAMAKTIKE TTou Ba pmopouoav va
XPnotpomonBouy yia Ty MoKeur GAwV TPoIOVTwWY, KaBWE Kat GMa
UAIKA a&iag mou umopouv va avakukAwBoLv yia e§oikovopunon Twv
TIEPIOPIOUEVWY PUOIKWVY TIOPWV.

3. Mmopeite va TTATE TN CUOKEUR 00, iTE 0TO KATAOTNO amd TO
0TI0i{0 AyOPACATE TO TIPOIGV, I} Va EMKOIVWVAOETE TO TOTIKS YpaPEio
AMOPPIUUATWV Yia AETTOPEPELEC OXETIKA HE TO TTANCLETTEPO EYKEKPILEVO
onueio ouloync AHHE (AnépAnTa HAektpikwv kat HAEKTpOVIKWV
JUOKEUWV). M0 TIG TTIO TPOOPATES TTANPOPOPIES YIA TN XWPA 0AG
emokepOeite T SievBuvon www.lg.com/global/recycling

AmoppPn TWV XPNOIUOTTOINMEVWY prrataplwv/
CUCCWPEUTWY

1.To oOpBolo autd pmopei va cuvdualetal pe Ta XnUikd cupBoAa yia
Tov udpdpyupo (Hg), To kadpo (Cd) rj To pdAuBso (Pb), av n pmatapia
TIEPIEXEL TOOOTNTEG PEYaNUTEPES a6 0,0005% udpdapyupo, 0,002%
Kadpio 1} 0,004% poAupso.

2. H améppun OAwv Twv PIaTaplwv/CUCoWPEUTWY TTPEMEL vVal
YIVETOL XWPIOTA A0 TA YEVIKA OIKIAKA AMOPIpaTa, HEow EISIKWY
EYKATAOTACEWY CUNOYIG AOPPIUHATWY TTou €xouv kaBoploTei amd v
KUB£€PVNON 1 amo TIG TOTTIKEG APXEC.

3. H owotr andppipn Twv maNwy HmaTapiwv/cCUCowPEUTWY AITOTPETEL
EVOEXOUEVES OPVNTIKEG CUVETTELEC VIO TO TIEPIBANOV, KABWE Kal yia Thv
uyeia Twv {Wwv Kal Twv avBpwmwv.

4. Na Mo avaAUTIKEG TTANPOPOPIES OXETIKA LE TNV amoppIPn Twv MV
UMTOTAPIWV/CUCOWPEUTWY, EMKOIVWVAOTE WE TO TOTIKO YPaQEio, TNV
apuodia umnpeaia SIGBETNC OIKIOKWY AMOPPIMUATWY 1} TO KATAoTNHA
amné to omoio ayopdoate To TPoidv.
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LUXVEG EPWTIOELG

370 KEQAAILO QUTS avaPEPOVTAL OPLopEVA TIPOPBAUATA TTOU EVOEXETAL Va
QVTILETWTTIOETE KATA TN XPrioN TNG OUOKEUNG 0aC. Na optopéva mpoPAruata Oa
XPELOOTE VOl EMKOWWVHOETE LIE TOV TTAPOYKO UTNPECLWV 0ag, AANG Ta TTEPIOCOTEPA
pmopeite va Ta S1opBwoETe Kal HOvol 0.

Z@ahpa kaptag SIM

BeBaiwOeite 6T n kdpta SIM gival owoTa TomoBeTnpévn.

Agv uniapyel ouvdeon SiktUou 1 undpxel anwAela SIKTUOU
XapnAd orjua. MetakivnBeite kovtd og mapabupo 1y o€ avoiyxTd Xwpo.

Eiote extog TG meploxng kahung diktuou tou médpoyou. ANAETe Béon kat eNéyEte
70 SikTuo.

Aev givan S1a0£o1peg ol KAAoEIg

To véo iktuo Sev eival e§ouaiodotnpévo.

S 1lyOUpEUTEITE TIWG SV EXETE OPIOEL PPayr KNOEWV yIa TOV EI0EPKOHEVO aPIOUO.
S1youpeuTEiTe WG Sev EXeTe OpioEl Ppayr KAOEWV yia TOV apIBUO TTOU KOAEITE.

Aev givat Suvatn n evepyomnoinon TG CUOKEVNG

Otav n pmatapia €xel amo@optioet Mpw¢, Sev Ba givat Suvatr n evepyomoinon
TNG GUOKEUNG 00,
DopTtiote MAMPWG TN UMATAPIA TIPLV VA EVEPYOTTOI\OETE TN GUCKEUH.

Mapdptnua 179



ZAipa eopTiong
BePawwbeite 61 n cuokeur @optietal o€ Kavovikr Bepuokpaoia.
ENéyEte Tov OopTIOTH KAl T GUVEEDT) TOU 0T GUOKEUN.

Na xpnolgomoleite pdvo ta eapTripata mou mepINAPBAVOVTaAL 0T GUOKEVAGIN Kal
eivat e§ouctodotnuéva amd v LG.

H pmarapia telewvel mo ypriyopa o€ oxéon pe 6tav ayépaca
OPXIKA TN CUGKEUN

'Otav ekTiBeTal N CUCKEUN 1 N Umatapia og TOAD UWNAEG 1 XapnAég Bepokpaaieg,
evdéyetal va pelwbei n Sidpketa (wng NG pmatapiag.

H katavdAwon pmatapiog 8a au§nBei dtav xpnotuomoleiTe opIopéveg
XOPAKTNPLOTIKA 1 EPAPHOYEC, OTwG To GPS, maikvidia fj 1o Internet.

H pmatapia ivat avaAwotpo kat n {wn g pmatapiog 6a petvetal pe tnv mapodo
TOU XPOVou.

Epgavifovtal unvopata 6QAaAIATog KAatd TV KKIivnon Tng
KApEPOG

Oopriote TV umatapia.

ATENEUBEPWOTE MVI N LETAPEPOVTAC ApPXEI OE Evav uTToAoyloTh 1y Staypdgovtag
apxeia amd T cuokeun oag.

ETAVEKKIVE( TN CUOKEUN.

Eav e€akohouBeite va avtipetwmiCete mpdBAnua pe TNV Epappoyn TG KAUEPAg
0QOTOU AKONOUBNOETE AUTEC TIC CUMBOUAEG, EMKOIVWVHOTE pE €va Kévtpo Z€pPIg
NG LG Electronics.
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H moiétnta tnG pwrtoypagiag givan Kakn

H motdtnTa Twv Qutoypagiwy 6ag vOEXETAI va TIOIKIAEL avahoya pe ToV
TePIBEAOVTA XWPO KAl TV TEXVIKH GWTOYPAEPNONG TTOU XPNCILOTOIE(TE.
Otav Byalete pwtoypapieg kal Bivteo, n moidtnta amd otabepr ywvia ivat
KOAUTEQN OE OX€ON HE TV QVTIOTOIXN OO EUPEI ywvid.

Edv Bydlete puToypaieg o€ OKOTEWVA €PN, TO BPASU 1 O€ ECWTEPIKO XWPO,
evdéyeTal va umdpyel 00puBog oTIC PwToyPaPies iy va givat Boléc.

Edv avtipetwmifete mpoARUaTA, KAVTE EMAVAPOPA TWV EMAOYWV.

H 086vn agri¢ avtamokpivetat apyd  A\avOacuéva

Edv TomoBetrioete mpooTtateuTikd 086vVNG 1 mpoatpeTikd e€aptripata otnv 006vn
ARG, AUTH EVOEXETAL VA PNV AEITOUPYEL OWOTA.

Eav gopare yavtia, €dv Ta xépla oag dev eival kaBapd 6tav ayyilete v 086vn
ARG iy €Qv ayyigete TNV 006VN e aIUNEA QVTIKEIUEVA 1) e Ta aKPOSAKTUAG oag,
auTr) VOEXETAL VA NV AEITOUPYNOEL GWOTA.

H 086vn agr¢ evoéxetal va unv Asitoupyrogt owoTd og cuvBrKeg uPNARG
uypaoiag rj tav ektebei o€ vepo.

EmavekkiviioTe Tn cuokeur 6ag yla va §1opBwbolv Tuxov mpoowptva mpoBAruata
AoylopiKoU.

Edv n 006vn a@ng €xel YPATOOUVIOTEL 1 UMOOTEL {nId, EMOKEPTEITE éva Kévpo
2¢pPig TG LG Electronics.

KaBuaotepei ) KoMl

EmavekkivjoTe T ouoKeun
+ Av n ouokeun oo KoMdeL 1y kaBuoTepei, pmopei va XpelaoTei va kheioeTe
KATTOLEG EPAPHOYEG ) VO ATIEVEQYOTTOIOETE T GUOKEUR KAl Vol TV
€EVEPYOTIOINOETE Eaval.

EKKIvAoTE TN GUOKELR
« Hemavagopd umopei va xpnotpomolndei av n 08évn maywoel, ) av Ta Koupmd,
n 084vn aPnG 1 N OUCKELN eV AVTAMOKPIVOVTAL TTLL.
- [l va enavaeépeTe T GUOKELN 0ag, TIATAOTE TAUTOXPOVA T TTAKTPA PEiwong
£VTOONG X0V KAl AEITOUPYIQG LEXPL N GUOKEUT VO EMAVEKKIVNOEL
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Emavagopd TG GuoKeurg
« Edv n xprion twv mapandvw peBodwv Sev amokataotrioel To mpoBAnua,

EKTENEOTE EMAVAPOPA EPYOTTACIOKWY SESOUEVWV.

+ XV 08évn pubpicewy, ayyi€te Sladoxikd Zuotnua > Emavekkivnon &

Emavagopd > Emavagopd epyooTactakwyv Sedopévuwv.

- Emavagépet ONeg TIG puBpioELC yia T ouokeun kat Slaypagel Ta Gedopéva.
Mptv MPOXWPNOETE OTNV EMavapopd pyooTactakwv dedopévwy, BupnBeite
va SnuoupynoeTe avtiypapo ac@aleiag yia 0Aa ta onuavtika dedopéva
TIOU €XETE AMOBNKEVPEVA OTN GUOKEUN.

- Av kataywpnoeg évav Aoyaplaopo Google oTn GUOKEUH, TIPEMEL Val KAVel
€i0060 pe Tov 610 Moyaplaoud Google UETE TV EMAVAPOPA TNG CUOKEUNG.

Aev Bpébnke ouokeun Bluetooth
TIyoupeuTeite wg n Aettoupyia Bluetooth €xel evepyoroinBei otn cuokeun oag.

S lyoupeuTEiTe WG N Aertoupyia Bluetooth éxel evepyomoinBei otn cuokeun pe T
omoia BéAete va ouvdeDeite.

BeBawwbeite 6L n ouokeun oag kat n GAn cuokeur Bluetooth givat evtog tng
péylotng epPéleiag Bluetooth (10 m).

Edv ot mapamdvw cupBouléc dev A0oouv To TPORANKA G, EMMIKOVWVAOTE HE éva
Kévtpo ZépPig tne LG Electronics.

Aev mpaypatomoleital c0vOEon 0TV CUVOEETE TN CUCKEUN O€
évav umohoyloth

S lyOUpPEUTE(TE WG To KaAwS10 USB Tou XpnOIUOTIOLEITE givat oUUBATO Ke TN
OUOKEUN 00,

S IYOUPEUTEITE TIWG EIVaL EYKATAOTNIEVO Kall £XEL EVNUEPWOEL TO KATAANAO
TIPAYPAULA 05ryNONG CUCKEUNG OTOV UTTOAOYIOTH GO,

H epappoyr mou AfjpOnke mpokalei mToAd opaipata
H epappoyr mapouatalel mpoPAfuata.
AQQIPEOTE KA EYKATAOTAOTE EQVA TNV EQAPHOYN.
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ENGLISH

About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact an
LG Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

- Some content and illustrations may differ from your device, depending
on the area, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use of
media.

+ Additional charges may incur for data services, such as messaging,
uploading, downloading, auto-syncing and location services. To avoid
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model tested for use at the ear is 0.357 W/kg
(10 g) and when worn on the body is 1.304 W/kg (10 g).

+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.



Information about the RF exposure from FCC

In August 1996, the Federal Communications Commission (FCC) of the United
States, with its action in Report and Order FCC 96-326, adopted an updated safety
standard for human exposure to radio frequency (RF) electromagnetic energy
emitted by FCC regulated transmitters. Those guidelines are consistent with the
safety standard previously set by both international and US. standards. The design
of this device complies with FCC guidelines and these international standards.

Part 15.19 statement

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that
may cause undesired operation.

Part 15.21 Statement

Changes or modifications not expressly approved by the manufacturer could void
the user's authority to operate the equipment.
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Body-worn Operation

This device was tested for typical bodyworn operations with the back of the device
kept 0.39 inches (1cm) between the user’s body and the back of the device. To
comply with FCC RF exposure requirements, a minimum separation distance of
0.39 inches (1cm) must be maintained between the user's body and the back of
the device.

Any beltclips, holsters, and similar accessories containing metallic components
may not be used. Body-worn accessories that cannot maintain 0.39 inches (1cm)
separation distance between the user’s body and the back of the device, and have
not been tested for typical body-worn operations may not comply with FCC RF
exposure limits and should be avoided.

Part 15.105 Statement

This equipment has been tested and found to comply with the limits for a class

B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

- Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.
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Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

Keep away from electrical appliances such as TVs, radios and personal
computers.

The unit should be kept away from heat sources such as radiators or cookers.

Do not drop.

Do not subject this unit to mechanical vibration or shock.

Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.

Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not charge the device when it is on soft furnishings.

The device should be charged in a well ventilated area.

Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the device.

Do not expose the device to liquid or moisture.

Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.
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+ If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

+ The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

+ A'mobile device requires proper air circulation in order to dissipate heat. Direct
skin contact and inadequate circulation of air flow to the device may cause the
device to overheat. The device must be at least 1.0cm from between the users
body.

+ Prevent dust of any other foreign substances from getting into the Charger/
USB cable port. It may cause heat or fire.

+ Avoid exposing the device to low air pressure at high altitude.

+ Do not expose the device to extremely low air pressure. Otherwise, it can cause
explosion of the battery or leakage of flammable liquid or gas.

+ Please ensure that the product does not get in contact with liquid. Do not
use or recharge the product if it is wet. Once the product becomes wet, the
liquid damage indicator changes color. Please note that this will limit you from
receiving any free-of-charge repair services provided under warranty.

Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.

Some hearing aids might be disturbed by devices.

+ Minor interference may affect TVs, radios, PCs etc.

+ Use your device in temperatures between 0 °C and 35 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.
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Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
- Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
SO require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.

Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to a reasonable level.

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E + Excessive sound pressure from earphones and headphones can cause
hearing loss.
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Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentially explosive atmospheres
+ Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

- Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your device for emergency calls. Check with your local
service provider.
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Battery information and care

+ You do not need to completely discharge the battery before recharging. Unlike
other battery systems, there is no memory effect that could compromise the
battery's performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the
battery life.

+ Do not disassemble or short-circuit the battery.

+ Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

Recharge the battery if it has not been used for a long time to maximise
usability.

Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ Always unplug the charger from the wall socket after the device is fully charged
to save unnecessary power consumption of the charger.

+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal's teeth or claws, come
into contact with the battery. This could cause a fire.

+ Power Consumption (Networked Standby Mode) : 0.4 W

Securing personal information

Make sure to protect your personal information to prevent data leakage or
misuse of sensitive information.

Always back up important data while using the device. LG is not responsible for
any data loss.

Make sure to back up all data and reset the device when disposing of the device
to prevent any misuse of sensitive information.
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+ Read the permission screen carefully while downloading applications.

+ Be cautious using the applications that have access to multiple functions or to
your personal information.

+ Check your personal accounts regularly. If you find any sign of misuse of your
personal information, ask your service provider to delete or change your account
information.

+ If your device is lost or stolen, change the password of your account to secure
your personal information.

+ Do not use applications from unknown sources.

A Notice for Battery replacement

Li-lon Battery is a hazardous component which can cause injury.

- Battery replacement by a non-qualified professional can cause damage

to your device.

Do not replace the battery by yourself. The battery can be damaged,
which can cause overheat and injury. The battery must be replaced by
a qualified professional. The battery should be recycled or disposed
separately from household waste.

In case this product contains a battery incorporated within the product
which cannot be readily removed by end-users, LG recommends that
only qualified professionals remove the battery, either for replacement
or for recycling at the end of this product’s working life. To prevent
damage to the product, and for their own safety, users should not
attempt to remove the battery and should contact LG Service Helpline,
or other independent service providers for advice.

Removal of the battery will involve dismantling of the product case,
disconnection of the electrical cables/contacts, and careful extraction of
the battery cell using specialized tools. If you need the instructions for
qualified professionals on how to remove the battery safely, please visit
http7/wwwi.ge.com/global/sustainability/environment/take-back-recycling.
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Features



Swivel features
Swivel Mode

You can swivel the product to use two screens. Swivel the product as
shown below.

Swivel-up
Use your right thumb to slightly push up the bottom of the main screen.
Main Screen
———=—
L&

Second Screen

E + Do not apply excessive force as the main screen opens semi-
automatically.

+ Be careful not to get your thumb jammed while pulling down the main
screen.
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Swivel Home

Swivel Home is the first screen that appears after swivelling the product.
In this mode, you can use the main screen and second screen homes
separately or together to utilize in various ways.

|

[ =

Main screen
Swivel Home
Second screen
Swivel Home
Main screen

The home screen of the main screen appears as below.

App icons

Choose and start an app by dragging an app icon left and right. Some
apps on the main screen can be used on both the main screen and second
screen.
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Configuring home screen

Touch and hold an empty space on the main screen, then configure the
home screen as desired.

Deleting app ]
icons
Configuring App trash can
wallpaper and ! -
themes Configuring

Swivel Home

Using app icons
Touch and hold an app icon. You can delete the app from the home screen
or use various app features immediately.

13N
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Second screen

The home screen of the seco
screen in various ways.

Quick access icons —

nd screen appears as below. Use the second

e
i =P, &

——e —

—— ]

Navigation bar

Second screen quick setting
You can drag the upper part of the second screen downward to open the

quick setting window.

+ You can tap /2 to add or delete an icon on the quick setting window or

change the location.
- Touch and hold an icon on

the quick setting window and the

configuration screen will appear.

Custom-designed Features
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LG Touch Pad

Use LG Touch Pad —

- Tap @5 to open LG Touch Pad.

( = )

[ Use with a

mouse

Use LG Touch Pad

[N

+ Once LG Touch Pad is activated in the second screen, a mouse key
appears on the main screen as in PC to move it and choose an icon
freely.
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Using Grip Lock
+ You can touch @I to start Grip Lock.

— Turn off Grip Lock

- The second screen is locked when Grip Lock is selected.

+ You can unlock it by turning off Grip Lock.

Custom-designed Features
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Multitasking in the Swivel Mode

Using multitasking by swivelling the product allows you to use one app on

both screens or use two apps on each screen simultaneously.

E « This feature may not be supported in some apps.

Enlarging videos
1 Tap @3 on the main screen.
2 Choose a video you want to play and tap Play video.

3 Tap ({ on the second screen.
+ The video controller screen appears on the second screen.

="\ =\

=

— Open the video
controller.

Control the —
video on second
screen

Custom-designed Features

22



Expanding YouTube app
1 Tap B on the main screen.
2 Choose the YouTube content you want to play and play it.

3 Tap (] on the second screen.
+ The Media Controller screen appears on the second screen.

o— Turn off the Media
Controller on the second
screen

Custom-designed Features
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Using Multi App

Once you select apps with the Multi App widget on the second screen,
you can use the selected two apps simultaneously every time you tap the
widget. Set the frequently-used apps as Multi App.

1 Touch and hold an empty space on the second screen.

— Set Multi App

A\

2 Tap Multi app settings (g,
3 Scroll down the app list and select two apps to use as Multi App.

N
————
& &
View ME:'te‘\:lA;v?/ D ) Select two apps
2 ©
@ 1M
S 2/
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4 Tap Apply.
5 The Multi App icon is created on the home screen of the second
screen.

Use the Multi App icon —

« To delete the Multi App icon, touch and hold the icon on the second
screen, tap Remove from Home, then tap Remove.

Custom-designed Features
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Camera features

Using the camera in the Swivel Mode

You can use the features specialised for the video recording when the
product is in the Swivel Mode.

Gimbal Mode

You can use the camera as if it is inserted in a gimbal. Record a video in the
Gimbal mode to minimise shaking.

T Change the product to the Swivel Mode.
+ You can also start the Swivel Mode camera by swivelling the
product in the camera app.

2 Tap (&) on the main screen.
3 Select Gimbal Mode by swiping camera modes.

4 Tap @ to start recording in the Gimbal mode.

Settings ! T Resolution
= ! ) e
Pan Follow mode \ 7 lash settings
FPV mode 1 Refresh
Follow mode o+ Lock mode
Sound effects t Joystick

Photo mode list — s

Navigation bar —s
=

—

+ To take a photo while recording a video, tap @.
« To pause the video recording, tap @. To resume the video recording,

tap @.
5 Tap @ to end recording.
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FPV (First Person
View) mode

Your rotations or movements are naturally reflected
so that you can record a video rhythmically and
dynamically.

Pan Follow mode

The up/down and clockwise/anticlockwise rotations are
fixed and the angle moves left/right. It is efficient for
capturing photos or videos when walking up the stairs
or moving in a car while maintaining level.

Follow mode

The clockwise/anticlockwise rotations are fixed and the
angle moves up/down and left/right.

It is efficient for capturing photos or videos of an overall
appearance of a large subject such as a concert or a
building.

You can move the joystick in any direction you want,
so that you can move the angle up/down and left/

Joystick right without rotating the camera while minimising
blurriness.
Lock mode Touch and hold to lock the angle.

Sound effects

+ Basic: You can record a video with a stable stereo
sound effect.

+ ASMR Recording: Use it to amplify the sound of the
subject in the screen to record a video with clear, small
sounds.

« Voice Bokeh: Use it to record a video with reduced
surrounding sounds and emphasized voice of a
subject.
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Taking Slo-mo

Make a fun video by controlling a movement speed. You can apply a
motion effect slower than normal.

1 Change the product to the Swivel Mode.
2 Tap (@) on the main screen.
3 Select Slo-mo by swiping camera modes.

4 Tap © or @ to choose a duration for the slow motion effect.

Set camera options — = &

—— Set flash options
Choose duration I

A e ——

- Part Slo-mo: Allows you to apply a slow motion effect to a specific
section of the video.

- Tap © at the moment where you want the slow motion effect to be
applied. With a short-press, slow motion effect will be applied for 0.5
second. With a long-press, slow motion effect will be applied until
you release your finger.

+ All Slo-mo: Allows you to apply a slow motion effect to the entire
video.
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Time-lapse recording
You can record Time-lapse videos optimised for the situation.

Videos can be recorded with optimal speed and steady motion by
analysing various shooting environments. The time-lapse speed can be
automatically adjusted according to the shooting target and environment.

You can also select the time-lapse speed manually.
1 Change the product to the Swivel Mode.
2 Tap (&) on the main screen.

3 Select Time-lapse by swiping camera modes.

+ Choose the screen magnification of the scene to be recorded on the
second screen.

Choose screen
magnification

Choose time-lapse
speed

A e ——

+ Choose the Time-lapse speed on the second screen.

E « If you select Auto, it automatically sets the speed suitable for the screen
to be recorded.
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/| Tap @ to record a video.
+ You can change a zoom and time-lapse speed while recording.

- If you tap the desired speed, the time-lapse speed is adjusted while
recording.

+ To pause the video recording, tap @. To resume the video recording,
tap @.

+ While recording a video, you may spread or pinch two fingers to
zoom in or out.

+ While recording a video, you may tap the desired area to adjust the
brightness.

5 Tap @ to stop recording.
+ The recorded video will be saved in Gallery.

+ Audio is not recorded during Time-lapse recording.
+ You can tap (€ to record a Night Time-lapse video.
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Taking a Dual recording video

You can use front and rear cameras simultaneously to record a video. You
can save the videos from each camera either as one file or two separate
files.

7 Change the product to the Swivel Mode.
2 Tap (&) on the main screen.

3 Select Dual recording by swiping camera modes.
+ The Front pop-up camera automatically pops up.

4 Tap @ to record a dual-recording video.

[ol
=

—

I— Rear recording screen

Front recording screen J

Split view — 2! — PIP

+ You can touch and hold the main screen and drag to switch the
locations of the front and rear camera screens.

+ To pause the video recording, tap @. To resume the video recording,
tap @.
5 Tap @ to end the recording.

E - If you choose to save separately, the videos of the front and rear
cameras are saved as separate files.

- If you choose to save as shown, the videos of front and rear cameras are
saved in one screen.

A + If you start Dual-recording mode, a built-in Front pop-up camera comes
out. Do not push or pull it with excessive force, or it may be broken.

Custom-designed Features 31



Taking PIP (Picture in Picture)
- If you tap (@) in the control screen of the second screen, the recording
screen is switched to take a PIP (Picture in Picture).
« If you tap (@), you can switch the screen locations of front and rear
cameras.

+ You can touch and hold the PIP screen and drag it to one of the four
corners as desired.

— Take PIP
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Audio recording features

Video recording with specialised audio

recording options

You can record a video using three different voice recording options to suit
your purpose.

1 Tap (&) and select Video by swiping camera modes.

2 Tap @ and select Basic, ASMR Recording, or Voice Bokeh by swiping
audio options.

. -d !g Q Audio options

Basic
You can record a video with stable stereo sound.

ASMR Recording

With two sensitive microphones in the device, you can record an ASMR
video.
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Voice Bokeh

You can emphasize the voice of a subject by reducing ambient noise.
+ To reduce ambient noise, drag the slide bar to 0.

Recording ASMR sounds

This feature allows you to record the audio clearly and precisely by
amplifying the sound from the microphones.

1 Tap LG>HD Audio Recorder and tap => ASMR.
2 Tap @ to record the audio.
- To pause the recording, tap @. To continue the recording, tap @.

3 Tap @ to end the audio recording.

LG 3D Sound Engine

LG 3D Sound Engine feature allows you to hear stereoscopic and
optimised sound. When playing music or video, you can enjoy stereoscopic
and immersive sound as if you were listening in the field.

1 Drag the notifications panel downwards.

2 Tap ®®)to turn on or off the LG 3D Sound Engine feature.

Or tap Settings > Sound > Sound quality and effects > LG 3D
Sound Engine and tap to activate it.

« If you connect an external audio device such as an earphone or speaker

to the product, a pop-up appears to turn on the LG 3D Sound Engine
feature.
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Google Assistant

Google Assistant overview

Your device has the built-in Google Assistant feature. Find answers and
get things done while on-the-go.

E « To use this feature, first connect to the network.

Launching Google Assistant
T Swipe diagonally from a bottom edge corner of the screen.
2 Tap GET STARTED.

3 Follow the on-screen instructions.
+ The device saves your voice data for recognition.

4 Set whether to use the the speech recognition feature.

+ When this feature is activated, you can run Google Assistant by
saying "OK Google" on the Home screen.

5 Tap Finish.

Accessing by Voice

T When the home screen is turned off or locked, say “OK Google” or
“Hey Google”.

2 When the Google Assistant screen appears, say a command or ask a
question.
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Accessing from Home Screen
1 Swipe diagonally from a bottom edge corner of the screen.

2 Say acommand or question when you see «« -+ on the bottom of the
screen.

E « In an environment where Wi-Fi or mobile data connection is poor, the
Google Assistant function may be restricted and the speech recognition
accuracy rate may be lowered.

« If the speech is ambiguous, the microphone is covered, a media player is
playing, or the surrounding is loud, the speech recognition accuracy rate
may be lowered. \When you are using the product via voice commands,
say with accurate pronunciation in a quite environment for better
speech recognition accuracy.
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Product components and
accessories

The following items are included with your device.

+ Device + Charger
- USB cable - Quick Start Guide
+ Ejection pin + Phone Case

A .

« The items supplied with the device and any available accessories may

Basic Functions

The items described above may be optional.

vary depending on the area and service provider.

Always use genuine LG Electronics accessories. Using accessories made
by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

« Some of the device parts are made of tempered glass. If you drop your

device on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your device
immediately and contact an LG Customer Service Centre.

If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional items, contact an LG Customer Service Centre.

Some items in the product box are subject to change without notice.

- The appearance and specifications of your device are subject to change

without prior notice for product improvement.
Device specifications may vary depending on the area or service provider.

Remove the protective film from the Fingerprint sensor before using the
fingerprint recognition feature.
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Parts overview

Pop up camera

Proximity/Ambient —
light sensor

[€)

——

®

— Earpiece

~— Power/Lock key

— Touch screen

Microphone ———

| O
Rear camera lenses — ‘ @
0 |
Flash — P .
I
S B S  E——
Speaker —

Basic Functions

+— Nano-SIM/
Memory card tray

— NFC

— Wireless charging
antenna area

——— Microphone

]» Volume keys (+/-)

— Fingerprint sensor

Charger/USB cable port
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A Do NOT attempt to remove the back cover by yourself.

+ Doing so may severely damage the battery and device, which could
cause overheating, fire, and injury. This device's back cover and battery
are not to be removed or replaced by a non-qualified professional.

+ Your phone is an electronic device that generates heat during normal
operation. Extremely prolonged, direct skin contact in the absence of
adequate ventilation may result in discomfort or minor burns. Therefore,
use care when handling your phone during or immediately after
operation.

- Volume keys
- Adjust the volume for ringtones, calls or notifications.

- While using the Camera, gently press a Volume key to take a photo.
To take continuous photos, press and hold the Volume key.

- Press the Volume Down key twice to launch the Camera app when
the screen is locked or turned off. Press the Volume Up key twice to
launch Capture+.

+ Power/Lock key
- Briefly press the key when you want to turn the screen on or off.
- Press and hold the key when you want to select a power control
option.
- Fingerprint sensor

- You can use the fingerprint sensor at the bottom centre of the
screen to use the fingerprint recognition function. See Fingerprint
recognition overview for details.
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Some functions may be restricted depending on the region and product
specifications of different telecommunications providers.

There are NFC chip and wireless charging antennas built into the rear
part of the product. Be careful not to damage or cover the NFC chip or
wireless charging antennas.

Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen.

Screen-protective film or accessories may interfere with the proximity
sensor.

If you use accessories such as protective films, covers, and cases that
are not genuine LG Electronics, be careful as the buttons, sensors, and
lenses of the product may not work properly. In this case, you cannot
use the warranty service provided by LG Electronics, and LG Electronics
does not guarantee damage such as product malfunction.

If your device is wet or is being used in a humid place, the touch screen
or keys may not function properly.
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There are two microphones built into this product. Be careful not to cover
the microphones. \While you are talking on the phone, do not cover the
microphone with your hand or fingers.

Do not use a phone case that is not a genuine product or cover the
microphone with accessories, tape, etc.

Hold the product correctly as shown in the image when you are using it.

Microphone Do not cover the microphone.

]

N

Microphone Do not cover the microphone.
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Turning the power on or off

Turning the power on
When the power is turned off, press and hold the Power/Lock key.

E + When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual

Turning the power off
Press and hold the Power/Lock key, then select Power off.

Restarting the device

When the device is not working properly or does not respond, restart it by
following the instructions below.

1 Press and hold the Power/Lock key and the Volume Down key at the
same time until the power is turned off.

2 When the device is restarted, release the key.

Power control options

Press and hold the Power/Lock key, then select an option.
« Power off: Turn the device off.

- Power off and restart: Restart the device.
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Installing the SIM card

Insert the SIM (Subscriber Identity Module) card provided by your service
provider to start using your device.

A « Be careful with the ejection pin since it has a sharp edge.

T Insert the pin into the hole of the card tray and press the pin, and then
pull the card tray out of the product.

2 Align the Nano-SIM cards on the card tray and press the card in the
direction of the arrow as shown in the figure.
Nano-SIM card 2

Nano-SIM card 1

+ The SIM card tray 2 also serves as the memory card tray. However, you
cannot put both the SIM card and the memory card (optional) at the
same time.
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3 Insert the card tray into the phone as shown in the figure.
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This device supports only Nano SIM cards.

Nano Micro Standard

e @

For problem-free performance, it is recommended that you use the
device with the correct type of SIM card. Always use a factory-made
SIM card supplied by the operator.

Do not lose your SIM card. LG is not responsible for damage and other
issues caused by loss or transfer of a SIM card.

Be careful not to damage the SIM card when you insert or remove it.
When you insert the SIM card or memory card, place it on the card tray
correctly.

\When you insert the card tray back into the device, insert it horizontally
in the direction of arrow as shown in the figure. Make sure that the card
placed on the card tray does not move out of its position.

Insert the SIM card with the gold-coloured contacts facing downwards.
Be sure to insert the SIM card into the device by following the
instructions in the user manual.

If you insert or remove the card tray from the device, be careful not to
let water or other liquids enter into the card tray. If a wet card tray or
card is inserted into the device, your device may get damaged.

Memory card is an optional item.

Frequent writing and erasing of data may shorten the memory card
lifespan.

Some memory cards may not be fully compatible with the device. If you
use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.
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Inserting the memory card

Insert the memory card into your device.

Depending on the memory card manufacturer and type, some memory
card may not be compatible with your device.

7 Insert the ejection pin into the hole on the card tray.
2 Pullout the card tray.

3 Put the memory card on the card tray with the gold-coloured contacts
facing downwards.

Memory card
(optional-sold separately)

S SIM card

@O
¢

BE S

\
J

.

4 Insert the card tray back into the slot.
A + Some memory cards may not be fully compatible with the device. If you

use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.

E « Frequent writing and erasing of data may shorten the memory card
lifespan.
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Removing the memory card
Unmount the memory card before removing it for safety.
7 On the home screen, tap Settings > Storage > /..

2 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

3 Remove the memory card from the card tray.
4 Insert the card tray back into the slot.
A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.

Battery
Charging the battery

Before using the device, fully charge the battery.
Charge the device with the USB Type-C cable.

Charging cable terminal
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A « If there is moisture on the charging port, exposed terminals, charging
cable, charging adapter, etc, do not use or charge the product. The
product may malfunction or get broken or damaged, and there is risk
of injury caused by electric shock, fire, overheating, explosion, etc. If
you find moisture on such areas, stop using or charging the product
immediately and completely remove the moisture.

+ Do not separate the battery cover.

This product uses a non-removable battery. Do not remove or replace

the battery cover or the battery. If you remove or replace the battery

cover or the battery, the product may be damaged, overheated or
explode.

Only use the USB cable and charging adapter provided with the product

as basic components.

Your device has an internal rechargeable battery. For your safety, do not
remove the embedded battery.

« Using the device when it is charging may cause electric shock. To use the
device, stop charging it.

E + Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

.

A charging adapter that supports fast charging is included with the
product. The fast charging feature may not work if a fast charging
adapter other than the genuine adapter provided with the product is
used.

« Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer: This may take
longer than plugging the adapter to a wall outlet.

« Do not charge the battery by using a USB hub that is unable to maintain
the rated voltage. Charging may fail or unintentionally stop.

« When you are visiting the Service Centre with a battery issue, bring the

product and the charger with you Since the battery is a consumable, the

battery life may be shortened as times goes by.

Basic Functions 49



Precautions when using the device

+ Make sure to use the USB cable provided; do not use third party USB
cables or chargers with your device. The LG limited warranty does not
cover the use of third party accessories.

- Failure to follow the instructions in this quide and improper use may
damage the device.

Wireless charging

This device supports wireless charging feature. Charge the device with a
Qi certified wireless charger (optional, sold separately).

Charging the battery with a wireless charger

1 Place your device on the centre of the wireless charger aligned with
the wireless charging antenna on the back of the device.
+ To check the wireless charging antenna area, see Parts overview.

2 When the battery is fully charged, remove the device from the charger.

A + When you charge the battery with a wireless charger, do not put a
magnetic, metallic or conductive materials between the device and the
charger: This may disturb charging of the device and the charger may
become heated. In this case, the device, charger or SIM/Memory cards
may be damaged.
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E - If the battery temperature exceeds a certain level while charging the

device, charging may be stopped.

If magnetic, metallic or conductive materials are attached on the back
of the device or a protective case is inserted, the device may not charge
properly.

« |f you charge the battery with a wireless charger in areas where the

network signal strength is weak, the network performance of your
device may be further degraded.

« Charge the device with a Qi certified wireless charger (optional, sold

.

separately). Because the LG limited warranty does not cover the use of
third party accessories, contact the third party manufacturer.

This product supports wireless charging. Use a Qi certified wireless
charger (sold separately) to charge the product. Some coiled wireless
chargers may not support wireless charging. Wireless chargers that
support EPP (Extended Power Profile) allow high-speed wireless
charging.

LG Electronics is not responsible for any issues concerning accessories
of other brands. For such issues, contact the manufacturer of the
accessory product.

Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.

To minimise battery consumption, follow these tips:
« Turn off the Bluetooth® or Wi-Fi network function when not using

them.

Set the screen timeout to as short a time as possible.
Minimise the screen brightness.

Set a screen lock when the device is not used.

Check the battery level while using any downloaded apps.
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Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping

Lightly tap with your fingertip to select or run an app or option.

Touching and holding

Touch and hold for several seconds to display a menu with available
options.
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Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging

Touch and hold an item, such as an app or widget, then move your finger
to another location in a controlled motion. You can use this gesture to
move an item.

Swiping

Touch the screen with your finger and move it quickly without pausing.
You can use this gesture to scroll through a list, a web page, photos,
screens, and more.
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Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

- Do not expose the touch screen to excessive physical shock. You might

damage the touch sensor.

« Atouch screen failure may occur if you use the device near a magnetic,

metallic or conductive material

« If you use the device under bright lights, such as direct sunlight, the

.

.

.

screen may not be visible, depending on your position. Use the device
in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

Do not press the screen with excessive force.
Gently tap with your fingertip on the option you want.

Touch control may not work properly if you tap while wearing a glove or
by using the tip of your fingernail.

« Touch control may not work properly if the screen is moist or wet.

« The touch screen may not function properly if a screen-protective film

.
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or accessory purchased from a third party store is attached to the
device.

Displaying a static image for extended periods of time may result in
after-images or screen burn-in. Turn off the screen or avoid displaying
the same image for a long time when you do not use the device.
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Home screen

Home screen overview

The Home screen is the starting point for accessing various functions and
apps on your device. Swipe up from the bottom edge of any screen to
directly go to the Home screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.

Home screen layout
You can view all apps and organise widgets and folders on the Home

screen.

5

Status bar — N

I ]
Yeather Widget _.-

'— Google Search widget

7 Y r_ ! i
Folder —- ~ ﬂ o

L Page icon
Ce O u G — Quick access area
L= 77~ TR |

Navigation bar

+ The Home screen may differ depending on the manufacturer policy, user

settings, software version or service provider.
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Status bar: View status icons, the time and the battery level

Weather widget: View the information of weather and time for a
specific area.

Google Search widget: Type or speak to pull open Google Search.

Folder: You can create folders to classify the app based on desired
criteria.

+ Page icon: Display the total number of Home screen canvases. You

can tap the desired page icon to go to the page you selected. The icon
reflecting the current canvas will be highlighted.

Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

Navigation bar: You can go to the previous screen or home screen
while using the app, and check the list of apps you used recently.

Using Navigation bar
Here is the gestures guide to control the Navigation bar.

To go to Home screen, swipe up from the bottom edge of the screen.
To go back to the previous screen, swipe in from the left or right edge
of the screen.

To go to Overview screen, swipe up and hold from the bottom edge of
the screen.

To quickly switch between apps, swipe right at the bottom edge of the
screen to go to previously used apps.

- Gestures is the default for the Navigation bar. To change it to Buttons
only<]/Q/ [:] on the home screen, tap Settings > Display >
Navigation bar, then select Buttons only.

Basic Functions 56



Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status
bar.

A No signal
%

Data is being transmitted over the network

Alarm is set

i Vibrate mode is on

Bluetooth is on

Connected to a computer via USB

Battery level

Airplane mode is on

Missed calls

Wi-Fi is connected

Mute mode is on

GPSison

3 Hotspot is on
R No SIM card
[N The NFC mode is on

E + Some of these icons may appear differently or may not appear at all,
depending on the device's status. Refer to the icons according to the
actual environment and area in which you are using the device and your
service provider.

« Displayed icons may vary, depending on the area or service provider.
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Notifications panel

You can open the notifications panel by dragging the status bar
downward on the main screen.

+ You can drag down the notice window or tap the arrow icon to open
the list of quick setting icons.

+ You can tap /9 to add, delete or arrange icons in the notice window.

- If you touch and hold the icon, the settings screen for the
corresponding function appears.

E « You can use the notifications panel even on the lock screen. Drag the
notifications panel while the screen is locked to quickly access the
desired features.
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Switching the screen orientation

You can set the screen orientation to automatically switch according to
the device’s physical orientation.

On the notification panel, tap Rotation from the quick access icon list.

You can also tap Settings > Display and activate Auto-rotate screen on
the home screen.

Editing the Home screen
On the Home screen, touch and hold on an empty space, then select the
desired action from below.
- Torearrange the Home screen canvases, touch and hold on a canvas,
then drag it to another location.
- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.
- To change wallpapers, themes, icons, and AOD, touch and hold on a
blank area of the Home screen, then select Wallpaper & theme.
You can also tap Settings > Wallpaper & theme on the home screen,
then select wallpapers, themes, icons, and AOD, to apply to the device.

+ To change the grid, touch and hold on a blank area of the Home screen,
then select Grid. Tap the desired grid, then tap Apply.

Basic Functions 59



- To configure the Home screen settings, touch and hold on a blank area
of the Home screen, then select Home screen settings. See Home
screen settings for details.

- Toview or reinstall the uninstalled apps, touch and hold on a blank area
of the Home screen, then select App trash. See App trash for details.
+ To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap Y, then tap the screen once
more.

Ll — Default screen
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Viewing the background theme

You can view only the background image by hiding the apps and widgets
on the Home screen.
Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or drag up — from the bottom edge
of the screen.

Moving apps on the Home screen

On the Home screen, touch and hold an app, then drag it to another
location.

« To keep frequently used apps at the bottom of the Home screen, touch
and hold an app, then drag it to the quick access area at the bottom.

+ Toremove an icon from the quick access area, drag the icon to the
Home screen.
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Using folders from the Home screen

Creating folders
On the Home screen, touch and hold an app, then drag it over another
app.

A new folder is created and the apps are added to the folder.

Editing folders

On the Home screen, tap a folder and do one of the following actions.
- To edit the folder name tap the folder name.
- To edit the colour, tap the right upper circle.

- To add apps, touch and hold an app, then drag it over the folder and
release it.

- To remove an app from the folder; touch and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

+ You can also add or remove apps after tapping ().

E + You cannot change the folder colour while using downloaded theme.
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Home screen settings
You can customise the Home screen settings.
1 On the home screen, tap Settings > Display > Basic Home.
2 Customise the following settings:
+ Select Home: Select a Home screen mode.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.

+ lcon shape: Choose if you want icons to have square or rounded
corners.

- Google feed: Show to the left of the main Home screen.
- Sort apps by: Set how apps are sorted on the Home screen.

- Hide apps: Select which apps you want to hide from the Home
screen.

+ Loop Home screen: Enable to allow continuous Home screen
scrolling (loop back to first screen after the last screen).

- Swipe down on the Home screen: Enable to search apps or
contents, or view notifications by swiping down on the home
screen.

- Swipe up on the Home screen: Enable to search apps or contents,
by swiping up on the home screen.

+ Home screen lock: Enable to prevent apps and widgets from being
rearranged or removed.
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Customise the Swivel Home

The Swivel Home is the first start screen that appears after swivelling up
the product. Use the Home screens of the main screen and the second
screen in various ways.

D
Clock and —jy¢
weather
Main Screen
APP T’
shortcuts
s———————>— Navigation bar

Second Screen —;

— Quick-access icons

Navigation bar —y

+ Clock and weather: You can check the current time and weather.
+ App shortcuts: You can quick start the apps on the list.

- Navigation bar: You can use some gestures to go to the Home screen,
previous screen, Overview screen, or quickly switch between apps.

- Quick access area: You can use the apps you want to start directly.

Basic Functions 64



Configuring the Swivel Home Screen

You can change the settings related to the Home screen of the Swivel
Mode.

7 On the home screen, tap Settings > Display > Swivel Home.

2 Choose the desired function to set a configuration.

- Swipe down on the Home screen: Select what you want to view
when swiping down the main home screen in the Swivel Mode.

+ Multi App Shortcut: You can choose to run two apps
simultaneously on the main screen and on the second screen.

- Swipe down on the Home screen: Select what you want to view
when swiping down the second screen in the Swivel Mode.

- Screen swipe effect: Choose a desired visual effect when you
swivel the phone.

- App drawer icon: Enable the App drawer icon @ visible on the
second screen.

- Home screen lock: Enable to prevent apps and widgets from being
rearranged or removed.

+ Help: View the help for Swivel Home.
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Screen lock

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of
time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

E « A screen lock prevents unnecessary touch input on the device screen
and reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.

Setting a screen lock
There are several options available for configuring the screen lock settings.

7 Onthe home screen, tap Settings > Lock screen & security > Select
screen lock and then select the method you prefer.

2 Customise the following settings:
+ None: Deactivate the screen lock function.
- Swipe: Swipe on the screen to unlock the screen.
- Pattern: Draw a pattern to unlock the screen.
+ PIN: Enter a numeric password to unlock the screen.
+ Password: Enter an alphanumeric password to unlock the screen.

Fingerprints: Unlock the screen by using your fingerprint.
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Customise Lock screen
You can customise lock screen.
1 On the home screen, tap Settings > Lock screen & security >
Customize Lock screen.
2 Select a function you want to set.
+ Clock: Allow you to set clock size on the Lock screen.
+ Shortcuts: Allow you to choose apps to run on your Lock screen.
This setting appears only when a screen lock is set.
- Weather animation: Enable this option to display weather
animations for the current location on the Lock screen.

- Contact info for lost phone: Allow you to set text to be displayed
on the Lock screen to identify the phone's owner.

Secure lock settings
You can set secure lock settings.

7 Onthe home screen, tap Settings > Lock screen & security > Secure
lock settings.

2 Select a function you want to set.

- Make pattern visible (shown only when Pattern is set as a screen
lock): Turn on to make pattern visible.

- Lock timer: Allow you to set the amount of time before the screen
automatically locks after the backlight turns off (time-out due to
inactivity).

- Power key instantly locks: Enable this option to instantly lock the
screen when the Power/Lock key is pressed. This setting overrides
the Security Lock timer setting.

+ Show lockdown option (shown only when a screen lock is set):
Enable this option to display the Lockdown icon when you press
and hold the Power/Lock button. Tap the Lockdown icon to turn
off Smart Lock, biometric unlocking, and notifications on the lock
screen.
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+ Smart Lock: Allow you to set trusted devices, places, voice, and/or
on-body detection that will allow your phone to remain unlocked.

E + Available menu options may vary depending on the lock screen method
selected.

KnockON

You can turn the screen on or off by double-tapping the screen.

5 « This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.

Disable KnockON

If you don't want to use the KnockON function, set as follows:

On the home screen, tap Settings > Extensions > KnockON and drag it
to disable the function.
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Fingerprint Recognition

Fingerprint recognition overview

You must register your fingerprint on your device first before using the
fingerprint recognition function.

You can use the fingerprint recognition function in the following cases:
+ To unlock the screen.

+ To view locked contents in Gallery or QuickMemo+.

+ Confirm a purchase by signing in to an app or identifying yourself with
your fingerprint.

E « Your fingerprint can be used by the device for user identification. Very
similar fingerprints from different users may be recognised by the
fingerprint sensor as the same fingerprint. For added security, set the
screen lock using a pattern, PIN or Password.

« If the device cannot detect your fingerprint, or you forget the value
specified for registration, contact the LG Authorised Service Centre with
your device and ID card.

Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease due to a number of
reasons. To maximise the recognition accuracy, check the following before
using the device.

+ At the bottom centre of the product’s screen, there is a built-in sensor

that recognises fingerprints. Be careful not to scratch or damage the
fingerprint sensor with metal objects such as coins or keys.

To purchase and use a protective film, check with the place of purchase
in advance to see if the product can use a fingerprint sensor. In some
products, fingerprint recognition may not be possible or the product
may malfunction. In this case, you cannot use the warranty service
provided by LG Electronics, and LG Electronics does not guarantee
damage such as product malfunction.
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- If you replace the protective film on the product with a polarized film
that diffuses the light or a film that is too thick, it may decrease the
fingerprint recognition rate.

If tempered glass or other thick protective film is attached to the
product, the fingerprint recognition function may not work properly. In
this case, be sure to remove the protective film in use from the product
before using the fingerprint registration and recognition function.

- If there are foreign substances (sweat, lotion, water, dirt, grease, etc.)
on the fingerprint sensor or on the finger to be put on the sensor,
fingerprint recognition may not work properly. Wipe the sensor and the
finger clean and remove all moisture before putting the finger on the
sensor.

If the finger's surface is rough due to it being scarred or pruney from
water, the sensor may not be able to recognise the fingerprint. In such
a case, register another finger's fingerprint.

- If you bend your finger or use the fingertip only, your fingerprint may

not be recognised. Make sure that your finger covers the entire surface
of the fingerprint sensor.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

The device may generate static electricity if the surrounding air is dry.
If the surrounding air is dry, avoid scanning fingerprints, or touch a
metallic object such as a coin or a key before scanning fingerprints to
remove static electricity.
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Registering fingerprints
You can register and save your fingerprint on the device to use fingerprint
identification.

7 Onthe home screen, tap Settings > Lock screen & security >
Fingerprints.

E - This feature is available only when the screen lock is set.
- Lock the device with a pattern, PIN or password.

« If the screen lock is not set, enable it by following the on-screen
instructions. See Setting a screen lock for details.

2 Check the location of the fingerprint sensor at the bottom centre of
the screen, and lightly place your finger on the sensor.

5 + Make sure that the finger fully covers the fingerprint sensor.

3 Follow the on-screen instructions.
+ Place your finger on the sensor and hold it until you feel a vibration.
+ Move the same finger around on the sensor a little by little until the
fingerprint registration is complete.
4 When the fingerprint registration is done, tap OK.

- Tap Add more to register another fingerprint. If you register only
one fingerprint and the corresponding finger is not in a good
condition, the fingerprint recognition may not work well. As a
preventative measure, register multiple fingerprints.
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Managing fingerprints
You can edit or delete registered fingerprints.

T On the home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it, tap
.

Displaying the fingerprint icon when the
screen is off

You can set to display the fingerprint sensor location on the screen when
the screen is off.

7 Onthe home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 Tap Tap to show icon when screen is off to enable the option.

Icon effect

You can choose an effect that appears when the fingerprint icon is
touched.

T On the home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 Tap lcon effect and select a desired effect.
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Unlocking the screen with a fingerprint

You can unlock the screen or view locked content by using your

fingerprint.

7 Onthe home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
- Screen lock: Unlock the screen with a fingerprint.

- Content lock: Access contents you have locked in Gallery and
QuickMemo+ with a fingerprint.

KnockON

You can turn the screen on or off by double-tapping the screen.

On the home screen, tap Settings > Extensions > KnockON to enable
the option.

- This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.
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Multi-tasking feature

Recent Uses Screen
Swipe the Navigation bar — upward and hold to view the recent use
history.

Pop-up window

You can open multiple apps on the screen and easily switch between
them at any time.

T Swipe up and hold — from the bottom of the screen.

2 Tap the app icon on the top left of the app screen and select Pop-up
window.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.

3 The app appears in the form of a pop-up window on the screen.

(I

np

E « This feature may not be available in some apps or screens.
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Using the pop-up window

+ — :Minimises the pop-up window. The pop-up window is minimised
into the app icon floating on the screen, which can be moved anywhere
you want.

U :Expands the app to full screen.
+ X :Closes the app.

- To move the pop-up window: Drag the top of the pop-up window.

+ To adjust the size of the pop-up window: Drag the left, right or
bottom edge of the pop-up window.

« You can open up to 5 apps using the pop-up windows.

« To select an app from the opened apps, tap one of the pop-up windows.
The selected pop-up window comes to the front.

+ Pop-up windows cannot be moved to the status bar or navigation bar
area.
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Using the app folder for pop-up windows

If you tap — on the pop-up window, the pop-up window is minimised into
the app icon.

You can move the app icon anywhere you want by dragging it.

np

If two or more pop-up windows are minimised, the app folder is created to
contain the app icons.

« The recently-used app icon is used as the app folder icon. If you tab the
icon, all the icons for the minimised pop-up windows appear in the app
folder.
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« If you touch and hold the app folder for pop-up windows and drag the
app folder into Remove, the app folder will be removed.

- To remove one of the apps from the app folder; open the app folder and
drag the app icon out of the app folder:
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Multi window

When using Gestures navigation (by default)

1 Swipe up and hold — from the bottom of the screen.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select Multi window.
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.
+ The selected app appears at the bottom half of the screen.

When using Buttons only navigation

1 Tap[Jon the navigation bar.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select =,
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.

E - To adjust the size of the split screen, drag the bar on the centre of the
screen.

+ To deactivate the multi window feature, drag the centre bar up or down
to the end of the screen.

+ The multi window feature is not supported in some LG apps or apps
downloaded from Play Store.
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Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

7 Onthe home screen, tap Settings > Lock screen & security >
Encryption & credentials > Encrypt SD card.

7 Read the on-screen overview of memory card encryption and then tap
Continue to continue.
3 Select an option and tap Encrypt now.

- New data encryption: Encrypt only data that is saved on the
memory card after encryption.

Full encryption: Encrypt all the data currently saved on the memory
card.

Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.

E + Once memory card encryption starts, some functions are not available.

- If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to
check if the battery level is sufficient before starting encryption.

Encrypted files are accessible only from the device where the files were
encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, format the
card.

+ You can activate memory card encryption even when no memory card
is installed into the device. Any memory card that is installed after
encryption will automatically be encrypted.
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Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down key at the
same time for at least two seconds.

+ Screenshots can be viewed from the Screenshots folder in the
Gallery.

Via Screenshot

On the screen where you want to take a screenshot, drag the status bar
downwards, then tap (0.

E + See Writing notes on a screenshot for details.

Screen recording

You can record the screen.

1 Drag the status bar downward to open the Quick access icons list.
2 (If necessary, swipe left over the Quick access icons area.) Tap (@).

3 Read the disclaimer and tap Start. It will start recording in 3 seconds.

Select front pop-up camera —l Stop recording

00:00:05 (&

Screen recording time Select voice recording

- When you tap @, the front pop-up camera comes up and the
display using the front camera is also included.
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4 To stop recording, tap ®. The recorded video will be saved in Gallery.

E « Ifyou violate another person's rights such as portrait right or intellectual
property right or defame another person’s reputation by using the
functions provided for the screen recording service, you may be held
liable to civil, criminal or administrative charges in accordance with the
relevant laws. LG Electronics is not legally responsible in any way for the
acts of users.

Entering text

Using the Smart toolbar

You can use various keyboard input methods in one place. You can select

the desired input method from the top of the keyboard.

1 Select the desired keyboard input method from the Smart toolbar.

2 Tap---and select the input method you want to show on the Smart
toolbar, or reorganise them.

—

Smart toolbar —e S - BT -

g - B =

E + Some supporting input methods may differ depending on the device
you have.

« You can turn on or off the Smart toolbar feature from the keyboard
settings.
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- © :Add emajis.
+ & :Tap to add animated emoticons or make your own emoji by
using a photo or camera.

+ @ :You can use Tenor's GIF keyboard. Tap Accept to use this
feature.

+ 22 :Open Draw chat.

- :Enter text by using voice.

+ 83 : Access keyboard settings.

- [ : Open the clip tray.

+ ¢ Enter text by handwriting. It is required to download the input

language data for handwriting. Tap Download to download the
input language data for handwriting.

. - Activate floating keyboard when you use the Multi-window
feature. You can also move the keyboard to the desired location.

. :Tap to use one-handed operation mode.
- 1 : Tap to adjust the size of the keyboard.
:Tap to adjust the transparency of the keyboard.

Basic Functions 82



Using the Smart keyboard
You can use the Smart keyboard to enter and edit text.

With the Smart keyboard, you can view text as you type without
bothering to alternate between the screen and a conventional keyboard.
This allows you to easily find and correct errors when typing.

Moving the cursor

With the Smart keyboard, you can move the cursor to the exact position
you want. When typing text, touch and hold on the space bar and then
drag left or right.

Smal rf keyboard

E « This option is available only on the QWERTY keyboard.

Basic Functions

83



Suggesting words

Smart keyboard automatically analyses your usage patterns to suggest

frequently used words as you type. The longer you use your device, the

more precise the suggestions are.

Enter text, then tap a suggested word or gently drag the left or right side

of the keyboard upwards.

+ The selected word is automatically entered. You do not need to
manually type every letter of the word.

Smartphone T T Fem—— e Smartphones

.?-...... .-.-...'!‘.
am ms

Copy and Paste

You can cut or copy text from an app, and then paste the text into the
same app. Or; you can run other apps and paste the text into them.

7 Touch and hold around the text you want to copy or cut.
2 Drag @/ W to specify the area to copy or cut.

3 Select either Cut or Copy.
- Cut or copied text is automatically added to the clip tray.

4 Touch and hold the text input window, then select Paste.

« If there is no item that has been copied or cut, the Paste option will not
appear.
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Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device froma TV.

71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing the items from the Gallery or Music app, tap Cgor : >
Play on other device.
Or on the home screen, tap Settings > Connected devices > Screen
sharing and then tap () ) to activate it.

3 Select the TV you want to connect to.

E « For use with Chromecast, Google Play services should be up to date.

Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music apps.

Connecting the devices

Connect both your device and another device that support DLNA function
to the same wireless network.

E + Make sure that File sharing (DLNA) is activated on both the device and
the connected device.

Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting the
¢ > Nearby devices menu in each app.

Use content from nearby devices as if you were using it on your device.
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Sending or receiving files
You can share files between your device and another LG device, or a tablet.

Sending files

From the Gallery or other apps, tap : > Share or o<, then select a device
on the file sharing list.

Receiving files
Drag the status bar downward and then tap File sharing.

If your device does not support the file sharing feature, on the home
screen, tap Settings > Connected devices > File sharing > SmartShare
Beam

E + You can share files with certain devices that support DLNA.

Do not disturb

You can limit or mute notifications to avoid disturbances for a specific
period of time.

On the home screen, tap Settings > Sound > Do not disturb.
+ Mode and select the mode you want:

- Priority only: Receive sound or vibrate notifications for the selected
apps. Even when Priority only is turned on, alarms still sound.

- Total silence: Disable both the sound and vibration.

- Select priorities: Receive alarms and the notifications for the selected
apps.
- Calls from: Set up a range of notifications when receiving a call

E - Repeated calls: Second call from the same caller within 15 min is not
silenced.
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- Messages from: Set up a range of notifications when receiving a
message.

+ Use Do not disturb: Turn on the Do not disturb feature.

- Sleeping: Set the schedule for which you want to turn on the Do not
disturb feature.

+ Help: View the help for Do not disturb.

AOD (always-on display)
You can view the date, time or signature when the main screen is turned
off.

Swipe the bottom of the Always-on display screen to activate features
including Camera, Capture+, Wi-Fi, sound settings, Bluetooth, Flash, Music
and more.

1 Onthe home screen, tap Settings > Display > AOD (always-on
display).
2 Select the image you want to display and tap Save.

« Tap the desired image among Digital clock, Analog clock, Dual
clock, Signature or Image.

- Tap Show display and select Tap to show for 10 seconds or
Always show.

- Tap Quick tools & music player to swipe over the status icons for
Quick tools and the music player.

- To enhance brightness for the Always-on display feature, tap
Brighter display.

- To view the help for Always-on display, tap Help.

I_;r] + The battery may drain faster when you use Always-on display. Turn this
feature off to save battery power.

+ To deactivate Always-on display feature, on the home screen, tap
Settings > Display > AOD (always-on display), and then tap @ .
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

+ You can use SmartWorld, Play Store or the app store provided by your
service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.

« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.

+ Smart\World may not be supported depending on the area or service
provider.

Uninstalling apps

Uninstall apps that you no longer use from your device.

Uninstalling with the touch and hold gesture

Press and hold any empty area on the screen, and then press € of the
app you want to delete.

Uninstalling by using the settings menu
On the home screen, tap Settings > Apps > App info, select an app, then

tap Uninstall
E + Some apps cannot be uninstalled by users.

Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.
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Installing and uninstalling apps during the
setup

When you turn on the device for the first time, you can download
recommended apps.
You can skip to the next step without installation.

App trash
You can view the uninstalled apps. You can also reinstall apps which were
uninstalled within 24 hours from now.
T Onthe home screen, tap LG > App trash.
You can also touch and hold an empty area of the Home screen, then
tap App trash.
2 Activate the desired function:
- Restore: Reinstall the selected app.
« 11 : Remove the uninstalled apps permanently from the device.

« Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

« This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.

Useful Apps 90



App Shortcuts

On the Home screen, touch and hold an app icon such as Call, Message,
Camera, Gallery and Settings to display a quick access menu. Use apps
more easily through App Shortcuts.

- Tap & to set the widgets for the app.
+ Tap () to check the app information.

E « This feature is available only on some apps.
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Phone

Voice call

Make a phone call by using one of the available methods, such as manually
entering a phone number and making a call from the contact list or the
list of recent calls.

Making a call from the keypad
7 Onthe home screen, tap (@ > Dial.

2 Make a call by using a method of your choice:
- Enter a phone number and tap @@.
+ Touch and hold a speed dial number.

« Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @@.

E + Toenter "+" when making an international call, touch and hold number
0.

+ See Adding contacts for details on how to add phone numbers to the
speed dial list.

Making Calls from Contacts
7 Onthe home screen, tap (8 > Contacts.

7 After selecting the number you want to call from the list of contacts,

tap &...
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Answering a call
To answer a call, drag @ on the incoming call screen.
+ When the stereo headset is connected, you can make calls by using the
call/end button on the headset.
+ To end a call without turning off the screen, on the home screen, tap
Settings > Network & internet > Call > Answer and end calls and
then activate End call with the Power key.

E + On the home screen, tap Settings > Network & internet > Call >
Answer and end calls > End call with the Power key, you can end a
call by pressing the Lock/Power key while the call-in-process screen is
turned on.

Rejecting a call
To reject an incoming call, drag @ across the incoming call screen.

- To send a rejection message, drag the rejection message option
across the screen.

+ To add or edit a rejection message, On the home screen, tap Settings >
Network & internet > Call > Call blocking & Decline with message.

+ When a call is coming in, press the Volume Up, Volume Down or Power/
Lock key to mute ringtone or vibration, or to hold the call

Checking an incoming call while using an app

When a call comes in while using an app, a pop-up notification can be
displayed at the top of the screen. You can receive the call, reject the call,
or send message from the pop-up screen.

5 + On the home screen, tap Settings > Network & internet > Call >
Additional settings > Incoming voice call pop-up and then select the
desired way you would like to display the incoming call while using an

app.
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Viewing missed calls
If there is a missed call, the status bar at the top of the screen displays X.

To view missed call details, drag the status bar downwards. You can also
tap (@ > Call logs on the home screen.

Functions accessible during a call

During a call, you can access a variety of functions by tapping the
on-screen buttons:

- Contacts: View the contact list during a call.

+ Hold: Place the current call on hold.

- Dialpad: Display or hide the dial pad.

- Speaker: Turn on the speakerphone function.

- Mute: Mute your voice so that your voice cannot be heard by the other
party.

+ Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.

- @ :Endacal

« ¢+ :Access additional call options.

« Available settings items may vary depending on the area or service
provider.
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Making a three-way calling
You can make a call to another contact during a call.
1 Duringacal, tap : >Add call

2 Enter a phone number and tap @.
+ The two calls are displayed on the screen at the same time, and the
first callis put on hold.

3 To start a conference call, tap Merge calls.

E + You may be charged a fee for each call. Consult with your service
provider for more information.

Viewing call records

To view recent call records, on the home screen, tap (8> Call logs. Then,
you can use the following functions:

- To view detailed call records, select a contact. To make a call to the
selected contact, tap &...

- To delete call records, tap : > Delete.

E « The displayed call duration may differ from the call charge. Consult with
your service provider for more information.

+ The deleted call history can not be restored.

« Pinch two fingers or spread your fingers apart to adjust the font size of
call logs or contacts.

Configuring call options
You can configure various call options.

7T On the home screen, tap (8 > Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messages

Sending a message

You can create and send messages to your contacts using the Messaging
app.

5 + Sending messages abroad may incur additional charges. Consult with

your service provider for more information.

T Onthe home screen, tap ©.

2 Tap D)

3 Specify a recipient and create a message.
+ To use multimedia options, tap ().
+ To access optional menu items, tap .

4 Tap B> to send the message.

Reading a message
You can view exchanged messages organised by contact.
T On the home screen, tap ©.
2 Select a contact from the message list.
E + While on the message list or chat window, you can adjust the font size

by placing two fingers on the screen and either widening or narrowing
the fingers.
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Configuring messaging settings

You can change messaging settings to suit your preferences.
T Onthe home screen, tap ©.

2 Tap : > Settings from the message list.

E « You can designate settings for the notice window, blocking calls, disaster
alert, multimedia messages, etc.

Camera

Starting the camera

You can take a photo or record a video to cherish all of your memorable
moments.

On the home screen, tap (&).

5

Before taking a photo or recording a video, wipe the camera lens with a
soft cloth.

Be careful not to stain the camera lens with your fingers or other
foreign substance.

.

Images included in this user guide may be different from the actual
device.

.

Photos and videos can be viewed or edited from the Gallery. See Gallery
overview for details.

Refrain from using the product for a purpose that may violate someone
else’s privacy or rights.
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Taking a photo

You can take photos with the camera in the product.

1 Tap (3 and focus on the subject.
+ You can touch the subject to focus on.

+ You may spread or pinch two fingers to zoom in or out.

2 Tap @ to take a photo.

+ You can also press the Volume Down or Volume Up key to take a

photo.

+ You can take a photo while recording a video by pressing @ on the

screen.

+ The options displayed on the shooting screen may differ depending
on the selected camera (front or rear) and camera mode.

+ The camera will turn off automatically if you do not use it for a while
after running the Camera app.

Apply filter effects

Set screen ratio

Set camera options ——-

Enable Al feature to —
automatically apply best

effect for the scene

] i Change flash settings

~— Change timer settings

— Select from standard
angle x1.0 zoom/
standard angle x2.0
zoom/wide angle x0.5
zoom

«—— Open Google Lens

——— Switch between front and
v rear cameras

1
Open Gallery ——
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5 + You can run the camera app by short-pressing the power key twice. On
the home screen, tap Settings > Extensions > Shortcuts and then tap
Open Camera to activate it.

+ When the screen is turned off or locked, start the camera by pressing
the Volume Down key twice. On the home screen, tap Settings >
Extensions > Shortcuts and then tap Open Camera (D) to activate it.

Customising the camera options
You can customise a variety of camera options to suit your preferences.

Tap £83 on the screen.

I_;r] « Available options vary depending on the selected camera (front or rear
camera) and the selected camera mode.

Auto scene By recognising the scene that is being recorded, applies the
optimizer optimal resolution setting automatically.
Composition By recognising the hgman figure vyhen taking a portrait,
recommends the optimal composition.
Tips Notifies the user when the subject’s eyes were closed or the
P picture is blurry for optimal photography.
Photo size Allows you to choose the photo size and aspect ratio.
Obtain photos in vivid colours and get compensated effects
HDR even when they are taken against the light. These functions
are provided by the high dynamic range (HDR) technology
equipped in the camera.
Utera v_\nde . Corrects the screen distortion when taking ultra wideangle
shot distortion
- photos.
correction
Saves storage space by compressing the image file in HEIF
Save as HEIF format. Other devices may not support image files in HEIF
format.
Live photo Record the action before and after you take a photo.
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Tracking focus

Enables the camera to remain focused on the subject you
touch on the screen, even if the subject is moving. (Available
when the Standard camera is in use.)

Grid

Display guide grids so that you can take photos or record
videos based on the horizontal and vertical reference lines.

Cheese shutter

Allows you to take a photo by saying ‘Cheese] ‘Smile,
‘Whiskey, ‘Kimchi, or LG’

Add watermark

Displays a watermark on the photos

Tag locations

Save the image with GPS location data.

Select if you want to store the pictures and videos in the

Storage Internal storage or SD card. (Available when a memory card
is inserted.)
Help Provide Help for each camera menu.

Additional options on the front camera

Selfie distortion

Corrects distorted parts of the face.

correction
Save as flipped | Saves as flipped images when taking a selfie.
Selfie shot Take a selfie by selecting its option between Gesture shot

and Auto shot.

5

camera.

+ You can apply the make-up effect when taking a selfie using the front

+ Gesture shot is taken by recognising the shape of a hand and Auto
shot is taken by recognising a face.
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Mode Selection

You can conveniently select from the modes displayed on the screen
which are selected to suit the shooting environment.

Tap () and swipe the camera modes left or right, or swipe the screen left
or right to select a camera mode.

Using camera modes

Record Time-lapse videos
You can record Time-lapse videos optimised for the situation.

Videos can be recorded with optimal speed and steady motion by
analysing various shooting environments. The time-lapse speed can be
automatically adjusted according to the shooting target and environment.

You can also select the time-lapse speed manually.

1 Tap (&) and select Time-lapse by swiping camera modes.
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Set camera options —g¢ el — Set/Cancel flash setting

Set screen resolution Night Time-lapse

Turn On/Off steady cam

e Select zoom

Select the time-lapse — Xl - EUFCREE

speed e — Current photo mode

Preview —ameke B — Switch to front-facing/

I rear-facing camera
Record videos
2 Tap @ to record a video.

+ You can change a zoom and time-lapse speed while recording.

« If you tap the desired speed, the time-lapse speed is adjusted while
recording.

+ To pause the video recording, tap @. To resume the video recording,

tap @.

While recording a video, you may spread or pinch two fingers to

zoom in or out.

+ While recording a video, you may tap the desired area to adjust the
brightness.

3 Tap @ to stop recording.
+ The recorded video will be saved in Gallery.

E + Audio is not recorded during Time-lapse recording.
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Recording a video
1 Tap (&) and select Video by swiping camera modes.
2 Tap @ to record a video.

Turn On/Off steady cam

Set screen resolution

Set camera —pg i —— Set flash setting

Apply filter effect

Tap to change the audio — : Select zoom

options from Basic, ASMR
Recording, and Voice

= Switch to front-facing/

rear-facing camera
Bokeh.

Preview - | I ecord videos

To take a photo while recording a video, tap @.
To pause the video recording, tap @. To resume the video recording,
tap @.

While recording a video, you may spread or pinch two fingers to
zoom in or out.

While recording a video, you may tap the desired area to adjust the
brightness.

3 Tap @ to end the video recording.
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Taking portraits

You can take photos or videos that make the subject more distinct and
stand out by blurring the background.

1 Tap (&) and select Portrait by swiping camera modes.
« Select a desired effect by swiping effect options for portrait.
2 Tap @ to take a photo, or touch and hold @ to record a video.
- To pause the video recording, tap @. To resume the video recording,

tap @.

Set camera —pg

s Set timer setting

Set screen ratio —

Set aperture value

— Select an effect

3 Tap @ to end the video recording.

5 + \When you see the message “Portrait is available’, start taking a photo.

+ The Portrait feature may not work if the camera cannot recognise the
subject.

+ While taking a photo, keep the distance to your subject to 1.3 ~ 5 feet.
« This feature is not available if the surroundings are too dark.
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Using a sticker

You can add various stickers in photos or videos. Also, enjoy a dynamic
effect through moving 3D AR stickers.

1 Tap (&) and select Sticker by swiping camera modes.

2 Tap @ to take a photo, or touch and hold & to record a video.
+ To pause the video recording, tap @. To resume the video recording,

tap @.
3 Tap @ to end recording.

3D AR Sticker

Depth camera on the back of the device allows you to create realistic 3D
AR Effect by recognizing facial contours in greater detail

1 Tap (5 and select Sticker by swiping camera modes.

2 Tap@®.

3 Swipe the sticker list left or right to select an AR sticker to use.
+ The face detected by the camera is scanned in 3D.
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4 Tap @ to take a photo, or touch and hold &) to record a video.
+ The photo is taken with 3D AR Sticker applied.

« The 3D scanning feature of Z-camera is available only for close-up
portrait shooting.

Using additional camera modes
Tap () and select More by swiping camera modes.

Night view
You can take vivid and clear night photos. Night view will run
automatically when you take a photo in a low light conditions.
You can also take clear night scenes by using the Night view feature
manually.
1 Tap (&) and select More by swiping camera modes.
2 Tap S
3 Tap @ to take a photo.
- To adjust the brightness of the photo, slide & left or right.

Adjust brightness
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E + Hold steady and firm so that the camera does not shake while taking
a photo.

Panorama

You can create a panoramic photo by moving the camera in one direction
to photograph and stitch continuous shots of a wide view.

1 Tap (2 and select More by swiping camera modes.

2 Tap A

3 Tap @ and then slowly move the camera in one direction.
A Tap @ to stop capturing the panoramic.

Set camera —.

« When moving the camera in one direction, make sure that the screen
you shoot is not out of the guide line.
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Manual Camera

You can create photos featuring professional touch by using a variety of
advanced features.

1 Tap (&) and select More by swiping camera modes.

2 Tap&.
3 Customize the following camera settings.
- If you select Auto, the options are automatically adjusted according
to the shooting target and environment.

+ If the Focus peaking option is selected, the focused area is
highlighted in color. This feature is available only in Manual Focus
(MF) mode.

Set camera —g¢ ; b Set timer setting

Set screen ratio Set flash setting

Apply filter effect

Reset the Displays
settings various Graphy
options
Adjust white Adjust shutter
balance speed
Adjust fgcus Adjust IS0
Adjust speed
brightness

4 Tap @ to take the photo.
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5 - If you tap (&) and select a Graphy effect, a list of recommended photos
with various settings will appear.

Selecting the Graphy effects allows you to shoot using the white
balance, shutter speed, and ISO setting values applied to the
recommended photo.

+ The Graphy feature is available only in Manual Camera mode.

+ You can see a variety of recommended photos if you download the
Graphy app from Google Play Store.

+ You may be charged for data usage, depending on your pricing plan.
- Tap £33, then tap Graphy photos @ ) to deactivate this feature.

Manual Video

You can record a video by manually customizing various options. Adjust
values for the white balance, focus, brightness, ISO, shutter speed and
more.

1 Tap (&) and select More by swiping camera modes.

2 TapX

Set camera —p3 b Set flash setting

Set screen resolution Apply filter effect

Reset the
settings

T — Adjust audio
balance

Adjust white — a8 <a— Adjust shutter
balance 61 speed
Adjust fgcus . Adjust IS0
Adjust speed
brightness
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3 Manually adjust the camera settings, as necessary.
4 Tap @ to record a video.

Slo-mo

You can create an entertaining video by changing the moving speeds of
subjects in your video.

1 Tap (&) and select More by swiping camera modes.
2 Tap @.
3 Customize the following camera settings.

4 Tap @ or L to select a duration of the slow motion effect.

+ Part Slo-mo: Allows you to apply a slow motion effect to a specific
section of the video.

- Tap © at the moment where you want the slow motion effect to
be applied. With a short-press, slow motion effect will be applied
for 0.5 second. With a long-press, slow motion effect will be
applied until you release your finger.

+ All Slo-mo: Allows you to apply a slow motion effect to the entire
video.

5 Tap @ to start recording.
+ To pause the video recording, tap @. To resume the video recording,

tap @.

6 If you want to finish shooting, tap @.
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YouTube Live
You can record a video and directly upload to YouTube.

To use this feature, you must meet the eligibility requirements. Contact
YouTube for the requirements.

1 On the home screen, tap (&).
2 Select More by swiping camera modes, then tap ().
- YouTube Live is available only when your device is connected to the

Internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.

Useful camera features

Taking a photo with the Al feature

When taking a photo, the Al feature recognises a subject and applies the
optimum effect to the photo.

E - Tap ‘ to deactivate the Al feature.
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Auto-Exposure/Auto-Focus lock

You can fix the current exposure level and focus position by touching and
holding the screen. To turn off the feature, tap a blank area on the screen.

Auto-Exposure/
Auto-Focus lock

E + This feature is available only in specific modes.

Zoom in or out

You may spread or pinch two fingers to zoom in or out when you take
photos or videos.

- Zoom in/out function is not available in the selfie mode (front camera).
« This function is not supported in a number of modes.
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Using the Burst Shot

You can take consecutive photos and view them as moving pictures in the
Gallery.

1 Tap () and select Photo.
2 Touch and slide @ to the left or right.

+ Multiple, consecutive photos (up to 100 photos) are taken while
you are holding down.

Gesture shot

You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.

You can also clench your fist and then open it towards the front camera.
+ In three seconds, a photo is taken.

»

i

E - To use this feature, switch to the front camera mode, then tap @ >
Selfie shot > Gesture shot.

+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.

+ This feature may not be available while using some of the camera
features.
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Auto shot

You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.

- The white coloured guide frame appears when the front camera
detects your face. If the subject within the guide frame stops moving,
the guide frame colour turns yellow, then the camera takes a photo.

5 - Tap §63 > Selfie shot > Auto shot to enable the Auto shot feature.

Interval shot
You can take selfies at an interval.

While using the front camera, you can show your palm to the camera,
then clench your fist twice quickly.

- Four photos are taken at regular intervals after a timer delay of three
seconds.

Save as flipped

Before taking a photo with the front camera, tap £63 > Save as flipped.
The image is flipped horizontally.

E + When using the front camerg, you can change how selfies are taken in
the camera options. See Customising the camera options for details.
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Gallery

Gallery overview
You can view and manage photos and videos saved on your device.

Viewing photos
You can view the photos saved to the product.
1 Tap @®and select a desired folder:
2 Tap adesired photo.
+ The Gallery folder contains Photos, Albums, Memories, and Play.

| —— Open Google Lens.

Back to the previous —¢ ~— Access additional options.
screen.

— Preview gallery

1 .
Add to or remove from —* *7— Delete images

your favourites. 1 .
Share images

Editimages

« Details menu appears when the screen is lightly touched. Touching the
screen once again makes the menu disappear.
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Playing a video
You can view the videos saved to the product.

Back to the previous — < ‘e— Access additional

screen. options.

Pause or play the video.

IR SEER: — Preview gallery

Add to or remove from —* _ = Delete images

our favourites. I
y I— Share images
Edit images

E + To adjust the sound volume, drag the right side of the video screen up
or down.

« To adjust the screen brightness, drag the left side of the screen up or
down.

« Dragging the screen to the left on the video play screen allows you to
rewind (REW) and dragging to the right allows you to fast forward (FF).
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Contacts

Contacts overview
You can save and manage contacts.
On the home screen, tap LG > Contacts.

Adding contacts

Adding new contacts

1 Onthe contact list screen, tap -
- A pop-up appears for selecting the saving location for contact.
Select the location you want.

2 Enter contact details and tap Save.

Importing contacts
You can import contacts from another storage device.

T Onthe contact list screen, tap : >Manage contacts > Import.

2 Select the source and target locations of the contact you want to
import, and then tap OK.

3 Select the contacts and tap Import.

Adding contacts to the speed dial list
T On the contact list screen, tap : > Speed dial.
7 Tap Add contact from a speed dial number.

3 Select a contact.

E + While adding a new contact, tap {313} to add a speed dial number.
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Searching for contacts
You can search for contacts by using one of the following options:

- Tap the search bar at the top of the Contacts screen and enter the
desired contact or phone number you want to search for.

+ Scroll the contact list up or down.
+ From the index of the contact list screen, tap the initial letter of a
contact.

E + Pressing the search bar at the top of the Contacts screen and entering
a contact or phone number brings up the integrated search results from
the call history and contacts list saved onto the product.

Contacts list

Editing contacts
1 On the contact list screen, select a contact.
2 On the contact detail screen, tap / and edit details.

3 Tap Save to save changes.

Deleting contacts
You can delete contacts by using one of the following options:
+ On the contact list screen, touch and hold a contact you want to
delete, then tap [
- Tap ¢ > Delete on the contact list screen.

E + Deleted contacts may not be restored.
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Adding favourites

You can register frequently used contacts as favourites.

1 On the contact list screen, select a contact.
2 On the contact detail screen, tap ¥y

Creating groups

T On the contacts group list, tap Groups, then tap -
2 Enter anew group name.

3 Tap Add members, select contacts, then tap Add.

/| Tap Save to save the new group.

QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety of options on this

advanced notepad feature, such as image management and screenshots,

which are not supported by the conventional notepad.

Creating a note
T On the home screen, tap LG > QuickMemo+.
7 Tap @ to create a note.

- @ :Saveanote.

+ < :Undo the previous edit.

+ > :Redo the recently deleted edits.

« T :Enter a note by using the keypad.

- o : Save your favorite pen types.

« 4/ :Write notes by hand.

« A :Erase handwritten notes.
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+ g :Change into the calligraphy font as you write by hand.
+ ¢ :Access additional options.

3 Tap @ to save the note.

Writing notes on a screenshot
1 While viewing the screen you want to capture, drag the status bar
downwards and then tap (7).
+ The screen is captured and displayed as a thumbnail on the right
bottom of the screen.
2 To write notes on the screen, tap ..
3 Write notes using the tools.
- T :Zoom in or out, or adjust the area to capture.
+ / :Write notes by hand.
+ & :Erase handwritten notes.
+ €5 :Undo the previous edit.
+ 2 :Redo the recently deleted edits.
+ (35 :Crop the screen as you desire.
4 Tap« and save the notes.
- Saved notes can be viewed in Gallery.
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Additional features after capturing a screenshot

DO MORE AT ONCE

Tap to capture entire
screen by using the scroll
capture feature.

Tap to record the screen.

. e gy~ — Tap to delete the captured
— m screen shot.

Tap to write notes on the
captured screen.

Tap to share the captured
screen shot.

E + You can capture the entire screen by using the scroll capture feature.

+ While using an app such as Messaging and Chrome, drag the
notifications panel downwards and then tap (2. Then, tap (¥ to
capture the entire screen you are currently viewing as a single file.

« This feature is available only on some apps that support the scroll
capture feature.

- Pinch two fingers or spread your fingers apart to change the memo
layout.
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Clock

Alarm

You can set an alarm to trigger it at a specified time.
7 On the home screen, tap LG > Clock > Alarm.

2 Tap-toadd a new alarm.

3 Configure the alarm settings and tap Save.

« If you select a previously set alarm, you can edit the alarm.

- Todelete an alarm, tap : > Delete at the top of the screen. You can also
touch and hold the alarm.

World clock

You can view the current time in cities around the world.
7 On the home screen, tap LG > Clock > World clock.
2 Tap-andaddacity.

Timer
You can set the timer to trigger an alarm after a specified period of time.
7 On the home screen, tap LG > Clock > Timer.

2 Set the time and tap Start.
+ To suspend the timer, tap Pause. To resume the timer, tap Resume.

3 Tap Stop to stop the timer alarm.
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Stopwatch

You can use the stopwatch to record a lap time.
7 On the home screen, tap LG > Clock > Stopwatch.
2 Tap Start to initiate the stopwatch.
- Torecord a lap time, tap Lap.
3 Tap Pause to suspend the stopwatch.
+ To resume the stopwatch, tap Resume.

+ To clear all the records and restart the stopwatch, tap Reset.

Music

You can play and manage songs or music albums.
7 Onthe home screen, tap LG > Music.

2 Select a category.

3 Select a music file.
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Turn on/off Flash Light.

Set sound effects.

Back to the previous — -

screen.

i Access additional options.

— Pause or play.

Tap to play from the
beginning of the current
file/Double-tap to play the
previous file/Touch and
hold to rewind.

Play in random order. —

Adjust the sound volume. —

-
sus

Bd

7

1
Add to or delete from your —— !

favourites.

5

software.

Tap to play the next file/
Touch and hold to fast
forward.

— Select a repeat mode.

— Go to Now playing list.

Some file formats may not be supported, depending on the installed

Files that exceed the size limit may cause an error.
Music files may be protected by international copyright owners or

copyright laws. You may have to obtain legal permission before copying
a music file. To download or copy a music file, first check the copyright

law for the relevant country.

.

Hi-Fi icon.

Useful Apps

This model supports Hi-Fi audio playback. Hi-Fi audio files display the

If you set the flashlight, flashlight blinks to fit the music being played.
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Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator.
1 On the home screen, tap Google > Calculator.
2 Use the keypad to make a calculation.
- If you want to calculate from the beginning, tap and hold (]

ThinQ
You can easily connect the product with ol appliances to monitor and

conveniently use the appliances.
On the home screen, tap LG > ThinQ

I_;r] + Washing machine, dryer, styler, dishwasher, oven, and robot cleaner can
only be registered when the product is in the standby mode.

+ Look for the ThinQ mark on the product to see if it can be connected to
ThinQ app.
« Tap = to check various function of the ThinQ app.
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LG Health

You can manage your health and maintain good exercise habits by
keeping track of the exercises you do.

Getting started with LG Health

You can configure LG Health when launching the app for the first time or
after resetting it.

7 Onthe home screen, tap LG > LG Health.

2 Follow the on-screen instructions to complete configuration.

Using LG Health

You can view main information on LG Health and manage the amount of
physical exercise and health information.

7 On the home screen, tap LG > LG Health.

2 The following options are available.
= :View your exercise log on the day you want to check.

- © :Begin tracking an exercise. The route and amount of your
physical exercise are recorded for each exercise type.

« + :Set your daily exercise goals including calories and steps, or set
various LG Health settings.

E « Health-related information provided by LG Health is designed for user
convenience and cannot be used for purposes of disease prevention,
treatment, diagnosis or other medical issues.

+ LG Health may vary or may not be available, depending on the country
and service provider. LG Health functions that are available and apps
that can be added to LG Health may vary, depending on the country. This
is due to differing laws and regulations.
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HD Audio Recorder

The HD Audio Recorder allows you to configure the audio settings
manually so that you can record audio based on your environment.

Recording modes

You can record a high definition audio file by selecting and configuring the
desired audio mode to suit the recording environment.

On the home screen, tap LG > HD Audio Recorder >=.

Normal
You can record audio without extra settings.

ASMR
You can record ASMR sound.

Concert
You can record audio in a concert or other music event.

Custom
You can manually configure the desired settings to record audio.

Studio Mode

With Studio mode, you can play an audio file or music and record your
voice at the same time, create a chord by recording your voice multiple
times, and record your comments over the presenter's or speaker’s original
audio file.

7 Onthe home screen, tap LG > HD Audio Recorder >=> Custom.
2 Tapd+

3 Select an audio file to use as background music.

/4 Tap @ to record voice.

5 Tap @ to save the recorded file.
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E « Background music can only be played through earphones. Make sure to
plug in earphones before using this feature.

- To change additional settings, tap + > Settings, then customise the file
type, bit depth, sampling rate and other settings.

+ When you select the Concert or Custom mode with earphones
connected, {,, appears. Tap { and then select the microphone to use.

» You can monitor the the sound quality with the connected earpiece
while recording audio. While recording audio in Studio mode, sound
monitoring is not supported. You can hear only the background music.

Game Launcher

You can set whether to use the game launcher where you can view the
list of games installed on the product and select game settings such as
muting media volume, limiting alerts, etc.

7 On the home screen, tap Game Launcher.

2 Select the desired option.

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it

On the home screen, tap LG > Smart Doctor.
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LG Mobile Switch

Easily transfer data from a used device to a new device via LG Mobile
Switch.
1 On the home screen, tap LG > LG Mobile Switch.
You can also tap Settings > System > Backup > LG Mobile Switch.
- If the app is not installed on the product, download and install the
LG Mobile Switch app from the Google Play Store.

7 Follow the on-screen instructions to select a desired method for
transfer.

E - Data in a Google Account will not be backed up. VWhen you synchronise
your Google Account, Google apps, Google contacts, Google Calendar,
Google memo app data and apps downloaded from the Play Store are
stored on the Drive app automatically.

« Fully charge the battery before transferring data to avoid unintentional
powering off during the process.

App trash

You can see the list of apps deleted on the home screen. The app that was
deleted within the last 24 hours can be recovered.

On the home screen, tap LG > App trash.
For more details, refer to App trash.
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SmartWorld

You can download a variety of games, audio content, apps and fonts
provided by LG Electronics. Customise your device to suit your preferences
by using Home themes and fonts.

E « If you use mobile data, you may be charged for data usage depending
on your pricing plan.

« This feature may not be supported depending on the area or service
provider.

T On the home screen, tap SmartWorld.
2 Tap : >LG Account, then sign in.

3 Select and download the desired content items.

RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to an LG Customer Service Centre as follows:

« To use this function, first you must agree to usage of the function.

+ If you use mobile data, you may be charged for data usage depending
on your pricing plan.

7 On the home screen, tap LG > RemoteCall Service.
2 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associate’s instructions to
enter a six-digit access number.

+ Your device is remotely connected and the remote support service
starts.
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Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

On the home screen, tap Cell Broadcast.

Google apps

You can use Google apps by setting a Google Account. The Google
Account registration window appears automatically when you use a
Google app for the first time. If you do not have a Google Account, create
one from your device. For details on how to use an app, see the Help in
the app.

E + Some apps may not work depending on the area or service provider.

Calendar

The Calendar app allows you to track your schedule of events (that you
created), organised by Day, 3-day, Week or Month.

Chrome
A fast, simple, and secure web browser, built for the modern web.

Docs

Docs is a collaborative, word-processing tool that powers productivity. Use
Docs to create, edit and work together in real-time.

Drive

Drive is a file storage and sharing app that makes it easy to find, share and
collaborate on work projects from anywhere, instantly.
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Duo

Make simple, high quality video calls to your friends and family on Android
phones and iPhones.

Gmail

Gmail is an easy to use mail app that keeps your messages safe, makes
your inbox smarter; and helps you stay organised.

Google

The Google app keeps you in the know about the things you care about.
Find quick answers, explore your interests, and get a feed of stories and
updates on topics that matter to you.

Maps

Going somewhere? Go with Maps, the app you can rely on for real-time
GPS navigation, traffic, transit, and details about millions of places, such as
reviews and popular times.

Photos

Home for all your photos and videos, automatically organised so you can
share and save what matters.

Play Movies & TV

Use your Google Account to rent or purchase movies. Purchase content
and play it anywhere.

YT Music

A new music streaming service from YouTube.

Sheets

Sheets is a collaborative spreadsheet processing tool that powers
productivity. Use Sheets to import, organise and analyse information
together in real-time.
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Slides

Google Slides is a collaborative presentation creation tool that powers
productivity. Use Slides to organise information, present results, and make
decisions together in real-time.

YouTube

Watch your favourite channels, listen to music you love, and upload videos
to share with people around the world.

Assistant

Your device has the Google Assistant built-in. Find answers and get things
done while on-the-go.

5 + The Google Assistant is not available in certain languages and countries.

Files
You can view and manage files saved on your device.
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Settings

You can customise the device settings in accordance with your
preferences.

On the home screen, tap Settings.

E - If you enter a keyword on the search window at the top of the screen,

you can conveniently run the items that need to be set.

Network & internet
Dual SIM card

You can configure Dual SIM settings.
T On the settings screen, tap Network & internet > Dual SIM card.
2 Customise the following functions:

+ SIM card 1:Change the name and icon of the SIM card 1.

+ SIM card 2: Change the name and icon of the SIM card 2.

+ SIM card colour theme: Change the colour themes for the SIM
cards.

- Cost save mode: Activate or deactivate the cost save mode. In the
cost save mode, if you make a call to a contact to which a specific
SIM'is assigned, this SIM is used for the call even if the other SIM is

active, for example, it is using mobile data.

- Mobile data: Select a SIM card you want to use for mobile data
service. You can also turn off this function.

- Data roaming: Select this option to enable the device to use mobile

data when you are roaming outside your home network area.

- Mobile data during calls: Access mobile data using the nondefault

data SIM card temporarily during an HD voice call with the same
card.
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Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
T On the settings screen, tap Network & internet > Wi-Fi.
2 Tap to activate it
- Available Wi-Fi networks appear automatically.
3 Select a network.
+ You may need to enter the network’s Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap the network and then tap Forget.

Wi-Fi network settings

On the settings screen, tap Network & internet > Wi-Fi.

Switch to mobile data:If the mobile data connection function is
activated but the device cannot connect to the Internet via Wi-Fi

connection, the device automatically connects to the Internet via the
mobile data connection.

I_;'] « This feature depends on the service provider.

« + :Customise Wi-Fi network settings.
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Wi-Fi Direct

You can connect your device to other devices that support Wi-Fi Direct to
share data directly with them. You do not need an access point. You can
connect with more than two devices by using Wi-Fi Direct.

T On the settings screen, tap Network & internet > Wi-Fi> : >
Advanced Wi-Fi > Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.

2 Select a device.
« Connection occurs when the device accepts the connection request.

E + The battery may drain faster when using Wi-Fi Direct.

Mobile data

You can turn mobile data on and off. You can also manage mobile data
usage.

Turning on mobile data
1 On the settings screen, tap Network & internet > Mobile data.
2 Tap to activate it.

Customising mobile data settings
71 Onthe settings screen, tap Network & internet > Mobile data.
2 Customise the following settings:

+ Mobile data: Set to use data connections on mobile networks.

- Limit mobile data usage: Set a limit for mobile data usage to block
mobile data if the limit is reached.

« + :Customise mobile data settings.

- Data usage volume is measured based on the product, and the
volume calculated by your mobile provider may be different.
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Call

You can customise call settings, such as voice call and international call
options.

+ Some features may not be supported depending on the area or service
provider.

71 Onthe settings screen, tap Network & internet > Call.

2 Customise the settings.

Tethering
USB tethering

You can connect the device to another device via USB and share mobile
data.

7 Connect your device and other devices via USB cable.

2 On the settings screen, tap Network & internet > Tethering > USB
tethering and then tap () ) to activate it.

E « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ When connecting to a computer, download the USB driver from
wwwilg.com and install it on the computer:
+ You cannot send or receive files between your device and a computer

while USB tethering is turned on. Turn off USB tethering to send or
receive files.

Operating systems that support tethering are Window XP or higher, or
Linux.
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Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the Internet by using your device's mobile data.

1 On the settings screen, tap Network & internet > Tethering > Wi-Fi
hotspot and then tap to activate it.

7 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi name (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.

+ This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

« More information is available at this web site:
http7/www.android.com/tether#wifi

Wi-Fi hotspot turn off timer

When the Wi-Fi hotspot has not been used for a specific period of time,
it is automatically disconnected. You can set the time for automatic
disconnection.

Bluetooth tethering

A Bluetooth-connected device can connect to the Internet by using your
device’s mobile data.

1 On the settings screen, tap Network & internet > Tethering >
Bluetooth tethering and then tap to activate it.

2 Turn on Bluetooth on both devices and pair them.
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5 - This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Network & internet > Tethering > Help.

Airplane mode

You can turn off the call and mobile data functions. When this mode is
on, functions that do not involve data, such as games and music playback,
remain available.

71 Onthe settings screen, tap Network & internet > Airplane mode.

2 Tap ())in the confirmation screen.

Mobile networks
You can customise the mobile networks settings.
7 Onthe settings screen, tap Network & internet > Mobile networks.
2 Customise the following settings:
+ Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

+ Network operators: Search for network operators and connect
automatically to a network.
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VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN

1 On the settings screen, tap Network & internet > VPN.

2 Tap+

3 Enter VPN details and tap Save.

Configuring VPN settings
71 Tapa VPN from the VPNS list.

2 Enter the VPN user account details and tap Connect.

- To save the account details, select the Save account information
checkbox.

Private DNS

You can configure the Private DNS (Domain Name System) options.
7 On the settings screen, tap Network & internet > Private DNS.
2 Select the desired option and tap Save.
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Connected devices

Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

71 On the settings screen, tap Connected devices > Bluetooth.

2 Tap to activate it.
+ Available devices appear automatically.
+ To refresh the device list, tap (.

5 + Only devices set as visible are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E « This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

2 Tap << > Bluetooth.

3 Select a target device for the file.
« The file is sent as soon as the target device accepts it.

E + File sharing processes may differ, depending on the file.
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Screen sharing

You can play the screen and sound of the device on a different device,
such as a TV, that supports the Miracast function.

7 On the settings screen, tap Connected devices > Screen sharing.
2 Tap () toactivate it.

3 Select a device from the list of nearby devices.
« If the desired device does not appear, tap Search to refresh the list.

+ After connecting to the device, the device displays the screen of
your device.

« Screen sharing turns off automatically if there is no sharing-compatible
device in the vicinity.

NFC

You can use the device as a transportation card or credit card. You can also
share data with the other device.

71 On the settings screen, tap Connected devices > NFC.

2 Tap())toactivate it.

« Touch your device with other device that supports NFC to allow
sharing data.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.
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Sharing panel

You can share contents from Gallery, Music and File Manager with nearby
devices. Also you can share the content with specific people in apps that
work with Google Direct Share.

7 Onthe settings screen, tap Connected devices > Sharing panel.

7 Tap @  to deactivate each option.

- Nearby devices: You can display the nearby devices to which you
can share contents on the Gallery, Music, and File Manager apps.

- Direct share: From an app which supports Google Direct Share, you
can display an icon which allows you to share contents to specific
people.

File sharing

You can send and receive files between your device and other LG devices
or tablets.

7 On the settings screen, tap Connected devices > File sharing.
2 Customise the following settings:
+ WING: Change the device name.

- Save to: Set the destination folder to save files sent from other
devices in.

+ File sharing: Permit receipt of files sent from other devices.

- SmartShare Beam: Share files with other devices via SmartShare
Beam.

+ Help: You can view help on sharing files.
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Media server

You can share media content on your device with nearby devices that
support DLNA.

7 On the settings screen, tap Connected devices > Media server.

2 Customise the following settings:
- Content sharing: Share content on your device with nearby devices.
+ WING: Set your device's name.

E - Depending on the user's product, the menu names may appear
differently.

- Content to share: Select the type of media content to share with
other devices.

- Allowed devices: View a list of devices permitted to access content

on your device.

Not-allowed devices: View a list of devices not permitted to access

content on your device.

Printing
You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.
On the settings screen, tap Connected devices > Printing.
- Tap Default Print Service to search for printers you can connect to. Or;
tap ¢ > Add printer to manually add a printer.
+ Tap (+) Add service to download the printer app you want.

E « This is available only when the mobile network or the Bluetooth
function is turned on.

- To down the printer app in (+) Add service, first log on to your Google
account.
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Sound

You can customise sound, vibrate and notification settings.

On the settings screen, tap Sound and customise the following settings:

Sound profile: Change the sound mode to Sound, Vibrate only, or
Silent.

Volume: Adjust the sound volume for various items.
Ringtone: Select a ringtone for incoming calls. Add or delete ringtones.

Notification sound: Select a notification ringtone. Set music saved on
the device as a notification ringtone.

System sounds: Select each system sound to turn on or off.

+ Ring with vibration: Set the device to vibrate and play a ringtone

simultaneously.

+ Ringtone ID: Create a ringtone for an incoming call from a particular

contact.

+ Flash alert for incoming call: Set the flash to blink according to LG

ringtone.

- Do not disturb: Set the time, range and app type to receive

notification messages. Receive notification messages only on particular
days of the week.

Sound quality and effects: Use the function to set the sound quality
and effects while playing a song or video.

Volume: Adjust the sound volume for various items.

Normalize volume: Use the function to normalise the volumes of
different sound sources.

Equalizer: Use the function to adjust the equaliser settings.

LG 3D Sound Engine: Use the function to play music or video in
three-dimensional, immersive and vivid sound when earphones,
speaker or other external audio devices are connected. See LG 3D
Sound Engine for detalls.

Live Caption: Set the device to detect the voice in the media and
automatically generate subtitles.
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- Vibration strength: Adjust the vibration intensity.

- Vibration type: You can select the type of vibration when receiving
calls.

- Vibrate on tap: Set the device to vibrate when you tap certain items
on the screen.

Notifications

You can check a list of installed apps, and configure the settings for
notifications.
1 On the settings screen, tap Notifications.

2 Customise the settings as desired.

Display
You can customise detailed settings for each screen type.
On the settings screen, tap Display and customise the following settings:

- Basic Home: Customise settings for the Home screen. See Home
screen settings for details.

- Swivel Home: Customise settings for the Swivel Home mode.

- Navigation bar: Configure the Navigation bar. For details, see Using
Navigation bar.

- AOD (always-on display): Always display information, such as the
date, time and notifications, even when the screen is turned off. For
details, see AOD (always-on display).

- Second Screen: Set the brightness or screen colour of the second
screen.

- Comfort view: Set the device to reduce amount of blue light on screen
to reduce eye strain.

- Night mode: You can apply a dimmed screen theme to avoid glare on
the screen at night time.
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- Screen colour: Adjust the colour, colour temperature for the desired
screen.

E - Tap®) toreset the settings.

Video Enhancer: \When playing back a video in full screen mode, you
can change the settings for brighter and more dynamic colour display.

Font: Change the font size, bold text or type.

Accent colour: Change the accent colour for settings, menus,
notification windows, etc.

Display size: Set the items on the screen to a size easy for you to see.
Some items may change position.

Full screen apps: Select apps to open in full screen.

Brightness: Use the slide bar to change the device's screen brightness.

+ Auto: Set the device so that the screen brightness is automatically
adjusted in accordance with the ambient light intensity.

- Extra brightness: Allows the display to be brighter than the maximum

brightness.

Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

Auto-rotate screen: Automatically rotate the screen according to the
device’s orientation.

Screen saver: Display a screen saver when the device is connected to
the holder or charger. Select a screen saver type to display.

One-handed screen: Make the screen size smaller to conveniently use
the device with one hand.
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Wallpaper & theme

You can select wallpaper, screen theme, icon style or AOD (Always-on
Display) for your device.
1 On the settings screen, tap Wallpaper & theme.

2 Tap Wallpaper, Theme, Icon, or AOD to customise the settings.

Lock screen & security
You can customise lock screen and security settings.
71 On the settings screen, tap Lock screen & security.
2 Customise the settings.
- Google Play Protect: Scan your device daily for potentially harmful
apps.

+ Find My Device: Remotely track the device location. You can also
protect your data securely if you lost your device.

- Security update: Check for software update and configure
automatic installation settings.

- Select screen lock: Select the desired screen lock method. See
Setting a screen lock for details.

- Customise Lock screen: Change the information displayed on the
locked screen.

- Secure lock settings: Change the secure lock settings.

- Fingerprints: Use your fingerprint to unlock the screen or content.
See Fingerprint recognition overview for details.

+ Content lock: Allow you to set a lock type (password or pattern)
for your Gallery files.

- Encryption & credentials: Configure the settings for SD card
encryption and credentials.

- Encrypt SD card: Encrypt the memory card to prevent use on
another device. See Memory card encryption for detalls.
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Credential protection: View the type of the storage where the
security certificate will be saved.

Trusted credentials: View your system's root CA certificates and
user-installed CA certificates.

- User credentials: View and change secure certificate information
stored on your device.

Install from storage:Install a secure certificate from a storage.

- Clear credentials: Delete user-installed secure certificates and
related credentials.

Phone administrators: Allow privileges to restrict the control or
use of the device to particular apps.

Trust agents: View and use trust agents installed on the device.

Screen pin: Fix the app screen so that only the currently active app
can be used.

Usage access: VView details on usage of apps on the device.

Privacy
You can find and adjust all your privacy settings.
71 Onthe settings screen, tap Privacy.

2 Customise the settings.

+ Permission manager: Allows you to check and change the
permissions granted to the apps.

« Lock screen: Allows you to set notifications to show on the lock
screen.

-+ Make passwords visible: Enable this option to briefly show each
character of the password as you type it so you can see what you've
entered.

- Device Personalisation Services: Allows you to get a suggestion
based on users, apps, and interactive content.
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Auto-fill service from Google: Enable this option to enter your
information saved in your account such as password, address,

or credit card number with a single tap. You can also disable this
option, use the Google Autocomplete feature, or add a new service
account.

Google Location History: Allows you to enable or disable Location
History. When enabled, Google periodically stores and uses your
phone's most recent location data in connection with your Google
Account.

From the Location History screen, tap : to view and/or manage
your location data.

Activity controls: Select activities and information which you want
Google to save.

Ads: Allows you to check the advertising ID and set the personalised
ads.

Usage and diagnostics: Enable this option to help improve the
Android experience by automatically sending diagnostic, device, and
app usage data to Google.

Location

You can check how your location information is shared and configure the
permission to access your location information.

On the settings screen, tap Location and set the desired function.
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Extensions

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it.

On the settings screen, tap Extensions > Smart Doctor.

Context Awareness

You can automatically change your device settings according to the usage
pattern and location.

7 Onthe settings screen, tap Extensions > Context Awareness.

7 Activate items you want to automatically change settings for.
+ AUTOMATED: You can set the device to change the sound
profile, Bluetooth and Wi-Fi options automatically in different
environments, such as At home, Away from home, At work, and Off
work. You can also set an app to open when earphones are plugged
in or a Bluetooth device is connected.

E + To use this feature, home or work location must be preset in My places.
On the settings screen, tap Location > My places to set the locations.

Personalised service

You can get intelligent results when using the integrated search.

7 On the settings screen, tap Extensions > Personalised service.
2 Tap())toactivate it.
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Extended view on Swivel Mode

Apps can be extended across both screens in Swivel Mode.

7 Onthe settings screen, tap Extensions > Extended view on Swivel
Mode.

2 Tap () toactivate it.

- EXTENDED BY DEFAULT: You can see an app in Extended view
when opening the app on the Main screen.

Gaming
You can configure settings for game tools, graphics and battery saving
feature.
7 Onthe settings screen, tap Extensions > Gaming.
2 Customise the following settings:
+ Game Launcher:Tap () to use the game launcher.

- Game tools: You can run the function while playing games by
touching the game tools icon among the home touch buttons.

- Game graphics: Adjust the game graphics.
E + When you change the resolutions on some games, the screen display
feature may not work properly.

« This function may not be available in certain game apps.

- Break time: Reduce the screen brightness and performance
whenever you leave the game running for more than 5 minutes.
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Screen recording
You can configure the settings for screen recording.
1 On the settings screen, tap Extensions > Screen recording.
2 Customise the following settings:
+ Include yourself in video by: Select one from the following options.

- Image:Includes your profile image in video when recording. After
selecting this, tap @ and select a profile image. Then, adjust the
size of the image using the slide bar.

- Front camera:Includes yourself recorded using the front camera
while recording the screen.

- Never: Nothing is included.

+ Audio source: Choose the audio source between Mic and

Contents.

- Video resolution: Select the resolution for screen recording.

Dual App
You can install duplicate messenger apps on the product and use two
accounts at the same time.

7 On the settings screen, tap Extensions > Dual App.
7 After reading the disclaimer; tap Confirm.

3 Inthe list of available apps, tap Install to install a copy of a desired app
and follow the on-screen instructions.

+ On the screen, the list of available dual apps is shown. During
installation, app icons are generated on the home screen.
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App suggestion

You can quickly access apps that you may need at the moment on the
Overview screen.

On the settings screen, tap Extensions > App suggestion.

Pen

You can configure options for using an Active pen (optional-sold
separately). Please note that this device supports the Active Pen AES2.0
(Active Electrostatic).

1 On the settings screen, tap Extensions > Pen.

2 Customise the following settings:

+ Pen key shortcuts: Configure the shortcuts on each button on
your Active pen.

- Pen Pop shortcut: Select which apps (up to five) to display as a
shortcut when the pen is removed from the device.

+ Memo preview: Turn on to display recent memos in Pen pop.
- Drawing sound: Turn on to apply sound effects in drawing mode.

- Show pointer: Turn on to see a pen pointer over where the pen
hovers.

- Ignore navigation bar gestures: Block navigation bar gestures
from being input, which is useful when drawing or writing on the
edge of the screen with an Active pen.
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Shortcuts
You can use buttons such as the Lock/Power, Volume, and Google
Assistant to run certain apps or functions right away.
71 Onthe settings screen, tap Extensions > Shortcuts.
2 Customise the following settings.
- Open Camera: Press Power key twice to open Camera.

- Open Screen-off memo: Press Volume Up key twice to open
Screen-off memo when the screen is locked or off.

- Open Camera: Press Volume Down key twice to open Camera
when the screen is locked or off.

5 + Google Assistant does not support certain languages.

KnockON

Double-tap the screen to turn the screen on or off.
See KnockON for details.

Increase touch sensitivity

You can set the touch screen more sensitive to your touch. Recommended
to turn this feature on when using a screen protector.

On the settings screen, tap Extensions > Increase touch sensitivity.
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Apps

You can check a list of installed apps, and configure the settings for
notifications, app permissions, and more.

1 On the settings screen, tap Apps.

2 Customise the settings.

Battery

You can view the current battery information or turn on power-saving
mode.

71 Onthe settings screen, tap Battery.

2 Customise the following settings:
- Battery usage: View the battery usage detalils.

- Optimised charging: Automatically adjust charging speed according
to how you charge to reduce heat and extend lifespan of battery.

- Adaptive battery: Allow you to save the battery by stopping apps
running in the background.

- Background restrictions: Enable this option to restrict background
apps to save the battery while using the device. Restricted apps
for power saving may not work properly or may not send you
notifications.

- Battery saver: Reduce battery consumption by cutting down some
device settings, such as the display brightness, speed and vibration
intensity.

- Power saving exclusions: Select apps to use without any
functional limitation while in power saving or battery optimisation
mode.
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Storage

You can view and manage internal storage on the device or storage space
of the memory card.

1 On the settings screen, tap Storage.

2 Customise the following settings:

- Internal storage: View the total storage space and free space in the
devices internal storage. View a list of apps in use and the storage
capacity for each app.

+ SD card: View the total storage space and free space in the
memory card. This option appears only when a memory card is
inserted. To unmount the memory card, tap

Accounts
You can add users to share your device and register a cloud account.
1 On the settings screen, tap Accounts.

2 Customise the settings.

Digital Wellbeing & parental
controls

You can view the product use time and set the timer for each app. Also,
you can manage the mobile phone use time by using the Bedtime Mode
and Focus Mode.

Select Digital Wellbeing & parental controls on the settings screen and
set the desired function.
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Google

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap Google.

System

Update centre

You can check and install the latest version of the app or software
provided by LG.

1 On the settings screen, tap System > Update centre.

2 Customise the following settings:

+ App Updates: Check if an app update is available. If available, you
can install the update.

- Software Update: Check if a software update is available. If
available, you can install the update.

Language & keyboard

You can customise language and keyboard settings for your device.
1 On the settings screen, tap System > Language & keyboard.

2 Customise the following settings:
- Language: Select a language to apply for the device.

- Manage keyboards: You can change the product’s basic keyboard
setting, set the use environments for LG Keyboard or other installed
keyboards, and set the speech recognition function for Google Voice
input. Also, you can set whether to display the keyboard button in
the touch button area on the home screen so that you can quickly
switch to another keyboard.
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Physical keyboard: Select to use the physical keyboard, or check
keyboard shortcut keys.

Autofill service: Enable this option to enter your information saved
in your account such as password, address, or credit card number
with a single tap. You can also disable this option, use Google
Autocomplete, or add a new service account.

Text-to-speech output: Configure the settings for text-to-speech
output.

Pointer speed: Adjust the pointer speed of a mouse or trackpad.

Reverse mouse buttons: Reverse the right mouse button to
perform primary direct-manipulation actions.

Date & time
You can customise date and time settings for your device.
1 On the settings screen, tap System > Date & time.

2 Customise the settings.

Memory

You can view the average amount of memory usage over a certain period
of time and the memory occupied by an app.

7 On the settings screen, tap System > Memory.

7 Tap w to set a time slot to retrieve data.
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Backup

You can back up data saved on your device to another device or account.
T On the settings screen, tap System > Backup.

2 Customise the following settings:
+ LG Mobile Switch: Allow you to transfer data from an old LG device
to your new LG device. See LG Mobile Switch for detalls.

- Backup & restore: Back up your device data or restore data to your
device from a backup.

A + Resetting your device may delete backup files saved in storage. Make
sure to copy and store the important backup files to your PC.

+ Google backup: Change Google drive backup settings. You can
also check the backup account currently used, or add a new backup
account.

Restart & reset
You can reset the device including network and app settings.
7 Onthe settings screen, tap System > Restart & reset.

2 Customise the following settings:

- Auto-restart: Automatically restart and optimise the phone at a
set time. Tap () to activate this feature. The device automatically
restarts at a set time and optimise itself: Select a date and time for
restart.
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E + You can set the device to restart itself once a week. The device
automatically restarts in an hour from the preset time.

+ Once the device restarts, notifications and badges are erased. Save
important data before the preset time.

+ The Auto-restart feature is not activated in the following situations:
When the screen is turned on, when the device is in use, when the
battery levelis 30% or less, or when the USIM card is locked.

- Depending on the telecommunication provider, the auto-restart
function may or may not be available.

+ Network settings reset: Reset Wi-Fi, Bluetooth and other network
settings.

Reset app preferences: Reset the settings for an app. The data
saved in the app will not be deleted.

Reset settings: Reset all system settings back to default.

- Factory data reset: Reset all settings for the device and delete
data.

E + Restarting and resetting your device deletes all data on it. Enter your
device name, Google Account and other initial information again.

« After data initialisation, the data cannot be restored.

About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap System > About phone and view information.

Regulatory & safety
You can view regulatory marks and related information on your device.
On the settings screen, tap System > Regulatory & safety.
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Accessibility
You can manage accessibility plug-ins installed on your device.
T On the settings screen, tap Accessibility.

2 Customise the following settings:

- Vision > TalkBack: Set the device to notify screen status or actions
via voice.

- Vision > Voice notifications: Set the device to read the caller
information via voice.

- Vision > Font: Change the font size, bold text or type.

- Vision > Display size: Set the items on the screen to a size easy for
you to see. Some items may change position.

- Vision > Touch zoom: Zoom in or out by tapping the screen three
times.

- Vision > Window zoom: Zoom in or out within a window and invert
the colour.

- Vision > Large mouse pointer: Magnify the mouse pointer.

- Vision > High contrast screen: Turn the background colour into
black for a high contrast screen.

- Vision > Screen colour inversion:Increase the display colour
contrast for people with low vision.

+ Vision > Screen colour adjustment: Adjust the display colour.
- Vision > Monochrome: Switch the screen to grayscale mode.

+ Vision > End call with the Power key: End a call by pressing the
Power/Lock key.

- Hearing > Live Caption: Set the device to detect the voice from the
media and automatically generate subtitles.

- Hearing > Caption preferences: Turn on the subtitle service when
playing videos for the hearing impaired.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls, messages and alarms.
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+ Hearing > Mute all sounds: Mute all sounds and lower volume on
the receiver.

+ Hearing > Audio channel: Select the audio type.

+ Hearing > Sound balance: Adjust the audio output balance. Use the
slide bar to change the balance.

+ Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

+ Motor & cognition > Touch input: Enter text by touching and
holding the screen or modify it by simply touching the screen.

- Motor & cognition > Physical keyboard: Customise the keyboard
settings.

+ Motor & cognition > Auto mouse click: Automatically click the
mouse pointer in case of no movement.

+ Motor & cognition > Touch and hold for calls: Answer or decline
calls by touching and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.

+ Accessibility features shortcut: Quickly access a frequently used
function by tapping O three times.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

- Select to Speak: Allow you to tap items to hear spoken feedback.
+ Switch Access: Create key combinations to control your device.
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Language Settings
Select a language to use on your device.

+ On the home screen, tap Settings > System > Language & keyboard
> Language > Add language, and select a language.

- Touch and hold = and drag it to the top of the language list to set it
as a default language.

LG Bridge

LG Bridge overview
You can back up contacts, photos and more to the computer or update
the device software.

E + See LG Bridge help for detalils.
+ The supported features may vary depending on the device.

+ LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
- Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

- Update the device software from a computer via USB cable connection.
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Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Select your region.
3 Click Support > Software & Firmware.
4 Enter the name of your device.
OR
Select by the Product Category.
5 Go to PC Sync > LG Bridge to download the setup file.

+ Go to Details to view the minimum requirements for installing
LG Bridge.

Phone software update

LG Mobile phone software update from the

Internet

For more information about using this function, please visit
http//wwwi.lg.com/common/index,sp, select your country and language.
This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

+ LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-
the-Air (OTA)

This feature allows you to conveniently update your phone's software to
a newer version via OTA, without connecting a USB cable. This feature will

only be available if and when LG makes a newer firmware version available
for your device.

To perform the phone software update,

Settings > System > Update centre > Software Update > Check now
for update.

E « Your personal data from internal phone storage—including information
about your Google Account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone’s software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google Account or screen

lock information can use the device.

All you need to make sure your device is protected is:

- Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

+ Add your Google Account on your device: If your device is wiped but
you have your Google Account on it, the device can't finish the setup
process until your Google Account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google Account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E « Do not forget your Google Account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.
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Open Source Software Notice
Information

To obtain the source code under GPL, LGPL, MPL, and other open
source licenses, that is contained in this product, please visit
http://opensource.lge.com.

In addition to the source code, all referred license terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM
for a charge covering the cost of performing such distribution (such
as the cost of media, shipping, and handling) upon email request to
opensource(@lge.com.

This offer is valid for a period of three years after our last shipment of this
product. This offer is valid to anyone in receipt of this information.

Regulatory information
(Regulation ID number, E-labeling, etc.)

For regulatory details, go to Settings > System > Regulatory & safety.
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Trademarks

+ Copyright ©2020 LG Electronics Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- Bluetooth®is a registered trademark of Bluetooth SIG, Inc. worldwide.

- Wi-Fi® and the Wi-Filogo are registered trademarks of the Wi-Fi
Alliance.

+ All other trademarks and copyrights are the property of their
respective owners.

HE HEVCAdvance™

‘E Covered by Patents at patentlisthevcadvance.com
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Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.
To prevent direct exposure to laser beam, do not try to open the enclosure
or make direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-F100EMW product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration
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Contact office for compliance of
this product

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

The use of the 5150 - 5350 MHz band is restricted to indoor use only.

AT | BE | BG | CH|CY|cz|DE|DK|EE| EL
Q ES A |{FRI[HR|HU|E |15 | m|U /L

WL M| NC|NO|PL|PT|RO|SE]| S

sk | AL [ ME|RS | mk| TR | BA | XK |ukow)

5G capability depends on the actual 5G network availability and compatibility
with the product. Please check the compatibility status on www.lg.com/it
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More information

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

- If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Aspect ratio
Some downloaded apps may not support specific aspect ratio.

In this case, select the most optimal screen ratio for the app or consult
the app provider for more information.

Appendix 174



Guide to data transfers

- For the data that can be exchange between LG devices or between the

LG device and a third party device, see the following table.

Third party
LG device Android iOS device
Type Item details - device —
LG device - LG device
LG device

Contacts, messages,

dial logs, calendar, voice @) O O
Personal | recordings
data Memos X O

Alarms X X
Media Photos, videos, songs,
data documents o o O

Home screen settings

(folders and widgets) % X X
Screen
settings Lock screen settings

(screen lock settings @) X X

excluded)

Downloaded apps O O
Apps Personal data of the o X B

downloaded app

Public certificate @) @) X
Others | Settings (Wi-Fi, Bluetooth,

Calls, sound & notification, @) X X

accessibility, battery)

E + Some data may not be transmitted depending on the software version,
app version, operating system, manufacturer or service provider's policy.
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Supported Frequency Bands Transmitter Output power

GSM 900 33.7dBm
GSM 1800 30.7dBm
W B1 24.2 dBm
W B8 25.2dBm
LTE B1 25.2dBm
LTEB3 23.7dBm
LTEB7 23.7dBm
LTE B8 25.2dBm
LTE B20 25.2dBm
LTEB28 25.2dBm
LTEB38 25.2dBm
LTE B40 25.2dBm
5G Sub6n1 25.2dBm
5G Sub6n3 25.2dBm
5G Sub6n7 25.2dBm
5G Sub6n28 25.2dBm
5G Sub6n78 22.7dBm
BT 2.4GHz 12dBm
WLAN 2.4GHz 19.dBm
WLAN 5GHz 20 dBm
NFC - 23 dBuA/m

Travel Adapter Information can be found at
http//www.lg.com/global/support/cedoc/cedoc
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from the

municipal waste stream via designated collection facilities appointed
by the government or the local authorities.

3. The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FAQ

This chapter lists some problems you might encounter when using your
device. Some problems require you to call your service provider, but most
are easy to fix yourself.

SIM card error
Make sure the SIM card is correctly inserted.

No network connection or dropped network
Signal is weak. Move to a window or an open area.
You are outside the carrier network area. Move and check the network.

Calls are not available

New network not authorised.

Make sure you have not set call barring for the incoming number:
Make sure you have not set call barring for the number you are dialling.

Device cannot be turned on
When the battery is completely discharged, your device will not turn on.
Fully charge the battery before turning on the device.

Charging error

Make sure device is charging at a normal temperature.
Check the charger and its connection to the device.

Use only in-box accessories which are authorised by LG.

The battery depletes faster than when first purchased

When you expose the device or the battery to very cold or hot
temperatures, the battery life may be reduced.

Battery consumption will increase when you use certain features or apps,
such as GPS, games or the Internet.

The battery is consumable and the battery life will get shorter over time.
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Error messages appear when launching the camera
Charge the battery.

Free some memory by transferring files to a computer or deleting files
from your device.

Restart the device.

If you are still having trouble with the camera app after trying these tips,
contact a LG Electronics Service Centre.

The photo quality is poor
The quality of your photos may vary, depending on the surroundings and
the photography techniques you use.

If you take photos and videos, standard angle quality is better than wide-
angle.

If you take photos in dark areas, at night or indoors, image noise may
occur or images may be out of focus.

If you have any problems, reset the options.

The touch screen responds slowly or incorrectly

If you attach a screen protector or optional accessories to the touch
screen, the touch screen may not function properly.

If you are wearing gloves, if your hands are not clean while touching the
touch screen or if you tap the screen with sharp objects or your fingertips,
the touch screen may malfunction.

The touch screen may malfunction in humid conditions or when exposed
to water.

Restart your device to clear any temporary software bugs.

If the touch screen is scratched or damaged, visit a LG Electronics Service
Centre.
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Hangs or freezes

Restart the device

- If your device freezes or hangs, you may need to close apps or turn the
device off and then on again.

Perform a boot-up

- Asoft reset may be used to reset the device if the screen freezes, or
the buttons, touch screen or device are no longer responding.

- To perform a soft reset of your device, simply press and hold the
Volume Down and Power keys until the device restarts.

Reset the device
- If the methods above do not solve your problem, perform a factory
datareset.
- On the settings screen, tap System > Restart & reset > Factory data
reset.

- This method resets all settings for the device and deletes data.
Before performing the factory data reset, remember to make back-
up copies of all important data stored in the device.

- If you registered a Google Account to the device, you must sign in to
the same Google Account after resetting the device.
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Bluetooth device is not located
Make sure the Bluetooth wireless feature is activated on your device.

Make sure the Bluetooth wireless feature is activated on the device you
wish to connect to.

Make sure your device and the other Bluetooth device are within the
maximum Bluetooth range (10 m).

If the tips above do not solve your problem, contact a LG Electronics
Service Centre.

A connection is not established when you connect the
device to a computer
Make sure the USB cable you are using is compatible with your device.

Make sure you have the proper driver installed and updated on your
computer.

Downloaded application causes a lot of errors
Application has problems.
Remove and reinstall the application.
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